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Lesson 00 

 Introduction

Getting to know TVPaint Animation

TVPaint Animation is a program compiled for graphic design and 2D animation. This program is intended 
for drawing and animation enthusiasts. With its bitmap approach, its goal is to cover the main needs of  
the artist. It offers a complete range of high-performance tools, the parameters of which may be set,  
whether for the layman or the professional artist and yet still offers the creative feeling provided by pen 
and paper.

TVPaint Animation is home studio.

Based on TVPaint technology, which is renowned worldwide since its success on the Amiga in 1991 and 
constantly upgraded for ever better performance, TVPaint Animation adapts to all production diagrams, 
whether traditional, fully digital or hybrid. 

Designed to work in all resolutions, it will delight all drawing enthusiasts thanks to its tools which offer 
limitless possibilities. Your creations are only restricted by the boundaries of your imagination !

Typographic conventions

In  order  to  simplify  understanding  of  the  techniques  described,  this  user  guide  uses  the  following 
typographic conventions :

- Italics : the names of menus, buttons, tabs, windows, commands, tools (all elements referring to one of 
the objects present in the program) are written in italics.
- [key] : designates a keyboard shortcuts.
- [key1+key2] : designates a key combination. Keep the first key pressed and then press the second key.
- left click / right click (LMB, RMB) : these shortcuts refer to a click on the left or right mouse button. 

As you are advancing in this manual, you will encounter the following symbols: 

 TIP

A symbol  representing  a  light  bulb  indicates  tips  and  hints  for  using  the 
program. 

 Remark

A symbol representing a warning sign  emphasises information that requires 
particular attention and indicates an important comment.

 Reminder

The reminder symbol  characterises any information the explication of which 
was already given in the manual.

 Pro only
All  the  features  with  this  symbol  imply  that  they  are  available  only  in 
TVPaint Animation Professional Edition.





Lesson 1

First approach of TVPaint Animation

In this lesson you will:

● Learn to open and close TVPaint Animation.

● Discover the various panels and windows.

● Start a project.

● Access InLine help.

● Set your preferences.



First approach of TVPaint Animation

After having followed the installation instructions in the Getting Started guide, you may now start 
TVPaint Animation. To do this, proceed as follows:
* Double-click on the desktop icon or use the start menu (for Windows users).
* Double-click on the applications folder icon or dock icon (for Mac OS X and Linux users).

The  TVPaint  Animation program and most  of the associated files are saved in the «program» 
directory of your operating system.

To use  TVPaint Animation, you may choose between the mouse or graphic tablet. The latter is 
more appropriate for persons wishing to have that « freehand » design feeling.

The various program panels

When the program is started, the following screen appears. 

Here you will find a description of the various panels displayed on the screen.

The Menu panel

The first  icons on this  toolbar  concern  the traditional  functions  found in  all  standard software 
packages: New (start a new project), Load (load an existing project), Save (save current project), 
Close (close the current project).
The  following  icons  are  used  to  open  or  close  various  TVPaint  Animation  panels (display 
coordinates, light table, timeline, etc.).
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The various program panels

To  move  the  menu  panel,  click  on  the  two  left 
vertical bars of the menu panel and hold the left 
mouse button, then move the cursor as required. 

The menu Panel then appears as opposite in the form of a 
panel.

Main panel

This panel is used to draw segments, ellipses, rectangles, 
curves,...  Brush  selection  and  cutting  options  are  also 
available here.

Color picker

This panel is used to select the color in which you wish to 
work.  Distinction  is  made  between  the A color (always 
referred  to  as  main  color)  in  the  left  rectangle  and  the 
B color in the right rectangle.

Tool panel

The  tool  panel  contains  a  wide  choice  of  buttons 
corresponding  to  traditional  drawing  tools:  airbrush,  brush, 
pencil, wet brush, etc.

Various parameters may be set: size, power, opacity, etc.
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The various program panels

  
Current project window

The current project window (or current drawing space) is the one in which you will  be able to 
express your artistic talents and create a wide variety of animated sequences.

The Timeline

This window is called a  «timeline» by many users. It is used to manage your notes, your sound 
tracks, your layers and insert keys for your effects (we will  discuss these points in subsequent 
lessons).

 

If the layer window is not visible on the screen, click on the Timeline 
icon on the toolbar to make it appear (keyboard shortcut [0] on the 
numeric pad).
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The various program panels

The Panel Bins

This feature is represented by two available free areas on each side of the screen.

These two additional  areas allow you to place  and arrange almost  all  the  panels  of  TVPaint 
Animation. With this feature, the workspace becomes totally clear.

The workspace can now be divided into 4 main parts containing the Current project window, the 
Time Line window and the two Panel Bins.

A full section will be dedicated to the Panel Bin feature in a next lesson.

Main menu

TVPaint Animation has menus located just above : File, Edit, Project, Layer, Image, Effects, View,  
Windows, Help.
Each of these menus offers specific options all of which will be described in detail in this manual.
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The various program panels

Working in Full Screen mode

A button, located at the top right corner of your interface, will allow you to work in full screen mode 
and optimize the space on scree.

 On Windows et Linux
 On Mac

Info Bar

This Info Bar is located at the bottom of the TVPaint Animation window. It contains information that 
the user likes to always have under their eyes.

* The first box contains the coordinates of the cursor (x, y), where the position (0,0) starts at the top 
left corner of the project.

* The second box contains the color of the image when the cursor moves over the project. This 
color considers the Alpha channel value of the pixel under the cursor of the project.
It means that the selected background color has no effect on these values. (When you start a new 
empty project, the image is not white but totally transparent, like this box will show you).

* The third box indicates the Proxy state. By the way, if you preview an animation with some lag,  
this element will become red.

 

* The fourth box can display several informations :

By default, it displays the title of the timeline. 

If the cursor is over a button with a help tooltip, the box displays instantaneously the first line of the 
help tooltip. 

And when a progress bar panel appears, the progress line is also shown in this box.

The  last  box  contains  all  the  Rooms,  and  gives  you  the  possibility  to  navigate 
between all of them. The Rooms section will be seen further in a next lesson.
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Some useful tips

Some useful tips

Move a window

If for some reason you wish to move a window, this is done by simply clicking on the title bar and 
then moving it to the required location while keeping the mouse pressed.

Close, minimize or maximize a window

On Windows, Mac and Linux, three buttons are present on most of panels and windows.

Windows and Linux Mac

Close the software, the project's window or the panel

Maximize / minimize the software or project's window

Reduce the software's window in the task bar or the dock

Collapse / uncollapse the project's window or the panel  / 

The size of some windows, the timeline for example, may be adjusted: it is possible to adjust their 
size with precision by clicking on one of the edges.

By the way, some shortcut may be used :
• [CTRL + W] or [CMD + W] to close a the project's window (without closing the project)
• [Shift + W] to close a project
• [M] to duplicate the window's project (attention, this manipulation is visible only if your window's 
project is minimized)

Sliders and mini-sliders

                          

The element above on the left  is  referred to as a slider.  It  is  located horizontally  under some 
windows (in particular under the current project window) or vertically next to these windows.
Click on the arrows with the left mouse button or slide the rectangle to view the content of the 
window with which the slider is associated, either up and down or left and right. 
As you have already guessed: the element on the right is a mini-slider which may be used to 
change the numeric value or percentage next to it with a left click and slide of the mouse on the 
double arrow.

When sliding the mouse on a mini-slider, press and hold the right button to 
accelerate movement.

Alphanumeric fields

   

Each time you rename a layer, project, effect or other element, you will be 
asked to enter a text in this type of window. Click on  OK to confirm the 
name change or click on Cancel.

The standard keyboard shortcuts:
[Ctrl+X] (cut), [Ctrl+C] (copy), [Ctrl+V] (paste), [Ctrl+A] (select all), [Ctrl+Z] (cancel) are valid in all 
alphanumeric fields (note that these shortcuts are valid for Windows and Linux. On Mac computers 
the user presses the [Cmd] key instead of [Ctrl]).
When required they are accessible with a right click on the concerned field.
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Progress bar

If required, the [Esc] key may be used to stop the operation in progress.

Working with projects

TVPaint Animation works with Projects which contain the artist's creations. The notion of project is 
vast and further details will be provided during the firsts lessons.

Create a new project

To do this, you may:

* Use the File main menu.
* Use the keyboard shortcut [Shift+N].
* Click on the first icon to the left on the toolbar.
 

The Template concept will be discussed in lesson 5.

The Project tab will be discussed in lesson 9.

    

Setting each parameter to create an animation in the 
format of your choice may be long and arduous.
Therefore,  a  popup menu  has  been  added  to  the 
panel to allow you to set the various numeric fields 
according to the most commonly used formats: PAL, 
NTSC, VGA, DTV, Film, etc.
Some of the pre-configured settings:
* Display : the format of the screen
* Clipboard : if there is an image in the Clipboard
* Current CustomBrush if a custom brush exists
* The Current Project format.
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Sometimes application of an effect with TVPaint 
Animation requires a certain amount of 
processing time. If your computer is carrying out 
such an operation, the progress bar appears to 
inform you of the progress of this operation.

A panel  then  appears  (see 
opposite).
This panel is used to define:

* The Name of your project 
*  Its  Width  and Height in 
pixels
*  The  Aspect  Ratio of  the 
pixels
*  The  Frame  Rate 
(Images/sec.)
* The Field display mode



Working with projects

TVPaint Animation uses all standard formats (even very high definition) both for image width/height 
ratios 4/3 and 16/9 as well as others.

Once all options have been selected, click on New Project. A project window then appears on the 
screen (see below). It is in this window that you will work and view your creations. 

  

TVPaint Animation allows you to work on several projects 
at the same time.

The maximum number of projects is limited only by the 
capabilities of your computer. 

View data relative to your project

To view data relative to your current project (size, frame rate, ratio, etc ...), simply move the cursor 
over the title bar and hold it there.

A small yellow window then appears with all the information you require.

Name a project

The default name for a new project is « Untitled (01) », « Untitled (02) », etc ... To render these  
names more understandable, it is possible to rename them as you wish.
To do this, simply use the  Project>Rename main menu.
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Working with several projects

TVPaint Animation offers the user the possibility to work with several projects on the screen at the 
same time. You can switch between the projects by clicking on the corresponding tab :

If you open several projects, you can switch to the needed project thanks to the little arrow on the 
right hand side. Please note the name of the open projects are listed in the menu  Windows > 
Projects. The checked name is the current project. 

Close a project

A project may be closed in four ways:
* Use the   button on the projects tab.
* Use the File > Close project main menu.
* Use the keyboard shortcut [Shift+W].

        

In order to avoid any mistakes, a confirmation 
message will appear (see opposite).
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The   Help   main menu  

InLine support

At  any  time,  a  help  function  referred  to  as  InLine  help, is  available  in  TVPaint  Animation.
Move the cursor over the icon for which you wish to obtain information (without clicking on it) and a 
brief description of the icon you are pointing at will appear together with any associated keyboard 
shortcut.

   

Opposite you will find the description corresponding to 
the Stroke tool.
If you wish to reduce the content of the InLine help or 
prevent  it  from appearing  on  the  screen  entirely,  the 
corresponding options are available in the Help menu.

The About... window

This section provides information about the program :
* name of TVPaint members
* name of beta-testers
* date of creation
* serial and license number
* copyrights

The Check for Updates option

This option allows you to check directly on TVPaint Développement's website if there is an update 
for your software. If your version is outdated, you will be allowed to download the latest version.
Lock and Unlock codes are needed to perform this operation.

To quit the program

We will now quit the program. To do this you may:

* Click on the Close button at the top of the screen  (Windows / Linux) or  (Mac)
* Select main menu File > Quit.
* Use the keyboard shortcut [Shift+Q]

If  you  want  to  quit  the  program,  with 
projects  that  still  need  to  be  saved,  a 
window asks if  you want  or  don't  want  to 
save all these projects before quitting.
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The   Preferences   panel     

The Preferences panel is accessible via the Edit main menu. This function is used to set various 
user options which enable re-organisation of the interface.

It comprises six tabs: General, Display, Interface, Memory & Cache, Sound, Startup.

The General tab 

The General tab indicated above comprises five sections.

* The first section Language is used to select the HMI language. At present, the user may choose 
between French, English and Japanese.

* The second section Keyboard shorts is used to attribute keyboard shortcuts to almost all icons 
and menu options.
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To create your own shortcuts, click on the  Configure button in the second section.  The window 
above then appears.

You  have  probably  noticed  that  when  the  InLine  help  appears,  many  tools,  options,  drawing 
modes, etc. already have associated keyboard shortcuts : don't hesitate to change them if they 
don't suit to you. Any modification in that panel will cause a modification in the InLine help.

Changing the shortcuts is really a piece of cake :

◦  The left-hand column indicates  all  keyboard keys and key combinations with  the associated 
functions when attributed.
◦ The right-hand column indicates all TVPaint Animation functions which may be attributed to a 
keyboard shortcut.
◦ The Assign button is used to assign a function to a specific key or combination of keys (in which 
case you will create a shortcut for this function). The combination [Ctrl] + Assign is used to add a 
function to a key. The various functions will be executed in the order they were added.
◦ The Unassign button has the opposite effect (in this case it deletes the shortcut).
◦ The File popup menu is used to save the keymap on your hard drive, load an existing keymap, 
clear the current keymap or reset to the default keymap.

* The third section Temp Directory of the General tab is used to define a temp directory in which 
temporary TVPaint Animation files may be stored.
◦ This directory may be modified using the associated text field or using the  Set button (a file 
navigator window then opens).
◦ The temporary files contain data relative to the current TVPaint Animation session. Data relative 
to your animations is also stored here (for example, the various stages of your work necessary for 
correct operation of the Undo and Redo options).

The faster the data storage device on which your temporary files are stored, the 
faster TVPaint Animation will work. Always ensure this storage device has sufficient 
available storage capacity.

Inexperienced users are not advised to change the default location.

* The fourth section of the General tab changes following your operating system.

◦ Windows     / Linux   :  Windows and Linux users can enable or disable the Sub-Pixel mode for future 
drawings. This is in direct relation with your hardware and, more precisely, with your graphic tablet 
if you are using one (we strongly recommend it!). 

All the latest models of Wacom® tablets work in Sub-Pixel, i.e. the tablet precision is greater than 
one pixel on the screen. Enabling this function when suitable hardware is used will allow you to use 
TVPaint Animation drawing tools with a precision greater than one pixel !

In the contrary case, if your hardware does not support this function, tablet management may be 
negatively affected (drift between the true position and the position of the cursor on the screen, for 
example) and will deliver results considerably different to those expected, in particular if you work 
with a platform of the TabletPC type or in double-screen configuration. 
We therefore recommend you check the compatibility of your hardware to  benefit fully from this 
function. 
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The Wintab option, when enable, allows you to use Wacom® drivers installed on your computer. If  
you are using another kind of  tablet,  based on the Windows'  Ink drivers, you can disable the 
Wintab option. 

◦  Mac OS X  : there is an additional OpenGL option. When this option is checked, it is OpenGL 
which displays all the interface of TVPaint Animation instead of QuickDraw. But, as it is said in the 
warning message before the confirmation to use this option, the OpenGL support is experimental 
with known bugs.

◦ That section also holds the Stroke Animator option. It is a likable function which allows to draw on 
a layer, during this one changes the current image each time the current tool is applied on the 
image.
For example, drawing with FreeHand Dot tool will apply each dot on a different image in the layer if 
this option is enabled and the [Ctrl] key held during the drawing.

* The section Save Alarm allows you to set an alarm that will remind you to save a project after a  
certain amount of time. This time can be defined in minutes in the text field below. At the end of the 
given time, a pop up alert will appear and will ask you to save your project :

* The section Backup Auto generates automatically backup files each time you will save, allowing 
you to get back your project, in case of problems (crash, lost file, human error, corrupted file etc...)

In the present case, “2” is written in the Backup Auto. It means each time you will save, there will  
be a shift between two backup files, plus a save on the main file (in .tvpp). 

Backup files are savec at the same place than the original .tvpp project and are named as follow : 
“file_name.tvpp.Year.Month.Day.Hour.Minute.Second”.

Each time you will save, the more ancient file will be modified, with a new date and hour. To open a 
backup file, you just have to delete the part with numbers, in order to keep only “file_name.tvpp”. 
An alert message will ask you if you want to convert your file as a .tvpp file. Accept, in order to  
open easily in TVPaint Animation. You can also drag and drop the file directly in TVPant Animation.

* The section Barbecue, once checked, will use your computer's resources at a maximum level. 
You shall avoid it if :
◦ you are using a portable device (your battery life will really poor) ;
◦ you are using other software, eager in ressources (crash risks).
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* The last section TVPP compression allows you to compress the size of your TVPaint flies 
(.tvpp), but keeps the same image quality.

Compressed files cannot be read by TVPaint Animation versions older than the 10.5 
version.

The Display tab 

The first section in the Display tab concerns brush and tool display (the latter will be discussed in 
detail in lesson 4).

* The Tool Display button is used to mask the tools preview when they are used as drawing tools. 
Only the mouse cursor remains visible on the screen and a frame indicates the exact location of  
the tool.
This option is sometimes practical when working on a computer with limited resources: the use and 
display of large tools may slow the computer down.

* When Hide shape display is disable, you could see the display of the current brush when using a 
shape tool, such as Rectangle or Ellipse.

*  The second section with the  Layer Icons option shows all  the thumbnails in a layer when a 
sequence is imported. It can take time to load and read all the images in the sequence to make the 
thumbnails, that's why it can be disabled and only the first and last one will be displayed.
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Layer Icons option Enabled

Layer Icons option Disabled

You can also disable or enable this option in the timeline 

* The last section contains several options for the Panel Bins feature. These functions will also be 
discussed in  the same lesson than the way to work with the  Panel  Bins.  Here is  only a brief 
description :
_ The left and right options display or not the left and right Panel Bins.
_ The options about the Time Line panel allow to display it differently.

 Horizontal Timeline

Vertical Timeline
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* The last section activate the Time code : your project will not be presented with a frame rate, but 
with a time code.

The Interface tab

* The first section "Color" of this tab may be used to modify the program interface colors.

The default colors used in TVPaint Animation are light gray in order not to interfere with the colors 
used in your projects. However, you are of course free to modify these colors as you wish.

◦ The first popup menu allows you to select the element for which you wish to modify the color 
(buttons, text selected, sliders, etc.). To the left of each element name, you will find a little colored 
box which shows-- the current color of the element.

◦ Next to this field you will find a square box indicating the display color of the interface element 
selected. Simply click on this box and then select any color on the screen to be assigned to this 
element.

◦ The Color scheme popup menu is used to quickly select a set of predefined colors or the default 
color scheme for the interface.

◦ The Highlight mini-slider, the Border and Mirror options give a new gradient look.

      

      

◦ The Save and Load options allows to share the interface settings.
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◦ The Reset button is used to return to the colors present when your configuration was loaded.

◦ The Apply button applies the selected colors to your current interface.

* The second section "Cursor" allows you to choose the Style of your cursor. The different choices 
are: cross, arrow, point or circle as illustrated here.

On Windows, four additional cursors are also available (Pen from 1 to 4), with the last one specially 
made for the left-handed persons.

* In the  third section  "Windows", the  Magnet option allows the various interface windows to be 
snapped to other windows and menus. This allows management of the interface to be quicker and 
more practical.
You may also choose to display the program without tool or title bars (for windows users), which 
increases the project working area.

* The fourth section "File requester" is used to select which type of file requester is to be used. 
Below you will  find examples of  TVPaint Animation specific as well  as standard Windows and 
Mac OS X file requesters. 

    
TVPaint interface    Windows interface 

    
Mac interface Linux interface 

    
The  TVPaint  Animation  file  requester  is  common  to  many  software  packages  developed  by 
TVPaint Développement  and  is  present  in  your  program regardless  of  your  specific  operating 
system.

The Never confirm button, when ticked, cancels the confirmation request which normally appears 
when a file is deleted or rewritten.
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* The next section "Project window" contains a tick box used to place the current project windows 
behind the other interface panels.

* The last option Use TVPaint Menu is only available for Mac OS X. When this option is checked, 
the main menu of TVPaint Animation is both available in the Mac menu and inside the TVPaint 
Animation  window.

The Memory & Cache tab

This tab first displays the physical memory available on your computer.

* Just below this field you will find a numeric field and mini-slider next to it. This field is used to 
attribute the amount of memory you require for the Undo option which allows you to «return» to 
and undo the previous steps when drawing on the screen. The higher this value,  the «further 
back» you may go. However, this default value is largely sufficient.

* TVPaint Animation uses the physical memory of your computer and one or several temporary 
files as discussed in the General tab. 
You may want  to  allow TVPaint  Animation to manage this  function  automatically  or  impose a 
maximum cache size to be used (this may be useful if you are working simultaneously with several 
programs demanding a large storage capacity).
With regard to this point, it should be noted that TVPaint Animation manages operating systems 
using over 3,2 Gigabytes of physical memory (for 64bits versions).

The Sound tab

All  these  options  will  be  deeply  developed  in  Lesson 8.  The first  section  is  dedicated  to  the 
scrubbing, and the second section to the audio frequency inside TVPaint Animation.
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The Startup tab

In this Startup tab, it is possible to choose what kind of project will be opened at the startup of the 
software. The first popup menu allows you to select the project parameters which will be used, like 
the Width, Height, Fields, Frame Rate, ... .
* “Remember last used configuration” will keep all changes you made in the interface of TVPaint 
Animation. Be careful, you must close the software correctly to save your choices.
*  “Keep always the same configuration”  is  very useful  for  schools  and training centers where 
students must keep a default interface. Whatever how many changes you'll bring, each time you 
will re-open the software, you will keep the interface by default.
* “Open Startup Panel” : It is possible to open the startup panel when the software starts. See 
further to have more information about this panel.
*  “Template”  :  It  is  possible to use a template.  When this option is selected,  a second popup 
appears to be able to select what template will be chosen.
* At least, “Open last used project at startup” will  open the last project you used with TVPaint 
Animation.

The Startup Panel

In  this  panel,  there  are  two  parts  for  the  Configuration  and  the  Template  management.  A 
configuration contains a lot of useful informations like the layout of panels, the interface colors, the 
palettes, etc …

With the Professional Edition, it is possible to create several kind of configurations 
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For example : a configuration adapted to dual-screen computer, a configuration adapted to HDTV, 
another one with other interface colors, etc … The current configuration can be saved when you 
quit the program. The starting panel of the program allows you to manage the configurations.

When restarting TVPaint Animation Professional Edition, the user may either create, copy or delete 
a configuration(you can also select their storing folder).

* To create a new configuration, click on the dedicated button in the window which first appears 
when the program is started (see below).

*  To duplicate  an existing configuration,  click  on the  Copy  button in  the same window. A text 
window will appear. You may enter the name of the duplicated configuration in the text field and 
then validate it by clicking OK.

* When a configuration is deleted, all effects, brushes, palettes, shortcuts… used previously will be 
lost. Of course, if you saved them in advance, you can reload and re-use them.

 By default, the configurations are located in the folder :
- C:\Documents and Settings\your_name\Application Data\TVPaint Animation 10  
(pro)\     

  for Windows users
 - Home Directory/Library/TVPaint Animation 10 (pro)/

              for Mac OS X users (be careful, Libraries are hidden on Mac Lion and Mountain Lion)
 - Home Directory/.tvp/
              Be careful, .tvp is a hidden folder

The second part, concerning the Template, allows you to start the software with a project which 
has all the parameters giving here.

The From File popup menu allows you to start the software by loading one of the ten previously 
used project.

Some details

Creation of a new project requires some additional explanations which you will find below:

Working without the notion of DPI

You may already be used to the notion of DPI (dots per inch).
The DPI is a pixel density unit often used in imaging and printing software packages. The higher 
the DPI value of an image, the more pixels it contains and the sharper the printed image will be.

In the animation field, the measurement used is the pixel. The notion of pixels is more practical as 
it adapts to the specificities of both metric and non-metric systems.

For example: the European PAL format uses a resolution of 720 pixels in width and 576 pixels in 
height, whereas the American NTSC format uses a resolution of 720 pixels in width and 486 pixels 
in height. 

The global size of your animation in centimeters, meters or inches depends entirely on the TV or 
cinema screen used to view them.
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The notion of pixel aspect ratio

The pixel aspect ratio is the multiplication coefficient which links the pixel width to the pixel height.
Depending on the video formats, the pixels may be either square or slightly rectangular.

      

 Avoid confusion between pixel aspect ratio and width/height ratio of a video (4/3, 
16/9, …). The ratio is the width/height ratio of the pixels.

Using ratios needs a serious knowledge in the video environment. If you begin in that 
domain, we advise you to choose a simple 4/3 or 16/9 format with a square ratio (equal to 1). 
For example, 800 x 600 for 4/3 or 1600 x 900 for 16/9.

Video fields 

Normally, a video image is composed of two fields which alternate at a speed which is too fast for 
the human eye, these fields are referred to as upper fields and lower fields. A field is a vertical half-
resolution image which contains every other line of the image. Interlacing of these fields is linked 
with the PAL, SECAM and NTSC standards. In PAL/SECAM, the upper fields appear first, whereas 
in NTSC it is the lower field which appears first.

This framing technique, even if twice as many images are required for the same video (50 instead 
of 25 images per second in PAL mode), has been adopted in order to improve the quality of image 
movement and precision. Taking advantage of the persistence of vision effect, it also allows the 
user to work with lower resolutions.

The use of video formats with fields is possible in TVPaint Animation. When creating a project, it is 
therefore necessary to indicate which of the two fields will be displayed first using the Fields popup 
menu. The option None (progressive scan) in this menu is used to create a project without fields 
(Highly advised !)
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Left: (pixel width) = (pixel height) x 2. 
The ratio is therefore « 2 ».
Right: (pixel width) = (pixel height).
The ratio is « 1 » and the pixels are square.

The pixel aspect ratio has a value of 1.067 for the 
PAL format and a value of 0.9 for the NTSC format.



Lesson 2

Drawing basics

In this lesson you will:

● Learn how to handle the various tools: airbrush, penbrush, wetbrush, pencil, 
mechanical pencil.

● Discover the various facets of the color picker.

● Draw simple geometric shapes and floodfill surfaces.

● Study the notions of opacity and transparency of a pixel.

● Study the notions of "colored background" and layers.

● Use and manage papers

● Use floodfill tools (gradients, opacity mappage...)



Drawing basics

It is very easy to draw using TVPaint Animation. In this second lesson we will draw a small house 
(see below) using TVPaint Animation's tools. In this way we can study the basics which will allow 
you to express your artistic talents.

Even if it is possible to draw with a trackball or mouse, it is strongly recommended to use a graphic 
tablet equipped with a stylus. This tool requires getting used to for beginners but it is much more 
natural to use for drawing.

Manage drawing tools

Presentation of the drawing tools

Drawing tools are located in the main panel. They determine the use of your tool : stroke, line, 
rectangle, ellipse, floodfill tools...

 This one active the Stroke. If you click on, you a pop-up menu will appear and you could 
choose Dot, One point Dot and Filled stroke. This last tool is a filling tool. It will be explained later 
in that lesson, with other filling tools.

 This one active the Line.

To trace a line in your drawing space :
* Click on the first tip
* Hold the click and move your mouse
* Drop the button to create a line

Hold [Shift] to draw a perfect straight line. This shortcut works with  Lines,  Dot and 
Stroke.  

By the way, if you hold the click on the Line's icon, you will have the possibility to use the tool Fill  
line. As a filling tool, its parameters will be explained later in that lesson, with other filling tools.

 To draw a rectangle, click on the center of the image and, without letting go of the mouse 
button, slide it towards the bottom right hand corner. Release the mouse button. A gray rectangle 
has now been drawn in the  current project window (see diagrams below). 
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  >>  >>  >> 

Hold [Shift] to draw a square instead of a rectangle.

 This icon is used to draw Ellipse. 
On the drawing space, click on the ellipse's center, then hold the click until you obtain the wished 
ellipse. Press [Shift] if you want to obtain a perfect circle.

If you click on that icon, you could choose different circle modes, such as 2 pts circle and 3 pts 
circle. The first one creates a circle by defining its diameter. The second one creates a circle by 
defining a diameter and a rotation angle.

 >>  >> 

2 pts circle

 This icon will give you an access to different Splines.
By default, you can draw 3 points splines, but you can also draw multiple points splines, such as 
Beziers splines and B-Spline splines.

HUD 3 points spline

To draw a 3 pts spline in your drawing space :
_ click on the first tip
_ hold your click and move your mouse or stylus 
_ drop the button and the opposite side
_ move again your mouse or stylus
_ click again, once you are satisfied of your spline.

 When using the B-Spline or Beziers spline, hold [Shift + Suppr] to delete the 
last placed points.
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HUD  B-spline

To draw a multiple points spline in your drawing space, click several times with your mouse or 
stylus to build a line broken by yellow lines or punctuated with red dots.

These both tools are very useful, because you can modify dots or lines.

*click on one of them and move your stylus in order to edit the spline. If you are using the Bezier 
spline, you can even use the tangent's handles
* for more precision, press [Ctrl] to move only one handle in the tangent.
*press [Ctrl] and click anywhere on your drawing space to move your spline.
 

* You can also close the spline thanks to the option  Close spline in the pop-up 
menu, that will appear if you right click.

* Then, always thanks to that pop-up menu, you can Apply Spline. You can also 
use the key [Enter].  

*  The option  Add to bin saves the current  spline,  in  order to  use it  later  (the 
software will ask you a name to save the spline).

To re-use a spline, open the pop-up menu and choose it among the different names proposed at 
the bottom. The pop-up menu can appear only if you started to draw another spline.

You can also delete a spline via the Erase menu.

The aspect of circles, rectangles, splines... that you obtain depends on the current 
tool : mechanical pen, pen brush, airbrush, crayon... (see below).  Please note if 
you want to use parameters of the current brush, use Fade connection. Connection 
will be discussed on lesson 7.

 
         circles   /  lines /  Bezier splines (applied with different tools)
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Setting the tools

You have numerous variables at your disposal to set your drawing tools. We will see in details the 
use of the Airbrush tool (the other ones will be explainesdin lesson 7) :

    

* The variable Size defines the tool radius in pixels.

* The variable Power defines the color quantity applied by the tool.

* The variable Opacity defines the global tool opacity.

The opacity defines a maximum opacity threshold which the drawing tool 
cannot exceed.

* The variable Aspect enables flattening of the current tool.

* The variable Angle authorises rotation around the tool Z axis.

* The variable  Step, if enabled, manages the waiting time between two 
applications of the same tool.

*  The variables  Drying and  Gradient will  be  discussed  further  in  that 
guide.

 In the little window to the left, it is possible to view the effect of the modification of 
each of the first five variables on the tool.

Some examples to help you understand the notions mentioned above:

   

See  opposite,  a  straight  line  drawn  with,  from  top  to  bottom,  the 
percentages  300%, 100% and 0% for the Step variable.

   

TVPaint written with the airbrush tool :
Angle = 90° and Aspect = 20%

 

  

Mechanical pencil tool left without Smoothing, right with smoothing.

If required, the Reset button resets the settings of the current tool.
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Setting of the brush profile

The right field in the tool panel provides a view of the drawing tool cross section.
Below you will find two profile examples for the airbrush drawing tool.

           
           

left to right: profile, three-dimensional view of the tool and its effect on the screen.

  

The   profile  of  brushes 
may  be  edited  in  the 
window shown opposite.
 
Click on the profile of the 
tool  you  are  using  to 
make it appear.

You have the choice :
* to create or delete the points of the spline (by left- and right-clicking on the profile line).
* to move the latter.
* to flip to the spline along the horizontal or vertical axis.
* to delete the current point.
* to choose the method applied to connect the points with each other: Linear, Spline or Polynomial.
* to select a pre-defined profile. 

  

There are 2 ways to select a profile :

•  The  first  is  as  for  the  palettes  and  mixers,  TVPaint 
Animation  offers  you  the  possibility  to  Load,  Save  and 
Reset the profiles from a file via the Bin popup menu.

• For the second way, the Bin popup menu allows also to 
Add/Remove custom  profiles  inside  the  software  and 
Select a custom profile to use and display it on the screen 
like on the opposite image.
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Activate Line smoothing

This feature is located in the menu Windows > Settings. You can also open this panels with a right 
click on any button from the Main Panel. 

* Option Source is used by other modes such as Panto and Healing. 
This option will be explained later.

*  Panto  adjusts the  Panto  mode.  It  is  explained  in  the  next  sub-
chapters.

* Healing adjusts the Healing mode. It will be explained later.

*  The last section is  the option allowing you to smooth your lines. 
Thanks to that feature, your lines will be optimized, making easier the 
inking step.

-The option Activate enable the lines smoother 

-The option Real Time enable the lines smoother in real time. When activated, the lines smoother 
will works when drawing. 

-The option  Smoothing indicate in pixels the distance used to define the smooth. The more this 
value is high, the more your line will be smoothed. 

If you activate Real Time, the more your value will be high, the more your cursor will 
move forward some pixels from your line. If you disable this f unction, your line will  
smooth when you will drop the click.

Not activated

Activated : 25

Activated : 50

Activated : 100
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Use colors

A Color and B Color

A very good tip:
It is possible to invert the two colors A and B of the color picker using 

the keyboard shortcut [N] or this little button 

Color panel has 4 tabs that we will study in detail : Cursor, Picker, Mixer and Bin.

R,G,B and H,S,L color systems (Cursor tab)

The  Slider  tab of the  color picker is the tab proposed by default. It is possible to define a color 
following different components : 

• RGB : Red, Green, Blue 

• HSL system: Hue, Saturation, Luminosity

• Hexadecimal : ideal for webdesigners.

You can move the cursors with a left click to the wished color. You can also move them with a right 
click on the wished nuances. Of course, you can also use the alphanumerical field.

Picker Tab

 

Go the the Picker tab of the color picker panel and choose a color as in 
the diagram opposite: a gray color with a slight yellow hue.
The choice of this color is important for the continuation, in particular for 
studying the drawing modes.
You will notice that the RGB information is indicated at the bottom of the 
panel, you can try to get as close as possible to them.

 

A right click on the same window enables the choice of other 
ranges, the colors of which vary according to hue, luminosity 
and saturation or according to the intensity of the colors red, 
green and blue. You can also make bigger this window, in order 

to pick up a color more easily.
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Mixer Tab

  

* a left click on the mixer surface incorporates the A color to the visible 
mixer which can then be «spread».
* hold [Ctrl] to select a color in the palette (you can also use the color 
picker, in the red circle)
* hold [Alt] to smear colors in the palette
* hold [Shift] to erase the colors

If you are not satisfied with the color obtained, you can delete it with the 
Delete Mixer choice.

A right click under one of the two tabs enables display of a contextual menu 
which is specific to this purpose and offers many choices (see opposite the 
Mixer tab menu ).

At first you can choose to work with pre-defined mixer surfaces: blue, clouds, 
inks, dirty, nebula, etc.

If the mixers proposed are not what you want, TVPaint Animation also offers you the possibility to 
create,  duplicate,  rename  and  cancel  your  own  palettes  or  mixers.  These  options  are  also 
accessible via the contextual menus (see above).

Bin Tab

  

The contextual menu (right click) will  allow 
you  to  work  with  different  pre-defined 
palettes : Grey, TVP 1, 2, 3 and 4. 

In  New Palettes,  you can create an  Empty 
Palette,  Duplicate current  palette,  create a 
New palette from image  (already imported) 
or  create  a  New  palette  from  last  used 
colors. 

Like in the contextual menu of the mixers, it is possible to manage the current palette with Rename 
and Delete Palette.

Other additional choices are proposed in the contextual menu : Replace color, Swap color, Spread 
and Remove color. These options directly behave on the current palette.
       
Respectively,  you can replace the color square by the  A color,  swap colors from two squares, 
spread colors from a square to another and, at least, delete a square.

You also have the ability to turn a palette into a custom panel. Custom panels management will be 
explained in lesson 19.
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Last, but not least, you also have the possibility to change the squares' size through the option 
“Colors size”.

At any moment, you can import or export palettes and mixers in the sub-menu “File”. It allows you 
notably to share your colors with several TVPaint users, even if it is more advised to use custom 
panels, in order to share also brushes and even scripts.

You can find the mixers and palettes provided by default with TVPaint Animation with parameter 
Default (Palette or Mixer).
The  pre-defined  palettes  et  mixers  will  be  restored  by  resetting  your  TVPaint  Animation 
configuration.

You should note, however, that the last two operations will delete the palettes and 
mixers that you have created yourself unless you have exported them previously.

 If the Sliders tab of the color picker is not selected (i.e. on each tab of the color picker 
except  Sliders), a line at the bottom referred to as  Status bar is visible. This line is 
used to display the A color  with RGB, HSL or hexadecimal values. Click on this bar to 
change the display.

Color History

   

When  you  draw  with  TVPaint  Animation,  the 
history of colors you have used is accessible with 
a left click on the   button (see opposite).

It is therefore very easy to re-use a color that you have recently used.
To delete all the colors, simply click on the Skull button.

Recover a color from the screen

It is possible to recover a color among those present in the 
current drawing in order to work with it again.
To  do  this:  either  click  on  the  A color  (on  the  diagram 
opposite, the main color is marked with a circle) or on one of 
the two Color Picker icon.
The cursor of the mouse or tablet  appears with a question 
mark. You may then point the cursor wherever you want, the 
A color will change into the color you point at. The shortcut for 
this action is the [;] key.
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It is possible to shade the A or B colors by left clicking on the latter in the main panel 
or  the  color  picker  and  then  keeping  the [Ctrl]  button pressed  when moving  the 
mouse to another color on the screen.

The Color Variations panel 

The Color Variations panel is accessible thanks to a right mouse click on the color box of the main
panel or via the Window main menu.

   It puts at your disposal several ranges of color, derived from the current 
A color.

• Some luminosity variations based on the A color.
• Some saturation variations based on the A color.
• Some chromatic variations based on the A color.
• The Step option allows to adjust the chromatic variation.

If  the  lock  button  is  checked,  the  color  boxes  will  stay  the  same 
whatever you do.

If the Lock button is not checked, the color boxes are automatically refreshed if you change the A 
color. (A simple click on a color of the Color Variation panel will change the A color into the one you 
have chosen)

Use filling tools

Filling tools presentation

Previously, we studied the shape tools (stroke, rectangle, ellipse...etc). Most of these tools has a 
variant, allowing you to fill a zone : filled stroke, filled rectangle, filled ellipse... etc. 

These tools have more or less the same options than the Floodfill tool (on the right).

If you are usin the  Filled line tool, hold [Ctrl] to switch in mode  Filled 
stroke.

Floodfill's smooth, opacity and a-aliasing

* Smooth : indicate with a number a quantity of pixels that will be used to 
make a gradient from transparency (external) to opacity (internal).

*  Opacity modifies the global opacity of your filling tool.  :  the more your 
value is weak, the more the result will be transparent.

* AAliasing anti aliased the result

Color gradient

TVPaint Animation allows you to create gradients with filling tools if you enable the Gradient option. 

You can also open the panel  Color gradient (see next page) if  you right click on the 
gradient (after you activate it) or if your go to the menu Windows > Tools.
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* The first horizontal bar represents the aspect of the gradient as it 
will be displayed on the screen.

* The second bar displays the colors chosen for the gradient. In 
our case, the two keys at the end indicate the A color on the left 
and B color on the right. 

* The third bar indicates the opacity chosen for both colors.

The keys are symbolised by a colored rectangle o.

As  for  the  mixers  and  palettes,  there  are  pre-defined  color  gradients  which  you  may  Copy, 
Rename, Delete. These pre-defined gradients are accessible in the popup menu indicated in the 
image below in the Gradient panel, on the top-left corner.
It is also possible to create your own gradients according to your color and opacity criteria:

* A right click on one of the keys of the color bar enables you to 
either delete the key, to assign the A color or B color to it or to pick a 
color.

* A right click on one of the keys of the opacity bar enables you to 
either delete the corresponding key or to set its opacity (or alpha 
value).

*  The  spread number  field mixes  the  pixels  within  the  current 
gradient.

* The  Dither numeric field works in the same way as the  Spread numeric field but uses colors 
which are not necessarily among those you have chosen, although they are quite close to them 
(this process is often used in the video sector).

* The Invert option flips the current gradient.

* The cursor enables calibration of the transition area from one gradient to another.

* The File popup menu enables you to load or save your gradients on a memory support. You may 
also choose to recover the pre-defined gradients of TVPaint Animation if required.

Whatever your choice may be, you will  have to draw a vector on the screen to determine the 
direction and extent of the gradient (see below).

         

From left to right: the gradients Linear, Spherical, BiLinear, Radial and Rectangular.
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When  the  gradient field  is  ticked  on  the  Filling  shape  panel, 
several types of gradients are available to you (click on one of the 
five buttons on the panel…).



Use filling tools

Color gradients and drawing tools

Assigning a color  or  opacity gradient  to  a drawing 
tool  provides  a  wide  variety  of  interesting  visual 

effects (see example opposite…).

The more power applied to the tool or the more repetition on 
the  screen,  the  more  its  color  will   cover  the  gradient 
chosen.

Opacity mapping

    

This window is accessible with a right click on the corresponding 
field of the Filling Shape panel and enables precise definition of 
the opacity and transparency areas when applying a filled shape.

You may draw the spline of your choice on the X and Y axes by 
placing points at your convenience. Three types of interpolation 
are  available  to  connect  the  points  with  each  other:  Linear, 
Spline or Polynomial.
In accordance with your settings, a new opacity mapping will be 
defined.
The two red splines define the opacity of each point of the map 
as indicated in the dotted example.

The File popup menu enables saving, loading or resetting the opacity mapping. It allows in addition 
to Add/Remove a custom opacity mapping and Select one from the Bin. If required, you may swap 
the two splines corresponding to the X axis and Y axis of the mapping  (Swap button) or flip each 
spline vertically or horizontally (Flip X and Flip Y buttons).

The Copy button is used to copy the current spline (the one that has a point selected thus yellow) 
on the other axis. On the image above, the current spline is the Y spline. You may also adjust the 
mapping by clicking on the image and sliding the mouse.

Here again, you have pre-defined parameters at your disposal in the Bin 
menu. Go to File > Bin and select the pre-defined mapping of your choice. 
                                           

The icons at the bottom of the window have a special function. They enable you to choose how the 
opacity mapping will be applied in the filled shape you will draw.

   

Let's take for example the opacity mapping (left) in order to floodfill 
a shape created using the spline tool (see below).

Depending on the options chosen at the bottom of the panel, the opacity mapping will be applied:
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* without modifications (1)
* adapting to the shape you will floodfill (2)
* according to a vector of your choice (3)
* in a circular fashion along a vector (4)

   (1)    (2)    (3)

For case (3), you must draw a vector on the screen, as you have 
done for drawing a gradient.

 

 For the fourth option, modify the X 
spline  as  shown  in  the  example 
opposite.

 (4)

Some remarks for using the Opacity function

The  Gradients  and Opacity mapping  functions combined for use in a layer are very useful  for 
creating effects of lighting or transparency independent of the background color or scenery (as 
they are not part of it).

This is the case for windows, tinted windows, lamps, projectors, etc … 

   

Above, the opacity gradients were used on a layer to create car headlights. They must no longer 
be modified when the background color changes, which results in considerable time saving.
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For case (4), you must 
draw  a  vector  on  the 
screen.

Note that the option on the Y 
axis is disabled.



Using papers

Using papers

How to use papers

Apart from reproducing a given pattern, the papers may be used to simulate drawing on a real 
paper. The combination of papers with different drawing tools provides very realistic results and 
enables imitation of  different  drawing styles:  charcoal,  painting on glass,  lithography,  etc.  (see 
below)

      

Some images are constructed using many papers.

The image opposite, for example, which is available 
on the CD was compiled using ten papers.

Papers can be activated by a simple click here, in the main panel : 

If you right click on this icon, you will open this panel :

   

At the top of the Paper panel, a menu allows you to 
select papers in different directories.

* All : Display all the papers available in all directories.

* TVPaint Animation : Display all the papers which are 
in the installation directory of TVPaint Animation.

* User : Display all the papers which are located in the 
user configuration.

Numerous options are available in the papers window. You may:

* Modify Hardness, Size and Angle of your papers.
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hardness 33%                                 hardness 66%                            hardness 100%

                    
size 200%                                     size 100%                                       size 50%

                    
angle 0°                                         angle 60°                                        angle 120°

* Invert the papers (Negative option).

                   
        original paper                            inverted paper

* Create a symmetry along the horizontal axis or vertical axis before application (options Flip X and 
Flip Y).

                 
                                                 original paper                                symmetry along vertical axis
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Create and manage your own papers

   

* Right click on one of the papers in the papers window to either 
choose the latter or delete it.

* Right click on the part of the window that does not contain any 
papers to create a new paper from the current image.

Selections, crop and transform

The various types of selections 

Six icons in the main panel are used to enable these selections. 

* Rectangle select
* Circle select
* Freehand select
* Select with Magic wand
* Splines select 

The last function allows you to clear the selections.

Complex selections and brush creation

That's not all, the Selection tool window opposite extends the range of possible actions. 

*  The  Smooth  option  works  in  the  same way as  that  presented  in  lesson 3  to  draw a filled 
rectangle.

* When checked, the Anti-Aliasing box smooths the contours of the future selection. 

* The Invert button inverts the current selection.

* The Clear button deletes it.

* The four buttons which follow are used to copy or cut the pixels contained in the selection and 
incorporate them in a new layer or new brush (animated brush or animation layer, if several images 
were selected previously).

* The Crop button is used to create a new project containing only the contents of the selection. 
Your new project will contain an image or animation layer depending on whether you have selected 
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From the popup menu:
* The  Add  and  Sub  options may be used to create complex selections: 
the  Add option  allows  you  to  add  a  new  selection  to  the  previous 
selection while the Sub option, as the name implies, will remove the new 
selection from the previous selection. You may obviously combine various 
Selection tools with each other in order to obtain the required selection. 

* The effect of the  Replace  option is that drawing a new selection will 
automatically replace the previous selection.



Selections, crop and transform

one or several images in the current layer. If your current project contains several layers you will 
find the same number of layers in the new project.

The transformation tools

These three tools have in common two parameters, that can be found at the top of the tool panel. 
Those parameters are Shift and Fill :

       
                          Original image                       Shift option                           Fill option

The option Fill will “loop” the image, contrary to the option Shift, that cuts definitely the image. Of 
course, these parameters are memorized, even if you use different tools.

The Panning tool 

* If you check the Move Selection Shape box, you will move the selection shape, without modifying 
the image :

      
                         Original image                         Fill option                           Shift option
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It is possible to transform all or part of several images using the three tools 
shown opposite: Panning, Transform and Wrap.

The Panning tool is used to move an image or a selection on the screen, 
pixel by pixel,  with a left click + slide of the mouse.

*  If  your  check  the  Move Image  the  current  image  will  be  taken  into 
consideration when shifting (like in the example above).



Selections, crop and transform

* If you check the Move Selection Content, you will move the selection 
and its contain at the same time (see the image).

 
* If you check in more the Move Camera box, you will move your image 
and you camera movement (more information about the  Camera tool, 
please read lesson 9).

The Transform tool

  

The Transform tool in the main panel is used to shift, rotate, increase 
or reduce the image. This tool is also accessible thanks to the shortcut 
[Ctrl + T].

* The  Panning X  and  Panning Y  variables are used to translate the 
image on the screen. The Center button is used to re-center it. You can 
also  use  the  shortcuts  [Ctrl+8],  [Ctrl+6],  [Ctrl+2]  and  [Ctrl+4],  to 
respectively move your image at the top, on the right, at the bottom 
and on the left.

* The Scale variable is used to modify the size of the image (increase 
or decrease).

* The Angle variable is used to rotate the image.

* The Reset button resets the settings.

* The AntiAliasing popup allows you to choose the precision with which the image contours will be 
smoothed.          

     

  None           Medium

     
      Best           Better

 

Drawing basics 2-19



Selections, crop and transform

* The part “Apply on” will allow you to choose if your changes will apply on the Current layer, the 
Current group or All layers.

* Fill satisfied with the settings, the Apply button is pressed to finish the operation.

         
     Original image               Move image and Shift mode     Move image and Fill mode        Move selection content 

To move several images at the same time (with Transform and Perspective tools), 
select them all in first befor applying the change. By default, the tool will apply on 
instance's heads only. 

We will explain everything about instances later.

The Warp tool 

This tool is used to put the image or current selection into perspective. A modification of the four 
corner coordinates of the image is sufficient to obtain a convincing effect. You may or may not fill  
the screen with the current image (see examples below). 

Here again, the same system as above is used (Preview then Apply).  Use the Reset  button to 
reset the settings. Like the Transform tool, the AntiAliasing popup allows to choose the precision 
with which the image contours will be smoothed. The result is similar to the Transform Tool.

               
       Original image                          Warp tool in Fill mode                                      Warp tool in Fill mode 
        with selection     

  

The blue line that appears on the screen during setting is the horizon line. You 
may move the two vanishing points as you wish to set the perspective.
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Further details

Notion of pixel opacity 

Thanks to what  you just learnt,  you are now able to draw with TVPaint 
Animation.  To  draw  the  little  house  described  at  the  beginning  of  that 
lesson,  please  use  the  Rectangle,  Line and  Flood  fill  tools.  Use  the 
Airbrush or 2-pts circle with a gradient to the transparency to draw the sun. 
This drawing will illustrate the next steps.

At this point, it seems at first sight that the image is mainly composed of white... in fact, that is not 
the case !

Now  change  the  Color  option  (bottom  left  of  the 
timeline)  into  None,  then into  Check  and note the 
changes taking place in the current project window.

layer                                              layer                                             layer

              
background = Color                       background = None                       background = Check

Everything happens as if our house and sun were drawn on a glass plate, the latter resting on a 
colored background (see perspective diagrams above...).

What we will refer to as Image layer in all future lessons is the equivalent of a transparent glass 
plate placed on a colored background of your choice. You are drawing on this plate and not on the 
colored background.

It is possible to change the color of the backgrounds Check and Color. To do so, click on the little 
colored square on the left, next to the pop-up menu, in order to obtain a cursor followed with a “?”. 
This cursor indicates you that you may choose any color on the interface of TVPaint Animation.

The second colored square will define the second color necessary for the Check mode.
 

The drawing modes

There are several drawing modes in TVPaint Animation:
Color, Behind, Erase, Panto, Light, Shade, Tint, Colorize, Smooth, Grain, etc. We will study the 3 
first ones : Color, Behind and Eraser, which are the most used mode with drawing tools and filling 
tools.

Other modes will be explained lesson 7

They are available in the popup menu located under the icons of the   Tool  panel (left click to 
access it).
If required, you may assign keyboard shortcuts of your choice to the various modes (see lesson 1).
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We will now draw a blue sky.
To do this:

*  Select  the  Freehand line  icon (in the  main 
panel).
* Select the wetbrush tool
(size:  100 pixels,  power:  100%, opacity:  100 
%). 

The red «1:4 » indicates that the tool is four times larger than the one visible in 
the white rectangle to the left.

Wetbrush in Color mode  
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You have already seen the  Color  mode (keyboard shortcut 
[F2]) as you have been using it  since the beginning of this 
lesson...
When  you  use  the  Color  mode,  your  line  and  color  are 
applied over the already existing image.

Some modes may not be used 
with all tools.



Further details

Wetbrush in Behind mode

Airbrush in Erase  mode (background=check)

Drawing tool history

Located in the Main Panel, next to the papers, the history of the drawing tool gives you an access 
to all drawing tools used since you opened the software : airbrush, pen brush, watercolor...

If you close TVPaint Animation and open it again, you will lose the history. If you want to 
save them definitively, use a Bin (lesson 7), or a Custom panel (lesson 19).

The Re-apply option

  >               > 

This is a situation that is often encountered: you have drawn an ellipse on your screen…
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When you select the  Behind mode (keyboard shortcut [F3]), 
TVPaint Animation will take into account the already existing 
pixels from the line as well as their level of opacity. When the 
option is chosen, the color is only applied to the transparent 
surfaces of the image.
The color is therefore not applied over the house or over the 
sun but is partially visible through the latter.
Floodfill in the entire image in blue using this mode.

The task of the Erase mode (keyboard shortcut [F4]), as the 
name  implies, is to erase the pixels of the current layer by 
making them transparent.
Thanks to this mode, it is possible to correct possible faults in 
a drawing.
Opposite, the Erase mode is used on a check background.



Further details

But, you have used the wrong tool: you used the  Oilbrush instead of the  Penbrush. The  Undo 
option allows you to go back (the ellipse drawn with the oilbrush will disappear), but you may have 
trouble drawing the ellipse again with the same precision…

Even when having written down the exact coordinates of the ellipse (center coordinates and length 
of the two half axes), it may be tiresome to reproduce exactly the same drawing on the screen.

The Re-apply option (keyboard shortcut [Enter]) was developed to counter this type of problem and 
facilitate your task…

When your ellipse is deleted, change the tool and adjust the parameters and colors. Then select 
the Re-apply option in the Edit main menu.
A new ellipse is drawn.

You may even do more than that as, before using the  Re-apply option, you have the following 
choices :  change  the  layer,  select  several  layers,  change  the  type  of  line  to  work  with  filled 
shapes… (see the examples above…)
It is even possible to define selections or cut animated brushes from the original drawing !

Zoom and View options

You will  find a  Zoom in tool in the  Main panel of the software. This tool 
allows you to zoom in or out in the drawing space, repectively thanks to the 
left or right click on your mouse. 

You could use also :
* Use the small « + » and « - » icons above as well as the mini-slider.
* Use the keyboard shortcuts [<] and [>].
*  Adjust  the zoom numerically  by modifying the percentage in  the text  field 
intended for this purpose.
* Use the shortcut [Alt + Right click + move to the right / left]

Note that there are other options in the project window which may facilitate your task :
* The button « 1 » enables re-initialization of the zoom to 100 % (the real size of your project).
*  The « F » button -activated by default-  re-aligns the image in the project window. It is  really 
useful, espcially when you zoomed a lot and want to see a global view of your project. If the project 
window is bigger than the full image, the zoom value will stop at 100%. 
* A right click on the « F » button uncollapses your project's window and make it floatting. 

These zoom options are available to make your task easier when working on small  
details.  However,  they do not  modify the images,  videos and photos themselves.  
You will find them all in the View main menu too.

Project displays are anti-aliased when zooming-out (20, 25, 33 or 50% of the original 
project size) This is very useful for people who works in very high resolution. (for example the 
HDTV format)

In lesson 1 we learned that it is possible to work with several projects at the same time.
It is also possible to open several project windows for the same project.
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You may use the [M] key of the keyboard or select New project window in the View main menu to 
do this. This is recommended when working with large zoom values and to keep an eye on the 
entire project.

   

If  you  don't  see  the  new 
window,  think  to  minimize  the 
current windows (lesson 1).

Note that in this case, any  modification 
made in one of the windows results in 
the same modification being made in all 
the other windows of the same project.

The  button   of  the  project  window  also  offers  you  several  very  useful  viewing  options 
depending on whether you use it with the left button of your mouse or the right button.

* A left click, without releasing the mouse button, followed by sliding the mouse, moves the image 
in the same way as the sliders located next to it. You can also imitate this behaviour by using [Alt + 
Left click + Mouse move].

* A right click without releasing the mouse button may be used to slide the current layer and only 
this layer to quickly view the enabled layer (see next lesson for the layer notion).

At the moment you release the button, the layer goes back to its initial position.
This is very useful when you are working with a large number of layers and you do not know which 
one is enabled.

This function is called Shaker and is accessible with the keyboard shortcut [A]. A simple touch on 
this key will make your current layer shake and reposition it immediately with the aim to rapidly 
view the current layer.

Notion of pixel opacity 

   

After having zoomed to approximately 2000% it is to be noted that 
the pixels in the center of the sun are somehow "yellower" than 
those on the outside.

In reality, the pixels making up our sun are all yellow. However, the 
pixels in the center are less transparent (or more opaque...) than 
those on the outside.

You will notice that the pixels of the sun let the colors of the check background through with more 
or less intensity while the pixels of the house are completely opaque: it is impossible to see the 
check background through the house.

Rotation of the workspace

One of the most useful tools for any artist is the tool that allows rotation of the work top as one 
would turn a piece of paper while drawing. There are several ways to turn your workspace.

The button  located in the project window is used to freely define an angle by left clicking 
and holding the button followed by a left / right movement of the cursor. You will see the workspace 
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rotate in real time and you just release the button once the desired angle is obtained. This free 
adjustment may also be carried out using the keys [Ctrl+Alt] + left click.

   The free adjustment and its HUD in the form of a traditional drawing workspace

     

You may also right click on the same button, which will open a menu 
(see opposite) in which you have the possibility to :

Reset the overall angle value (keyboard shortcut [Insert]), 

Rotate the view +15° (keyboard shortcut  [Shift+PageUp]), 

Rotate the view -15° ([Shift+PageDown]), manually define an angle 
value (Set option) or choose a pre-defined angle among 15 values 
all multiples of 15.

Flip the view on the X and/or Y axis.

Note that Rotate +/- 15° will always be rounded off to the prior/next multiple of 15. For example, if 
you  work  at  first  with  an  angle  of  25°  and  then  decide  to  tilt  the  project  by  +15°  using 
[Shift+PageUp], you obtain an angle of 30° and not 40° as 30 is the first multiple of 15 after 25. 

Flip Horizontally and Vertically

In the pop-up menu above, you can also invert the display following the axes X and Y (Flip X / Y). 
These functions can also be found in the main menu View, with the options Flip Horizontally / 
Vertically.

Whatever if you choose the option in the main menu or the 
pop-up menu, the  Flip Horizontally/Vertically options can be 
used to invert horizontally and/or vertically the image in the 
project window. These two options don't change the project. 
It's only a way to see the current image of the project with a 
different point of view (like the rotation of the workspace).

Shortcuts [ [ ] and [ ] ] allow also to invert X and Y axes, respectively.
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Original Image                                   Flip  Horizontally

                
              Flip Vertically                       Flip Horizontally & Vertically

The Coordinates

The  Coordinates  window is  accessible  via  the Windows  >  Guides 
main menu.
* left you find the coordinates in pixels of the pixel pointed with the 
mouse as well as its RGB values.
* right you find a small zoom box with a central point.
* if you draw a rectangle, the two empty lines will indicate the width 
and height of the latter in pixels.

There you will also find the length of the two half-axes if you draw an ellipse.

The Grid

The grid is, in fact, a kind of plotting paper the parameters of which may be set and the basic unit 
of which is the pixel.

    

As you have probably guessed, this option is also accessible in the Windows > Guides main menu. 
Once enabled, it  does not affect your project itself,  but the way you will  draw (just disable the 
option to make the red grid disappear…).
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Using a grid is very useful when :

* drawing parallel lines, 
* placing a brush at regular intervals 
on the screen,
* aligning a text along a vertical line, 
* etc.
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* The Grid panel which is accessible with a right click on the Grid icon in the Tool bar or via the 
Windows main menu is used to set the width and height of the boxes (use the numeric fields of the 
same name or the mini-sliders).

* The Start X and Start Y numbers will help you shift the grid on the surface defined by the work 
area. Those values can be negatives.

* If required, you may adapt these four values in such way as to recover the image using the 
current brush and the Brush size button.

* The Set button is used to interactively define the grid parameters by drawing a dummy rectangle 
in the current project window.

* The Show box displays the grid when it is checked.

* The Snap box renders the grid magnetic. This option imposes that the user may only use the red 
pixels at the intersections of the horizontal and vertical lines. This works as if the cursor on the 
screen were magnetically attracted to the grid intersections.

The Guides

The purpose of the  Guides  of TVPaint Animation is to create customized and magnetic marker 
points in the current project window. When using the guides it  is very easy to draw concentric 
circles or parallel lines.

         
The following options are available in the guide parameter setting window:

* Once the  Set button is selected, any click with the mouse in the current project window will 
generate a horizontal and a vertical line. It is therefore possible to create « a grid with irregular  
graduations » and to impose the line intersection points as the only points to be used.

* The Reset button is pressed to go back to a project window without guides.

* The Show box, when checked, displays the guides.

* The Snap box imposes the yellow pixels at the intersections of the horizontal and vertical lines as 
the only pixels to be used. This works as if the cursor on the screen were magnetically attracted to 
the guide intersections.

The Files popup menu enables saving and loading of your guide positions.
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The Safe Area 

The  Safe area  may be displayed in the current project window: it  may be 
enabled via its  Display popup menu (see on the left). The  Safe area allow 
viewing of what will effectively appear on the TV screen (i.e. the Safe Area).

You will find also many other options that you can make visible or not : grids, 
guides, stencils, paper, fiel chart, animator field, animator disk, camera and 
notes.

 

Display settings

    

The Display Settings window is accessible via the Windows > Settings main 
menu and is used to choose the color  and opacity of the guides, stencils, 
safe area, animation disk, etc.

You  may also  enable  display of  the stencil,  paper and selections  when 
using the latter.

The safe area has some additional parameters: position of the action and 
text safe areas may be set in percentages.

History panel

Int  the menu  Windows > Tools,  you will  find a history panel.  The contain of  the history panel 
depends on the project.

Latest actions are at the top of the list. The oldest are at the bottom. 
Same actions are memorized in groups. For example, if you draw 
with a brush and then, change your tool, strokes made with the first 
brush will be put into a group.

  > 

The history panel allows you to save the creation's steps. For example, if you hesitate between two 
renders for an illustration, you can save the both compositions and navigate from one to another.
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First render

Second render

To save an action, click on the action group that interests you and mark an action by clicking on the 
empty square :  it  will  now contain  a green M. If  you mark several  actions,  you will  have the 
possibility to navigate from a mark to another one thanks to green arrows.
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Lesson 3

Spatial Management of Layers

In this lesson you will learn to :

● Study the notion of the layer with its multiple aspects.

● Name, move and select layers.

● Assign a group to a layer.

● Use the basic Blending Modes of the layers.     



Layers and timeline

Layers and timeline

First drawing

    

We'll start by drawing a little man in 
the center of our image.
To  do  this,  use  the  Oilbrush  tool, 
select FreeHand and the red color
(R=255, G=0, B=0).

Now display the Timeline if it is not displayed yet (shortcut [0]). The following window will appear :

 

This  window shows that  our  little  man was 
drawn  on  a  layer  named  «Untitled  1». 
Indeed, every layer has a name.

Rename a layer

We will now rename the layer. You have the choice to : 

* Select Rename layer in the Layer main menu.

* double click on the layer's name
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Create a New layer

TVPaint Animation offers the possibility to work with several layers. With a bit of practice, this will  
make your work much easier. To create a new layer you can :

• Select New Layer in the main menu  Layer 

• You can also use the keyboard shortcut [Ctrl+N] 

  

• You can also use the New button on the timeline. 
This panel (see opposite) will  appear. You could 
name the layer,  choose the group,  the blending 
mode,  the  position  in  the  layer  stack  and  its 
behaviors.

If you click on Import, you could import a footage.

If  you  right  click  on  the  button  New from  the 
timeline, you will create automatically a new layer 
using the last parameters configured in the panel 
on the left.

   

Our timeline now comprises two layers: the « 
character » layer and our newly created layer, 
referred to by default as « Untitled 1 ».

You may also rename this layer. We will call it 
« gray blob ».
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*Call  up  the  popup  menu  by  clicking  on  the  layer  name  in  the 
Timeline (here : « Untitled 1 ») or with a right click on the layer name.

Once the popup menu is displayed, select the name of the layer at 
the top of the menu and release the mouse.

Independent of which method was used, a text window will appear. 
You may now enter the name (« character ») in the text field and then 
validate it by clicking on OK.



Layers and timeline

The advantage of working with several layers

 

Now draw a gray blob in the center of the image on the new layer using 
the  penbrush  tool  (radius:  50  pixels,  power:  100%,  opacity:  100%, 
mode: color) 
At first sight, the gray blob seems to cover the little man.
But in reality this is not the case...

  

When  looking  at  the  thumbnails  in  the 
timeline, we see that the gray blob and the 
little man are on two different layers.

We  have  thus  overlaid  two  layers  on  our 
white  background,  as  illustrated  in  the 
diagram below.

« Gray Blob » layer

« character » layer

White background

The gray blob therefore does not delete the little man. If you use the same tool in Erase mode on 
the same gray blob, you will note that the little man will reappear!

There are several ways to mix the colors of overlaid layers. We will see the basic 
ways further in the lesson, and all the other ways in a next lesson.

The current layer

The current layer is symbolized by a clear gray color and that little blue pencil :  

When you draw in the work window, the modifications are only applied to this layer. The dark gray 
layers remain unchanged, independent of their position.

To change the current layer you can: 
* Use the arrow keys [ ↑ ] and [ ↓ ] on your keyboard.
* Click on the layer of your choice in the Timeline on the left side of the vertical slider.
* Use the shortcut [ , ] to select the layer. To do that, press the [ , ] key (the cursor change into an 
arrow with a question-mark), position the new cursor over the project window, and when it is over a 
pixel  from which you want to get its layer,  click with the left  button.  If  there is  only one layer 
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(through all the layers with colors) at this position, the layer will be automatically selected. If there 
are several layers with colors at this position, then select the layer you wish in the popup menu.

                         

When the menu appears, there is a preview near the name of the layer to make the choice of the 
wanted layer easier.

Show and hide a layer

   

It is possible at any time to only show the layers of your choice.
The layers visible in the project window are those ticked in green in the 
first column of the timeline.
The hidden layers are those which are ticked in red in the same column 
and the name of which is displayed in gray (click on the color fields to 
toggle a layer from visible state to hidden state and vice versa).

 You can draw only on a displayed layer.

Whatever the displaying options are, once the icon with the eye is ticked, only the current layer is 
displayed. You can also use the shortcut [=].

By  default,  this  option  only  displays  the  current  layer.  However,  you  can  manage  the  layer 
attenuation through the menu Windows > Settings > Display settings.  Thanks to the part “Layer 
attenuation”, you can then configure an reduced attenuation.

 >>
Display curren layer without « Layer attenuation »             Display curren layer with « Layer attenuation »
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Flip layers

We will learn now how to  flip two layers. This is how it is done:
Left click on the small frame representing the gray blob in the timeline, then slide the cursor on the 
timeline until it is under the « character » layer. Release the mouse button.

 > 
                       before flip                                      after  flip                                                    no flip (merge)

       

« character » layer

« Gray blob » layer

White background

                 position of layers after flip

We now have the configuration as shown in the diagram above. In the current project window, the 
little man is positioned on top of the gray blob.

When trying to flip two layers, a frequent mistake made is to move one layer on 
top of another. This is the process of merging two layers (which will be described 
in detail later in this manual).

The case being, click on  Cancel in the merge options window to return to the original 
layer arrangement.

The Undo option in the main menu may be used to undo the modifications made to 
the project as well as for those applied to the timeline.

Erase the content of a layer

It is possible to erase the content of the current image in the current layer without using the Erase 
mode of the drawing tools.

To do this, just click on the icon of the main panel opposite or use the shortcut [Backspace].

Of course, this option only affects the current image of the current layer. Other images and layers 
will stay intact.

For the next lesson, you will have to create a third layer that you will call « Glass ». Thanks to the 
tool  « Filled  rectangle » with  Gradient activated,  draw a  glass  in  front  of  our  character.  Both 
features have been explained lesson 2.
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Modify the global opacity of a layer

Global Opacity of the Glass layer with various values:

      
    0%                                 20 %                             40%                              60% 

      
           80%                             100%

Merge layers

When it is no longer useful to work with several layers, you have the possibility to merge the layers.

The Merge popup menu in the timeline offers you five options for this purpose.

These options are also available in the Layer main menu.

* Merge selected layers: the non-selected layers are not merged.
* Merge visible layers: in this case, the hidden layers remain intact.
* Merge all layers: the layer resulting from this operation contains the current image.
* Merge Current group's layers : all layers from the current group will be merged.
* Merge Other groups' layers : all layers from other groups will be merged.

To  select  an  additional  layer  (multi-selection):  press  the  [Ctrl]  key  on  the 
keyboard and left  click on its thumbnail.  You may also  use the [Shift]  key to 
select all layers between the last selected and the one you are clicking on.
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Modification of the « glass » layer's global 
opacity  will  vary  the  opacity  of  all  pixels 
making up the layer.

You may modify the global Opacity of a layer:

* by left clicking on the white bar on the timeline.
* by right clicking on the same bar to call up the numeric field shown 
opposite.
* via the contextual menu of the layer.
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Another possibility is to slide one layer on top of another and call 
up the merge options shown opposite.

If you tick the  Stamp field, the merger is made according to the 
opacity of the layer moved and the A color.

You may choose to cancel or keep the original layer as well as 
apply one layer on another in color, erase, behind mode, etc.

Blending Modes concept 

In this lesson, it has been seen that the layers are overlaid to create the final image of the project.

The final image or animation is the result of the mixing of all the pixels of these layers. 
The mixing of these layers is applied from the bottom to the top of the layers list.

But ... there is maybe a need to mix the pixels of each layer in different 
ways. 
With the above example, layer 3 is applied over the result of layer 2 
and 1. But whereas the colors of layer 3 are just copied on the resulting 
layer, the content of the layer 3 could Erase, Tint, Saturate, Overlay, ... 
the content of the resulting layer.

It is already possible to do it  in some way, with a limited number of 
modes. When you drag a layer over another one and drop it, a popup 

menu appears and asks how the pixels of the dragged layer should be mixed with the other layer.  
But in this case, the two layers will be merged and the informations of each layer will be lost. It is  
often preferable to keep the layers separated.

The solution is to mix the layers but without needing to modify them. To do that, the layers should  
be mixed "on the fly". 
There is a popup menu in each layer in the left side of the Layers panel which allows you to select 
the way to mix the layer, it is called the Blending Mode.
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Like it is said, each layer has its own Blending Modes. What does it involve? ... An 
infinity of possibilities. Seriously, each layer can be blend in a different way with 
the other layers. To be more precise, the image in the current layer will be blend in 
its Blending Mode with the resulting image of the blending of all the layer under 
the current layer.

And the final image is instantly displayed in the project window and without having 
to modify something in any layer!

All the Blending Modes are available on the left part of the Layers panel with a 
left- or right click on its name.



Blending Modes concept 

* Color

          

The  default  Blending  Mode  is  the  Color  mode.  All  the 
pixels of the current layer are applied over the source. It is 
this image that will  be called the original image. It is the 
blending  mode  of  the  layer  with  the  house  which  is 
changed. This is the original image.

* Behind

        

With this Behind mode, all the pixels of the current layer 
are  applied  in  the  source,  only  when  the  pixels  of  the 
source are transparent.

* Erase

        

The Erase mode will  erase all  the pixels  in  the  source, 
everywhere  the  pixels  of  the  current  layer  are  not 
transparent. (This mode does not care of the color of the 
pixels in the current layer)

* Shade

        

All  the  non-transparent  pixels  in  the  current  layer  will 
Shade the source. (This mode does not care of the color of 
the pixels in the current layer)

* Light

        

Almost like the Shade mode, the Light mode will brighten 
the  source depending  on  the  current  layer.  (This  mode 
does not care of the color of the pixels in the current layer)
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* Colorize

        

This mode will  Colorize the  source with the colors of the 
current  layer.  This  mode  keeps  the  luminosity  of  the 
source.

* Tint

        

With the Tint mode, the color of the current layer will tint all 
the colors in the source. This mode keeps the luminosity of 
the  source,  like the  Colorize mode,  and keeps also  the 
saturation of the source.

* Saturate

        

The  Saturate mode  will  increase  the  saturation  of  the 
source by using the colors of the current layer.

* Value

        

The Value mode uses the color of the current layer and the 
saturation and hue of the source.

* Add

        

The  Add mode will add the colors of the current layer to 
the colors of the source.
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* Sub

        

The Sub mode will subtract the colors of the current layer 
from the colors of the source.

* Multiply

        

The colors of  the current  layer  will  be  Multiplied by  the 
colors of the source. The result is usually a darker layer.

* Screen

        

The colors of the current layer and the colors of the source 
are  inverted,  multiplied  to  each  other,  and  the  result  is 
inverted again. The result of this mode is usually brighter.

* Replace

        

Copy all the pixels of the current layer on the  source by 
processing  the  non-opaque  pixels  of  the  current  layer 
differently of the Color Blending Mode.

* Substitute

        

Blend the pixels of the current layer with the ones of the 
source in function of the layer opacity. 

If  opacity  =  100% :  the  house  will  be  displayed  with  a 
transparent background.

If opacity = 0% : the background will be displayed without 
the house.
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* Difference

        

The  Difference mode subtracts the current layer and the 
source, and get the absolute value of the result.

* Divide

        

The  source is divided by the current layer.  The result  is 
usually a lighter layer.

* Overlay

        

The Overlay mode darkens the layer, but not as much as 
with Multiply mode.

* Dodge (Light2)

        

The brighter the current layer is, the more the source gets 
lightened.

* Burn (Shade2)

        

It is the reverse of the Dodge mode. It tends to make the 
layer darker.
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* Hard Light

        

The Hard Light mode is the Overlay mode with the current 
layer and the  source swapped for the computation. This 
mode obtains bright colors and sharp edges.

* Soft Light

        

The Soft Light mode is similar to the overlay mode. It tends 
to make the edges softer and the colors not so bright.

* Grain Extract

        

The  Grain  Extract mode  can  extract  the  grain  from the 
source by using the current layer.

* Grain Merge

        

The  Grain Merge mode merges the grain  of  the current 
layer into the source.

* Subtract

        

Another way to subtract the current layer.
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* Darken Only

        

The  Darken  Only mode  gets  the  smaller  value  of  the 
current layer and the source.

* Lighten Only

        

The  Lighten  Only mode  gets  the  greater  value  of  the 
current layer and the source.

Further details

Delete, duplicate a layer

It is possible to delete a layer, an option which is quite different from erasing its contents…

To do this, select  Delete layer then click on Confirm in the contextual menu of the timeline (to do 
this, you may also use the Layer main menu).

To duplicate a layer, proceed in the same way using the same menus.

Lock a layer

To lock a layer may be useful under several circumstances.
Click on the little padlock located in the timeline in front of the layer to be locked.

Once a layer is locked, it is no more possible to draw on it.
Click again on the padlock to unlock the layer.

3-14 Spatial management of layers



Further details

Reduce a layer

   

It  is  practical  to  reduce a  layer  when 
there  are  too  many  of  them  to  be 
displayed on the screen. 

A left click on one of the arrows in the 
black  circle  on  the  diagram  opposite 
increases  or  decreases  the  size  of  a 
layer in the Timeline.

The layer itself is not changed in any way but only its name and global opacity are visible in the 
timeline.

Use groups 

In  TVPaint  Animation,  you  have  the  possibility  to 
organize your layers by using pre-defined group.

Click on that icon  in the first column of the timeline 
to modify the group where you will put your layer.

      

If a color box is not checked, it means that all the layers put in 
the corresponding group will not appear in the layer stack. But 
their contain will be visible in the drawing space. 

The button on the left is dedicated to layers that does not have a any group.
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The opposite popup appears and displays all the available groups, differentiable by 
a color.

The line of color boxes, corresponding to the different groups, at the bottom left of 
the  Time Line window can be very useful when you really begin to have a lot of 
layers.



Further details

       

The green and red boxes are not selected, thus 
the layers don't appear in the Time Line window.

Nevertheless,  their  presence  is  symbolized  by 
colored lines.

By right-clicking on the color boxes, the opposite 
popup menu with some options appears.

* Show this group's layers (same behavior than just left-clicking on a color box).
* Show all groups
* Hide other groups' layers
* Select or Unselect this group's layers
* Protect or Unprotect this group (with a password)
* Lock or Unlock this group's layers
* Activate or Deactivate this group's layers
* Activate or Deactivate other groups' layers

All groups' colors and name can be modified, click on that icon  on a layer and select the Edit 
option (see below).  A new panel  (Edit  groups)  appears and allows you to proceed with many 
changes.

 >>> 

In the panel Edit groups, you will see a sub-menu Options. This menu also allows you to... :

• Reset your colors and use the default ones ;
• Save as default groups the current used group ;
• Export the color values of your groups ;
• Import these values.
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Use masks

Using the mask is very handy when handling the layers.

It enables you to draw, on the layer of your choice, the opaque pixels of another layer in exactly the 
same place.

In this way it is possible, for example, to modify the « texture » of a drawing without changing its 
shape (see below).

How to proceed :
* First of all, create two layers in the timeline, then draw the little red man shown above in one of  
them (whatever the drawing tool).

 

* Then enable the Mask for this layer (see opposite).

* Hide the layer with the little red man, then create a layer above. Now, any 
drawing will then be limited to the opaque areas of the layer containing the 
little red man. 

For example, drawing a filled rectangle with color gradient and use of a paper on the screen will 
display image 1, drawing with drawing tools, gradients, papers and specific modes will obtain the 
results 2 and 3 (see below).

     >> (1)   (2)   (3)

It is possible to flip the mask and only draw on the transparent areas of the layer containing the 
initial little man (examples 4 and 5 next page).

To do this, proceed as described above and click on the button Invert the mask indicated in the 
following diagram (this must then turn black).

← Enable the mask

← Invert the mask    (4)     (5)

This icon   on the timeline enables disabling of all masks or inverting 
of all masks according to your choice in the menu. 
It is possible to work with several masks divided into different layers: in 
this case, the masks are added up.
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When  a  pixel  is  partially  opaque,  it  may  only  be  partially  modified  when  using  a  mask.  For 
example, a pixel with 80% opacity can only be painted with maximum 80% opacity when the mask 
mode is used (if the mask is inverted, it may only be painted with maximum 20% opacity).
Finally, you should understand that, when pressing the Erase button while using a mask, only the 
part of the drawing corresponding to the mask will be erased.

If you see this icon  active in the menu panel, it means a mask (or a 
selection) is active. Don't forget to disable that button or disable the mask 
if you want continue to draw, without using a mask.

Preserve Alpha Channel

In TVPaint Animation, you can also preserve the Alpha channel of a layer. Its use is similar to the  
masks' use, as it lock the existing pixels in the current layer, in order to modify it (changing the 
color, for example).

Contrary to the masks, this function does not affect the other layers, only the current one.

Be  careful : do not preserve the alpha of an empty layer or turn it into a 
mask ! You could not be able to draw anything, without knowing why.

Display masks and papers

You may also enable display of the stencil, paper and selections via the Display menu (explained 
in detail in lesson 2), in order to give you a better idea on the the working zones and the used  
papers.
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Lesson 4

 Temporal Management of Layers

In lesson 3, we handled the layers using the timeline. However, the notion of time 
did not come up at all. 
This lesson deals with the notion of time.

In this lesson you will:

● Study the concept of the animation layer.

● Work with brushes and animated brushes.

● Handle the commands for project viewing.



Animation layers

Animation layers

Start by reproducing the image of lesson 2 in a project with square pixels (Aspect Ratio equal to 1), 
not using fields (see lesson 1 for an explanation concerning fields and ratio). The image below has 
been drawn thanks to the Oilbrush tool. Don't forget to place the house, sun, sky and grass on four 
different layers. 

You should have the following timeline on your screen :

Creation and concept of an Animation Layer

Everybody knows how a film is projected in a movie theater:
a film roll is placed in front of a powerful projector, enabling display of the pictures on a screen 
located a few meters away.
The images are projected at such speed that they give the illusion of movement to the spectator.

TVPaint Animation works with the same principle: it is possible to create your own virtual film rolls 
and project them onto your television screen.

In TVPaint Animation we refer to this roll as:  Animation Layers.

As we will see hereafter: the advantage of TVPaint Animation resides in the fact that it is possible 
to overlay several rolls (for example: one with a background scenery, another with a character and 
another with a foreground scenery.)

As we saw in lesson 3, it is possible to create animation layers using the New menu in the timeline, 
the main menu Layers, or using the shortcut [Ctrl+N].    
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Some layers may be reduced 
for  future  timelines  (see 
lesson 3).

Create an animation layer and name it 
«  Cloud  ».  Place  it  in  front  of  all  the 
others.  You  then  have  the  timeline 
shown opposite.



Animation layers

If  you  know TVPaint  Animation  for  a  long  time,  you  probably  know  the  Image 
Layers.  Those layers are still available in the software, in the menu Layer > New 
Image layer.  But as they are very few used and less useful  than the  Animation 

layers, they will not be explained in the user guide. We remember you : if you want to turn 
an Image layer into an Animation layer, please right click on the the Image layer and Make 
anim.

Add images

We have just created a layer with a single image (empty…). To make our first  film, we have to 
increase the number of images in our roll. To do this, several ways are available :

* You can use that button  in the Animator Panel (explained lesson 6).

* You can also stretch the white band (at the end of your image) to the 10th image in your timeline :

When  you  will  drop  your  click  on  that  window (see  below)  will  appear.  Click  on  Add  empty 
instances, then press Apply.

Movement and orientation within the timeline

Use the [� ] and [↓] keys to change the current layer.
                                                                                                                              
When you are in an animation layer, you can move between the images of this animation using the 
[� ] and [� ] arrows on the keyboard.

You may also use the mouse to move inside the timeline, by clicking on the 
space-time location of your choice.
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Animation layers

The white square with two red bars enables you to identify the current image viewed in the window 
of the current project.

The title bar contains several indications. From left to right :
* The name of the project you are working on.
* The time code of the first and last image of the project (TimeCode, or image number).
* The total project duration.
* The name of the current layer.
* The time code of the first and last image of the current layer (TimeCode or image number).
* The total duration of the layer.

Create a brush

    

Go to the first image of the animation layer named « cloud » and draw 
a gray cloud using the tools of your choice.

Then limit viewing to the current layer (shortcut [=]).

   

Let's take an example:
Draw a Rectangle around the previously drawn cloud. When this is 
done, you will note that your current brush is not one of the standard 
tools: the cloud itself has become your brush!
Press the stylus on your tablet if you doubt it: the cloud has turned 
into a paintbrush.
Don't forget to erase your tests before continuing!

Several  CutBrush tools are at your disposal in the main panel to simplify 
your  task  when  creating  a  brush  :  Rectangle  CutBrush,  Polygonal, 
FreeHand and Magic Wand.

See opposite:  
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We will create an animation in which the cloud will move from left 
to right. To do this, we have to make our cloud into a brush. Select 
the icon shown below from the main panel. This option is used to 
carry out Rectangle CutBrush. But, what does this mean?



Animation layers

The first animation

The first  image in our animation layer « cloud » contains … a cloud.  The other nine images, 
however, are empty.
* Go into the second image of this animation layer  using the  [ � ] and [� ] arrows on the keyboard 
and apply the brush in order to place the cloud slightly to the right of the cloud on the first image in 
the animation layer.
* Proceed in the same way for the third image of the animation layer, again moving the cloud 
slightly to the right of the one in the second image.
* Proceed in the same way to the last image of the animation layer.

To  make  easier  your  cloud's  movement,  you  can  use  the  Light  table (more 
informations lesson 6).

You will note that the corresponding icons of the timeline display the cloud and when you move 
inside the layer using the [� ] and [� ] arrows on the keyboard, your cloud will move!

Now spread the display  and  press  again  [=]  or  in  order  to  see the clouds  and  the other 
elements of your different layers. If you move on the timeline, you will notice the background is 
visible on the first image and also on the next images, whereas your layer contains only one image 
(exception for the cloud layer, which contains 10 images).

 >  >  >  >  

Logically, we could not be able to see the background layers after the first image (as they do not 
exist). But, you will notice, next to the background layers, the text Hold.

This text informs you that a  Post-behavior is activated.  Hold  holds the display of the last layer's 
image. As each layer composing the background contains only one image, the background is hold 
as long as the animation will be played.

Other  Post-  and Pre-behavior are available, such as None (image is visible only if it does exist), 
Ping-Pong and Repeat (those both modes will be explained lesson 6).

Another solution consists in stretching all layers as long as the layer with the cloud's animation :

– Select all the layers (except “Cloud”). Press [Shift] to select a sequel of layers or press [Ctrl] 
if you only want to select some layers (exactly like if you wanted to select files in your 
computer).
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 Selected layers will obtain a yellow aura (see next page).

- Clic on the white band at the end of one selected layers (any layer, as you prefer), and stretch it 
as long as the Cloud's layer (10th image, so).

- Drop the click : that window (already seen above) will appear again.

- Choose Stretch  and disable Interpolate. Then press Apply.

Other modes available in that window will be explained lesson 6.

Play an animation

Using the keyboard arrows to play an animation is not very practical. You have certainly noticed 
already: the most suitable options are available in the current project window.

Here are the functions of all buttons available :

 the  traditional  buttons  Play and  Stop  as  you will  find  on  video  recorders  and 
camcorders,  etc.

[Space] makes a pause during the play. If you press that key again, the 
play will continue where you had stopped it.

 to advance or rewind one frame in the current layer.
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 to go to the first or last frame of the current layer.

 to  go to  the  previous key  or  next  key  (the  notion of  keys will  be explained in  the 
following lessons).

 to modify the  Frame rate when playing the animation. Note that this value is not 
necessarily used when exporting your sequences.

This function only changes the display's frame rate when playing your animation. It 
does not  modify your project and will not be save or exported with the project. If you 
want to definitively change the frame rate, please go to Project > Modify Project.

 Press this button to play the animation in a loop.

 If you have chosen a sound track to accompany your project (see lesson 8), press this button to 
play it with your project.

Keyboard shortcut [W] allows you to play your animation starting a few frames before the current 
image and stopping a few frames after the current image. Then you come back to the image you 
were working on just before pressing the button. The framerate used is the one selected in the 
project window popup menu. 

The number of frames played on either side of the current image may also be set in the preview 
settings (see the Preview Settings section of this lesson).

You can also use the shortcut [H] and [J] to “flip” your animation back and fro, respectively. Hold 
one of these two keys to move the cursor, than drop it to let it going back to its initial position.

* The yellow rectangle located in the graduated line underneath the buttons indicates the image 
and the number of the image currently displayed on the screen.

* The Mark in and Mark out buttons :
These are numeric or time values indicating the frame from which the animation will start playing 
as well as the frame at which it will be stopped.
In order for this function to be taken into account when playing your animation, you must enable 
the corresponding buttons.
Two red and green markers enable identification of the mark in and mark out points.

On the top of the Layers panel, four options are available with the RMB to easily set and toggle the 
Mark in and Mark out values.

The 
Remote Control
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Animation layers

If required, it is possible to display some of these buttons in a separate 
window  referred  to  as  Remote  control,  which  is  accessible  via  the 
Windows > Tools main menu. The buttons containing numbers are used 
to define the play frame rate (in frames per second).

Play an animation on fullscreen

 

It's  possible  to  play  the  animation  in  fullscreen, 
without any panels and menus. If the [F11] key is hit, 
the animation will be displayed on the full size of the 
screen.

The Time Code is displayed if the option is activated. (See the Preview 
Setting section further to have more details)

Other movement methods

You may use the timeline or project window to move within the project. To do this, just click and 
slide on one of the rectangles shown below :

If you use the left mouse button, you change the image.

If you use the left mouse button, you change the image.
If you use the right mouse button you return automatically to the original image when releasing the 
button.

Fielded projects
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Now let's move on to fielded projects and/or projects with a ratio other than 1 :

* Button B enables display of both fields simultaneously when playing an animation or video. 
* Button 1 will display the field which you have defined as the first field.
* Button 2 will display the second field of the current image.

Note that the 1 and 2 buttons may only be used if your project is set to use 
fields. Furthermore, moving to the next image in a project containing fields 
will have the effect that the cursor of the current image does not move to the 
next image but to the next field (as an image is composed of two fields).

Button A of the current project window is used to enable/disable pixel Aspect Ratio display.

This does not modify the current project: only its aspect in the project window 
will be different.

The Navigator

   

The other buttons, specifically used for navigation on the project surface, 
are found in the Navigator window which is accessible in the Windows > 
Tools main menu.
This  panel  also  allows  you  to  have  a  low  quality  preview  of  your 
sequence/animation which can be useful by pressing the  button.

* Button N shown above is used to open a new project window.
* The red rectangle indicates the current display area in your window relative to the full image.
* The Display popup menu is the same as the one described in lesson 3.

Select and erase the contents of the images in an Animation Layer

Now we will see how to erase the contents of the Cloud layer.

This may be done with the  button on the main panel for all images one after the other, but this 
may be too time-consuming when working on long animated sequences.

The trick is to select all images of the layer using the option  Select all  in the contextual menu 
(keyboard  shortcut  [Ctrl+A]).  Your  timeline  must  be  displayed  as  shown below:  a  light  yellow 
rectangle is present underneath the selected images.
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fields.



Animation layers

   

Pressing the  button will erase the contents of 
all selected images in the layer.

It is possible to only select a part of the layer by clicking on the first image to 
be selected and sliding from there to the last.

Our sequence has been replaced by empty images. You may now make another cloud move with 
the cloud brush, as you did previously. Then, use all the knowledge you acquired thanks to this 
User guide to create a sun movement.

 > 

Reverse selected images of an Animation layer

Some options may speed up your work considerably. 

The  option  named  Reverse  selected  images is  used  to  reverse  the 
images  of  a  layer  in  time.  It  is  only  available  in  the  image  menu 
(accessible  with  a  right  click)  after  having  selected  the  images  to  be 
flipped in an animation layer of your choice.

See below an example with our animated cloud whose the image have 
been reversed :
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Move the layers in the timeline

As with the image layers in lesson 3, it  is possible to move the animation layers in space. For 
example, you may move the cloud behind the house or the sun in front of the cloud  (in case of a 
very high cloud, obviously), etc. But this is not all: image layers and animation layers may also be 
moved in time. Increase the image layers to 20 frames and the following timeline will appear :

Now click on any image of the «clouds» layer and slide the mouse to the right before releasing the 
button.  You  have  now moved  your  layer  in  time.  Do  the  same  with  the  «sun»  layer.  In  the 
screenshot  below,  the «clouds» layer  will  only  be shown starting  from the tenth  image of  the 
animation and the «sun» layer starting from the fourth image.

In the Layer main menu, the "Lock Position" option allows to lock the position of a layer, and then, 

it  can't  be moved anymore. The   symbol will  be displayed immediately after the click on a 
locked layer.

The range in number of frames (or in seconds, if you are in TimeCode display mode) 
located  at  the  top  of  the  timeline  offers  a  global  identification  system,  enabling 
location of each layer in relation to the  others within the current project.

The ranges under the frames of a layer (in number of frames or  Time Code) only refer to 
these layers.

Further details

Show, hide the icons

It is possible to show or hide the icons of an animation layer in the timeline. You will find this option  
in  the  contextual  menu of  the  animation layer  (the  first  and last  image are,  however,  always 
displayed).

The Auto Fit option in the timeline

When  using  a  very  long  animation  layer,  it  may  be  discouraging  having  to  use  the  sliders 
continually to only view a section of the timeline.`

Temporal management of layers 4-11
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Fortunately it is possible to modify the timeline scale :

Click  and  hold  the  Z button  of  the  timeline  to 
modify its display (stretch or increase the icons 
from the current image depending on the left or 
right movement of the mouse or trackball).

The Auto Fit popup menu may be used to adjust the size of the icons in the timeline in order to 
view the entire project, current layer, current image, current selection or keys.

You can also use [Alt] + RMB + movement on the right or on the left, respectively 
to zoom or unzoom in the timeline.

Using the Bookmarks

 

It is possible to place Bookmarks on the images of your animation 
layer (circled in black above) using the corresponding option in the 
Edit main menu.
Once  the  Bookmarks are  placed,  the  keyboard  shortcuts 
[Shift+Ctrl+→]  and  [Shift+Ctrl+←]  enable  you  to  move  to  the 
closest  Bookmark to the left or right of the current image. Finally, 
the keyboard shortcut [Shift+Ctrl+↑]  creates a  Bookmark for  the 
current image or deletes the Bookmark if the current image already 
contains one.

If the project contains a huge number of  Bookmarks, they can easily be removed by using the 
option Edit > Remove All Bookmark in the main menu.

Use the Image mark Panel

In the menu Windows > Tools you will find the Image marker panel. This panel allows you to mark 
images, in order to differentiate key images and breakdowns, for example.

   

All menu : in this menu, you can  Edit mark, Remove all mark in the  
current layer  and  Remove all marks in the clip.

Basically, marks are in dark blue. Other options, similar to the All menu 
are also available. The menu  Add / Remove allows you to add new 
color codes.

+  : allows you to add a mark in the wished color
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-  : remove the current mark of the current clip

 : allows to navigate to the previous or next mark (all colors or only the wished color).

 allows to navigate from marks to marks, from the current layer to the next below.

 allows to activate the loop mode.

Name an instance

The image-mark is not sufficient enough ? Double click on an image (instance's head or exposure 
cell) and a windows will appear : enter the instance's name in order to identify it more easily.

Double click on the instance of your choice

$

This windows appears : enter the instance's name

$

The new name appears below the instance

More explanations about instances will be given in lesson 6.

The Stroke Animator option

This option is accessible in the  Edit > Preference... panel directly under the  General tab. Like it 
was said in Lesson 1, this option allow you to draw over several frames. With the [Ctrl] key pressed 
during the drawing, the current frame will change automatically. 
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Here is an example, choose the  Free Hand Dot option with the  Pen Brush tool. Create a layer 
which has around 30 frames and place the current frame to the first one.

Now, press the [Ctrl] key and start to draw. The current frame changes during the drawing. And 
when the last frame becomes the current one, the drawing starts again on the first frame. And 
when you stop drawing, you will see one (or more if the animation has looped during the drawing) 
dot on each frame.

This feature is really useful to animate decorative elements, fireflies flying in the night, annoying 
insects, water jet...

The Preview settings panel

The preview settings  are used to configure the way your computer and program interact to play 
your animations.

  

You may open the  preview settings panel shown opposite via the 
Windows > Parameters main menu. The preview panel settings are 
also present in the info bar, at the bottom. 

Background proxy render : enable this option if you want the proxy calculates your animation when 
you're doing nothing. If you disable this option, the proxy won't calculate anything. 

   >>  

Force proxy render : enable this option if you want read your animation after the proxy has totally 
calculate you animation. If you disable this option, the proxy will calculate your animation when 
playing it. 

In TVPaint Animation, when you play an animation, ratio's quality directly depends on the temp file, 
located in your hard drive. 
The best quality will be calculated following the transfer's speed of your hard drive.

Proxy quality : indicate, with a numerical value, the images' quality when playing your animation. 
The more the percent is high, the more the quality is good. Check Full quality preview if you want 
to play your animation with the real image quality.

Show TC : enable this option if you want to see the Time code (if your timeline uses the time code 
mode) or the FPS code (if your timeline uses the frame mode). 

Time Warning :  this  option  allows you  to  display  the  proxy  in  red  if  your 
animation gets some lag when playing it.

Play all : enable this option if you want the proxy calculate all images. If you disable this option, 
some images can be unread when playing the animation. 

Flip book : choose how many seconds the Flip book (shortcut [W]) will run.
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Further details

The Stopwatch

The Stopwatch  is  an innovative function,  allowing you to mark  the beat  of  an animation  or  a 
soundtrack.

   

 allows you to start the stopwatch. Press again to pause it.

 marks the beat measured by the stopwatch.

Reset resets the stopwatch.

Enable  Metronome  to  beat  with  a  little  sound.  You can choose the 
tempo by entering a numerical value (in frames per second).

Link to playback allows you to read your animation and the stopwatch 
at the same time.

After marking one or several beats, feel free to convert these marks by 
clicking on the Actions menu.
* New scene : put the rhythm into clips, in order to create an animatic 
* New layer : put the rhythm into instances 
* New bookmarks : put the rhythm into bookmarks
* New image marks : put the rhythm into image marks

Do not forget an instance has to be created before marking it.

*  Create sound from tempo : turn the created rhythm into a sound visible in the space for sound 
tracks (explained lesson 8)
* Create sound from marks : turn the mark (made via the image mark)
* Calculate tempo change the metronome's tempo, following the beat you marked.
* Clear list delete the beat list.
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Lesson 5

Handling TVPaint Animation projects and Layout

In this lesson you will :

● Learn how to handle TVPaint Animation projects: load, save, import, export, 
etc...

● Study the notions of Templates, Dependencies.

● Discover the Share manager.

● Discover the Video Grabber Panel.

● Work with the Panel Bins concept.

● Study the notion of Rooms.      



Handling TVPaint Animation projects

Handling TVPaint Animation projects

Introduction

In  lessons 3 & 4 we studied the concepts of  image layers  and animation layers as well as their 
temporal and spatial specificities.
What we refer to as a  TVPaint Animation  project  (or simply  project), is all image, animation or 
Xsheet (see lesson 8) layers in a timeline (whether created by drawing, scanning or any other 
method) with all associated options: global opacity, pre- post- behavior, FX stack (see lesson 10), 
number of images per second, position in the timeline, resolution, etc.

Save a project

In lesson 1 we saw how to create a project with the parameters of your choice.
After having worked with tools and layers (lessons 2, 3 and 4), you may wish to save your project 
for later use. To do this, use the Save project or Save project as functions in the File main menu.
Save project  (keyboard shortcut [Shift+S], [Ctrl+S] and [Cmd+S]) allows you to save the project 
under the current name, whereas  Save project as asks you to choose a new file name for your 
project. This function allows you to easily duplicate your project as you progress with its creation.

Use the requester

A file explorer then asks you to select an access path and file name for your project. 

This window is laid out as follows: 
* The text field at the top of the window allows you to enter the name under which the file is to be 
saved.
* The second text field just below the first is used to select the type of files to be displayed in the 
right section of the window. 
* The popup menu to the right of this field is a shortcut used to select the file types of your choice.  
In  the  default  setting,  all  file  types  are  displayed  (extension  .PNG  .BMP .JPG …).  TVPaint 
Animationprojects have the extension .TVPP.
* The left section of the window contains the directory path. When necessary, the sliders (and 
fingerwheel of your mouse) may be used to scroll through the list of folders available for storage. A 
right-click on an item in this list opens a contextual menu offering access to  Open,  Delete and 
Rename functions.
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The  and  buttons are used to display or hide the content of your storage supports, folders or 
sub-folders.
* The  is used to return to the parent folder.
* The arrows  are used to scroll through the history of selections in the file explorer. In this 
way, you may quickly find the folders in which you last saved your work.
* The right section of the window displays the files contained in the folder you selected on the left 
side of the window.
* You may choose to display thumbnails of your files (button Thumbs, button Scan) or display a list 
containing information relative to your files: type, name, count, resolution, time, size, date of last 
save (button  List,  then button  Scan). Note that some data is not taken into account for all  file 
formats.
* It is also possible to delete the selected file, rename it or create a new folder using the buttons 
Delete, Rename and New folder.
* Once you have selected the file or folder you require, click on OK.
* To quit the file requester and ignore all operations, click on Cancel.

   

When using the second text field, the question 
mark is considered a random number or letter, 
whereas the asterisk is considered a complete 

random word.

For example :
* Enter « *.jpg » to display all image files of the type jpg in the right section of the window.
* Enter « dessin003?.jpg » to display all files named dessin003 followed by another character and 
the extension « .jpg ».
Therefore files between dessin0030.jpg and dessin0039.jpg will appear whereas dessin0020.jpg or 
dessin0040.jpg will not.

Above an example of a file requester with projects displayed in the form of thumbnails.
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Save a Template

      

A template is a blank project using a predefined resolution, speed, 
aspect ratio and number of layers and images.
It  is  possible  to  save  a  Template using  the  dedicated option 
indicated in the File main menu opposite (the template will have to 
be given a name).

In this way you may select the template you just created when a new project is started.
You may also use one of the many predefined models.

Load an existing project

To load an existing project from the data storage support,  simply press the keyboard shortcut 
[Shift+L] or the Load option in the File main menu. The file requester will then ask you to select an 
access path and file name.
Now that you know how to use the requester, load the file « running kid_2.tvpp » (the project can 
be found on the TVPaint Animation DVD-ROM).
If the project loaded is too big, too small, possesses too many images or has an incorrect pixel  
ratio, you may modify it.

 A list of files previously loaded with TVPaint Animation is available in the  File  main 
menu. Simply click on the name of one of these projects to load it again.

If you know the TVPaint technology for a long time, you probably knows the .tvp 
formats and even .mir and .aur formats. These old formats are still readable by 
TVPaint Animation, but only the .tvpp formats can be still generated (see further).

Modify a project

The option Modify project is accessible in the Project main menu. 
The latter opens the panel illustrated below:

* The project properties are indicated on the top left-hand side of the window and include: Project 
name, Width, Height, number of frames per second, Pixel aspect and Field options. Bottom left you 
will see the future size of your project, after modification.
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* Just below, a popup menu is available in which you may select the predefined format you require, 
corresponding to the format you will obtain after modification.
It is possible to modify a project originally in VGA format, to obtain a project in NTSC format.

*  The numeric  fields  located  under  the  popup menu change according  to  your  choice  in  the 
predefined formats menu.
Of course, you may modify your project for your own format (for example to create an animated gif 
on a website).  All  you have to do is modify each option manually:  Width,  Height,  Frame rate, 
Aspect Ratio,  Field (a mini popup menu is available for the parameters  Frame rate and  Aspect  
ratio). 

The  Lock  aspect button allows  you  to  keep  the  width  to  height  ratio  of  the  original project.
The Rotation parameter is used to rotate the project 90, 180 or 270 degrees.

* Here you will discover the functions of the next five buttons:
By default, when the Modify project function is used, TVPaint Animationkeeps your original project 
and creates a new project which is modified according to the parameters you have selected.
- The Resize to new size button enables, when checked, the resizing of your original project to a 
new size.
- The Correct aspect ratio button forces the program to respect the original image aspect ratio (this 
avoids the creation of disproportionate images).

               

- The  Stretch to new frame rate button, when checked, increases or decreases the number of 
images so that your new project has the same duration as the original project.
If,  for example, your original project displayed 24 images/second and your frame rate is set to 
12 images/second,  your  project  will  last  twice  as  long  (the  number  of  images  is,  by  default, 
retained). If the button Stretch to new frame rate is checked, some images will be deleted so that 
the original project and modified project have the same duration.
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In  the  opposite  case:  original  project  with  12  images/second,  modified  to  a  project  with 
24 images/second,  the  modified  project  will  be  shorter  than  the  original  project.  If  the  button 
Stretch to new frame rate is checked, intermediate images will be added to the modified project to 
make it coincide with the duration of the original project.
-  The  two  aforementioned  examples  are  similar  to  the  layer's  contract and  stretch section 
discussed in lesson 6. The Time interpolation button also refers to this function as it imposes layer 
stretching or contracting with interpolation when the button Stretch to new frame rate is checked.
- The Remove project button is used when the original project is not to be kept on the screen.

Use of the  Remove project option is at your own risk as in this case the  Undo 
function cannot be used to help you out…

* The right section of the project modification panel enables selection of the portion of the project 
which is to be modified. The mark in and mark out buttons as well as the associated numeric fields 
will help you select the first and last images of the project to be modified.
* The central numeric field and slider are used for navigation over the entire duration of the project.

Load an image or animation

It is sometimes useful, when working, to load an image, video or animation which has not been 
saved in a format which manages layers as well as their layout and opacity, etc… (in other words, 
an animation which has not been saved in one of the formats TVP, MIR or AUR)
In this case, a new panel, referred to as import footage panel, appears directly after selection of a 
file in the requester. This panel is as follows:

This panel is similar to the project modification panel.

Let's assume you have loaded a video file (AVI or MOV)
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-  On the top left-hand side of  the  import  panel  you will  find all  information relative to the file  
selected in the requester window (size, frame rate, aspect ratio, etc.).
- These are followed by a text field which indicates the path and name of the file you have chosen.
- The Browse button allows you, in case of error, to choose another file in the requester window.
- The Preload button will be discussed in the Dependencies section of this lesson.

Your video file may be modified when imported to suit your needs:  project name, width, height,  
frame rate,  aspect  ratio,  field,  rotation may  all  be  modified  as  we discovered  in  the  previous 
section.
The  Alpha  popup menu, however, possesses specific options including:  Guess, Premultiply, No 
Premultiply, Without alpha and Alpha only.
*  The option  Guess will  consider that  the  Alpha  value is  equal to the maximum RGBA values 
present in the sequence.
* The option Premultiply refers to the method of calculating each pixel. In this case, each pixel is 
multiplied by its alpha value which results in the fact that these pixels are calculated quicker than 
with the No Premultiply option.
* The option Without alpha will load your sequence without transparency if it had any beforehand.
* Finally, the option Alpha only will only load a mask of the sequence. This mask will be extracted 
from the alpha layer of the sequence.

Further down, three tabs allow you to choose the form to be given to your imported video: the 
imported video may be created either as a new project, a new layer in the current project or as a 
custom brush (these three options are mutually exclusive).

* When a video is loaded as a new project, three options are available:

- The video sample loaded will be that located between the two time markers on the right side of 
the panel. You may also choose to include sound with your video by checking the Import audio box 
in the import footage panel.
- The single frame check box, if checked, will create a project with a layer and a single frame: the 
frame selected in the right side of the panel.

The last menu (Split scene) will be explained lesson 9

* When a video is loaded as a new layer or a new clip, a new set of options similar to those 
encountered in the Modify Project section becomes available. You may:
- Stretch your video file to fit the dimensions of your current project,
- Adapt the aspect of your video to that of the current project,
- Compensate for any possible frame rate differences between your current project and your video 
by stretching or contracting your video,
- Choose to stretch or contract with or without interpolation,
- Create a layer with a single frame (here again, a single frame or large sample may be imported 
between the mark in and mark out points).
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* When a video is loaded as a custom brush, the same options are available with the exception of 
the Stretch to project size option.

When you load a file in PSD format, a new project is automatically created (no 
import  footage  panel  is  opened)  and  the  image  layers  are  all  present  in  the 
timeline.

Dependencies

The  Preload button present  in  the import  footage panel  is  used to choose whether  the video 
footage on which you wish to work is to be read directly from the computer storage support or if it is 
to be included in your current project.
This option is important for the following reasons:

* Let's assume your projects possess layers composed of non-preloaded video footage.
When loading the same project again, TVPaint Animationwill look for the data necessary to display 
the images, layers and timelines in the external video files. This function is interesting as it saves 
space when saving as your project does not contain all the images it comprises.

* To avoid having a project which is dependent on external videos, you may, when video footage is 
imported for the first time, preload it immediately. Your project will then be more voluminous when 
saved, but at least there will be no risk of loosing the data when the imported files are modified.

* In addition of images and videos, sound tracks can be linked to your project. To know more 
about, please read lesson 8

Export files

Saving a project in TVPaint Animation format with all associated layers may require a considerable 
amount of storage capacity.

Even if it contains specific data relative to your project (opacity, layers, etc…), the TVP format is 
not a practical solution if you want to share it with your friends at parties or on a website. Use of the 
dependencies  function  will  render  your  project  smaller,  but  it  is  not  more  practical  in  the 
aforementioned cases.

The option File > Export project to...  is used to convert your project into a format of your choice: 
animated  GIF,  AVI  or  QuickTime file,  numbered  frames sequence,  etc.  You  will  find  this  very 
practical as you are able to save your work in smaller files.

5-8 Handling TVPaint Animation projects and Layout

If you forget to do this, it  is possible to preload the files later via the main menu 
Project > Dependencies > Load all.
This menu also displays the path and name of files on which your project depends.
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renamed, this will have an incidence the next time your project is loaded (the layers 
and images concerned will not be found…).



Handling TVPaint Animation projects

This option is present in the File main menu. Once selected, the following panel appears:

Its layout should be familiar to you. You may choose to export an image, an image sequence, a 
video, keep the layers or a custom brush (possibly animated).
You will see 4 different tabs : Project : Display, Clip : Display, Clip : Layers structure and Custom 
Brush : Display. Each tab will be discussed in that lesson, but first at all, we will see the first part of 
the export panel, identical from a tab to another.

* The first section of the panel contains several options:

- The Browse button and an associated text field are used to enter the name and location of the file 
to be exported.

- As allows to choose the kind of export you want : 
• Single image (save the image visible in the right section of the panel only), 
• Sequence (save, frame per frame, the images located between the Mark in and Mark out 

points.  By  default,  the  images are  numbered  as  follows:  file_name_1,  file_name_2,  … … … 
file_name_123, … Sequence becomes Animation when exporting in a video format.

Including a « 0 » in your file name may help with numbering your images. For 
example if the first file name is « dessin_000 », the images will have the names 
dessin_001.jpg, dessin_002.jpg, … …dessin_354.jpg…

• Animation button is used to save all the frames between the Mark in and Mark out points 
in a single file and is available for some file formats (deep, gif, quicktime, fli, avi).

- Export and Cancel respectively export your animation or cancel (and so, close the export panel). 
But before exporting anything, we will study the options from the different tabs.
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Project   and   Clip   tabs :  

The difference between the Project and Clip tabs will be explained lesson 9.

* The second section deals with the export file format:
TVPaint Animation allows you to export your projects in a wide variety of formats: DIP, AVI, GIF, 
BMP, QUICKTIME, DPX, FLI, PNG, PCX, SUNRASTER, PSD, TGA, JPG, ILBM, TIFF, and you 
can add these formats for TVPaint Animation: FLYER CLIP, D1 RTV, CINEON, SGI, SOFTIMAGE, 
VPB.
Each format has its own features which are explained in an appendix.
Some are configurable (for example AVI format), others are not.

The codecs present in the popup menus and their configuration options are those installed in your 
operating system.

In order to save a TVPaint Animation project  in DVD format,  you must  have a 
MPEG-2 encoder codec installed on your computer.

When required, and depending on the various formats of export, you may need to set the following 
option parameters:

- Mode : you may choose to export your work in the form of images or a video with a limited palette  
(8 bits=256 colors), a large palette (24 bits=16.777.216 colors), a palette which takes into account 
the pixel transparency: 32 bits, a palette with no color data, but only pixel transparency (a mask).

- The palette : in the case of a limited color palette, you may choose to use a gray scale palette, 
the user define located in the Bin tab of the palette panel, a global quantized palette to be used for 
all frames of your footage or animation, or a  local quantized palette which is modified for each 
frame of an animation.

- The number of colors : you may also choose a precise number of colors between 2 and 256 (to 
do this you must first choose one of the two quantized palettes).

- Dither : the Dither button is used to disperse the pixels of your animation in order to simulate use 
of a palette with a lot more colors (technically referred to as «Floyd-Steinberg dithering»).

- Alpha : options relative to the Alpha function were discussed on page 7.

* The third section of this panel manages the restrictions and attributes imposed on a file to be 
exported (width, height, frame rate, pixel aspect ratio, field), compared with the original attributes 
(chosen when you created your project).
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* The last section allows you to choose some behaviors, following the options you chose in the 
thrid and secon section.
- The Background button, when checked, renders all the pixels of your images opaque using the 
background selected (color, check or none) which is placed behind the transparent pixels of your 
images.
- The Correct aspect button is used to correct the pixel aspect ratio of the images to be exported in 
accordance with the setting made in the fourth section.
The Stretch to frame rate button, when checked, imposes a previously selected frame rate on the 
file to be exported while retaining the original duration.
-  If  the  aforementioned  button is  checked,  the  Time interpolation  button allows you to decide 
whether the frame rate (or fields) correction should be carried out by interpolation (smoothing) or 
duplication (or deleting as the case may be).

Layer   Tab :  

* Old TVPaint format :
This format is useful for persons who work with the current version of TVPaint Animation and a 
version older than the 9.5 version (released in September 2009), using the .TVP format (and not 
the current .TVPP).

You will obtain a file equal to the current clip. If you didn't know or used these old versions, do not 
care about this export.

* .PSD format :
If you want to export a project in .PSD from the Project or Clip tabs, you will export one image (or 
an image sequence) with all the layers merged, without transparency.

If you want to export your project with layers, you will  need the options of the  Layer  tab. Two 
modes are available :
- Single image : all layers and all images that compose your project will be in only one file. Each 
element will be save as a layer and transparency will be preserved.

- Sequence : each image will be save in a .PSD file. If that image is originally composed of several  
layers, the .PSD file will keep all the layers. Transparency is also preserved.

* .CSV format :
This format is really useful for people working on several software and who quickly need an xsheet.

The .CSV format generates a .CSV file (readable with Open Office or Microsoft Excel) and an 
image folder. Those images are in fact the first image of each instance (the instance meaning is 
explained lesson 6),  from each layer.  Each image has a name and a number  sequel  (do not 
change them !). Combined with the .CSV file, now you are able to know in which order those 
images does appear, exactly like a traditional xsheet.
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Custom brush   tab :  

Export's options are the same than the Project tab. As you guess, this option allows you to export 
directly the custom brush you are currently using. This option is really interesting, in particular if  
you want to gain time (it is faster to cut a custom brush and export it, than cropping an image and  
then, export it) or create a tutorial. 

You want to explain to someone how to use a panel ? Hold the said panel (as if 
you wanted to move it) and press [G] on your keyboard. If you go on your drawing 
space : surprise ! Your panel is now a custom brush !

Once all the options are set for the current project in the export project panel, they will be linked to 
the current project. So, each time the export project panel will be opened, all the parameters will be 
filled by the ones set by the user the last time he exported a file with this project.

The Share manager  

This function  becomes really  useful,  especially  if  you are  using TVPaint  Animation in  network 
(ethernet or wifi connection), inside a studio or a school. The Share manager simply allows you to 
share a project, a clip (explained lesson 9) or a custom panel (lesson 19).

You will  open this manager by clicking on that icon   from the  Menu panel or by going to 
Windows > Tools. The manager will appear like this :

On your right hand side, you will see all people connected to your network. The green people are 
the  persons  currently  connected.  The  grey  people  are  the  persons  who  have  been  already 
connected before, but who are currently off-line.
A new person is connected on your network but you don't see him/her  in your list ? Don't forget to 
Refresh list to detect the newcomers in your network.

A simple right click on the list will open this pop-up menu :

• Favorites will allow you to choose your favorite neighbors and display them only.

•  Hide offline users, as you guess, allows you to hide the offline users from the 
list.

• Remove allows you to remove a neighbor from your list.

As you are connected to a network, you will also appear in you neighbors' list. In order to be easily 
recognizible, you can change the Identifier at the top of the manager.
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At the left bottom corner of the manager, you will notice two menus : “Type” and “Which one”.

  

In “Type”, you will have the possibility to choose the type of file you wish to send : full project, a clip 
(a sotyboard element explained lesson 9), or a cusom panel (that may contains your brushes, your 
colors and your script, which is explained in detail lesson 19).

In Which one, you can choose simply the name of the element you are about to send, following the 
Type you have just chosen. In the example above, we have chosen to send the current project. 
However, if we decide to send a Custom panel, choices will be different :

  

After choosing the object to send, select the addressee (by clicking on his / her name, which will be 
underlined in yellow) and click on the big button “Send” :

Then, your neighbor will have the choice between accept it... :

… or not
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Then, when it will be your turn to receive a file, you will obtain a visible 
alert. The button from the Menu panel will becomr blue (see next).

The  Share manager will display an alert too and will propose you to accept or refuse the object 
sent by a neighbor :

Then, you are free to accept or refuse the object. If you accept it, this object will be automatically 
available in your TVPaint Animation interface. If you closed by inadvertence, you can still re-open it 
by clicking on the bleu folder icon.

Above the object list, you can organize the element types you want to Display or eventually Clear 
the list.
Video options
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The Video Input panel

It is sometimes useful to refer to video footage to create the drawings necessary for an animation. 
For this reason, it is possible to enter a video directly into the software. 

TVPaint Animation is compatible with WDM standard equipment without having to install specific 
drivers or plugins. For information, WDM devices are Windows Device Manager devices (used by 
most WebCam and DV format camcorders). On Mac OS X, TVPaint Animation is compatible with 
QuickTime devices.

To grab video footage, you must first ensure your peripheral device is correctly installed. 
Then, you must right-click on the  V button located on the bottom right-hand side of your 
project window or go to the menu Windows > Parameters.This action opens the Video input  
panel.                      

If  your device is correctly connected to your computer,  opening this window will  show what is 
presently «seen» by the device in the preview window.

Here is the Video input panel :

* Device :  you choose here which video input source you need (very useful if  you get several 
cameras or webcams). The “Settings” button, just below, directly open you camera / webcam's 
application. 

* Mix : the mix option is a little like a light table (very useful if you make stop-motion movies). This 
option change your drawing space and your preview's opacity.

Grabbed image (on the left : drawing space / on the right : the video input panel)
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Grabbed image + new stacked preview image, not grabbed yet (the drawing space and the image 
from the preview are 50%  opaque)

* Rotation : rotate the grab angle from 0°, 90°, 180° or 270°. (very useful if you want to use the 
video input to line-test an animation made on paper. Instead of turning your camera, rotate I with 
TVPaint !)

* Apply in : you can choose where you grabbed image will go. :
_Append image : add a new image into the same layer 
_New layer : add a new layer with the grabbed image 
_Current image : replace the current image by the new grabbed one 

* Length : here you can define how many exposures your grabbed image will get. In that case, the 
instance will only have one exposure. 

* Field : here you can manage the fields during grabbing. :
_As is : no field 
_Lower first : only lower fields will appears 
_Upper first : only upper field will appears 
_Mix : the image will be composed of 50% higher fields and 50% lower field 

* Enable play : read the entire clip (very useful if you're making a stop motion movie) 

* Frame rate : choose here the preview frame rate 
_Playback read the preview like the clip playback 
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_1/2 playback read the preview half as the clip playback 
_1/4” playback read the preview four time less as the clip playback 
_Project read the preview with the project's speed (the one you've chosen when you've created 
your project) 
_1/2 project read the preview half as the project 
_1/4 project read the preview four times less as the project 

* Play frame : choose how many image you want to see when play the preview 

* Hold frame : choose how long will appear what your camera / webcam is filming (in FPS) after 
playing the preview. 

And then, the Grab input button grab the an image. 

A detailed example of animation created with the help of the video grabber and a 
Canon camera is available in lesson 19 (chapter « Canon plug-in ») of this manual.

The Video Output panel 

  

* The Refresh button allows you, if possible, to obtain a real time display on the external device. 
(by default, the display is refreshed after each stroke)
* The Keyer button allows you to improve the management of the transparent pixels with some 
external devices.
* The  Fit  button allows you to adjust the dimensions of your current project in order to obtain a 
better result on the external device.

Please read the appendix  of  this  manual  to  obtain  the complete  list  of  external 
hardware compatible with TVPaint Animation Pro.

Up to the end of this lesson, we only speak about the interface features, the content and the 
parameters of all the panels are not really important. This lesson is principally based on the panels 
position and the layout.

The   Panel Bins   feature  

The idea of the Panel Bins, is to "clean up" the interface of TVPaint Animation. When you begin to 
have around ten panels open at the same time, it can become a little confused. And I don't speak 
to have to move several panels.
Consequently,  the  idea  was  to  bring  together  all  the  panels  in  a  single  place to  simplify  the 
management of the panels. It is like that the Panel Bins concept came.
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Locate the Panel Bins

There are two areas which represent the two Panel Bins, one located at the left side of the TVPaint 
Animation window, and the other at the right side. The two Panel Bins are enabled by default.

On this screenshot, you can see that the workspace can now be divided into 4 main parts:
1) The Project window
2) The Timeline window
3) The left Panel Bin
4) The right Panel Bin

Almost all the panels in TVPaint Animation will be able to be stored in one of the two Panel Bins.

Working with the Panel Bins

The use of the Panel Bins is awfully simple ... just drag and drop a panel inside a Panel Bin. Yes, 
that's all! A panel is automatically added to a Panel Bin when it is dropped on it.

        

To  drag  a  panel,  click 
and drag the title bar of 
the panel.
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If there are too many panels inside a Panel Bins, 
a slider  appears on the right  or  left  side of  the 
Panel Bins.

You want to get a panel out from a Panel Bin, just drag and drop the panel outside it. And as it is  
possible to do this, it is always possible to keep floating panels anywhere in the program window.

You can also see that when you add a panel to a Panel Bin, all the other panels inside it, move 
automatically to add all the necessary space for the dropped panel. Same behavior if a panel gets 
out of a Panel Bin, all the panels under it, will fill automatically the empty space left by the panel.

        

  To  gain  even  more  space  in  the 
Panel  Bins,  all  the  panels  can  be 
collapsed  (the  triangle  on  the  top 

right corner of the panel). Of course, when a 
panel is collapsed or extended, all the other 
panels in the Panel Bin move automatically.

Handling TVPaint Animation projects and Layout 5-19

Mac user does not have 
a triangle, but this gray 
button : 



The Panel Bins feature

Another option of  the  Panel  Bins allows you to work on an even cleaner workspace,  it  is  the 
triangle on the top of the Panel Bins.

When this option is activated  (like in the image above), the Panel Bins are always visible.

Whereas when this option is not activated   (like in the image below), the  Panel Bins hideout 
when the cursor is not over them.

And when the  Panel Bins are hidden, only a thin bar is still visible near the TVPaint Animation 
window borders. To show the Panel Bins again, move the cursor on this bar, and the Panel Bins 
will reappear.
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Some exceptions

Even if almost all the panels in TVPaint Animation can be dropped inside the Panel Bins, there are 
some exceptions like: the Project window, the Time Line window, the Light Table and the FX Stack, 
and some others ...

* The Light Table, the Share manager and the FX Stack are always floating panels. They can not 
be re-stretched on the standard width of the  Panel Bins  without an important loss of their user-
friendliness.

* The Time Line window can not be inside the Panel Bins but has some options relatives to the 
Panel Bins.

This window can be a floating one or a window fixed at the bottom of the TVPaint Animation 
window. (The fixed window is recognizable with the unique button in its top right corner)

               Fixed Time Line Window                                                     Floating Time Line Window

To change the fixed window into the floating window, double click on the title bar of 
the Time Line window.

To change the floating window into the fixed window, click on the 
triangle (an oval icon on Mac – see lesson 1) in the top right corner 
of the Time Line window.                            

If it is fixed at the bottom, an option becomes available like in the Panel Bins. It is the faculty to 
hide out when the cursor is not over the Time Line window. Like in the Panel Bins, this option is the 
triangle on the top right corner of the Time Line window.
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*  The  Project window,  when  it  is  maximized,  fills  always  all  the  empty  area  left  by  the  two 
Panel Bins and the Time Line window.

Below, there are some examples of the automatically restretching of the Project window.

 Project window with Panel Bins and Time Line                   Project window with Time Line window

            Project window with Panel Bins                                                 Only Project window

More options ...

More  options  are  available  to  manage  the  Panel  Bins.  They  are  accessible  in  the  Edit  > 
Preferences panel under the Display tab.

* The two first options enable and disable the left and right  Panel Bins. If these options are not 
checked, the two Panel Bins totally disappear from the TVPaint Animation window. They are not 
only hidden, they really don't exist anymore.

If  you  disable  a  Panel  Bin while  there  are  panels  inside,  these  panels  become 
normal floating panels. And if you enable again the Panel Bin, you must add again all 
these panels inside the Panel Bin.

* The Large Time Line option stretches the Time Line window between the 2 sides of the TVPaint 
Animation window, rather than between the two Panel Bins.
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If this option is not checked, the Time Line window will be like in the image below.

* The Right Time Line option places the Time Line window vertically near the right Panel Bin.
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Working with   Rooms   

Now we have seen how to manage and optimize the position of all the panels in the software. Why 
not apply the concept to several "virtual" software windows, to still improve the workflow. This is 
called the Rooms concept, and we will see how this idea has grown up.

To  create  an  animation,  several  steps  must  be  respected,  the  sketch,  the  inking,  the 
compositing, ... , and each step needs its own tools, panels, shortcuts,  ... . It is as simple as that!  
Each step doesn't need to display all the panels, like during the compositing, there is no need to 
keep the Main or the Tool panels open for example.

As viewed in lesson 1, all the Rooms are easily accessible in the right side of the Info Bar or with 
the main menu View > Rooms. There are four Rooms which are totally customizable.

The aim of a Room

The only goal of a  Room is to store the interface and layout of the program and reuse it. That 
means all the position of the panels, if they are opened/closed, the keyboard shortcuts, the color 
scheme, the light table parameters, ... .
And like there are four Rooms available, it's like you have four TVPaint Animation windows opened 
at the same time! It's a Multi Interface Configuration.

Your projects are always the same between each Room, it's only the interface and layout of the 
panels which change.

If you select another  Room with the [Ctrl] + [Alt] keys pressed, the new selected 
Room will get all the parameters of the previous Room. By this way, you can easily 
copy the layout of a Room into another Room.
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Customizing your Rooms

The default Rooms are only a starting-point. There are many many other ways to use the Rooms. 
The following examples won't be detailed like the default ones, the aim of these examples is to let  
your imagination and your needs of course, manage and arrange your own Rooms.

Room 1 : Original TVPaint Animation 10 interface

Room 2 : sketching room
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Room 3 : Interface using TVPaint Animation 9 color scheme

Room 4 : Interface with a special Correction panel, for teachers and studios
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Lesson 6

The steps to create animations

In this lesson you will : 

● Learn,  one  by  one,  the  various  stages  involved  in  the  creation  of  an 
animation using this application (Scan cleaner, light table, rotative drawing 
disk and inking options will be introduced).

● Use the Animator Panel.

● Use the scan and print options of the software.

● Learn how to use instances.

● Study the notes over an animation.



The steps to create animations

Introduction

The  aim of  this  section  is  to  sum up  the  various  steps  involved  in  creating  a  cartoon  using 
TVPaint Animation and to deal with frequently asked questions. Some steps will be explained in 
more detail when studying the corresponding effects.

Working with hand-made drawings

Import an images sequence

You may choose to create the images for your future cartoon either traditionally on paper with PEG 
holes (see below) or more directly in TVPaint Animation.

TVPaint Animation works with Twain standard scanners in Windows and Linux.
* The File > Twain > Select option is used to choose the scanner you intend using.
* The File > Twain > Acquire option displays the Twain interface of you scanner in order to begin 
working with the latter.

On Mac OS X, TVPaint Animation works with ICA standard scanners. Use the File > ICA > Acquire 
option to display the acquisition interface.

Pay attention : 64 bits versions of TVPaint Animation do not always support scanners

If you could not scan directly into TVPaint Animation, scan your images from the 
software provided with your scanner and save your images as an image sequence : 
« image001 », « image002 » etc...
To import  that  sequence,  drag and drop the first  image  from that  sequence into 

TVPaint  Animation.  Think  in  uncheck  Single  image in  the  import  panel  and  all  your 
sequence will be imported. More information lesson 5.

In this way, when you scan a set of images, you may either import these images directly after the 
current animation layer, or in a new animation layer, or simply in a new project.
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Working with hand-made drawings

Inversely, it is also possible to print the content of a project.
The File > Configure printer option displays the options available on your printer,
The File > Print option opens a new window:
- At the top of this window you will find the name of your printer.
- The Setup button displays the options available on your printer.

 

Crop  a project
The  Crop  tool  is  used  to  define  a  rectangular  area  in  the  current 
project and to transform the content of this area (including all layers) 
into a new project.
This  is  very practical  when cropping your  animations  due to badly 
defined edges (see example below).
The variables Start X and Start Y are used to define the top left-hand 
corner of the rectangular area, whereas the next two variables adjust 
the Width and Height.
Lock aspect retains the current width/height ratio.
You can also use the HUD to edit the area to crop.

         
before cropping                                                     after cropping
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- The Single tab opposite is used to print the current image.
You may adjust the size and position of your image on the future sheet 
of paper using the click and slide function as well as the Scale field.
The Center button places your drawing in the center of your future sheet 
of paper.

-  The Anim  tab offers the possibility  to  print  several  images of  your 
animation (merged layers) on the same sheet of paper.
In addition to the image size and position setting options, you may:
Choose the number of rows for your images.
Display the position of each image on the timeline.
Choose every second, third, fourth, etc. image in the Steps field.
The two buttons in the bottom right-hand corner of the panel are used to 
scroll through the various pages to be printed.



Working with hand-made drawings

Clean-up the sequence

Once the drawing has been scanned, it is possible to :

*  Delete white or  gray pixels  to  imitate the use of  a true animation overlay (this  operation is  
necessary for later coloring as well as for use with a background).

  or     will give :  

* Clean up your drawings in order to correct rough pencil lines.

            (zoom)     >> 

To obtain this result, use the feature  Basic scan cleaner, available in the  Image > Modify  menu, 
specially designed to accomplish the two aforementioned operations in a few clicks. You can also 
use the FX Color > Scan Cleaner, if the parameters of the Basic scan cleaner does not fit to you. 
FX stack will be discussed in lesson 10.

Once all  drawings have been scanned,  many users wish to delete,  add  or  duplicate  images. 
Sometimes, they also have to transfer complete images or layers from one project to another. It is 
this traditional, and yet vital, aspect that we will now examine in more detail.

Flip an image

It is possible to flip your images around the horizontal, vertical or both axes. 

            
       Original image                        Horizontal flip                           Vertical flip              Horizontal and Vertical flip

To do this, simply use the main menu options  Image > Modify > Flip (Horizontally, Vertically or  
Both) an image or the selected images.
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Working directly with TVPaint Animation

Working directly with TVPaint Animation

The Sketch panel

The  Sketch  panel comprises some useful preset tools which will  allow you to create and clean 
sketches, as if you were drawing by hand.
The Sketch panel tools are designed for users who work with both computer and graphic tablet and 
who want to keep their old drawing tools habits. (pencil, eraser, ...)

Here is a detailed description of the panel :

   

* The pencil icons allow you to draw sketches as if you had real 
pencils. Three colors are available : black, orange and blue. The 
blue  and  orange  pencils  draw  with  Behind mode  though  the 
black pencil draw in Color mode.

* The  paintbrush icons allow you to paint any pre-existing line 
into the color. You can turn any line blue, orange or black.

* The flask icons allow you to turn your image into blue, orange or black.

* The first series of erasers allow to erase only the color that is displayed on the icon.

* The cross icons delete the color(s) : orange, blue, orange and blue, black while leaving the other 
colors intact.

* The eraser icons allow to ... erase a portion of the image. The first eraser is small. The second 
eraser is bigger and smoother.

Two supplementary  Sketch panels are available : the first one is  Sketch Panel 
Red (orange is replaced by red) and the second one is  Sketch Panel RGB. It 
contains 3 colors (red, green, blue) and the black. These both panels can be 

found in Windows > Custom panels.

Now, let's study how to draw and clean a sketch step by step :

* Firstly, erase the content of the current project or open a new project window.
* Use the blue and the orange pencils to rough out your drawing.
The two colors, orange and blue, can help you to differentiate the portions of the image (here, the 
head and the legs are in orange, the arms are in blue.)

               

* If you need to do so, use the two erasers at your disposal to refine on our image.
In the example below, the first eraser was used on the head of the character, the second eraser 
was used on the arms. (the colored eraser will only delete the corresponding colors)
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Working directly with TVPaint Animation

               

Whether you draw or erase, don't forget that the rotative drawing disk can help 
you work with more precision.

* Once the sketch with orange and blue colors is finished, use the black pencil to clean up the 
drawing.

                

* Now use the blue cross  icon : you now have deleted the blue construction lines of the arms : only 
the black lines of the arms are now visible.
The orange and black areas of the image (head and legs) are still visible.

                

When you use the two colors blue and orange to draw, it  is easier to choose 
whether part of the image should be erased or kept.

* If you use now the orange cross icon, only the black lines will stay on the screen. The sketch is 
more precise than at the beginning.
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Working directly with TVPaint Animation

                

* At this state of the process, you can stop here or continue to have a better result.

* We have turned here the lines into orange by using the orange flask icon. It is still possible to add 
some lines or to clean the image with the erasers.

                

* If you want, you can turn the arms of the character into blue by using the blue paintbrush icon.

               

* Here again, we draw with the black pencil on the colored construction lines.

               

* Now we can delete the orange and blue construction lines : The image is not rough anymore. (if it 
is not the case, you can return to the previous steps)
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Working directly with TVPaint Animation

                

This method is not the only one that can be used with the Sketch panel : you can 
use three colors in a different way or you can use only two colors.

Some  artists  uses  one  color  for  the  characters  and  another  color  for  the  
background landscape ...

It should be easy for you to adapt the Sketch panel to your workflow.

Managing the images of an animation layer

Move and duplicate one or several images

To move one or several images, select at first the images you want.

It is possible to select several consecutive images of a layer with a simple click 
and slide of the left mouse button under the timeline icons. The selected images 
are then marked in yellow (see below).

It is therefore possible to duplicate or delete all selected images in the same way as 
described above.

Then, click again on the selected images and hold the click : selected images will become pink and 
will indicate that you can move them in the timeline.

If you move your selection in an empty space : you will remove its presence from its original place, 
and move it somewhere else. If needed, the previous instance will be stretched automatically.
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Managing the images of an animation layer

To  duplicate  your  images  selection  into  the  same layer  (in  order  to  repeat  it  further  in  your 
animation, for example), you just have to hold your click and press [Ctrl].

You can also duplicate your selection to another layer by dropping it to the layer above or below 
(the layer has to be created before).

Be  careful !  If  you  put  your  selection's  copy  above  an  image  sequence,  your 
selection will overwrite the images.

To avoid any incident,  press [Shift]  to  insert  your  selection  between two images, 
without overwriting them.

You can also copy, cut or paste an image selection, respectively with the shortcuts [Ctrl + C], [Ctrl + 
X] and [Ctrl + V] (use [Cmd] instead of [Ctrl] if you are a Mac user).

Insert or delete one or several instances

A right click on the timeline opens a contextual menu which allows you to 
insert instances (this function has been already explained in lesson 4), after 
the current image.

You  can  also  use  those  buttons   from  the  Animator  Panel to  add  instances  (more 
information about that panel further).

images inserted from image 18

To delete several images, think at first in doing a selection, then press the key [Del] (be careful :  
[Bk Sp] does not delete the images but clear their contain). You can also delete them from the 
contextual timeline menu (do not forget to confirm)

The Insert, Duplicate, Delete images options are also available in the Image main 
menu and in the Animator Panel.
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Managing the images of an animation layer

Cut, Copy, Paste layers

The method used to cut, copy and paste an image or animation layer from one project to another is 
the same as that used for images.

To select several layers, simply left click on these layers while pressing the [Ctrl] or [Shift] keys as 
explained in lesson 3. The layers selected then appear in yellow. 

The layer's contextual menu is located in the left section of the timeline, the timeline's contextual  
menu is on the right side of the timeline (see below).

The Cut, Copy, Paste layers options are also available in the Layers main menu.

Before  transferring  the  layers  from  one  project  to  another,  always  ensure  the 
resolution is correct, otherwise your images may be distorted. 

Use the Peg-holes registration

“Pegs” are little holes made in paper sheets to hold them together on a “peg bar”, in order to draw 
and animate.

If you want to scan an animation made on paper and use a scanner with feeder you will notice your 
sheets are not stabilized and so, when playing the animation, the result is really unpleasant.

To fix this problem, TVPaint Animation contains a tool named  Peg-holes registration. The  peg-
holes registration is a very useful option to quickly and efficiently scan animations made on paper. 
In fact, this option realigns the animation, thanks to the peg holes. 
To use this function, just open the Window > Tools > Peg-holes registration. A little window like this 
will appear : 

Into this window, you can configure the peg hole's size (height and width). To see the peg holes on 
your workspace, please click on Set pegs position.
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Managing the images of an animation layer

Place  the  two  red  rectangles  above  the  original  peg  holes.  Modify  their  size  to  precise  the 
alignment. 

Be careful : do not set the red rectangles too near from the pegs ! You must respect a 
tolerance or the registration will not be efficient (see below).

And then, apply. The animation will be re-aligned automatically. 

By the way, you can choose any image from your animation to set the peg-holes registration : the 
layer will be entirely re-aligned. 

Working with instances : 

In this chapter :
* The blue images are the new ones.
* The grey images are those which have been drawn in one of the previous steps.
* The green images are here to show the global render of the animation, once it is 
finished.

Introduction
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Working with instances : 

In traditional paper animation, the animators are often using the following method :

1 

2 

3 

4       =      final

This simple process needs some successive subdivisions along the animation layer of the timeline.
That's  not  always  easy  because  the  images  duplication,  creation  or  copy  are  not  always 
convenient to use.  Adjusting the timing of the whole animation usually needs to duplicate and/or 
delete some frames and can be time consuming.
That is the reason why the use of the images instances is clearly advised.

What is an Instance ?

    

An instance is simply an image in an animation layer, an image whose 
duration can be adjusted. 

Each instance in the timeline has now two small squares which allows 
to use this feature. The one at the bottom on the right is for stretching 
the duration of the current instance. To do so, simply click on this little 
handle (it becomes yellow) and move it as shown opposite.

You have just increased the duration of the current image.

Any  image  of  an  animation  layer  is  considered  as  an  instance.  Of  course,  if  you  stretch  an 
instance, the following instances will shift back :
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* First the key images are drawn. The purpose is to 
get a handle on the global movement, on the required 
number of images, on the timing to schedule, etc ...

In the example opposite, the kid is running from the 
left  to  the right  of  the  screen.  Two key images are 
drawn.

*  The second  step  is  to  locate  and  draw the  most 
important frames. In our example, this is when the kid 
is jumping (the two feet are not on the floor).

* Finally, the inbetween pictures are added :

To begin,  an  image is  drawn between each  picture 
already visible on the timeline.

After  this,  new  inbetweens  are  added  among  the 
previous one. this usually helps a lot to obtain a good 
quality of animation (in other words a smooth flow of 
movement)

* The subdivisions are repeated until the animator is 
satisfied of the rendering. 



Working with instances : 

Original layer

Extend Exposure Cells without [Ctrl] key

If you pull on the left, your instance will decrease to the head's instance (the first image).

You will  notice another square on your instances, on the left at  the top, this time. This handle 
allows you to stretch an instance without modifying the total duration of your animation.

Hold the click on the handle (that will become yellow) and move on the left or the right :

Some vocabulary

Here is the name of each new element visible on screen :

  

Opposite,  we  have  an  Instance containing 
four Cells. The first cell is called Head Cell or 
more simply : Head.

The following cells (when existing) are called 
Exposure Cells or Exposures.

The  tail of  our  instance is  the  little  handle 
ending the Instance which you can drag to 
adjust the number of Exposure Cells.

Above the Head, you will find a handle, named the sprocket. The sprocket allows you to adjust the 
number of exposure cells without change the global timing of the layer.

The number of Cells in an instance is displayed on the top right corner of the Instance.
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Working with instances : 

The content of the cells

Whatever the size of the instance could be, the exposure cells are an accurate reproduction of the 
head cell. At the first sight, all the cells of the instance have then the same content.
You should however take into account that  all  the cells of  an instance do not  have the same 
function : Indeed, if a modification of the head cell has a repercussion on the exposure cells, it's 
clearly not the same if you decide to modify an exposure cell directly.

Splitting an Instance into two smaller Instances

  

Once an exposure cell is modified, the current instance is broken 
into two smaller instances.
For example (opposite), our instance contain the letter “A”.
Modifying the third  exposure  cell  by  deleting  the letter  “A”  and 
drawing the letter “B” will  create two different instances, the first 
one containing the letter “A”, the second containing the letter “B”.
We will then see the following images when playing the sequence: 
A  A  A  B  B.

  

The option Image > Instances > Auto Break Instance  is available 
in the main menu
When it is not checked, the exposure cell which is modified, won't 
create a new instance. The new image will be copied in the head 
of the instance

It is also possible to force the splitting of an instance. Place the current image at the 
position you want to split  the instance, and select the  Image > Instances > Break 
Instance option.

How to use the Instances for animating

Now, let's study a new example :
In our animation, the elephant falls from the top of the screen, then gets up, and finally leaves the 
screen by walking to the left.

        
1 > 2                                                        2 > 3                                                  3 > 4

We can already and easily distinguish four key images from which the inbetweens will be drawn.
Let's re-use the method introduced earlier in this lesson, but with image instances : 
* First create a new animation layer and duplicate the current frame three time. You must have four 
empty instances on the timeline.
* We need then to draw the four key images in each instance.
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Working with instances : 

*  Just  after  this  operation,  you  can  adjust  the  timing  by  choosing  the  appropriate  number  of 
exposure cells in each instance.

If you need a quick preview of the animation when drawing, it is advised to use the 
Flip-Book option. (see lesson 4 for more details)

* Once this task is finished, we can break the four existing instances in order to draw the first 
inbetweens. (the inbetweens are drawn in blue for more readability)

You can use the Light Table option to help you during the drawing process. It will take 
only the head cells into account. (please read the  Light Table section further in this 
lesson)

* Now we can break, move and resize again the existing instances in order to draw the second 
series of inbetweens. Below, you will find the beginning of the resulting timeline.
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Working with instances : 

At any moment of this process, you can, by only a few mouse clicks, change the 
number  of  cells  of  your  instances,  and  then  improve  the  whole  timing  of  the 
animation.

* Continue the process by breaking again the existing instances and by adding inbetweens. Stop it  
once you are satisfied with your animation.

- - - - - - - - - - - - - - - - - -

   1 > 2       

To  finish,  here  is  a  quick  overview  of  the  steps  which  were 
needed to create the animation from the first to the second key 
image : 

The blue « I » below shows where the last instance was broken 
(ie : split) into two instances.

   

Here are the two key 
images, at the ends of 
the animation

A  first  instance  is 
created  in  the  middle 
of the layer.

Two  new  instances 
are  created  for  the 
inbetweens.

The  instances  are 
moved and resized.

Two last instances are 
created  for  the  last 
inbetweens.
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Working with instances : 

The Faux-Fixe feature

 

By  default,  all  the  images  in  the  exposure  cells  are  the  same,  by 
definition, they are only a "link" on the head image.

However, this feature allows to use the previous images of an instance, 
in its exposure cells. 

This option is really useful, in particular when a character stops moving, 
but whose the lines still shake (a graphical aspect very appreciated by 
traditional animators).

This is made possible by the option  Faux-Fixe Value available in the 
timeline's  contextual  menu.  That  value  is  applied  on  the  wished 
exposure cell (you cannot use that value on the instance's head).

Let's see an example of the behavior of this feature. Let's say we want to repeat elements from 
that animation on the last instance, on the the third exposure cell : 

In this feature, the value represents how many previous images will be repeated in the exposure 
cells of the last instance, from the exposure cell of your choice (in the present case : the third one).  
Ìn our example, we want to repeat the previous exposure cells, the instance's head and the three 
previous instances, so 12  images :

The third exposure cell contains a blue circle, the sixth one will contain a red rectangle etc... and 
this repetition will loop as long as the instance will have exposure cells.

The Faux-Fixe Value set to 12 images

You can also set different behaviors than Repeat, such as Ping-Pong and Random.

Ping-Pong
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Working with instances : 

Random

How to change the line's color

  

You can use the option opposite in the layers stack in order to draw only on the 
existing pixels of your image.

It allows, for example, to change the colors of your drawings.

 >  >  >  > 

Only the layer with that option enable will be affected.

Erase the content of an image instance

Using the erase button  of the main panel on the head cell of an instance erases its content.

  >  

Using the erase button  of the main panel on an exposure cell of an instance always breaks the 
instance into two smaller instances.

  >  

Using the erase button  of the main panel on several cells and/or instances turns each cell into 
an empty single instance.

  >  

Navigate in the layer

Some options are available in the Image > Exposure menu to make the way to navigate between 
the different parts of the instances easier .

* To navigate between several instances, it is possible to use he shortcuts [Page up] and [Page 
Down]  or [Ctrl  + left  arrow]  and [Ctrl  +  right  arrow] on your  keyboard or  click on these icons 

 in the remote to go to  previous instance and go to next instance. 
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Working with instances : 

Original position

Go to Previous Instance

Go to Next Instance

* The layer's beginning or end are also easily accessible via these icons  in the remote 
or the shortcuts [ã] (also called [Home]) and [End] of your keyboard.

Original position

Go to beginning

Go to end

As we saw in lesson 4, you can use the shortcut [H] and [J] to flip your animation 
respectively back and fro.

Add Exposure cells in an instance

With the  Image > Exposure > Add Exposure option, it's possible to add a new exposure in the 
current instance.

Original

     
Add Exposure
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Working with instances : 

Remove Exposure cells from an instance

Two different options are available to remove exposure cells from an instance.
* The  Image > Exposure > Remove Exposure option removes one exposure cell in the current 
instance.

Original

 
Remove Exposure

* The  Image > Exposure > Remove all  Exposures option removes all the exposure cells in the 
current  instance. Only the head of the instance will be kept.

Original
 

  
Remove All Exposures

You can also use buttons from the Animator Panel, that will be explained later.

* If several instances are selected and the Remove all Exposures option is used, all the exposure 
cells from the selected instances will be removed. And the selection will be stretched on the heads 
of the modified instances.

Original
 

     
Remove All Exposures

Delete Selected images

In the previous part, the function only applies on the exposure cells, and now the question is how 
to remove heads ?
To do so, just select the delete option in the contextual menu of the layer or the appropriate button 
in the animator panel. 
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Working with instances : 

 

It's always possible to delete exposure cells by this way.

Deleting the exposure cells of an instance will make all the images of the layer move to the left.  
The head of your instance stay the same.

     

Deleting the head cell of the first instance of the current layer will make all the images of the layer  
move to the left, but will keep the containing of the instance.

Deleting the head cell of an instance in the middle of the layer will also make all the images of the 
layer move to the left, but will keep the containing of the instance.

     

Merge layers

We already saw in lesson 3 how to merge image layers. It is not really different if you decide to  
merge animation layers with instances. You can use the merge menu of the timeline or drag'n drop 
a layer on another layer.
TVPaint Animation will always try to create instances in the merged layer.
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Working with instances : 

   

Opposite, four layers :
A,  B,  C  and  D  are 
going to be merged.

(we  used  the  option 
Merge all Layers)

The  resulting  layer 
uses  the  instances 
system.

The empty space between the two original layers is replaced by an empty instance. 

Stretch a layer

We have described how to increase the number  of  images of  a layer  by inserting some new 
exposure cells in the instances. There are, however, other methods to increase the number of 
images in a layer.

Click and slide to the right on the tab encircled in black (see below) to call up the panel shown 
opposite.

The example (next page) gives you an idea of the effects produced by the various options.
Interpolation  is nothing but a fade effect computed and applied by TVPaint Animation to fill  the 
intermediary images which will be inserted between the original images.

It  is  possible  to  stretch  a  layer  to  the  left  by  repeating  the  operation 
described above with the left tab.
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Working with instances : 

   

Original layer to be stretched to the 
right.

Stretch without interpolation.

Stretch with interpolation.

Repeat: Loop.

Repeat: Ping-Pong.

Repeat : Hold.

Repeat : Exposure.

Add empty Instances.

Add empty Exposures.

Shrink an Animation layer

It is also possible to reduce the number of images in a layer using an 
analog method.

Click and slide to the left on the encircled tab below to call up the 
panel shown opposite. 

The example below gives you an idea of the effects produced by the 
various options.

The original layer which will be contracted in time.

Move the tab to the left.

Option Shrink without interpolation.

Option Shrink with interpolation.

Option Cut images.

With interpolation, the numbers « 1,2,3 » are mixed in the same image, the numbers « 4,5,6 » in 
the next, then « 7,8,9 » etc …
Without interpolation, the intermediary images between images 1, 4, 7 and 10 are deleted.
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Working with instances : 

It  is  possible to  shrink a layer from the left  by repeating the operation described 
above with the left tab.

Pre- and Post-behavior

  

Did you notice the small triangles on either side 
of the layers?

A left click on the triangles offers you access to the options regarding pre- and post-behavior of the 
layers.

Let's take the case of post-behavior as an example (pre-behavior works in the same way). You 
may  choose  between  the  options:  None,  Repeat,  PingPong (the  last  option  only  applies  to 
animation layers), Hold.
These options have the same effect as those offered when stretching a layer. However, in the 
present case, the layer is not stretched and the post-behavior will be taken into account until the 
end of the animation.

These options are also present in the contextual menu of the layer.

How to use several layers at the same time

If you use instances when working, it could be sometimes helpful to use several layers at the same 
time (for instance, if you want to stretch a drawing and its colors).

  

You  can  select  one  layer  by  using  the  left  mouse  button  on  its  main 
thumbnail. 
If you want to select more than one layer, you can use the [ctrl] key and 
select the needed layers by using the same method. Of course, you can 
also use the layers contextual menu. And by right-clicking on the colored 
boxes in the Time Line window, all the layers of the color can be selected.

Let's imagine we have selected the two layers below (which yellow enlightened). We are currently 
located on the fourth image of the timeline.

If we stretch the instance on the Edges layer by moving its tail, the corresponding instance on the 
Colors layer will be stretched in the same way.
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Working with instances : 

If you stretch the Edges layer by moving the right tab, the Colors layer will be stretched in the same 
way (we have chosen here to add empty images)

If you move the Sprocket to adjust your instances durations :

If you click and slide a selected layer on the timeline, the other will follow.

The Recompute Exposures option

This option of the Layer main menu will try to transform the images of the current layer into heads 
or exposures cells. This option will only work if there are several identical images in your layer. 
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The Animator Panel

The   Animator Panel  

We have not yet discussed these panels which appear in the right panel bin, when the program is 
started. They comprise a wide variety of functions which will help you save a great deal of time 
when you start  to get the hang of using the program. You will  have noticed that  many of  the 
functions already discussed are present in the Animator Panel. It was, however, important for us to 
start by explaining the fundamentals of the program before introducing you to some shortcuts!

Everything  in  relation  with  the  creation  or 
modification of custom panels will  be discussed in 
lesson 7 and 19.

Amongst these, you will find the possibility to add images before or after the current image, split a 
layer (after the current image), delete an image or layer, convert an image layer into an animation 
layer and vice versa, define bookmarks (add/delete), etc.
Now we are going to take a closer look at these functions...

The first thing you will notice is that the panel is sub-divided into several sections:  Clip,  Layer, 
Instance, Exposure and Misc. 

Clip :

   These icons justify all layers from a clip on the left or on the right.

   This icon selects all layers from the clip.

   This icon moves the layers forward, in the way to make a layer begins when the previous one 
is finished.
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   This icon splits a layer in two after the current frame. The old part (left) stays on the current 
layer and clip, the other part (right), will be created into another layer, into another clip.

   This icon creates bookmarks.

   With these icons, you can circulate between bookmarks.

“Clips” are storyboard elements. They will be discussed about lesson 9.

Layer

   This icon selects the entire layer.

   This icon deletes the current layer.

   These icons duplicate the current layer, by keeping its contain (green) or by emptying it  
(white).

   These icons split  in  two the layer  after  the current  frame (left)  or  join together  two 
selected layers (right)

        

Instance

   This icons selects the entire instance.

   This icon deletes the current instance.

   This icon duplicates the current instance.

   This icon erases the current instance's head.

   This icon applies special effects from the FX Stacks and recompute the instances.
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   This icon adds a Faux-fixe (loop animation).

   These icons add a new instance before (left) or after (right) the current frame.

   These icons add as much as instances you need before (left) or after (right) the current 
frame.

   If you remember well, you have the possibility to name an instance. 

Thanks to this button, you can apply the same contain than the current instance to all instances 
using the same name.

For example,  let's take this example below, where several instances with the same name are 
repeated in the timeline :

Let's draw a blue cross on one of them :

And now, let's use the button to apply the same drawing on all instances using the same name :

Exposure

   This icon select the current exposure.

   These icons add one or several exposures into the current instance.

   These icons delete one or several exposures into the current instance.

   These icons convert an exposure into an instance by keeping its contain or by clearing it.

   This icon recomputes several similar instances to create only one instance with several 
exposures.
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 This button has pratically the same role than the previous one, except it allow you to define a 

range. This feature is really useful for people who made their storyboard on a different software 
and want to work then with TVPaint Animation.

Import your storyboard as a video format and use the tolerance range to recompute the instances 
with a similar content.

Original images sequence

Final result

Miscellaneous

 These two buttons enable the use of a virtual stack in which you will store the current 
image with the first button. This image may then be used by simply pressing the second button. 
Note, on the one hand, that the last image added to the stack is always the first to be removed 
and, on the other hand, that the number of images stored in this virtual stack depends on the hard 
drive space available.

The classical tools of the animator

Rotate workspace

This a sum-up of the informations from lesson 3.

When working with pencil and paper, you often have to rotate the page in order to touch-up the 
lines drawn.
This is also possible with TVPaint Animation thanks to the workspace rotation function.

    

This is done by left clicking on the button illustrated opposite in the current 
project window and then moving the mouse.

The steps to create animated graphics 6-29



The classical tools of the animator

 It is possible to play your animation with a tilted workspace! 

   

Note  that  workspace  rotation  always  takes 
place from the center of your project window. 
If  necessary,  you may use the bottom and 
right-hand sliders of your project window to 
position the latter (see opposite).

 

While the workspace is rotated, it becomes visible in the form of an 
animation disk. If you do not need this function, it may be disabled in 
the Display popup menu of the current project.

Animation artists who prefer to use the Animator fields  may use the 
same menu to select this option (see below).

 

Using the light table

The light table is a familiar tool to cartoon and animation artists. It simplifies drawing of the current 
image by offering a tone-down view of the images before and after the current image.
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To activate the light table, click on this icon, on the wanted layer.

If you click on the light bulb icon  in the menu panel or via the  Windows 
main menu :

* Load the animation « Running Kid 2 » and display only the current layer.
* Start by choosing the  color option in the popup menu on the left-hand side of the Light table 
panel to display all frames in front of the current frame in the color indicated (default color red).
* Then disable all the frames behind the current frame that you do not want to see by clicking on 
the corresponding frame number.
* Go to the frame in the center of the animation.
* To enable the light table in your layer, click on the LT icon in this layer.

The following image will appear in the current project window:

 

The light table is an extremely practical tool as it is also possible to display all frames  after the 
current frame in time and for a given layer.
If you configure your light table as indicated below (choose the gradient option in the popup menu 
on the right-hand side of the Light Table panel), the frames after the current frame «in time» are 
displayed in a colored gradient, with more or less opacity depending on their position in relation to 
the current frame.

Now that you understand how this tool works, let's go back and take a closer look at its control 
panel:
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* The two popup menu allows you to display the images after and before the current image with :  
their original colors, a color or a gradient of your choice.

* The two colored boxes near those popup menus allow you to select the colors on the screen or a 
gradient in a preset list to view the frames before and after the current frame.

* The use of colors in this viewing mode is not mandatory. If you wish to keep the original image 
colors, select the option none (See below).

* The sliders are used to manage the opacity level of frames displayed.

* The numbers are used to select the frames to be displayed.
For example: in the panels shown as an example above, the number 5 to the right of the zero is  
selected and its slider is set in the center of the scale.
This means that the fifth frame after the current frame will be visible with medium opacity.

* The second popup provides some options on the displayed images.

* The bin popup provides all the standard functions to load/save custom light tables.

The number 0 enables or disables the light table, its slider manages the 
global opacity of the table.

The Out-of-Pegs feature

The “Out-of Pegs” feature allows you to move images coming after or before the current image, in 
order to make easier the inbetweens. This feature is situated in the Light  Table and  does not 
modify the final render of your animation, even when you play it.
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_ The light table can be apply on the frames before and after the current 
one, or on the instance heads, or on the bookmarked images.

_ The Front option allows to display the light table images in front of the 
current image.

_ The  All and  None options allow to display all the images of the light 
table or no images.

_ The Link option avoids having to move each slider individually by linking 
them to one another.
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Here is an animation with a running character :

This animation contains 3 instances and needs inbetweens, between the first instance and the 
second one. Break the instance thanks to the key [Del] or thanks to that icon  in order to create 

a clear instance between the two instances. 

Then, open the light table's panel and activate it on your layer (see the screenshot), in order to see 
by transparency your  previous image and your next  image.Thanks to  the Light  Table,  start  to 
quickly draw the inbetween.

As you can see, the light table has gray square under each image's slider and because there is a 
black triangle under the current image. Click on a gray square when you want to select and move 
an image before or after the current one.

For example, if  you click on the square of the image after the current one, the square will  be 
activated : a “0” and a green HUD will appear. The HUD allows you to move the display in order to,  
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for example, trace the head, check the leg's length etc... When you move the display, the HUD 
becomes red. If you want to move another image, click on another image's square (for example :  
image after the current one).   

When an image is moved, the “0” stays, in order to remind you there was a change. When you 
moved all your images, you simply have to choose your drawing tool and complete your 
inbetween. If you want to reset the display, click on on the black triangle, under the 
current image's slider, in order to open this little pop-up menu (on the right). “Link all” 
will allow you to move and resize all your “out-of-pegs” positions in once and Reset will clear all the 
positions.

You can also remove individually the “out-of-pegs” with a right click.

Then, you will be fere to finish your drawing properly.
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The Timeline Notes

The  Timeline Notes was created in order to provide the animator with a way to add graphical 
annotations and notes to its animation. It is a tool to make its work easier.

The Timeline Notes is accessible in the Timeline window and looks like this :

On the screenshot, you can see that the Timeline Notes is divided into two parts, a left and a right 
one. All the options of the Timeline Notes are available in the left part. The right part is dedicated to 
the drawing annotations. By default, you can directly draw on the right part with a blue pencil.

The options part

We can see that there are 3 sub-sections in this part.

* Let's start with the second part.

It holds the main tools of the TimeLine Notes feature. Most of the tools available here look a lot like 
the tools of the Sketch panel, studied at the beginning of this lesson.

The three colored circles allow you to change the color with which the annotations 
will be drawn.

The five options underneath change the current tool type.

 The Pencil tool icon allows you to draw annotations with the color of the icon, as if you had a 
real pencils.

 The Color Eraser tool allows you to erase only the color that is displayed on the icon.

 The Tint tool icon allows you to paint any pre-existing annotations into the current color. You 
can turn any line blue, red or black.

 This action deletes all the annotations of the current color, and leaves the other colors intact.

 This  action allows  you  to  turn  the  TimeLine  Notes into  blue,  red  or  black  color.  All  the 
annotations will be colorized with the current color.
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Remember that the Undo ([u]) and the Redo ([Shift]+
[u]) actions are available in the TimeLine Notes.

 The  Eraser tool completely erases the  annotations independently of their color.  It has the 

same functionality than the Color Eraser tool ( ) but without taking care of the line color.

 The Clear All action simply erases all the annotations in the TimeLine Notes.

 The Slice tool allows to split the TimeLine Notes into two parts. Select the tool, click on the 
position you want splitting and drag the right part of the TimeLine Notes where you want.

 The Move tool moves all the TimeLine Notes. Just click on the right side and drag it.

* Now, let's say a word on the option in the third sub-section.

_ The  Grid slider value enables discreet gray vertical  lines on the  TimeLine Notes.  This value 
represents the number of image between each vertical  line.  The aim of  this option is that  the 
animator can clearly see to what images, his annotations correspond.

If the slider value is 0, the vertical lines are disabled. It is the default value.

* Finally, the first sub-section holds 2 options. 

_ The Size slider parameter allows to change the size of the different pencils which are used. Each 

pencil ( , ,  and ) stores its own value. 

_ The functionality of the popup is really interesting. It allows you to play all the TimeLine Notes 
over the project when it is played in real time. This option can draw the TimeLine Notes at different 
positions and sizes over the project.

Examples :

Now that all these options have been studied, let's see an example with the elephant project.

Add annotations with the Pencil tool and with different colors
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With the Faux-Fixe feature, 50 exposure cells have been added to the project, so the annotations 
don't correspond anymore to the animation

No problem ..., select the Slice tool above the 24th frames, cut it and move the right part of the 
TimeLine Notes to the corresponding frame

Play your animation, and your TimeLine Notes 
will be displayed during the playback over the project

You will find a little dot on the top right corner, in that part of the timeline. If you 
click on it, you will lock the timeline for notes, in order to avoid any mistakes or 
errors.
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The inking process

The floodfill tool

Our running kid is drawn on an animation layer. We will now fill in the background with the Floodfill tool.

When using the traditional  Fill  option you choose a pixel in the current project window and then 
click on it. We refer to this pixel as the origin pixel. 
The Fill option changes the color of neighboring pixels until it is prevented from progressing by the 
«border» pixels.

    

Opposite, the «border» pixels in black and 
the color dispersion from the origin pixel in 
blue.

The options indicated above allow you to choose the type of pixels to be used as a «barrier» for  
the Floodfill function (i.e. pixels which will not be modified after choosing this option).
Depending on your choice made in the  Fill popup menu, the pixels considered to be «barrier» 
pixels will be those with:
* a different color from the original pixel color
* a different density
* a different color and density
* a different luminosity 
* a color identical to the B color.

Depending on your choice in the Source popup menu, the pixels considered to be barrier pixels are 
located:
* on the current layer (by default)
* on all layers behind the current layer
* on all layers in front of the current layer
* on all layers displayed on the screen
It is therefore possible to color our running kid on a layer independent of its contours.
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Once the  Floodfill  tool has  been  selected,  various  options  are 
proposed in the Filling shape panel shown opposite:

- The color modes were discussed in lesson 2 and 7,
-  The  Smooth,  Opacity,  Gradient  and  Opacity  mapping options 
were discussed in lesson 3,
- The Custom brush option was introduced in lesson 4 and will be 
fully explained in lesson 7.

We will therefore only take a closer look at the second section of 
the Filling shape panel.
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Let's take a look at the timeline below:
(in this case, the white pixels are transparent following a clean up of the animated footage)

Go to the «coloring layer» located behind the «Running Kid» layer and choose the layer placed in 
front of the current layer to color the running kid in the «coloring layer» using the outline of the 
«Running Kid» layer. 
It is then possible to obtain the following result :

        

*  The  Range option  enables  you  to  numerically  adjust  the  tolerance  threshold  for  the 
aforementioned criteria (Fill shape  menu).

For  example,  opposite,  a  green  shape  is  drawn  with  an  airbrush  on  a 
transparent surface with a checker background.
The  floodfill  option  applied  in  the  center  of  the  circle  with  the  color  blue 
provides the image results shown below.

fill = color and opacity, expand = 0  (in all cases below)

                                                  
        range = 0      range = 50                 range = 100                  range = 200                  range = 255

Progressively, it is noted that the tolerance to «border» pixels  becomes less and less.
* The Expand option increases the size of the floodfill area to the number of pixels of your choice.
This enables you to limit the number of border pixels.
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For example: you draw a green line with the airbrush. A left click with the 
Floodfill tool and the color blue and you will obtain the following results:

Floodfill = color and opacity, range = 0  (in all cases below)

             
 expand = 0    expand = 5     expand = 10    expand = 15   expand = 20    expand = 25    expand = 30   expand = 40

Combine the two options Expand and Range to avoid the result indicated below left and to obtain 
the result below right.

  >>  

*  The  Gap  option allows you to avoid «overspills»  when you try  to fill  a surface which is  not 
completely closed.

Low values are used in the case of «small gaps», whereas high values are used for larger gaps (it  
is worth noting that higher values sometimes result in a lower floodfill quality).

   

   

   

6-40 The steps to create animated graphics

Image with «a gap»

Floodfill the character without Gap closer

Floodfill the character with Gap closer



The inking process

The Auto Pick Color option

Finally, you have noticed that there is also a box called Auto pick color.

This option will save a great deal of time as it allows you, when checked, to pick a color when you 
click and to place it when you release the button. Combined with a Light table which only displays 
the previous frame, you may pick the color from the previous frame and place it in your current 
frame.

Fill inside

Another way to fill  your drawings does exist,  through filled shapes, just like  Filled  stroke. This 
option is called « Fill inside ».
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This feature allows you to quickly fill a drawing zone. It is really useful, especially when you want to 
fill a complex drawing with a lot of little stroke, like the drawing below, made with a pencil tool.

By creating a new layer below the Drawing layer and by choosing some parameters of  Filled 
stroke, we will  have then the possibility to fill  all  the drawing (the red HUD visible in the image 
below)...

    

… and so, fill inside the drawing very quickly.

The feature  proposed are  very similar  to  the ones met  in  the flood fill  tool.  Only  ths function 
“Include lines” is a little different. This option allow you to include or not the lines in the colorisation. 
Below, you will see an example of colorisation, without the lines.
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Create shadows

Once you have finished coloring your running kid, you may add shadows to the latter using the 
toonshading effects discussed in lesson 13.

        
toonshading                                     toonshading                                  Drop Shadow

To finish the animation

Camera movements

Now that your running kid is animated, it  is possible to add a scenery behind him and to add 
camera movement  (see below).  Two effects  will  help  you with  this:  Keyframer  and  Multiplane 
camera (go to lessons 15 and 16 for details of these effects).

Add music

The graphic design side of your project is now complete. If you wish, you may now add a sound 
track in order to give it that final touch. (Read lesson 8 for more details about this subject.)
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Lesson 7 

Other TVPaint Animation drawing tools

In this lesson, you will: 

● Finish studying the drawing modes.

● Use the clipboard.

● Use the spare image.

● Learn how to use animbrushes as drawing tools.

● Use cutouts and selections.

● Create and manage custom panels



The other drawing modes

The other drawing modes

We studied in lesson 2 several drawing modes : color, behind and erase. We are now going to 
study the other drawing modes at our disposal.
The drawing and the photography below will serve as a basis in this chapter.

        

The Shade and Light drawing modes

As  their  names  speak  for  themselves,  these  drawing  modes  require  almost  no  additional 
explanation. They are used to darken or brighten the opaque areas of the image where you draw 
your line.

Just note that the higher the Power and Opacity of the drawing tool, the more the drawing carried 
out in these modes will approach opaque white or opaque black.

In this example, we used the Airbrush tool with a power of 100 % and an opacity of 17 %.

        
Airbrush tool in Shade mode Airbrush tool in Light mode

If the chosen background is white or black, do not confuse the  Erase mode with 
these  two  modes  :  the  modes  Shade and Light modify  the  color  of  the  pixels, 
whereas the Erase mode modifies their opacity.

The Darken only and Lighten only drawing modes

Darken only darken pixels lighter than A color.

        

Darken only with dark blue
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Darken only with kaki

On the other side, lighten only lighten pixels darker than A color.

        
Lighten only with dark blue

        
Lighten only with kaki

The Saturate and Unsaturate drawing modes

These two modes are used to increase or decrease pixel saturation.
A highly saturated color is a very bright color whereas a less saturated color is rather dull and 
closer to gray. Here, the Penbrush tool was used with an opacity and power of 100% for a radius 
of 30 pixels.

        
                                 Penbrush tool in Saturate mode              Penbrush tool in Unsaturate mode

The pixels of the house are gray with a light red hue.
The Saturate mode will therefore increase their red components and render them more vivid. 
The Unsaturate mode will have little effect on the same pixels as they are already close to gray.
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The pixels of the sun and sky are very saturated.
The Saturate mode will therefore change the yellow hues only a little.
The Unsaturate mode will modify them according to different shades of gray.

          
                                Penbrush tool in Saturate mode               Penbrush tool in Unsaturate mode

The Smooth and Sharp drawing modes

The Smooth mode attenuates the contours of elements in the image and creates a blurred effect 
while the Sharp mode will accentuate them.

        

                                Penbrush tool in Smooth mode                Penbrush tool in Sharp mode 

        

The Burn and Dodge drawing modes

Burn and Dodge respectively allow to increase or decrease the light density of your image. 

        
Burn
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Dodge

The Colorize and Tint drawing modes

These two modes modify the color of the pixels:

* The Colorize mode adds the A color while respecting the pixel luminosity of the source image.

* The Tint mode also adds the A color but respects the saturation as well as the luminosity. The 
more a pixel is close to a gray, white or black color (with all the shades they contain), the less 
effect the color change will have.

This is visible in the drawing areas corresponding to the cloud : they are less affected by the Tint 
than by the Colorize  mode. Here the A color is red.

         

                                 Airbrush tool in Colorize mode              Airbrush tool in Tint mode

          

The Negative and Solarize drawing modes

The  Negative mode inverses the value of the pixels in the source image (the yellow of the sun 
becomes blue, the black text becomes white, etc.).

The Solarize mode gives a slightly different result than the Negative mode. 
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It  mixes  the negative  of  the  source image with  the source image itself  and thus  imitates the 
photographic solarization procedure.

        
                               Airbrush tool in Negative mode                 Airbrush tool in Solarize mode

          
     

The Grain and Noise drawing modes

The Grain mode adds a multi-colored grain to the current image. This creates a texture imitating a 
light photographic grain.
The Noise mode adds a single-colored grain. The color applied is the A color. 
The  Grain and  Noise modes themselves also depend strongly on the power and opacity of the 
drawing tool. Here the A color is a gray color.

Penbrush tool in Grain mode Penbrush tool in Noise mode 
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The Emboss drawing mode

       
Airbrush tool in Emboss mode

The Emboss mode accentuates the image contours by adding a shadow.
Once the tool is used on the image, it appears to have more volume.

The Add and Sub drawing modes

The Add mode adds the R,G,B,A values of the current tool with the A color to the R,G,B,A values 
of the source image pixels. The result is the image shown on the left.
The  Sub  mode subtracts the R,G,B values of the  A color from the R,G,B values of the source 
image pixels. The result is the image shown on the right. 
Here the A color is purple: R=128, G=0, B=128.

        
                                Airbrush tool in Add mode                        Airbrush tool in Sub mode

        

The Multiply and Screen drawing modes

The Multiply  mode multiplies the individual values of the R,G,B channels of  the source image 
pixels with the sum of the R,G,B values of the A color pixels. The Screen mode inverses the values 
previously used.
Here again, the A color is purple: R=128, G=0, B=128.

These last four modes:  Add, Sub, Multiply and Screen are more useful when 
they are used with brushes or with certain effects. 

We will come back to them in further lessons.
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                                Airbrush tool in Multiply mode                  Airbrush tool in Screen mode 

          

The Alpha Diff drawing mode

The Alpha Diff mode works essentially on the Alpha channel of the tool and the image pixels.
If the Alpha channel value of the pixel in the image is less than the Alpha channel value of the pixel 
of the tool, the new image pixel color gets the tool pixel color.
Otherwise, a percentage of the tool pixel Alpha channel value is computed in function of it and of  
the image pixel Alpha channel value. This percentage is applied on the image pixel color, and then, 
added to the tool pixel color.

This Alpha Diff drawing mode is very useful for drawing transparent colors and keeping the same 
"global" Alpha component value of the tool in the image. A good example is for a layer which would 
contain shadows. With this mode, it is possible to draw a shadow with different tones of grey but 
always keeping the same Alpha value.
We can see this mode like a global non-drying mode.

Let's see an example with the cloud above the house.
On the first images, three ellipses have been applied successively on the cloud layer with the 
default Color mode with different color values.

Original Image

          
color 255 0 0                            color 128 0 0                            color 20 0 0

On the following images, the same ellipse with same colors has been applied on the cloud layer. 
The only change is the Alpha Diff mode.
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color 255 0 0                            color 128 0 0                            color 20 0 0

The Panto drawing mode

The  Panto  mode is used to reproduce,  by translation of  the vector of  the X,Y coordinates,  all 
sections of the layer (the X,Y values being those present in the Shape settings panel).

It is possible to interactively define the X,Y values using the Set button (keyboard 
shortcut [Shift+P]) of the Shape setting panel (drawing a segment on the screen will 
determine the X and Y values).

E.g. for X= -360 and Y= -238  you will obtain, after having used the penbrush to draw a line at the 
height of the sun in the final image (corresponding to the diagram below) :

         

Here are the steps to use the panto mode correctly :

1) first, use the RMB on main panel tools and set the vector X and Y (set values or click on the 
'Set' button and draw the vector on your project).

2) choose a drawing tool like Airbrush and set drawing mode Panto in the popup menu under the 
drawing tools icons.

3) on your project you have two cursors. One simple for the source and another with preview for  
the destination. Pixels under the first one are copied under the second one with the settings of the 
current tools.

By changing the  Source option in the  Shape settings  panel, the pixels used, under the source 
cursor, will be the ones which are in the selected Source. 
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The image to clone can be:
* The current one.
* The previous image of the current layer.
* The displayed image of the project (like in 
the previous example).
* The selected paper (opposite).
* The image provided by the spare.

An example with the source set to paper

The Healing drawing mode 

The Healing drawing mode is an image-editing tool. It will certainly interest some users who want 
to improve their photography.
I works like an enhanced pantograph : it allows to reproduce the texture and the global illumination 
of a reference area, and preserve the color data.

 

The reference area can be set in the  shape setting panel 
(we already talked about it in lesson 2).  It is accessible in 
the  Windows > Parameters menu or with a right click on 
one of the seven drawing shapes.

In the examples below, two wounds of a photographed hand have been corrected by using the 
Healing mode with the airbrush tool. The pantograph mode on the right doesn't give good results, 
with similar settings.

 > 

    
Source picture with                                Corrected picture                                   Corrected picture
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the reference area (black cross)               with the Healing mode                           with the Pantograph mode

    
With a bit of practice, it could be easy for you to remove the dimple of your photographs.

  >  
  The face with dimples                                                   The same face with the dimples removed

Please note that the reference area can be located on a different picture than the current one. The 
reference area can be the background,  the displayed picture,  the current  image, the previous 
image, a paper or an image copied into the spare.

It is therefore possible to fake your photographs : here below, some scars have been added to the 
skin by using this fissured wall picture as reference layer.

   
 The same face with scars added                              The reference picture for the Healing tool

Clipboard and spare

The clipboard

The clipboard menu is located in the Edit main menu and comprises four useful options which, in a 
way, serve as an interface between TVPaint Animation and your other software packages.
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Clipboard and spare

*  The  Copy  brush  to  clipboard option  makes  the  current  brush  available  for  other  software 
packages installed on your computer.
* The Copy image to clipboard option makes the current image displayed in your project (including 
the background) available for other software packages installed on your computer.

Word processors, spreadsheets and digital creation software packages generally 
use a function referred to as  Paste buffer content or  Paste  which you simply 
have to call up in order to use your brush or image.

When you use the [print screen] key on your keyboard or when you use the Copy option (to be 
understood «copy to buffer») in the program, it is possible to recover the image stored in TVPaint 
Animation :

* The Get brush from clipboard option makes the current image stored in the buffer memory of your 
computer available as current brush.

* The New layer from clipboard option creates a new image layer from the clipboard.

For the latter option, ensure the size of your current project is adapted to that of 
the image stored in the buffer memory, otherwise the image may be cropped.

The Spare image 

It is possible to virtually store the current image in order to use it at a later time (mixing options) or 
to use specific drawing modes (Merge or Impressionist modes).
This image is referred to as spare image. 

Above you will find the options available in the Edit > Spare main menu.

                  Spare

           Current image
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The  following  examples  will 
provide  a  better  understanding 
of this notion.

Save the TVPaint  logo opposite as a spare image (main menu 
Edit > Spare > Copy to spare or shortcut [Shift+J] ) 

Delete it  from the current layer (standard delete tool:  ), then 
draw an ellipse with an opacity of 75% in its place.

* The option Swap spare (shortcut [J]) returns the TVPaint logo to 
the screen and replaces the spare image with the ellipse.
Using this function again will redefine the TVPaint logo as spare 
and will display the ellipse in the center of the window.

*  Depending on your  selections  in  the popup menu,  the Spare 
mixer option offers the following results:



Clipboard and spare

                  

* Finally, the option Delete spare is used to delete the spare image.

If you are working with several projects at the same time, note that each project 
has its own spare image.

When you save a project, the spare page is also saved with this project.

The Merge drawing mode 

The Impressionist drawing mode 

This drawing mode will be discussed in the Special brushes section of this lesson. It also requires 
the use of a spare image.

To perfectly master the drawing tools.

Using Drying, Grain and Light

In lesson 2, we have seen different drawing tools and some brushes from the tool panel. This 
lesson will teach you how to increase our knowledge of the different brushes and their options.

Drying reinforces the painting illusion :

     
without Drying                 with Drying
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The  Merge drawing  mode  is  only  available  once  a  spare 
image has been defined.
It may only be used with the airbrush, penbrush, mechanical 
pencil, pencil and wetbrush tools.

It  is  used  to  draw  the  portion  of  the  spare  image 
corresponding  to  the  area  traveled  by  your  stylus  on  the 
screen.
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Grain (available with Oil brush and Pencil brush) reinforces the tool's texture

               
            silk                               soft                           medium                          hard

Light (Oil brush only) gives volume to your painting

Three different Light configuration

The Warp brush

The Warp brush may be used to give the impression that a drop of water has fallen on the image. 
Combined with certain types of paper, it gives the impression that you are looking at the image 
through a window. There are two types of warps: warp out and warp in (see below).

                    
Warp in at top                                   Original image                               Use of this tool on an image
Warp out at bottom

The Special brush

The special brush works differently according to the drawing mode selected.
It shifts the image pixels:
* uniformly in Shift mode, 
* degressively in Smear mode,
* by adding color in Mix mode ,
* by taking into account the spare image pixels in Impressionist mode.

Below you will see the results of the first three modes from top to bottom (each line was drawn 
from left to right).
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As  indicated  above,  the Impressionist  mode requires  a  spare image  in  order  to  work.  When 
drawing a line in this drawing mode, the current image is deleted in order to make place for a spare 
image and the latter is smeared in the direction of the line drawn. 

This  creates quite an eye-catching effect  when working with a small  tool  and with « dotted » 
Profiles and a Ratio close to 0% (see Special brush panel below).

When required, the current image used as spare image may also provide a very original artistic 
effect.

       

Opposite an illustration in impressionist 
mode with  parameters  panel  together 
with the current image = Spare image.

(The  use  of  the  spare  images  is 
explained further)

 

The Text tool

The Text tool is used (shortcut [T]), as its name implies, to generate text brushes.
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* Color smear mode (the A color is red)

* Mix mode (the A color is red)

* Shift mode 

* Smear mode 
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Here you will  find a general  introduction into how to add a text to  your 
images: 

* Enter the text of your choice in the text field at the top  of the panel.
- That button “▼” gives you an access to the last sentences and words that 
you wrote in the text field.
- The  “L” button open a window with a larger text field, in order to work 
with long sentences.

* Direction is used to choose the direction, between horizontal and vertical 
lecture. 

* Select Letter mode or Word mode depending upon whether you wish to 
display the entire content of the text field or simply one letter at a time.

Letter mode up / Word mode down

* Select your font on the pop-up menu or on the “...” icon, just next. This icon opens a text editor, in 
order  to  easily  choose a  font  and its  size  (the  panel  change a  little,  following your  operating 
system) :

   
All changes to the numeric fields or using the mini-sliders will be taken into account and displayed 
interactively on the screen for several seconds in order to allow you to view the result of changes 
and settings made. 
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* The Size variable defines the font size in pixels.
* The XScale variable manages the font width.
* The Space variable defines the space between characters (a negative value overlaps the 
characters).
* The Italic variable modifies the inclination applied to characters.
* The Rotate variable is used to increase or decrease the angle formed between the text and the 
horizontal axis. 
* The Track variable adapts the space between characters, but this time, in proportion to the size of 
each letter in the text field.
* The Opacity variable defines the text transparency.
* The Outline variable creates an outline of varying thickness around the letters, but renders the 
interior of the letters transparent.
* The Smooth variable applies a blur to the letters.
* The Border variable creates an outline of varying thickness around the letters.
* The Glow variable creates a luminous halo around the letters.
The border and glow may be of any color of your choice.
* If the Letter button is selected, an Anim. (Animation) popup menu is present: you may then 
choose to apply the letters in the text field once only, in a loop, randomly or in ping-pong.
* If the Word button is selected, a Step variable is present: this variable works in the same way as 
for standard drawing tools (see lesson 2).

Now you just have to apply your text on your layer, wherever you want, with a simple click on your 
drawing space.

The fonts used by TVPaint Animation are of the « .ttf » (True Type Font)  format.

* The Reset button resets all settings.
* The «▼» button provides access to the last phrases or words entered in the text field.
* The B button opens a larger text field in order to work with longer texts.
* The number in the bottom left hand corner of the panel represents the text width in number of 
pixels (a width which is dependent on your settings).
* The Create brush button allows you to transform your text into a custom brush and switch to the 
brush settings in the tool panel. 

In addition to the settings via the mini-sliders, do not forget to tick the boxes 
to take these variables into account.
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The Custom Brush tool options

In lesson 4, we have explained how to use the cut brush tools. In that lesson, we will see in detail  
how this tool works.

If you select one of the five icons in the main panel, the Cut Brush panel appears 
in place of the tool panel. 

  

You may:

* Create a brush by deleting at the same time the area in which it is 
located on the screen (Cut  option in the popup menu).

* Smooth the cut brush (see lesson 3: smooth the contours of a surface).

* Remove as many transparent pixels as possible around the brush 
(Optimize option).

* The Display option is used to cut your brush through the visible layers. This is referred to as deep 
cut. Below, the sun, cloud and sky are placed on three different layers. The current layer is the 
cloud layer:

                            
Area to be cut                                  Brush obtained                                           Brush obtained

                                                      without deep cut                                          with deep cut

* With the Keep option you may keep all the previous brush tool parameters (refer to the following 
section to study the various parameters available). So if this parameter is not set, the new brush 
tool parameters will be initialized with their default values.

* The  Brush Smooth option is only accessible if  the  Keep parameter is  not set.  It is coherent, 
because if the  Keep parameter is checked, the previous  Smooth option of the brush tool will be 
kept. This Brush Smooth option is a way to create a new brush tool with default parameters (the 
Keep parameter is not set),  with only setting the  Smooth parameter of this brush tool with the 
Brush Smooth option value of the Custom Brush tool.

Once a brush is cut, you will automatically switch to the tool “Stroke”. The Tool panel will use the 
option “Custom Brush” (see next). I

t is possible to use it as such. Numerous parameters are available.

* Modify the Wet Profile option. 
This option is only working with the Alpha Stamp and Alpha Max Stamp 
mode. Before the current custom brush is applied in the current image, 
the Wet Profile modifies the original custom brush, and it is the result 
which is applied to the image.

Here are some examples of different Wet profile using the same brush :
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Wet profile :                                                                                

   

Wet profile :                                                                       

Modify the shift and the Opacity options :

          

 shift = 100 / opacity = 100                  shift = 100 / opacity = 0                   shift = 100 / opacity = 15    

* Modify the brush mode :

_Color : corresponds to the original colors of the brush

_Alpha Stamp : only opacity is considered. The brush now 
use the A color

_Luma Stamp : colors of the brush will change from A colors 
to B color, following the luma.

_Luma Invert Stamp : works like Luma Stamp, but inverted 
(see opposite)

_Hue Stamp :  uses the A color but keeps the hue.
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The example above uses colors A (R = 5, G = 255, B = 8 ) and 
B (R = 255, G = 183, B = 11).

_Alpha Max Stamp : records the maximum opacity value of your brush pixels and 
uses it  as a limit not to be exceeded during the drawing. An example with that 
brush :

                            
        Alpha Max mode           Alpha mode 

_Smear stamp  smears your brush (whose the color is defined by A color) with the current image :
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_Smear source is a little more complex, because it needs a source, that you can define in the 
Shape settings panel. Smear source allows you to smear the source you defined with the A color. 
This option is really great for people who want to make “painted rotoscopy”.

In the following examples, we used the forest photography (used to explain the drawing modes) 
and different custom brushes from the Tool bin (explained later in that lesson) :

* Modify the global Size of the brush.

*  Use the  Shift option.  It  allows you to distort  the current  image in the 
direction of your stroke. It is often used with the opacity parameter set to 
0%. (see below)

 When using the Shift option, the Alpha Stamp and 
Alpha Max Stamp modes are not available.

* Modify the Jitter of the brush.

* Modify the Opacity of the brush.

* Modify the Angle of the brush.

* Modify the  Step between two applications of the brush on the screen. 
This option enables drawing in a discontinued manner.
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* The Smooth option is used for more precision during drawing.

_ None : No smoothing during the drawing.

_ Medium : a standard smoothing.

_ Best : a best smoothing but requires more computer resources.

* Use the feature Warp : this option allows you to warp your custom brush automatically following 
your zoom value on the working space.

Zoom value : 100%

Zoom value : 200%
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Zoom value : 200%

Do you see ? Whatever your zoom value, your brush will always warp itself and will always seems 
to keep the same size.

* Use the Projection feature, that allows you to turn a custom brush into a splatter brush.

Pay attention : the rendering of this feature depends a lot of the tilt sensitivity set in your graphic 
tablet's drivers.

* Use the Drying option (saw in that lesson).

* Change the Handle of the brush: in other words, change the position of the cursor in relation to 
the brush which is centered by default.

* The Anim option will be discussed later.

* Optimize the brush: i.e. re-align the brush to conserve less transparent areas around the brush 
(see next page).
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                          Normal brush                       Non-optimized brush                         Optimized brush

            

                        Centered handle                    Handle top right                            Handle custom-placed

* Use the Stamp in place option which allows to apply the current  Custom Brush on the current 
image at the same coordinates at which it was Cut in its original image.

* Reset the brush settings.

Traditional drawing modes are applied to the brushes and sometimes provide interesting results:

                                      
Original brush  Image on which the                    Application in                       Application in
(the white pixels                brush will be applied                   Multiply mode                     Screen  mode

are opaque)

   

Let's  talk  about  the  Edit  button:  it  is  used  to display  the panel  shown 
opposite. The various buttons from left to right and top to bottom have the 
following functions:

* double the size of the brush.
* double its width or height.
* turn the brush +90°.
* flip brush on X axis.
* optimize the brush.
* cut brush size in half.
* cut brush width, height in half.
* turn the brush -90°.
* flip brush on Y axis.
* replace the transparent areas with B color.
* lock the width/height aspect ratio.
* modify the size of the brush numerically or in the project window.
* rotate the brush to an angle of your choice.
* add a border to the brush (you may choose the color and thickness of 
the border).
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* anti-aliase the brush when modifying size and angle.
* use the opacity map (see lesson 3).
* reset all settings and recover the original brush.
* validate the modifications and use the new brush.

It is possible to obtain all the configurations shown below and many more !

The notion of Animated Brushes

Using the Display option which was displayed during the brush cut, we saw that it is possible to cut 
a brush in space, several layers deep … It is also possible to cut a brush in time: this is referred to 
as animated brush.
We will study this notion in detail using examples.

Create an animated brush

* Create an Animation layer of 10 images, then create a bird with a different wing position in every 
image of the layer (see timeline below).

You  can  use  the  light  table 
(lesson 6) to help  you in  the 
making of the animated brush.

* Select all the images of your layer.
* Carry out a rectangular brush cut in a size similar to that of the image.
* TVPaint Animation will ask you if you wish to cut an animated brush via a small window.
* Answer yes.

You have just created your first animated brush ! 

We will soon be able to use it in the current project or in another project (in the example, we are 
going to use the same project, used in lesson 4) :

Check that you are working in color mode then click several times anywhere in the blue sky. 
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This is the result :

The birds you have drawn before have become your brush «each in 
turn» as you place them on the screen!

A few words on parameter setting for animated brushes:

* At the bottom of the Tool : Brush panel you will find the number of 
the image currently used.
* The Anim  popup menu of the Tool : Brush panel controls how the 
images appear.

The images in your animated brush may appear in various ways :

Other modes also allows you to modify the animation with a connection with 
your stylus, following the  pressure,  the  speed, the  direction, the  tilt,  the  twist,  
the  azimuth and  the  altitude.  You  can  also  invert those  connections.  More 
informations about connection further. 

All other options and parameter settings for the brushes 
studied  previously  (modification  of  size,  opacity, 
direction) also apply to animated brushes …

Reproduce an animation from an animated brush

Now, imagine you want to re-use your animated brush as an animation, frame per frame.

* First create a new project in the same dimension than your animated brush
* In an layer, create as many instances as images composing your animated brush (10, in the 
present case).
* In the Tool panel, click on Reset to reset your brush's parameters. Check also if the animation is 
in Loop mode.
* Click in the center of your first instance, in order to apply the first image from your animated brush 
(do not draw ! Just click once)
* Now select the next instances (not the first one)
* And press [Enter]

All images from your animated brush are applied, frame per frame, on each instance.

Floodfill using a brush

The Filling shape panel appears when you decide to draw a filled surface or floodfill a surface on 
the screen. This panel enables the use of the brush as a fill pattern. The Brush Wrapping button 
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enables this function. There are several methods available. Following the horizontal and/or vertical 
axis, you may :

* apply the brush while adapting its size (width and/or height) to the surface to be filled, without 
distorting the brush (if necessary, the whole brush will not be visible) (Stretch option).
* apply the brush at regular intervals without distorting it (Tile option).
* distort the brush so that it takes the shape of the surface to be filled (Wrap option).

       
Standard brush        Stretch                         Tile                   Wrap

The connections

   

Throughout this lesson, we have modified the size, power, opacity, etc. of our 
tools  and  you  have  certainly  noticed  the  letters  located  in  a  box  left  of  the 
corresponding numeric value.

These are the  Connection parameters.  The corresponding contextual menu is 
accessible by clicking on the box.

Most graphic tablets available on the market are sensitive to pressure, stylus 
travel speed and inclination, etc …

TVP Animation  takes  all  these  advantages  into  account  and  it  is  therefore 
possible to imitate the specific aspects of drawing by hand.

Here are some examples:
* If you connect the Size  of the pen tool with the stylus Travel Speed, the thickness of the line 
drawn  will  be  thicker  the  faster  you  move  your  stylus  (to  do  this,  select  Speed  in  the  Size 
connection menu).
* If you connect the stylus Pressure to the airbrush tool  Power, the more you push down on the 
tablet with the stylus, the brighter the color will be on the screen.
* If you connect the Opacity of the wetbrush tool to the Altitude of the stylus, inclining the stylus will 
render the aquarelle almost transparent.
A wide variety of setting combinations are available. Below we will describe each of them. It is then 
up to you to make the connections according to your needs and creative spirit, don't hesitate to 
experiment!

The first set of connections applies to pointing peripherals (mouse, trackball, stylus) :
* Invert: invert the effect of the connection chosen.
* Profile Editor: it will be explained in the next chapter.
* None: no connections.
* Speed: the parameter connected to the Speed will change at a speed proportional to the stylus 
travel speed.
* Direction: the parameter connected to the Direction will change according to the direction of the 
stylus.
*  Orientation: the  parameter  connected  to  the  Orientation will  change  according  to  the stylus 
orientation. 
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* Fade: the parameter connected to Fade will decrease its values as the line drawn progresses.
* Random: the parameter connected to Random will vary randomly.

The second set of connections applies only to stylus and graphic tablets:
*  Pressure: the  parameter  connected  to Pressure of  the  parameter  connected  will  vary 
proportionally to the pressure applied to the stylus on the tablet.
* Altitude: the parameter connected to Altitude will vary proportionally to the angle formed by the 
stylus inclination on the tablet.
*  Azimuth:  the  parameter  connected  to  Azimuth will  vary  proportionally  to  the  angle  formed 
between the stylus projection on the tablet and the vertical plane.
* Twist: the parameter connected to Twist will vary when you roll the stylus between your fingers. 
(you need a 6D Art pen from Wacom to use this connection)
* Finger Wheel: the parameter connected to  Finger Wheel will  vary according to these options 
when using the Wacom airbrush finger wheels.

Just above, you will find a summary diagram of the connections previously indicated. Note that 
some tablets do not offer all these options. For optimum results, TVPaint recommends the use of 
Wacom® tablets !

The  speed,  fade,  orientation  and  direction  connections  are 
adjustable.

Orientation angle, direction angle, speed curve and fade speed 
may  be  modified  in  the  Connection  Settings  window  (select 

Option in the connections contextual menu shown on the previous page).

Below you will find some examples to illustrate the effects:

Size connected to Fade for various fade values.

Size connected to Direction (left drawing).
Size connected to Orientation (right drawing).
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Size connected to Speed using various curves.
All three lines were obtained by increasing the stylus travel speed (i.e. 
with progressive acceleration).

The Text tool with Rotation connected to the stylus Direction.

The connections Profiles

  

A Profile Editor option is also available in the connection menu. Once selected, it 
opens a new window with a profile curve.
This profile curve allows you to adjust the interaction between the parameters (size, 
power,  opacity,  ...)  and  the  connection  you  have  just  chosen  (fade,  pressure, 
random, ...)
A lot  of  profile  curves  are  then  available.  For  instance,  the  airbrush  tool  has  4 
parameters which can use up to 10 connections. There are then 4 x 10 = 40 potential 
profile curves.
The applications of the profile curves are numerous, and we will only study here the 
most important examples.

• Size and Pressure

If you connect the stylus Pressure to the Power of the Pencil tool, the more you push down on the 
tablet with the stylus, the thicker your line will be. In the example below on the left, the size of your 
tool will be bounded between 0 pixels and  30 pixels. (In this example, we want to focus on the size 
parameter behavior, so we will choose connection = none for the power parameter.)

Now if we change the profile curve as shown below on the right, the minimal size value for your  
tool will be 15 pixels.

• Size and Fade
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Let's admit that we draw a straight line on the current picture, from right to left  with the oilbrush 
tool. If the profile curve stays unchanged, the line thickness is smaller and smaller.
The horizontal axis of the Connection profile panel shows the chosen connection from the maximal 
value to the minimal value.
The vertical axis of the Connection profile panel shows the values of the Size parameter.
As a consequence, if we change the profile curve as shown below, you will obtain the following 
results :

• Angle and Random

Let's admit that you are using an animbrush with four images in order to add some colored flags on 
a picture. (see below, the handle of the animbrush is on the red cross or red line and the anim 
behavior is set to Random)

  1  2  3  4         
                                                                                                                          handle
Here is the result if you draw a straight line with the settings opposite :
(Don't hesitate to modify the Step parameter if you need to change the distance between the flags)

   

If we choose an angle of 90°, the result is monotonous ...

   

If we connect the animbrush Angle parameter to Random, the flags will 
be arranged in every directions. It is completely disordered ...
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Now let's modify the profile curve as shown hereafter :

The angle of the animbrush will be randomly chosen 
between  80°  and  100°  compared  to  the  horizontal 
axis. The general aspect will be less monotonous.

(each gradation represents 90°)

The minimal and maximal angular values on the vertical axis 
of  the  profile  curve  are  the  same  as  the  one  you  have 
chosen in the tool panel of the current custom brush.

For instance, if you select an angle of -50°, the gradations will then be :

  >>>  

• Size and Random

We will now continue to work on the same example :

    

The purpose is now to make all the flags have a different size.
Of course, we can connect the Size parameter of the brush to Random.

   

Nevertheless a problem persist : we can have too small flags.

To  remedy  this,  we  only  have  to  select  a  minimal  size  for  our 
animbrush in the profile connection window.

Opposite and below, some randomly selected values between 75% 
and 100% of the original size will be used.
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The drawing tool panel : Bin tab

The  numbers  next  to  the  brushes  indicate  the  number  of  animated  brush 
images or size of the brush.

Right click on the brush in the tab to:
* Add the current brush to the bin
* Get the brush you just clicked on as current brush
* Swap the current brush with the one you just clicked on
* Export the brush
* Delete the brush from the bin

Your settings are saved if your normally quit the software. If you savagely quit the 
TVPaint Animation, your brushes will be lost. That's why we advise your to use 

custom panels (see further in this lesson).

The Tool Bin panel 
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Two tabs are available for each drawing tool: 
The Options tab you have already seen and the Bin tab.

Regardless of the tool you are using, you may save the settings applied 
(Size, Power, Opacity, Angle, Profile, Connections, Gradient, Mode, etc.) in 
order to use them again later.

Right click on the empty area of the Bin tab to:
* either Add the current brush to save it.
* or Get a brush of your choice to be saved.
In both cases, a miniature of your brush appears under the tab.

The Tool Bin  panel is one of the custom panel present when you 
start the program for the first time. You will  find that panel in the 
right panel bin.  Although relatively basic at first sight, this panel is 
also very useful to store your brushes thanks to the last two buttons 
it contains.

The   is used to grab the current tool and place it in the panel 
under the two buttons. An icon is automatically created according to 
the tool to be used. 

The second button  fulfils the same function as the first except 
that it grabs the tool together with the A and B colors active when 
the tool was grabbed.

Once you grab a tool with or without its colors, the current paper, 
the parameters and the connection profiles are taken into account. 
It is then possible to create and store more realistic drawing tools.
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Now all you have to do is click on the icon of the tool grabbed in order to use it again. This proves 
extremely practical when you have specific drawing habits !

Even if this panel is included with TVPaint Animation, the Tool bin is a custom panel. It means it a 
panel that you can create by yourself ! You are also free to create new panels for each type of tool 
and to save your favorite brushes which are easily identifiable !

This quick initiation to custom panels will allow us to continue this lesson on the creation and 
management of these panels.

Custom panels - 1  st   part   

Introduction

It is possible to create your own custom panels and icons in TVPaint 
Animation to adapt the interface to your needs. To access the custom 
panels of TVPaint Animation, use this menu (on the left). 

The  custom  panels  are  similar  to  the  Tool  bin  that  we  just  met. 
Numerous  icons are  represented and each of  them has a  specific 
function : brush, color or action.

   

Create a custom panel

By default, when you create a custom panel, it will be empty, but we will learn how to fill it further.

A newly created panel is as shown in the image opposite 

A RMB click in an empty area of a customized panel will open the 
menu shown opposite.

        

The following options are available : 

* Grab Current tool  allows you to save your current tool with all its 
settings and connections: airbrush, penbrush, custombrush, etc ... 
This action creates a button in the current panel. The icon of this 
button is the one of the tool grabbed and it provides fast access to 
the previously grabbed tool. Note that the option to grab the current 

tool is also accessible by simply pressing the  button of the Tool 
Bin panel which is present by default. 

* Grab the current tool with colors has the same effect as the previous operation except that the 
tool  is  saved with the A and B colors defined at  the moment  of  grabbing.  This  option is  also 

accessible via the  button of the Tool Bin panel.
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* Grab current colors and create a library of colors.

* Add Action or series of actions (this part will be more detailed lesson 19).

* Add new line of icons to be filled.

*  Add vertical and/or horizontal separators  between your icons (click with the right button on the 
latter to remove them ...). Note that the horizontal separators can be collapsed to save space. They 
can be named also, by a right click on the triangle.

Be careful : when you save a custom panel, the papers linked to your tools are not 
saved. In other words, if you decide to save a custom panel, only the brushes and 
their settings will be saved on your hard drive.

This doesn't matter if you used the papers that are given by default with the software.
However, if you have created and used your own papers, you will have to save and load them 
separately. Your custom papers are located in the Papers sub-directory of your configuration. 
Here is the path for Windows, Mac and Linux users :

Windows : C:\Documents and Settings\User\Application Data\TVPaint Animation 10 

                   \config_name

Mac........ : User/Home/Library/TVPaint animation 10 (pro)/config_name

Linux..... : User/Home/.tvp/config_name

A lot of thematic custom panels (manga, pixel art, chinese brush, ...) are available 
in the Contents-Sharing section of our online forum. http://www.tvpaint.com/forum/

How to manage the panels.

Now we will look at the options proposed in the panels themselves. In the sub-menu shown below, 
which is accessible with a right click in an empty area in your custom panel, you may :
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* Rename the current custom panel.
* Show icon only  (without text).
* Delete the current panel.
* Duplicate the entire panel.
* Export as a TVPX file.
* Import  /  Export  the current panel in  .bin (for 
TVPaint Animation older than 9 version).
* Send to somebody connected on your network 
(see lesson 5)
*  Embedded in project your custom panel, so it 
will open automatically with your project.

A custom panel can be now tagged as Editable or not.
In a non-editable panel, all options which modify the 
panel,  are not  available anymore :  Rename, Select 
action buttons with the cursor, Cut, Copy, Paste, Add 
Action, ...
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In the second sub-menu you may :

* Create a New custom panel (you may create an unlimited number), 
embedded to your project or not.
* Load a new tool bar from its .bin file.
* View the name of the custom panels visible on the screen.

   

You may also define a keyboard shortcut for each action created using the keyboard 
shortcuts panel !

How to use the TVPX format

Now it is possible to export a Custom Panel as a TVPX file. This format makes easier the way to 
share  all  your  creation  inside a  Custom Panel.  All  the brushes,  plugins,  scripts,  ...  inside the 
Custom Panel will be compacted into one simple TVPX file.

       

Once your Custom Panel is finished, right-click on it 
and choose the option This Panel > Export As TVPX...

          

A panel will  appear to set some options of the 
exported file.

* The first field Unique Name is used during the export. It has an internal use in the TVPX file.
* The Name field will be displayed during the installation of the TVPX file.
* The Splash Screen image will be displayed during the installation of the TVPX file. The options 
available are:
        _ None : No image will be displayed.
        _ Current Image : It is the current image of the project which will be used.
        _ Custom Brush : The current image of the custom brush
        _ Grab Custom Panel : Use the preview of the custom panel to get the image.
* The license field asks a text file to display the license during the installation.
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* The author's name of the TVPX file, and a copyright.
* And finally, the location to save the TVPX file.

All  these  options  will  be  used  during  the  installation  of  the  TVPX  file.  So  how  to  install  a 
TVPX file ? ... just drag'n drop the file over the TVPaint Animation window. 

     

A window will then appears to present the TVPX file 
(with the license, author name, copyright, ...), click 
on the Next button to access the second window. 

     

In  this  second  window,  it  is  possible  to  see  which  custom 
panels are available for installation, click on OK, the custom 
panel will install.
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Lesson 8

Sound and XSheet

In this lesson you will :

● Manage the Audio Multi Tracks.     

● Learn to use the XSheet layers.     

● Make a Lip-Sync.     



Audio Multi Tracks 

Audio Multi Tracks 

All the audio parameters are available in the second part of the Time Line window, between the 
Notes and the Layers.

The audio section can be separated into two parts. On the left side, there are all the parameters of 
the tracks (name, volume, offset, ...) and on the right side, there is a preview of the track during the 
animation.
Just a little word about the Master Track, it is a sort of special track. It always exists even if no track 
is loaded. This functionality will be detailed below. Otherwise, all the imported tracks add a new 
entry under the Master Track.

The sound track here, in the Clip : timeline tab is a “local” sound. A “global” sound, 
whose the use is very similar to the local sound, also exists. It will be discussed in 
lesson 9.

How to add audio tracks to a project

There are two ways to add new audio tracks to a project.
* In the main menu, the Project > Load Sound ... option opens a panel to choose the audio file to 
import.
* In the left side of the audio section, a click on the symbol below, to the right of the Master Track 
name, opens a popup menu and allows you to Load a Sound Track... .

If  you have already loaded tracks,  a history of  the 
previously  loaded  files  will  appears  in  this  popup 
menu under the Load a Sound Track ... option.
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Now it is possible to load several tracks on a project, let's talk about the Master Track functionality. 
The aim of the  Master Track is to merge all the audio tracks, and see preview of what the final 
sound will look like. We can say that the Master Track is to the project preview, what the Tracks are 
to the layers.

The audio tracks parameters

The main audio parameters are available on the left side of the audio section. Here are the various 
functions proposed :

* The triangle at the left of the track name displays the optimized display or the reduced display.

With the optimized display, the preview of the track is more accurate in the right side, and new 
options appear in the left side.

* This icon   allows you to put sound tracks in a group. Its use is similar to the color groups,  
discussed in lesson 3.

* This icon  shows the sound is audible. If you click on, you will mute the sound track and this 
icon   will appear. 

Be careful,  if  the  Master Track is muted,  no sound will  be 
played, even if your track is active.

Note that the  button in the current project window is used 
to play a sound track when the project is viewed.
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* The triangle at the right side of the track name opens a popup menu. The options available are 
different if the menu is the one of the Master Track or of another Track. The menu with the Master 
Track has been described above. The options available with the standard tracks are :

_ Lock: allows to lock the current track. All the options which would modify the track, are disabled.

_ Duplicate: clones the current track and adds it to the end of the tracks list.

_ Delete: removes the current track from the tracks list.

_ Move down and Move up : respectively allows to move down or move up the sound track (those 
options are in grey in you have only one sound track).

_ Offset ... : opens a dialog box to choose when the track starts inside the animation.

The additional following options appear when the optimized display is activated:

* You can lock a track by clicking on the black point • or via the popup menu. When the track is 
locked, this icon appears 
The Master Track has no Lock button, it is no possible to directly modify it.
* The nearby check box is to mute the track. (It is the same check box of the reduced display)
* And finally, the slider is the global volume of the track.

The audio tracks preview

Let's  take  a  look  at  the  right  side  of  the  audio  section.  All  the  audio  tracks  are  graphically 
represented in this side.
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As said previously, the Master Track is the "sum" of all the tracks of the project. It's clearly visible 
here.

The offset option is already detailed in this subsection. Note that the other 
way to modify this option is only to click on and drag an audio track (by 
clicking on its preview).

Some blue lines can also be seen on each audio track. The aim of these lines is to allow a basic  
Fade option.

* When the blue line is at the bottom of the audio track, the audio sound is on the minimum (i.e. no 
sound played).
* When the blue line is at the top of the audio track, the audio sound is on its maximum. (Set with 
the slider option of the optimized display)
* During the time that the blue line is increasing or decreasing, the program fades the audio sound 
in function of the current time and between the minimum and the maximum values of the audio 
sound.

It is also possible to add Annotations on each audio track and at any position. By double clicking 
on a track, a popup appears (with the current time in its title) and asks the text which will  be 
displayed under the cursor position.

With a right click on an audio track, a popup menu appears and asks to split the current track. This 
option doesn't really split the track, it duplicates the current track and adjust the  Fade option on 
both to simulate the splitting of the current track.
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Before Splitting

After Splitting

The Undo ([u]) and Redo ([Shift]+[u]) actions are 
obviously available for the audio tracks.

The Preferences panel options

In the Preferences panel (Edit > Preferences), under the Sound tab, more functions are available 
concerning the audio.

* The first section of this tab refers to the Scrub options.
_ The first Scrub Duration option sets the duration of the scrubbing.
_ The second popup  Scrub Mode allows to choose when the tracks should be played,  Never, 
Always, or only when the user Scrubs.

* The popup Sampling Rate in the second section, lets the user select the sample rate wherein 
every audio tracks will be re-sampled during their import in TVPaint Animation. To have the best 
results, all the imported audio tracks should be at the same sample rate than the one given in the 
Sound tab of the Preference panel. If it is not the case, it is of course possible to import the audio 
track, but there will be maybe a loss of quality of this audio track.

*  The last option,  Play project  sound in clip allows to play the global  sound when working in 

Timeline : clip mode (more information about the global sound in lesson 9). 
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The XSheet Layers and XSheet Panel 

Introduction and principle

Maybe are you not familiar with XSheet layers and Lip-Sync notions. Here are some informations 
regarding their origin :

The word XSheet comes from eXposure-Sheet or dope-Sheet.
It comes from the days of traditional animation when the XSheet was a paper list that numbered all 
frames of a scene and in which the animator could write down his drawing numbers with the right 
timing. (see below)
It helped the animators to plan their animations and also worked as a guide for the cameraman to 
know how to shoot the scene. 
For instance,  synchronising the lips of a character with a recorded soundtrack (in other words 
doing a Lip-Sync) was possible with the XSheet.

The XSheet panel, commonly called XSheet tab in TVPaint Animation Pro (see next pages) is the 
digital transposition of the classical paper XSheet. 
The reason XSheet panels were included in TVPaint Animation Pro is to make easier to time and 
synchronise the animations, thanks to the XSheet layers.
It is also a very useful tool for people who uses to scan their drawings. The main advantage of the 
XSheet layer is that a frame that is used multiple times in a scene need only to be adjusted or 
colored once and all instances of this image in the XSheet layer will change accordingly.
It saves a lot of time since the process of copying and editing frames is much simpler and easier to 
control through the XSheet panel. (This is much simpler than the old way in which you'd have to 
manually copy and paste frames in the layers of the timeline.)

For example, let's assume that the coloring and the shadows of a character are on separate layers: 
If you need to re-arrange your animation in time, it is always very tedious to edit a layer in the 
same way twice or more ...  Fortunately, with the XSheet panel this can be done really easily and 
quickly.
All those notions may seem abstract at first, but you can relax. We will quickly study some concrete 
situations and examples.
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The projects used in this chapter
 
To  make  the  XSheet  layers  easier  to  understand,  you  will  have  to  load  the  project  file 
(Running Kid.tvp) from your TVPaint Animation Pro DVD-Rom.
Those who have downloaded the demo version of the software will find this file in the download > 
content sharing section of the TVPaint website (www.TVPaint.com/)
Once the project is loaded, you should obtain the following animation and timeline.

      

Five layers are visible: an image layer called « background » and four animation layers called 
« shadow », « colors », « Running Kid » and « Toonshading ». Each layer has its own assigned 
color.
Please note that the project does not have any XSheet layer at this time. 

First approach of the XSheet panel

To swap between the Timeline and the XSheet panels, you only have to click on the corresponding 
tab (see below)

Let’s study first the left part of the XSheet panel. (the right part will  be the subject of a further 
chapter).
The left part of the  XSheet panel  is in a way the mirror of the  Timeline. (see next page for the 
screenshots) :
* Each column of the XSheet Panel corresponds to a layer of the Timeline, with its color. The title 
of a column is the name of the corresponding layer.
* Each line of the XSheet panel is numbered. This numbering is the same as the one you can find 
on the top of the corresponding timeline (see below)  
* The image layers contain an unique image repeated through the time, so they are not subdivided 
in the XSheet panel.
* As the animation layers contain different images, they are subdivided.
* The bookmark located here and there on your timeline are also visible and modifiable in the 
XSheet panel.

You can also use the sliders or the arrow keys of your keyboard to 
navigate through the XSheet panel.
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* The thumb button offers several possibilities to change the display mode of all the layers. With a 
left click on this button, it swap between the classical XSheet display and the thumbnails display 
(see further in the section XSheet tab (left part)). But if you right click on it, a popup menu appears, 
and allows to choose the size of these thumbnails.

      

The size of the thumbnails can be Small, Medium and Big.

* The second column, between the column of the image number and the first layer column, can 
contains two informations. It contains both the Master Sound Track, and the Time Line Notes. 

    

The Master Sound Track and the Time Line 
Notes are not editable in this column.

There is still the possibility to add some annotations in this column by a double click, like it is done 
in the Master Sound Track in the Time Line tab.
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A few simple options of the XSheet panel

 

_  _  _  _  _  _  _  _  _  _  _  _  _

                       

   Timeline tab 

  XSheet tab

At the ends of the column, it is still possible to set the pre and post behavior of your layers (see  
next page).
In the example below, a few pictures from the third layer are selected. They are enlightened in 
yellow in the Timeline and also in the XSheet tab.
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A lot of  options regarding the layers are 
both available in the Timeline tab and the 
XSheet tab.
A right click with your mouse button on an 
image  in  the  XSheet  panel  opens  a 
contextual  menu comparable  to  the  one 
encountered via the timeline.

You  will  find  in  this  menu some options 
already encountered in lessons 3  and 4:
* Insert, Duplicate, Delete, Rename, Copy, 
Paste…one or more images.
* Set Post or Pre behavior.
* Set Opacity,
etc ...

* The (green or red) colored circle, once you click on it, 
allows to display or hide the corresponding layer.
* The small lock button allows to manage the locking of 
a layer. 
* The grey dot under the bulb manages the activation 
of the light table. 
* The black triangles allows to reduce or increase the 
size of the columns in the Xheet panel.
* The current layer is lighter than the other layers.

- The « background » layer is hidden
- The « Toonshading » layer is locked
- The Light Table of the « Colors » layer is activated
- The « Shadow » layer is reduced
- The « Running-Kid » layer is the current layer

In the XSheet tab opposite :
* The letter « A » indicates that the column represents 
an animation layer.
* The letter « I » indicates that the column represents 
an image layer.
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 < > 
Timeline tab                                                                         XSheet tab

After selecting several layers, the option Align left and Align right from the Layer menu 
allows to align your layers on either side of the current image in each tab (Timeline or 
XSheet)

How to create a XSheet layer

Let's now open a new project and come back to the Timeline tab :
You already know how to create an Image or an Animation layer. Creating an XSheet layer can be 
done using the same way, using the New popup menu of your Timeline or using the Layer main 
menu.

 > 

At this state, the Rename, Duplicate, Delete, Copy, Hide and other classic options of the software 
are still available. But you certainly noticed that you can't shrink or stretch this new layer. There are 
no thumbnail icons too.

      

The  +  and  –  buttons of the XSheet tab can also be used to 
create or delete a XSheet layer.

The letter « X » indicates that the column represents an XSheet 
layer.

Managing the content of an image of the XSheet layer or managing the position in time of its 
images have to be done in the XSheet panel.

Once your XSheet layer is created, you have to specify in the XSheet tab one or more sources. 
Otherwise, it will not be possible to use it, because you can’t draw on a XSheet layer. The images 
of the chosen sources will constitute the elements of the XSheet layer.
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How to create and manage the sources

The source management can be done in the right part of the XSheet panel.
In order to add a source column, you have to use the “+ src” button encircled below.
The “- src” button allows to remove a source column from the right part of the XSheet tab.

       

The choice of a source for your column can 
be  easily  done  thanks  to  the  popup  menu 
located at the bottom right of the XSheet tab.

Your source can be :

* an animation layer in the current project

* another open project

* a sequence

It’s  also  possible  to  change  the  names  of 
your  source  layers,  for  a  better  readability. 
You only have to use the popup menu name 
opposite.

   

If the Layer Type is selected, a menu Layer will allow you to choose which 
one you want as source. (see opposite)
Same behavior with the Project Type selected.
Image layers are not available as source.

The width of both sides of the XSheet tab can be adjusted by dragging the middle 
separator. The thumbnails options and the position of the separator are also saved 
with your project.

Do not confuse the source columns on the right part of  the XSheet tab and the 
layers columns on the left part of the XSheet tab. The source columns are used to 
manage the content of the XSheet layers and are not visible in the timeline whereas 

the layers columns are also visible in the timeline. (see below)

Some explanations  about  the  Sequence source  option.  As  seen  previously,  a  source  for  the 
XSheet Layers can be an open project or one of the layers of the current project. The Sequence 
source  allows  to  choose  an  external  file  (all  the  supported  formats  in  TVPaint 
Animation Professional Edition are available) and use it as a source.
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A concrete example

If you have followed this lesson from the beginning, you should have two projects on the TVPaint  
Animation Pro screen. The project Running-Kid.tvp and a new project called Untilted-01 containing 
an XSheet layer. 

Project called Untilted-01 we added the Running-Kid image sequence as source, as shown below. 
Now we only have to add some images from our source into the XSheet layer.

Here again, the thumb button allows to swap between the XSheet display and the 
thumbnails display.

If you selected a “clip” as source, its layers are considered as if they were merged.

How to manage the content of a XSheet layer

We are now going to modify the content of our XSheet layer.
* Before beginning, you must know that it is possible to stretch a XSheet layer by doing a drag'n  
drop at one of its extremities. So you can obtain several cells, as shown next page.
* After this operation, you have to enter in the cells the references from a source image.
To do so, you have to use the following syntax : Source Column : Source Line
(The cells containing the character « -  » doesn't have any reference.)
* The cells manually filled have their reference image written in black.

* By default, all the cells following a manually filled cell are written in pink color and have the same 
reference image. Those images are also called keyframes.
* Once finished, each cell from the XSheet layer correspond to an image chosen into the Source 
columns. (For a better readability, you can use the thumbnail view in order to replace each cells by 
its corresponding image)
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Opposite,  here  is  how  to  stretch  an  XSheet 
layer. 

Opposite :
* The first three cells of the exposition layer are 
empty.
*  The fourth cell of the XSheet layer is the 26 th 

image from the source column called Kid.
* The four last cells have the same reference as 
the fourth cell.

 With thumbnails        Without thumbnails

          XSheet Layer with its cells                    Source images and columns

If you selected an open project as source, the source project will be stretched to fit 
the XSheet layer.

In order to fill in the cells of an XSheet layer (in other words, to add images in a 
XSheet layer),  you can also drag’n drop thumbnails  and cells from the source 
columns into a XSheet layer.

It is also possible de manage Xsheet layers from the Clip : Timeline tab. Click on the handles and 
stretch your layer, in order to make it longer or shorter.

You can also manage sources easily in the  Clip : Timeline tab. Just double click on a tween in 
order to rename it.  Here, enter the source name (for example, Kid:16) in order to use the 16th 

image from the Kid source (of course, a source has to be loaded in the Clip : Xsheet).
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 > 

Of course, if you enter a name that does not refer to a source, you will obtain an empty image.

Select and move several images in a XSheet layer.

 

You can also select your images from the Clip : Timeline  tab. If you hold this selection and move it 
to an anim layer, the exposures cells will be turn into instances :
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If you want to select several images in a XSheet layer, hold the [shift] 
key  down  and  do  a  drag'n  drop  with  the  LMB  on  the  cells  or 
thumbnails of the XSheet layer.
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The icons of the XSheet tab

Each icon below has a specific action regarding the XSheet layer or the XSheet tab. We will now 
explain each of them separately in the next page.
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This button allows you to shuffle the selected images of a XSheet layer.

This button allows you to cut the selected images / cells from a XSheet layer.

This button allows you to copy the selected images / cells. It can be either source images 
or images / cells from a XSheet layer.

This button allows you to paste the cut or copied images / cells from a XSheet layer into 
existing images / cells. This action deletes the selected images and insert the new ones.

This button creates a new XSheet Layer.

This button deletes the current XSheet Layer.

This button toggle the thumbnails / cells view.
(A right click on it opens a popup menu with several options)

For a better readability, the icon opposite allows to display / hide the columns of the image 
and animation layers in the XSheet panel.
This option is only working with the XSheet tab and does not interact with the timeline or 
the project display.

This button allows you to add a source into the XSheet tab.

This button allows you to delete a source from the XSheet tab.

This button allows you to add one tween to each selected frames.

This button allows you to delete one tween from each selected frames.

This button allows you to add multiple tweens to each selected frames. A popup menu will  
appear to set the number of tweens to add.

This button allows you to delete multiple tweens from each selected frame. A popup menu 
will appear to set the number of tweens to delete.

This button allows you to invert the order of the selected frames.
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You can also use : 
the LMB and drag to « move » (cut and paste) a selected range of frame. 
Ctrl + LMB to « move » (copy and paste) a selected range of frame

Here is a small summary diagram :

The options that allows to cut, copy, or paste the cells can be applied from an 
XSheet  layer into itself  or  into another one. (however,  it  is  not  possible to cut 
source images)

Select a default source

      

When you click on the name of your XSheet layer, a popup 
menu  called  default  source  appears  at  the  bottom  of  the 
XSheet tab.
It is then possible to assign a source column by default to 
your XSheet layer : all  the references of the cells will  only 
need a number of picture in order to be taken into account.

This  is  very  convenient  to  create  new  XSheet  layers 
synchronised with the current one.

You  only  have  to  duplicate  the  current  XSheet  layer  and 
change the default source of the duplicated XSheet layers.

About the projects

When a project needs some images to be repeated several times,  it’s  advised to use XSheet 
layers. It allows to decrease the size of the project when you save it on your hard drive, because 
each repeated image is saved only one time.

When  you  save  a  project  in  TVP Animation Professional Edition,  the  related 
XSheet tab and layers are saved too. (Your project will still be available / usable 
with previous softwares from TVPaint. But, the XSheet and sound quotes layers 
will not be viewable nor usable.)
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The steps to create a lip-sync 

In  this  section,  we  will  learn  how  to  synchronize  the  facial 
movements of a character (especially his mouth) with a preloaded 
audio track.

The main idea is of course to give the impression that the words 
come from our animated character and not from a recording that 
has been added over an animated sequence.

     

The project Lipsync.tvp and the audio track voice.mp3 will be taken as a basis to study the lipsync 
steps. You can find them on the software CD ROM. Those who downloaded the evaluation version 
of TVPaint Animation Pro can find those files in the “content sharing” section of our online forum. 
(http://www.tvpaint.com/forum)

Here is the timeline of the project Lipsync.tvp

Layer  “eyes”

Layer  “pupils”

Layer  “brows”

Layer  “face hair”

Layer  “hair color”

Layer  “mouth 4”

Layer  “mouth 3”

Layer  “mouth 2”

Layer  “mouth 1”

Layer  “jaw”

Layer  “face-color”
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We have chosen the following colors to have a better readability through the timeline:
-the layers relative to the mouth movements are in red.
-the layers relative to the jaw and face are in blue.
-the layers relative to the eyes movements are in purple.

If you play now this project, the result will not be really interesting. But we will quickly remedy this 
situation.

Calibrate the options relative to the audio track

Now that  the  project  is  loaded  in  TVPaint  Animation Pro,  let’s  import  the  audio  track  named 
voice.mp3.

Once your audio track is loaded:
* Begin by setting the offset parameter with accuracy
* Lock your audio track in order to prevent unwanted changes
* Select “scrub” or “always” as parameter for the audio jog, with a duration of 2 or 3 seconds.  (see 
first chapter for more details)

The option called: ”Enter audio scrub duration” allows you to specify the duration 
of the sound that you will hear after each movement throughout the timeline.
(This option is functional only if the “jog audio” parameter is not in “none” mode.)

At this point in the process, your movements throughout the timeline should be followed by one or 
several sounds.

Positioning syllables and phonemes

It  is  now advised to display the XSheet panel in order to continue our work. (Although all  the 
coming steps can be done directly in the timeline.)

When  you  move  your  cursor  (ie:  change  the  current  image)  through  the  timeline,  try  to  find 
syllables and phonemes.

Then,  add  an  annotation  on  the  corresponding  place.  To  do  so,  use the option  Notes which 
appears in the audio track contextual menu or in the Images main menu.

8-20 Sound and XSheet



The steps to create a lip-sync 

You should obtain a XSheet panel like the one below :

If  the  text  that  you  want  to 
synchronize with your character  is 
long,  try  to  add bookmarks to the 

images from which a syllable or phoneme 
starts.  It will be easier to find again those 
images later.

You can already hide the animation 
layers.  Those  layers  will  not  be 
visible  when  the  project  will  be 

finished.

They are only here in order to be selected 
as source for the XSheet layers.

However,  you  can  set  hold  as  post-
behavior  for  the  Image layers.  (they  will 
stay  visible  until  the  end of  the lip  sync 
process)
You should obtain the image below :

   

Create some source columns

As explained on page 8, you have now to set your sources images and columns in the right part of 
the XSheet tab. Here below, the source columns are created from the existing animation layers of 
our project. (the column fcolor is linked to the layer face color)
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Create some XSheet layers

Now, let's create some XSheet layers.

For each sound of the audio track, the jaw and the face skin should move accordingly,  as our 
character is talking. (see below)

  >  >  >    

The  movement  of  the 
character's jaw

  >  >  >    

The  movement  of  the 
face's skin

Two synchronised XSheet  layers will  be needed here to do the job.  Only their  default  source 
column will be different. (fcolor and jaw)

Each sound of the audio track can be broken down into separated sequences :

  >  >  >   

Opposite, the « O » sound

  >  >  >   

Here the « A » sound

  >  >  >   

The « I » sound

  >  >  >   

The « E » sound

Each time that the « O » « A » « I » or « E » sound will be encountered on the timeline, you will 
then have to reproduce the corresponding configuration.
A XSheet layer derived from the two last described XSheet layers will be used here. However, it 
will not have a default source, because it will use the four source columns (mouth1 mouth2 mouth3 
mouth4)

Finally, you will have to make the character blink periodically in another XSheet Layer.

  >    >    >    >  

The movement of the brows will depend on the context of the scene. It can express astonishment, 
neutrality, fatigue, etc ... It will also need an XSheet layer.
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The steps to create a lip-sync 

Here is the result with the XSheet tab :

Let’s  assume that our character  comes from an animated TV series.  It  will  be 
possible to re-use the same images for the face, XSheet layers constructed with 
the method,…etc…

- - - - - - - - - - -

You can always transform an XSheet layer into an Animation layer with Instances 
by using the Transform into Animation Layer option (use the layer contextual menu 
in the Timeline).
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Lesson 9

Create and manage a storyboard

In this lesson, you will learn to :

● Create a storyboard and how to manage the different functions (draw, write a 
text, etc... )

● Turn  your  storyboard  into  an  animatic  and then how to  add sounds  and 

camera movements. 

● Export your storyboard / animatic in order to share your work. 



What is a storyboard ?

What is a storyboard ?

A storyboard is a vital narrative part in animation because it allows a transition between the script  
(from a text) to the animation. A storyboard indicates to animators what they have to do : rhythms, 
how to animate, etc...  A storyboard contains many details such as dialogs, special effects, camera 
moves.

A storyboard is made of a succesion of serapated pictures which represent shots. If storyboards for 
live-action movies can be very simple (one picture per shot), storyboards for animation have to be 
more precised :  most of time, a shot or a scene will be composed of many pictures to describe it 
properly.

You  would  understand,  a  storyboard  is  an  essential  step  in  animation.  That  is  why  TVPaint 
Animation includes a storyboard module and that is also why it is important to learn how to use it.

Create a storyboard

Define the project  

First of all, go to Files > New Project to create the project which will contain your storyboard. The 
panel just below will appear (you have already seen lesson 1). This time, we will care about the tab 
Project with Camera.

As you can see, there are three columns : 

•  Camera View (Final Output) represents the point of view of the camera that will be used at the 
final export
•  Drawing  Area  represents  the  size  of  the  working  space,  which  can  be  used  to  make  big 
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background (for example)
• Ratio represents the enlargement percentage between Camera View and Drawing Area
When an animation movie is made, camera moves are usually used (zoom, travellings, etc ... ). 
Those camera moves needs a larger working space to add them later.

For this example, we propose you to select the format DTV 720 x 200%.Then, click on New project 
to create your new project.

To know more about the meaning of the other terms, (Frame rate, Aspect Ratio ...) please read the 
first lesson.

First clip and first drawing.

The function storyboard of TVPaint Animation is visible in the tab Project, in the timeline. 
Click on the tab in order to have this : 

This  white rectangle is  called a clip.  A clip  is  composed of  layers and pictures and is  always 
included in a scene (in this case, we have a scene with only one clip : the both elements cannot be 
differentiated).

If you double click on your clip, you will access to  Clip mode : layer, where you will be able to 
manage layers and pictures.

Come back to tab Project and select a drawing tool. Draw in the working space : you will see then 
the same drawing in miniature, in the clip.

If  you double click again on the clip,  you will  see the clip's layer contains a picture with your 
drawing.  

You have just drawn the first image of your storyboard !
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Manage your storyboard

Create scenes and clips

Come again to the tab Project and create a new scene. To create a new scene, double click on the 
empty zone next to the current scene.

You have just created a new scene which contains one clip !

You can also use these icons  to create a new scene before (left icon) or after (right icon) 
the current scene.

You can also add one or several clips into a scene, in order to parse the scene into several steps 

(clips). To create a new clip into the current scene, you can use these both buttons : .  

• The first button add a clip before the current clip :  

 • The second button add a clip after the current clip :

  

Change scenes and clips

Other buttons are present in the tab Project and are used for :

 This button allows you to join the current scene with the next one, in order to obtain only 
one scene, composed of several clips.
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 This button cuts a scene after the current clip. The resting clips form a new scene.

 This button allows you to duplicate a clip and all its contents (layers, drawing, etc... )

  This button allows you to duplicate a scene and all its contents (clips and their contains).

 This function allows you to split a clip into two clips (reunited into the same scene), after the 
current picture (clip has to contain several images).
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Manage your storyboard

Contrary to other functions, this button  is not situated in the Project tab, but in 
the Animator panel.

  This function allows you to merge the current clip with the next one into the same clip.  

In  order  to  manage  more  easily  your  storyboard,  TVPaint_ 
Animation  includes a  numbering  system of  your  scenes  and_ 
clips, in the left corner, at the top of each clips (see opposite).

In the present case, the number 1 indicates the scene number : it means 
this scene is the first one of the storyboard. The numbers 2/3 indicates 
that we are on the the second clip of the current scene, and that this 
scene is composed of 3 clips.
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Storyboard's aspect : 

Other functions are available in TVPaint Animation to help you in managing your storyboard.

 This button allows you to  lock the order of your scenes and clips. However, you are still 
able to change the contents of your clips (texts, drawings, etc...)

 This button allow you to change the size of your thumbnails. Its use is really simple : you 
only have to maintain a left click on Z and move to right or left with your mouse to enlarge or 
reduce the thumbnails.

• Rename a clip 
Double  click  in  the  Untitled zone of  your  clip  or  right  click  on the visualization  area of  a  the 
thumbnail and select Rename Clip.

• Assign a group to a clip  
Clips can be brought together into the same group, as layers too. To assign a group to your clip,  
right click on the visualization area of the thumbnail and select "Group"

Features  of  clips'  groups  are  the  same as  groups  available  in  Clip :  Layers or  in  the  sound 
management. Please read lesson 3 to know more about how to manage groups.
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• Hide a clip
Sometimes, a scene can be deleted from a movie, or can have several versions. In such cases, it 
could be bad to delete all your work. It is better to hide this scene and keep it safe, "just in case".
To hide a clip, right click in the visualization area of your clip and select Hide clip, or left click on the 
right corner, at the top of your clip.

• Move a clip
Maintain a left click on the clip's name and move it where you want. If you select and move a clip  
contained in a scene, the clip will turn into a new scene containing one clip. If you move it from a 
scene to another scene, it will adapt consequently.

• Change your storyboard's view 

Basically, the first storyboard's view mode is the thumbnail mode . Three other view modes are 
available to optimize the making of a storyboard.

The Column view  or the Row view  are the most used views, traditionally.

These both modes allows you to add informations such as action, dialogs and notes. You can even 
copy paste a text from a text file. 
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The fourth view, the Timeline view , is used to visualize your storyboard as an animatic.

Turn a storyboard into an animatic 

What is an animatic ?

The animatic is the next step after a storyboard. An animatic is just an animated and rhythmic 
storyboard that will be used as a reference for animators.
Traditionally, it's very long to turn a paper storyboard into a video (you have to scan, cut, edit...),  
but with TVPaint Animation, this step is instantaneous. As each clip is composed of one layer and 
one image at least, you juste have to give a duration to each image to create your animatic.

Give a duration to your clips

There are two ways to give a duration to your clips.

The first method consists in editing each image's clip in the tab Clip : Layers and repeat it as many 
time as you need. 

The second method, more simple, consists to stretch each clip by using the timeline view in the tab 
Project.
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Turn a storyboard into an animatic 

This method allows you to give rhythm to your animatic without spoiling the number of images  that 
compose your clips. For example, if your clip contains 4 images, stretching your clip will not create 
new images.

Be careful ! Be sure that the post behavior of the layers which compose your clips 
are in mode  Hold,  Repeat or  Ping-Pong.  In  None mode, you will  have a blank 
preview :
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The duration given to each clip appears in the right corner at the top (in  thumbnails,  columns or 
rows views) or at the bottom (in the timeline view). You can choose to display the time code or the 
number of images (see below) in your preferences.

Once your animatic is done, click on the play button to see the result. 

Be careful, you can see the wholeness of your animatic only if you are in the tab 
Project. If you are in the tab Clip : Timeline, you will see only the animation of the 
clip.

Add sound

There are two ways to manage sound with TVPaint Animation : either in a global way (concerns 
the whole project) or in a local way (peculiar to each clip). With this lesson, you will learn how to 
manage global sound. Please read the previous lesson to learn how to manage local sound.

Global sound is used for a whole project : for example, we advise you to load musics, background 
sounds, etc... It's interesting to note that local sounds (loaded in clips) are audible when you are 
playing the whole project and vice versa, if you enable Play project sound in the clip in the Sound 
tab, from the Preferences panel.

To load a global sound, use the timeline view in order to have the menu which allows you to load 
an audio track. Click on Add a soundtrack to open your  documents and choose your sound.

Once loaded, your sound will appear in a thin belt. Click on the arrow on the left to have more  
settings and options. 
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The functions of the global sound are the same as the local sound. We recommend you to study 
the lesson 8 to know more about this subject.

Only one additional option is available for the global sound : the function Split track to clips 

This function splits global sounds and sends each part in corresponding clips, in order to manage 
sounds independently (for a lip-sync, for example)

So, this soundtrack will be split in each clip :

9-12 Create and manage a storyboard



What is a storyboard ?

Making a camera movement

The camera tool is a useful function to make easy and instantaneous camera moves, which could 

be modified very quickly. The camera tool is placed in the main panel :  When clicking on that 
icon, the camera will be automatically placed at the center of your image. The A position of your  
camera is then symbolized by a red rectangle.

Now click again somewhere else in your drawing space. A new (blue) rectangle will appear and the 
first red rectangle will become green) : you have just made a camera move from position  A to 
position B :

Now you can set intermediate positions between A and B by hauling the blue line, linking A and B 
together :
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Now you can play your camera movement through the camera's view thanks to these both icons :

Of course, if your clip has only one image, you will play an epileptic animation. We 
advise you to stretch that image, in order to set a duration, before playing your 
camera movement.

Now your animatic contains a camera move, you can see it in the_ 
clip's thumbnail, as a drawn schema. If you put your cursor on,_ you 
will even play the animation in the thumbnail.

TVPaint Animation Professional Edition includes a features named “Passepartout”. 
This  feature helps you to imagine better  the  final  output,  with the camera view :
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Configure your camera 

Of course, you can now configure your camera in order to change its aspect or its movement. 
Concerning the movement, the simple way consists in selecting a camera position (click in its 
center)...

… then, use handles to move, reduce, enlarge or rotate the chosen camera position.

Other parameters are present in the camera's panel tool : 

In addition to modify a camera position's zoom, place and rotation,  you 
can :

• Configure a motion Blur with a percentage (the higher that percentage is, 
the more visible your blur will be). A motion blur increases the illusion _of a 
fast movement.

• Change the mode as  Spline, Linear  or   Smart  spline in order to have a 
smooth or hard movement.
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• Modify the Time profile in order to slow down or accelerate your _movement : just double click to 
obtain that window (see below) and _modify your camera's speed :

  
        Regular                      Begins quickly and ends slowly        Begins slowly and ends quickly

To configure your movement precisely, don't hesitate to scrub your cursor on the timeline : in order 
to see a blue line on the Time profile Editor. That blue line symbolizes the current image on your 
timeline and can help you to configure how and when your camera shall move.

The tool panel will also allows you to :

• Lock your movement and avoid any modification

• Use commands to Invert, Load, Save or Reset your camera movement

• Change your camera's definition thanks to Parameters... button

If  you  are  following  this  lesson  from  the  beginning,  you 
created  a project with a Camera view DTV 720 (smaller than 
your drawing space). If not, your camera's size is equivalent 
to your drawing space's size

Here,  you  are  free  to  chose  any  pre-configured  format  or 
create your own format. If you need more information about 
other parameters (pixel ratio, fields...),  please read the first 
lesson.
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Chosen parameters have an influence on the camera positions. Attention ! Changing a camera's 
definition could change the perception of the camera movement you have previously made. So  be 
careful and chose the camera's format before moving it.

4/3 Borders displays on 4/3 borders on your camera's positions. Of course, if  your 
camera is already defined as a 4/3 camera, you will not see those borders !

Another function, Safe area, allows you to display the safe area 

In special cases, you will probably need to render definitively your camera movement. If so, go to 
Project menu and choose Render Camera to a New Project (keep layers) or Render Camera to a 
new merged Project (merge layers).

Create and manage a storyboard 9-17



Export your storyboard / animatic 

Export your storyboard / animatic 

Three kinds for exporting 

Three export modes are available in File > Publish : PDF, HTML and EDL. Of course you can also 
export your storyboard as a video or an image sequence. To know more about this, please read 
lesson 5.  

PDF export 

Exporting in PDF is really useful for printing, in particular if you have to submit your work quickly 
(meeting, producer, book...). Here is the PDF export panel :

• Browse allows to choose where your PDF file will be saved.

• Copyright allows to include the owner's name (artist, studio, school...)

•  Small  logo allows to  include the logo of  your  film,  series or  even the  owner's  logo (studio, 
producer...). Click on the button with three points to load an image.

• Page format allows to choose the export format (A4, A3...)

• Layout orientation en page allows you to choose the storyboard's aspect : rows or columns

• Layout scale allows to define the images' size

• Thumbnail view allows to choose the camera movement's display, following your needs : 

Full project size    Camera variable size           Camera constant size
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Frame allows  you  to  select  which  image  will  be  used  as  a  thumbnail  when  printing  your 
storyboard : the first image from each clip (Clip Frame in), the last image from each clip (Clip 
current frame), or bookmarked images from each clip (Bookmarks). 

You  can  also  can  also  choose  the  PDF  file's  orientation  (Portrait or  Landscape)  and  the 
informations' display  (Action, Dialog, Notes, Colors and hidden clips).

Once your parameters are chosen, click on Export.

HTML export

Export in HTML is really useful : contrary to PDF files, HTML export allows you to preview each  
thumbnail's animation  and camera moves, when putting your cursor above. And nothing else 
simple but read a HTML file : you just need a web browser !

Composed of a HTML file and a pictures folder, it's really easy to insert them in a web page (via a 
FTP server) or compress them and send them by email.

You will find the needed parameters in the tab HTML in the Publish panel.

• Browse allows to choose the folder where the HTML file will be saved.

• Copyright allows to include the owner's name (artist, studio, school...)

• URL allows you to include a link to your website in your HTML file

• Top-left logo and Small logo allow you to include logos of your film, series, studio, school etc..., 
Click on the button with three points to load an image.

• Export Animation allows to export the thumbnails' animation. Disable it if you don't want to export 
the thumbnails' animation.

• Clip Background allows to choose the background colors needed to differentiate scenes

Basically, three configurations are possibles to export in HTML : Japanese view (rows), Occidental 
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view (columns), Thumbnail view (only the thumbnails). You can change these views or even create 
your own style.

If you add a new style, this window will appear :

Here you can :
• give a name to your new style
• choose how to organize your thumbnails (horizontally or vertically)
• choose the separation : no separation (as a traditional storyboard), with 1 clip per line or with 1 
scene per line

Then, you will define : 
• which informations will appear (scene-clip-duration)
• the preview size (thumbnail size of each clip)
• the preview view (when the cursor is not on a thumbnail) and animation view ( when the cursor is 
on a thumbnail)
• which comments will appear (action – dialog – notes )

At last, before exporting your storyboard in HTML, you can choose to export 
it with several views at the same time : you just have to check views you are 
interested in. Then click on :
•Export to obtain a HTML file + an images folder 
• Export (email) if you want to obtain only one compressed file, ready to be 
sent by email.

Here is an example of a storyboard, exported in HTML :
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EDL Export

EDL export allows to export each clip in a Quicktime or AVI video and generate an Edit List file too. 
This  EDL file,  when  executed  in  a  compositing  software,  allows  to  load  all  videos  from your 
animatic you have just exported, in the good order.

You will find all needed parameters in the tab EDL in the Publish panel.

Format and Mode allow to choose the export clips' format. You can also configure codecs thanks to 
the Config button.

Browse (Original parameters) allows to define the folder where the EDL file and videos will be 
exported, conserving the original project's configuration.

Browse (Custom parameters) allows to define the folder where the EDL file and videos will be 
sexported, but changing your project's configuration. (width, length and image per second)

You can also choose to export an audio file's copy.

Then click on  Export (Original parameters) or  Export (custom parameters), following parameters 
you need to export your animatic as a video sequence + the EDL file.

Here is an example of a video sequence + the EDL file :

Create and manage a storyboard 9-21



Export your storyboard / animatic 

Export to...

In the lesson 5, you have learned how to manage your projects and how to export them. Of course, 
once you have finished your storyboard / animatic, you are free to export it as a video or an image 
sequence. Now open the Export to... panel (from the File menu).

You  have  probably  noticed the  tabs  Project :  Display and   Clip :  Display. The  only  difference 
between these both tabs is simple : the first one exports the full project (scenes and clips), the 
second one only takes in consideration the current clip.

 

In the  Project :  Display tab,  you will  see the option  Split  Scenes,  that 
allows you to export your project in once, but it will split clips (a little like  
the  EDL  export).  You  will  obtain  a  files  sequel,  named : 
“file_#scene_#clip_#image”.

For example, with that project :

Following the export modes, you should obtain :

.AVI export in animation mode : .PNG export in images sequence     :
(no image number in animation mode)
• Storyboard_001_001.avi • Storyboard_001_001_001.png
• Storyboard_002_001.avi • Storyboard_002_001_001.png
• Storyboard_002_002.avi • Storyboard_002_001_002.png
• Storyboard_003_001.avi • Storyboard_002_001_003.png

• Storyboard_002_002_001.png
• Storyboard_003_001_001.png
• Storyboard_003_001_002.png

Then, if you want to import that sequenceagain in TVPaint Animation, you will just have to drag and 
drop the first file of the video or image sequence. The import panel will open. Click on the Project 
tab and, at the bottom of the panel, look at the options of the Split Scenes menu :

• Image imports only the image sequence (from a same clip), into one single clip.

   >  
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• Clip imports only the image sequence (from a same clip) as a clip sequence (one image per clip), 
brought together into one single scene.

•  Clip-Image imports only a clip  sequel (from a same scene) and their  images into one single 
scene.

• Scene-Clip imports only a clip sequel (from a same scene) and their images. Each image will be 
place in a new clip.

• Scene-Clip imports the project as it was originally.

In these cases, do not forget to uncheck Single image when importing !
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Lesson 10 

 Working with the FX stack

In this lesson you will:

● Use the FX-Stack.

● Discover the concept of the animation keys.

● Create our first 'real world' animation.      



 Working with the FX stack

In lessons 2 to 9 we have, amongst other things, studied the TVPaint Animation drawing tools and 
discovered  the  timeline  and  its  functions.  You  are  now able  to  produce  «  frame  by  frame » 
drawings.

TVPaint Animation also offers you a wide range of effects. This has been specially designed for 
working on animated footage. 

These effects or composition tools are available in the Effects main menu (see opposite). They are 
arranged according to categories. We will study them progressively in the subsequent lessons.

The effect stack or FX stack

 It is possible to set the parameters for your effects in a special  window (for 
example : the power of a blur, the luminosity of the animated footage, the speed 
of a fade …), this is the FX stack.

You call up the FX stack by clicking on the FX icon in the tool bar or by selecting FX stack panel in 
the Windows main menu.

The Add FX popup menu contains all the effects indicated above: the menu 
is identical to the Effects main menu.

10-2 Working with the FX stack

The effects categories comprise:
* Blur : to alter the existing pixels of the animation.
* Colors : to rework the colors of an animated footage.
* Distortion : to distort the images of a footage.
* Keying : to cut out a part of the current animation.
* Motion : to manage camera movement.
* Paint : to repeat a line on the screen.
* Rendering : to create lighting and particles effects.
* Stylize : to rework the pixels of an animated footage.



The effect stack or FX stack

Initial study of the FX stack

Load the project named « house » which you have created in lesson 4. Merge it and spread the 
layer over thirty images. The resulting layer will be named « house ». 

We obtain the following timeline and screen:

    

   

Our effect stack is presently empty.
Select the effect Stylize > Mosaic  from the menu. The 
effect stack must look like the one shown opposite.
Now  modify  the  parameters  Width and  Height by 
setting the values to 20 and 30.

The result is immediately visible on the current image: the image is cut in blocks of 20 pixels in 
width and 30 pixels in height (the color of a block is equal to the average of the pixels making up  
the block in the original image).
The  Smooth button enables blending between adjacent blocks, the image obtained is therefore 
closer to the original image.

            

                         Original image                                                      Image with preview of the effect 

That said, the right image above is, in fact, for the moment only the preview of our mosaic effect  
(disabling the Preview button allows you to return to the original image).

To validate your settings and apply them into the current layer, all you have to do is apply your 
effect : click on the Apply FX stack button at the bottom of the FX stack window. Your current layer 
will  be  modified  according  to  your  settings  (if  required,  use  the  Undo  option  to  undo  the 
modification…). Don't forget that all images of the layer must be selected if required.

Working in real time

Almost  all  software  packages  on  the  market  impose  a  preparation  stage  and  then  an  effect 
calculation stage. Viewing the final result on the screen is only possible after completing these two 
stages. In the best case, you have a window for a low-res preview of your effect at your disposal.
TVPaint Animation does not adhere to this model and employs a much more interactive method. 
You have the possibility to view the results of these effects in real time!
Once  the  Preview  box  is  checked,  it  is  possible  to  play  your  complete  animation  using  the  
Play   button on the control panel. It will then be shown with all the modifications you have 
chosen in your stack.
In other words, any modification of the parameters within the effect stack is immediately visible on 
the screen, in full size and full resolution whether your project is a simple image or an animation.
Sliding along the timeline using the keys [←] and [→] also allows you to view progress frame by 
frame.
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The effect stack or FX stack

The various viewing modes

For the moment we will stay with our Mosaic effect. 
There are several  types of  viewing:  they are  available  in  the popup 
menu at the bottom left of the FX stack window (see opposite).

You may view the effect on the entire image, its left half, its right half, the top or bottom… you may 
even modify the viewing area to your convenience by sliding the border line on the screen (to do 
this, left click on the line and slide it).

         

Here again, the Play  button is pressed to preview your effect in real time but only on a given 
region of the screen.

Some operations

* If you have applied the Stylize > Mosaic effect, click Undo to cancel the effect and return to the 
unmodified animation.
* Go into the Options popup menu of the FX stack and choose Delete all.
Your stack is empty again.
* Select the Transition > Fade effect from the available menu.

*  Add  a  second  layer  behind  the  current  layer  and  name  it 
« Flowers ».
* Import the project « Flowers », merge it and spread it over 30 
images.
* Copy all the images of the layer obtained into the layer named 
« Flowers » in your project.
* Finally, go to the first image on the timeline, on the layer named 
« house » (see timeline below).
* Modify the value of the position parameter to 50% then apply 
the FX stack.

  

The « Flowers » Project
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The effect stack or FX stack

You obtain the following image:

  >     

You have certainly understood that this effect creates a fade between the image of the current 
layer and the image on the lower layers.

Indeed, but this effect is applied to the current image (the first) and not to all the images of the 
layer, … so let's remedy this.

Click on Undo to find the layer named « house » intact.
Now select all the images of the layer and apply the FX stack.
The effect now applies to the entire layer.
This is not yet perfect: the fade effect is locked at 50% of its progress for all images of the layer… it 
does not evolve in time.

To obtain a true fade effect on the screen, one has to apply the FX stack with a position value : 0% 
for the first image, 1% for the second, 2% for the third … and so on all the way to the last image…
(assuming  that  our  animated  footage  has  a  total  length  of  100  images… If  not,  complicated 
adjustment calculations must be made!).
At first sight this seems like a long and complicated process. Fortunately, TVPaint Animation offers 
tools which reduce this fastidious process to a few seconds: the Animation keys.

Apply FX

Now, the remaining step is the application of the FX. But before pressing on “Apply FX stack”, we 
will discuss about the Apply on line.
In this part of the FX panel you can choose on which layer(s) the FX will be applied :
• Current layer to apply the FX only on the current layer
• Current group to apply the FX on all layers from the same group as the current layer
• All layers, as you guess, apply the FX on all layers from the current clip.

Then, you can choose if the FX will be applied :
• on a selection only (so, do no forget to select the images you want)
• or on all instances contained in the layer(s)

At last, choose to apply your FX on all frames or on instance's heads only.

Following the chosen parameters, you will obtain different results.
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Working with animation keys

Working with animation keys

It is possible to set the parameters for our fade effect to 0% for the first image in our layer, then to 
100 % for the last.
In  this  way  TVPaint  Animation  takes  charge  of  calculating  the  progress  of  the  effect  on  the 
intermediate frames. 
This is what we refer to as working with Animation keys.
Once this concept is understood, you will no longer work frame by frame.

Proceed in this way for our current project :

* Go onto the first image of the « house » animation layer. Set the effect to 0% 
then click on the button shown opposite.

* A symbol        appears in the timeline 
(see opposite) under the first image.

The name of the Fade effect is written to the left of the timeline.
* The  Fade  effect is now set to a value of  0% for the first frame of the timeline. At this stage, 
application of the FX stack has no animation effect. Indeed, the value of this key will be repeated 
for all frames after this one.
It is necessary to create a second key before applying the FX stack in order to obtain an animation 
effect.
*  Go on the last  image of  the «  house »  animation layer,  create  a  key using the   button 
of the FX stack.

You may now immediately set the effect to 100%. In this case it is not 
necessary to click on the button « C » as before and the key represented 
by the symbol  will be created automatically.

The timeline is modified as below: 

* Note that by sliding along the timeline using the [←] and [→] keys of the keyboard or pressing the 
Play   button allows you to view the progress of the chosen effect from the first to the last 
frame.

To sum up, an animation key is a sort of adjustable time parameter lock which sets the value 
chosen by the user to a precise point in the timeline.
However, the drawing tool parameters vary dynamically according to the user's direct action on the 
project and may therefore not be assimilated to animation keys.

On next page, you will see the result that you could obtain on the screen.
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Working with animation keys

        

        

        

Manage the effect's progress

You have probably noticed the Progress  button under the name of each effect. This button is used 
to manage the speed at which the chosen effect will be carried out.

The Progress profile editor will then appear.

This being the case, the progress profile editor has a very specific function within the effect stack:
* The abscissa in the graph represents time,
* The ordinate in the graph represents the progress of the chosen effect.

Let's go back to the fade effect in the « house » layer:
* Use the Undo option to recover the layers intact.
* Choose the same keys as those indicated in the chapter above.
* Draw the spline above before applying the FX stack.
After playing the project you will note that the effect is first carried out slowly and then at top speed 
(see timeline below). This corresponds to our spline : it rises slowly first and then very fast.

In the same way, if we choose the spline shown below before applying the  FX stack, the Fade 
effect will be fast at the beginning and slower at the end.
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Click  on  the  Progress button  and  then  on  the  small  black 
section appearing on the screen (see opposite)

The interface of this window is identical to the one presented 
for brush profile setting in lesson 2.

The  Bin and  Spline menus,  the  Flip  X,  Flip  Y  and Delete 
buttons are the same as the ones you have studied before.



Working with animation keys

 

If the spline rises and then falls off again, progress of the effect will change accordingly:

 

Managing effects with several parameters

Now close the « house » project and load the « prehistoric » project.
* Merge the layers of this project.
* Stretch them over thirty frames.
* Delete the content of the FX stack.
* Choose the Blur > Center blur effect.
The following timeline appears :

    

To make it easier we have deliberately chosen to work with an animation 
layer  always  containing  the  same  image.  Everything  that  follows  also 
applies to an animation layer.

You will see that there are three parameters which may be locked with an animation key:

* the position of the center,
* the power of the blur,
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Choosing a horizontal straight in the profile will stop progress in time of the effect.



Working with animation keys

* the radius of the circle in which the blur is not applied.

The position of the circle in which the blur is not applied as well as its center are shown in the 
preview (see image above)

The parameters directly adjustable on the screen (handles, circles, spline) are referred to as HUD 
(HUD stands for Head Up Display).
The Hide HUD of the FX stack is used to hide the latter. 

Now let's take a look at the timeline: 
* As soon as an animation key is created, a left click on the Center Blur triangle in the Timeline 
below displays the name of the parameter which have been set with the animation key.
* To the right of the parameter names, corresponding key lines will be displayed as you create your 
keys.

It is possible to create animation keys for each parameter, for the image of your choice along the 
timeline.

A separate set of keys may be created for each parameter (Center of circle, Power, Radius). This 
means that the parameters may progress in time independently of each other. For example: the 
power  of  the  centered  blur  may  decrease  slowly  while  its  radius  may  increase rapidly,  all  at 
different times …

Thanks to several keys, the parameters can be adjusted in time. This is the case for the Center 
parameter in the timeline above : three animation keys are placed on the key line associated with 
the Center parameter.

Below, the effect produced using these three keys.

      

The first key line in the timeline has the name of the effect in the stack and 
displays all its keys.
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Some parameters may be adjusted directly on the screen by clicking and sliding 
the mouse on the color handles (shown opposite).
When the effect is applied, circle and handles will, of course, have disappeared.



The path

The path

When position  parameters progress  in  time,  there must  be a path taken by the parameter in 
question.
For example, three animation keys were created at images 1, 6 and 30 for the Center parameter 
above.
The center of the Center blur effect consequently follows a path as time progresses.
In our example, the path is visible via the HUD and looks a bit like a red « V ».

It is possible to choose an interpolation mode between the key 
points which define your paths.

You may choose to connect the points in a linear, spline or smooth manner using the first menu of  
the effect (the Tools menu will be studied later in lesson 14).

                            
           Linear                                                     Spline                                                   Smooth

When using Spline, it is possible to use handles. The [Ctrl] key + mouse click on a 
handle are used to move only this handle.

Moving from key to key

The contextual menu for the keys

When using animation keys:
*  The  layer  contextual  menu  offers  the  possibility  to  select  the  frames  
corresponding to the keyline.
* The Auto Fit menu is used to adjust the zoom of the timeline in order to view all 
the keys.
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It is not always easy to place yourself on a key within the timeline, 
especially when the project contains many images. 
The «  triangle » buttons in the effect stack or in the current project 
window (see opposite) are used to move rapidly from one key to 
another without having to use the [� ] and [� ] keys or the mouse.
If they are in black, they indicates that there is an animation key on 
the left or the right of the current position. Otherwise, there is no 
more animation key.

A right click in the timeline on a « keyline » (see opposite), calls up a 
contextual menu.
You may :
* create or delete keys (which requires confirmation),
* select one or all keys (they will then be displayed in yellow...),
* cut, copy, paste keys (a process already used for images and layers: 
see lesson 6).



The path

Contract, stretch a key line

In the previous lessons we learned how to contract or stretch an animation layer.  This is also 
possible for key lines (see below).

         Stretch
                                                         Contract

  

If required, it is possible to move a key 
from  one  place  to  another  in  the 
timeline  (click  and  slide  with  the  left 

mouse button).

Use the selections

When you make a selection on the screen and then apply an FX stack, the latter is only applied to 
the selected area (whether you apply the stack to one or several images makes no difference).
This is very useful when you apply your effect to a precise area in your image or animation.

    

More details about the FX stack

A more complex effect: the Rendering > Lighting effect

  >>      

This effect is used to light up the image or sequence of your choice as if using an exterior light  
source  (light, projector…).

By default, nothing is present in the list. The Lights menu may be used to create one or several 
lighting effects among the following categories: Spot, Omni and Ambient.
As soon as a lighting effect is created, you may duplicate, delete or rename it. 

The Lights menu displays the name of the light whose parameters are shown in the stack. If you 
work with several lights you may go from one to the other by selecting their names in the Lights 
menu.
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More details about the FX stack

Here an overview of the different lighting types:

*  Ambient lighting lights up the scene globally in the color of 
your choice. Values under 100% will darken the image, values 
higher than 100% will brighten it. 

* Omni  lighting lights up a circular area of your choice similar to 
a projector located on an axis perpendicular to the image. The 
parameters  to  be  set  are  color,  lighting  intensity,  center  and 
radius of the circular area, as well as altitude of the virtual projector.

          
                    Omni projector diagram                Omni HUD                          Omni lighting     

*  Spot lighting lights  up  the  image similar  to  a  tilted  projector.  Two  position  parameters  are 
available for this mode, which allow you to adjust the position of the light source as well as its 
direction.

         
                    Spot projector diagram                Spot HUD                            Spot lighting                              

Spot and Omni lighting have a profile editor which works similarly to that of the drawing tools  (see 
lesson 2 for more details).

               
                        Omni                                        Spot                                         Profile
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For  many  of  the  parameters  described  above,  the  settings  may  be  made 
directly on the screen (don't forget to display the HUD).



More details about the FX stack

With the  Light  popup menu it  is possible to use 
several light sources (regardless of type), as well 
as to rename, duplicate or delete them.

This  is  how  our  cave  may  be  lit  up  in  various 
ways !

This  Lighting effect only applies to the opaque pixels of the current layer. To 
obtain the examples above it is therefore necessary to first merge the layers of 
our project.

Single effect, multiple effects

Up to now we have only used a single effect in our stack. 
TVPaint  Animation  also  offers  the  possibility  to  use  a 
succession of effects.
For  a  better  understanding  of  this  notion,  we  will  use  the 
merged « prehistoric » project that we have used before.

Using the parameters below, place a Center blur effect in your FX stack.
You now have the following preview:

     

   

May  be  you  noticed  the  options Multiple  FX  and Simple  FX  in  the 
Effects main menu or in the Add FX popup menu of your stack.

If you select a new effect in the popup menu:
* When Multiple FX is checked, the chosen effect is added to the present effect.
* When Simple FX is checked, the chosen effect will replace the present effect.
Check Multiple FX in the menu and choose the Rendering > Lighting effect explained above: this 
effect will automatically position itself over the current effect.
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More details about the FX stack

Result of the FX stack above

Current effect, preview and collapsing of effects

* One of the effects in your multiple FX stack is always selected. This effect is referred to as 
« current effect » (the one which seems to appear « brighter » while the other effects are « gray »).
The keys visible in the timeline are always those of the current effect.

* When several effects are used, it is possible to collapse them using the   buttons top left.

* The check boxes close to the arrows indicated above are used to enable or disable the effect 
they belong to. 

Opposite,

The Lighting effect is enabled and reduced.

The Center blur effect is disabled and visible.

The current effect is the Lighting effect.

If the FX stack above is applied to our initial frame, we obtain the 
image shown opposite:
Only the Lighting effect is taken into account. There is no Center 
Blur applied before it.
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Set the parameters for the two effects as shown 
opposite. 

To simplify our example, there is only one type of 
lighting used and our effect  applies only  to one 
frame (so no key is required …).
This  said,  everything  that  follows  still  applies  if 
you use keys and animation layers.

Once  the  preview  is  enabled,  you  see  the 
following result:
lighting is applied « after » the center blur of the 
previous page!

The advantage of our stack with two effects is that 
it  is possible to modify any of the two effects at 
any time during the preview.

Modifications  of  this  kind would  indeed be very 
fastidious if you used a single effect at a time: 
application of the FX stack twice in a row for two 
different effects followed by the Undo option twice 
in a row, change the first effect, reapply the two 
effects one by one, undo option again, etc.

It is also possible to accumulate the number of 
effects of  your choice or  even several  times 
the same effect if you need it!
Remember the Play    button to view the 

effect on the animation layers … 



More details about the FX stack

Swap two effects

The effects contained in the stack are executed 
from bottom to top during preview or application. 
There  is  a  kind  of  chronological  order  for  the 
effects …

The results may therefore vary if two effects are 
swapped:

* In the left image below, the FX stack  applied is 
the one illustrated opposite.
The center blur is applied after lighting.

* In the right image below, the FX stack applied is 
the one illustrated on the previous page.
The center blur is applied before lighting.

              
Preview of the FX stack above          Preview of the FX stack of the previous page

 It is also possible to swap the effects by clicking on and sliding its name. 
The process is identical to the one used to swap the layers in lesson 3.

Reset and rename effects 
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A left click on the right triangle above calls up a contextual menu which may 
be used to: 

Rename the current effect in the  FX stack,  Create  or  Delete  an animation 
key,  Reset  the effect parameters to their initial values,  Duplicate or  Delete 
the effect from your FX stack.

The  Options menu of the effect stack may be used to delete or reset the 
values of all your effects.



More details about the FX stack

Undo/Redo of the FX stack

It is possible to Undo/Redo all what is done in the FX stack.

Two buttons are available at the top of the FX stack, near the Bin button. 

Save the settings of the FX stack

We have learned how to create and save our own graphic palettes, our settings of custom tools, 
our pre-defined gradients, etc.  It  is  therefore only  natural  to proceed in the same way for our 
effects:

The FX Bin menu for each effect offers several options:
* The Add option allows you to store your effect for later use (you will first be asked to name this 
effect).
* The Export option saves the current effect to a storage support.
* The Import option recovers an effect from a storage support.
* The Delete option deletes an effect.

The  FX Bin  menu for the entire stack works in the same way, but may be used to add, import, 
export or delete an entire stack.

When you add an effect to a pre-defined effect stack, all keys and profiles 
relative to the progression of each effect you have created are also saved.

FX stack and TVPaint Animation projects

We may be repeating ourselves, but it is important to remember that it is indispensable to Apply 
the FX stack so your effect is taken into consideration and affects the current layer (if not, all you 
do is preview it…).
Also note  that,  when you save a  project,  as  well  as saving the layers,  their  position  and the 
associated parameters (Position,  Duration,  Pre-Post- Behavior,  etc.)  you also save the current 
effects stack.
This makes it possible to keep a complete and intact animation and the effect stack necessary for 
your finishing touches. Useful, isn't it?

When you work with  several  projects  at  the same time,  note that  each 
project has its own effect stack.

Introduction to the video effects  

A lot of notions here need a good understanding of the multiple FX and FX-stack concepts.
So it is advised to read the last chapters before beginning with this one.
Please note that we will only mention here the function of the effects and their place in the FX-
stack.
The parameters and options of the effects will be described deeply from lesson 11 to lesson 18.

In this section, we will create a small opening sequence for a weather report.
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The Undo ([u]) and Redo ([Shift+u]) shortcuts are applied on the FX Stack 
if the Preview option in the FX Stack is enabled. Otherwise, they have their 
normal behavior.



Introduction to the video effects  

Do to so, we have several video sequences at our disposal :
The first one with a forest, another one with a sunset and the last one with some clouds

 > >  > > 

* Begin by importing those sequences in your project. Resize them if it is necessary. (note that the 
sequences  can  be  directly  imported  from your  camera  into  the  software  by  using  the  Video 
Grabber panel). Don’t forget to use a project with fields if your video sequences are fielded.

* Move them inside your timeline as shown below and import the music. A color has been added to 
the layers to make them more recognizable.

You should have three overlapped layers (look at red areas in the timeline above). This will help us 
to use the transition effects. Above, a transition effect has been applied on the first animation layer 
of the timeline. The zoom factor of the timeline has been increased to make it more visible.

Here is the resulting transition :

> > > >

* To add a personal touch to our weather report, it is possible to use several effects : 
Below,  the  Blur  >  Radial  Blur effect  was  used.  Therefore,  the  animated  sequence  appear 
progressively on screen.
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Introduction to the video effects  

  >   > 

* You can easily make butterflies fly in front of the trees and make them follow the paths of your  
choice, as explained in the lesson 14 :

        

      

* We will now work on the “Sunset” animation layer : It is possible to distort the pictures to stay 
close to the weather report theme. This can be done by using the Rendered > Waves studied in 
lesson 13. Below we imitated two water waves, as if two rocks were thrown into water.

  >   > 

* We have afterwards to manage the transition between the «Sunset» and the «Clouds» animation 
layers. Below, the  Transition > Classic  effect with the  circle option has been used. Here is the 
timeline and the rendering :
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We used the butterfly animated brush (supplied on the TVPaint 
Animation CD-Rom)  with the Motion > Keyframer effect and a 
pre-recorded path for each butterfly.
Of course, our two butterflies can be added on a new layer : it 
will allow you to keep the «trees» animated layer unchanged.

By  using  a  new  layer,  you  will  also  be  able  to  change  the 
moment when the butterflies have to appear : you only have to 
move the whole layer through the time axis of the timeline.



Introduction to the video effects  

> > > >

It is possible to modify the timeline scale thanks to the Z button of the timeline. (see 
lesson 4)
You can also use bookmarks to navigate easily through the timeline. (see lesson 4)

* Let's now add a rainbow in the cloudy sky :

            

To do so :

*  Create  a  new  layer  (the  clouds 
animation layer will remain intact)

*  Draw a  rectangle  filled   with  the 
spectrum  gradient,  as  shown 
opposite.

       

After this, you have to use a multiple FX-stack  with these 
effects : (in order, from the first to the last)

*  Color > Color Adjust : the red area should be on the 
outside of the arc and the violet area on the inside.

* Blur > Radial Blur : this effect will allow you to create the 
arc itself. The center of the radial blur must be located far 
from the colored rectangle (out of the viewable area, to 
be exact).

* Blur > Gaussian Blur  will merge the colors a little.

* Transition > Fade  will make the rainbow fade in as time 
progresses.

Here is the result :
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Introduction to the video effects  

  >    >  

* Now, you only have to add a title to this sequence, thanks to the Rendered > Simple-text effect.

        

We used here the effect Rendered > Simple-Text (you can fill in 
the text, adjust the font, the border, the shadow, their colors or 
gradients ...)

This effect is very convenient because it allows to keep all the 
colors, border, font and shadow settings and to re-use them with 
another text line ...  (for example if you need to do a translation )

* For the final touch, we need the Rendered > Lens-flare effect :

        
        Lens-Flare effect on the check background                    Here on a new animation layer     

Here is the resulting timeline with the text, the rainbow and the Lens-Flare on separate animation 
layers.

And the animation itself : 

> > > >
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Lesson 11

The effects of the Blur and Transition group

In this lesson you will:

● Discover the various Blur effects at your disposal.

● Discover the various Transition effects at your disposal.

● Learn how to increase the transition possibilities by using the FX-stack 



The Blur group effects

The   Blur   group effects  

The blurs are often used to hide faces in recorded animations. Sometimes, they are also used to 
create artistic effects.
In order to study the effects of the Blur group, we will use the two pictures below : a photo and a 
drawing.
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Independent of which blur effect you will choose, don't forget it will be controlled by 
the animation key system.
A recorded video sequence can also become gradually blurred in time.



The Blur group effects

Some details regarding the Blur effects of TVP Animation :

The Blur > Cubic Blur effect

This is the most standard blur: the more you increase its size, the less the sharp and angular areas 
of the source image will be visible. It may also be applied only to the transparency channel of the 
image (alpha channel).

    

The Blur > Gaussian Blur effect

An image with a Gaussian Blur may be compared to an image seen through a camera that is not 
set correctly. 
The Gaussian Blur is more precise than the Cubic Blur.
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The Blur group effects

The Blur > Chroma Blur effect     

The Chroma Blur takes only the tint and saturation pixel informations into account. The dark and 
light areas of the picture are not affected by the Chroma Blur. Only the chromatic component of the 
picture is affected by the blur.

    

The Blur > Center Blur effect

We studied the Center Blur in detail in lesson 9 about the FX-stack concept. The parameters are 
the position of the center, the power of the blur and the radius of the circle.
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The Blur group effects

The Blur > Radial Blur effect

This blur is applied in a circular manner around a point the position of which you have chosen on 
the screen. The second parameter to be set is the power of the blur.

    

The Blur > Directional Blur effect

This blur is applied only in the direction (angle) of your choice and the spread of your choice. You 
may set the vector parameter directly on the screen.

   

The Blur > Median Blur effect

When using the Median Blur, the color of the pixels obtained after application of the blur depends 
on the colors of the adjacent pixels in the initial image.
The Median Blur comprises all kinds of modes, the effects of which you may admire below :
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The Blur group effects

Median Blur effect in Smooth mode

    

Median Blur effect in Light halo mode

    

Median Blur effect in Dark halo mode
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The Blur group effects

Median Blur effect in Light mark mode

    

Median Blur effect in Dark mark mode

    

Median Blur effect in Double edge mode
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The Blur group effects

Median Blur effect in Impressionist mode

     

The Blur > Deinterlace effect 

This effect allows you to manage the fields of a project. It has only one parameter to choose the 
way the fields will be modified.

Original Image
Five modes are available in this popup:

           

* Copy Lower Field: the Lower Field will be copied to 
the Upper Field.

           

* Copy Upper Field: the Upper Field will be copied to 
the Lower Field.

           

* Interpolate  Lower  Field:  the  Lower  Field  will  be 
interpolated from the two adjoining Upper Fields.

           

* Interpolate  Upper  Field:  the  Upper  Field  will  be 
interpolated from the two adjoining Lower Fields.

           

* Mix Fields: The new Upper field are computed from 
the current Upper Field and the two adjoining Lower 
Fields, and the new Lower Field are computed from the 
current Lower Field and the two adjoining Upper Fields.
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The Blur group effects

The Blur > Motion Blur effect 

The purpose of this effect is to apply a blur involved by some fast movements in an image or an 
animation. The animator can define a flow, based on a vector field, that the pixels of the image will 
follow.

This effect comprises four tabs :

• The Edit tab

          Source Image

* The first button allows you to set the size of the vector field. More exactly it allows you to set the 
number of vectors that you will use on both the horizontal and vertical axis.
Once you have chosen the size, you can edit the current vector field itself.
To do so, display the H.U.D and draw directly on the screen (to be exact : on the H.U.D) with the  
purple circle, as shown below.
If you have a picture behind the vector field, you should see the render of the distortion.

      
                          Vector field                                                            Modified image

     

The  left  mouse  button  allows  to  increase  the  tension  of  the 
vectors in a chosen direction.
The right  mouse button allows to decrease the tension of  the 
vectors in a chosen direction.

The red points are the source points of your vectors, (they can't 
be moved)
The green points are the destination points of your vectors, 
The blue segments are the vectors themselves.

For a given picture in your timeline, modifying the vector field creates an animation 
key.
If more than one animation key is created in the timeline, it means that your vector 
field and thus the distortion will evolve in time.
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The Blur group effects

* The Reset Current Key button resets the vector field of the current picture in the timeline. If this 
picture does not have an animation key, a new one will be automatically created.

* The button :  allows you to modify all the vectors of the field in only one operation. This tool is 
perfect if you need to distort, move or pivot an image entirely.

              

The more vectors you will use, the more time you will need to render 
the effect.

* The button :  allows to change the parameters of your H.U.D brush (i.e : the purple circle)
Like the common tools (airbrush, etc ...) that you use to draw, you can set its profile, size and also  
power.

     

Let's  admit  that  we will  always  choose the direction  opposite 
when editing our vector field (i.e : the red arrow) :

The pictures below shows the impact of the different settings at 
your disposal.
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The Blur group effects

• The Selection tab

       

*  In  this tab,  you  can  select  the  vectors  of  the  field  that  you want  to  edit  via  the  previously  
discussed tools.
By default, all the vectors are selected. The two buttons Select All and Clear Selection allows you 
to reset the selections.

As in the main panel, you can use one of the three selections icons :  Square, Freehand 
or Circle selection.

   

When doing a selection, if a vector is selected, it appears 
in yellow instead of blue. (if you want to select a vector, 
just select its source)

If a vector source is not selected, its H.U.D color becomes 
lighter.

The tools available in the Edit menu will only apply on the 
selected vectors.

The circle selection use the same parameters as the H.U.D brush (the purple circle) so you can 
select your vectors by “drawing on the H.U.D”
It allows you to have source points only selected in part and thus to have nice effects when editing 
the vectors.

Note that if you reset the size of the vector field, all the settings that you have done 
(vectors, animation keys, selections, ...)  will be lost.

• The Render tab

    

The Render tab allows you to choose :

* The distortion mode of the image borders

(The example below illustrates the three modes at your 
disposal.)
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The Blur group effects

                      
                                       Source Image                                               Vector Field

                
                      None Border Mode                            Mirror Border Mode                         Loop Border Mode

• The Display tab

   

The  three  buttons:  Show  Source, Show Destination 
and Show Vectors allow you to select exactly what you 
want  to  see  on  the  H.U.D  :  the  red  source  points 
and/or  the  green  destination  points  and/or  the  blue 
vectors.

The button Show Only Selection allows to see only the 
vectors located inside the current selection.

The   Tran  sition   g  roup effects  

All transition effects in TVP Animation have a position parameter which requires the use of the 
animation key system (as described in lesson 9).
As well, we chose to make this parameter vary between 0% and 100% for each transition effect in 
order to show you their specifications. A setting of 0% will leave the picture intact and a setting of  
100% clears the picture (100% transparent). 

In order to study the effects of the Transition group, we will use the picture below.

Be careful  that  the transitions are  made between the frames and a full 
transparent image.

Transitions are not transformations between two pictures.
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The Transition group effects

   
original image

The Transition > Block effect     

In this effect, you can adjust the number of rows and columns which will create blocks. To set the 
number of blocks, you just have to increase these two values. You can also select the way these 
blocks will appear or disappear on screen : random or in a direction you want.

  >  >  >  >  > 

The Transition > Blind effect     

This transition hides progressively a part of the current image. The numeric field value represent 
the number of division on the screen.
There are three types giving different results : crop, slide and stretch.

  >  >  >  >  > 

  >  >  >  >  > 

  >  >  >  >  > 
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The Transition group effects

The Transition > Classic effect     

Classic  transitions makes the current image appear or disappear by moving a frontier. This one 
can have different shapes (circle, line, rectangle), as well as the color you want or even be faded.  
In case of circles and rectangles, you can adjust the position of the center of the shape.
The linear and tools menu will be explained in the lesson introducing the Motion group effects.

  >  >  >  >  > 

  >  >  >  >  > 

  >  >  >  >  > 

The Transition > Fade effect

The Fade transition is the most common transition ever used and does not need any other settings 
than Position. It was also introduced in lesson 9.

  >  >  >  >  > 

The Transition > Slide effect     

The Slide transition moves your video in a predefined direction you have to select. You just have to 
select the direction in the Direction menu.

  >  >  >  >  > 

  >  >  >  >  > 

The Transition > Rotary effect     

This transition clears the image following the movement of a clock's hands. The check box allows 
you to select the direction of movement and the menu is used to select the center on which the 
effect will be applied.

  >  >  >  >  > 
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The Transition group effects

The Transition > Page Turn effect     

This transition effect acts as if a paper sheet was removed from the screen.
You can choose to turn the page from the window border you want thanks to the Direction menu.

  >  >  >  >  > 

There are three modes : image, color and gradient as shown below :

       

Increasing the transition possibilities by using the FX-stack     

You can easily create new transitions possibilities by using multiple effects in a same FX-stack.

For example, using the Classic Transition effect with the Rotary Transition effect in the same stack 
can give this result :

  >  >  >  >  > 

Below, the Classic Transition, the Blind Transition and the Gaussian Blur effects were used in the 
same stack :

  >  >  >  >  > 

       

Of course, we can't show you here all the possible 
combinations because they are so many ...

But we guess you will certainly try some of them.
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Lesson 12 

 The effects of the Color and Keying groups

In this lesson you will learn to:

● Touch up the colors of a video sequence or an animation.

● Handle the effects of the Keying group.

Unless indicated otherwise, all images in this lesson have only one layer.



Color channels

Color channels

Based on the additive color principle, all colors are a mixture of red, green and blue (more or less 
dark) in exact proportions. 

The effects in the   Color   menu  

 

The Color > Black & White converter effect

The Black & White Converter effect has three parameters that may be locked using an animation 
key. By default, it transforms the images by deleting the color data. We therefore obtain the same 
effect as photos taken with a black and white film.
Increasing the value of the  Red parameter will make the red pixels of the original image lighter 
when changing over to gray. Reducing the value will make them darker (see next page).
The same principle applies to the Green and Blue parameters.

       
    Default settings                                    Parameter Red at value 0                    Parameter Red at value 255
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The color of a pixel therefore has a darker or lighter  Red component, a 
darker or lighter  Green component, a darker or lighter  Blue  component 
and a last component which indicates the pixel transparency level.

This last component is referred to as Alpha component.

Let's  take  a  look  at  the  image 
opposite:  the  various  colors  were 
spread  and  mixed  on  a  wooden 
palette.

All  colors  of  the chromatic  circle  are 
present  on  this  palette  (red,  orange, 
yellow, green, blue, purple).

This image will allow us to study all the 
color  modifications  available  in 
TVPaint Animation.

To do this, load the project « palette ».



The effects in the Color menu

Below, a zoom on the red area of the image :

                     
      Default settings                   Parameter Red (value 0)       Original image                      Parameter Red (value 255)

The Color > Color Adjust effect

We'll keep the image from the beginning of this chapter and 
study the Color Adjust effect shown opposite in detail.

This effect uses the traditional notions of color modification 
for drawing and photo touch-up software packages:

* The Brightness parameter is used to increase or decrease the global brightness of the current 
image or video (use negative values to decrease brightness).
In other words, all the pixels present are either changed over to the black color or the white color.

      
  Brightness + 75%                            Original image                                Brightness - 75%

* The Contrast parameter, if increased, will accentuate the luminosity differences between the light 
and dark areas. When decreased, it will reduce them.
A setting close to 100% will only make the primary colors appear, as well as black and white. A 
setting close to 100% will make the image or footage almost entirely gray.

      
    Contrast + 75%                                     Original image                                     Contrast – 75%

* The  Saturation  parameter accentuates or reduces color vivacity.  A setting close to 100% will  
reduce the number of pixels close to the gray colors while reviving the colors, a setting close to 
−100% will produce a gray drawing.
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The effects in the Color menu

      
    Saturation + 75%                                 Original image                                      Saturation – 75%

* The Gamma setting is often used for photo touch-up but also enables lightening or darkening an 
image without leaving the impression that a dark or light sheen was placed over it. Its value may 
vary between 0.01 and 5.

         
  Gamma = 2                                             Original image (Gamma =1)                 Gamma = 0.5 

At  first  sight,  the  Gamma parameter  seems  to  have  the  same  effects  as  the 
Brightness parameter.  This  is  true,  with  the  difference  that  the  Brightness 
parameter affects all pixels on the screen whereas the  Gamma parameter affects 

the light and dark pixels only marginally.

Below you will find an example of the difference between a gamma reduction and a reduction of  
the brightness : 
Reducing  the  Gamma by  half only  slightly  affects  the  pixels  making  up  the  paint  and  the 
background: the latter remain bright and clear. 
Modifying the Luminosity to � 50% gives the same pixels a darker hue.

        
  Original image (Gamma =1)           Gamma = 0.5                                    Luminosity - 50%

* The  Angle  parameter enables rotation of colors at the angle of your choice around the color 
wheel (see below).
For example: going from angle 0° to the angle 90° will transform the orange colors in the image to 
green, blue to purple,…etc.
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The effects in the Color menu

        
     Original image                                  Rotation of colors of 90°                The color wheel

* The Rotation parameter reflects the number of turns around the color wheel before arriving at the 
chosen angle. This allows you to make the colors vary in a time cycle, which is sometimes useful 
for colored logos.

In the example below, we start with a blue TVPaint logo (R=0, G=0, B=255), placed on each image 
of an animation layer comprising forty-eight images.

An animation key is placed at the first image of the layer, locking the value « 0 » for the Rotation 
parameter. A second key is placed at the last image of the layer, locking the value « 2 » for the 
Rotation parameter.

When the FX stack is applied, you see the following result:

The logo changes color in cycles, going twice in a row through the colors of the color wheel.

The Color > Color Eraser effect

Let's assume that we want to delete the green and blue colors in our image. This is easily done 
using the Color Eraser effect.

By  erasing the color  we  understand  erasing the data  relative  to  the  color 
composing the pixels  and not  modifying the opacity  of  the pixels.  In  other 
words, we unsaturate the pixels with a precise hue.

         
                                                                 Original image                                         Image with green and blue 

 hues erased                     
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The effects in the Color menu

Start by selecting a color in the green area of the image in the Color box of the panel above. Part 
of the green pixels will then be unsaturated and turn to gray. To obtain a better finish, you may 
increase or decrease the tolerance or softness thresholds.

To select the pixels according to their hues, the color bar of the panel as well as the 4 mini-sliders  
will help you.

  non-unsaturated hues,

  progressively unsaturated hues,

  completely unsaturated hues,

The  Invert  button  is  used  to  invert  the  final  result:  saturated  pixels  become 
unsaturated and vice-versa. If necessary, the popup menu Display enables recovery 
of source image viewing.

The Color > Tint Replacer effect

  

The Tint Replacer effect is based on the same 
principle as the Color  Eraser effect,  with the 
difference  that  you  do  not  unsaturate  the 
colors
.
Indeed,  using  Shifting  values  enables 
progressive modification of the hue, saturation 
and luminosity of the chosen tint  range. You 
may  thus  easily  toggle  one  color  range  to 
another.

The  Shifting  values  are  calculated  as  being 
« gap » in the H.S.L system between the two 
colors  of  the  panel  (blue  and  yellow  in  this 
example).

    
                              Original image                                  Orange tint changed to red tint
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The effects in the Color menu

The Color > Color replacer effect

This effect allows you to modify a color in an easy way, just by choosing the Source color (the color 
you want to change) and the Destination color (the one you want to obtain). If the change does not 
fit exactly your needs, you may use the parameters Tolerance and Softness.

This effect is really useful to change a drawing with simple colors.

Original image              Modified image

The Color > Curves effect

Each pixel on the screen is defined by its components: 
* The so-called R.G.B.A generates the color of a pixel with four components: red, green, blue and 
alpha. In this system, the values of the four components vary between 0 and 255.
* The H.S.L.O system generates the color of a pixel using four other components: hue, saturation, 
luminosity, opacity. In this system, the values of saturation and luminosity may vary between 0 and 
255, the hue may have a value between 0 and 359 (thus the previously used concepts of angle 
and color wheel).
Inversely, any pixel on the screen may be broken down in each of the two coordinate systems. 
Modifying the color of a pixel therefore means you modify the values of its components.

The  Curves effect  enables  precise  management  of  these 
modifications: the  Mode  popup menu offers a choice between 
the two systems described above.

Let's go, for example, into the H.S.L.O system and take a look at 
our  image.  Next  to  the  name  of  each  component  we  find  a 
miniature  profile,  comparable  to  those  we  encountered  when 
studying the drawing tools and acceleration of an effect.
Click on the luminosity miniature profile to call up the edit profile 
window.
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The effects in the Color menu

The options proposed are traditional: flip the curve along the « X » 
or « Y » axes, use pre-defined curves,  save the settings,  modify 
interpolation of the points… 

Now we just have to study the meaning of the curve:
*  The horizontal  axis represents all  luminosity values that  may be contained in  a pixel  on the 
screen (values between 0 and 255)
* The vertical axis (also known as  LUT:  Look Up Table) represents all  luminosity values of the 
pixels once the Curve effect has been applied.

Let's take the curves below as examples:

We have just studied the luminosity curve in detail. Now it's up to you to work with the other curves 
and use them to the advantage of your projects. 

The Color > Histogram effect

We have just seen that it is possible to work on pixels using curves.
TVPaint  Animation also offers the possibility  to work on the colors on a more «statistic level» 
thanks to the Histogram effect. 

The first function of the histogram is to provide information about the distribution of colors on the 
screen.
Let's take for example the images below and select the  Master tab  in the first row of tabs and 
Luminosity in the second. We will obtain the following graphs :

 >    > 

The Log box enables use of a logarithmic scale instead of a proportional scale. For the moment, 
pay attention that this box is not checked …

* The more dark pixels the image on the screen contains, the more dense the graph is to the left 
(this is the case for our red planet).
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*  In  this  example:  the  luminosity  of  every  pixel  is  divided  by  two  after 
application of the effect (for example, a luminosity value of  50 changes to 25 
after application of the effect).

* In this example, the luminosity of every pixel remains unchanged.

* In this last example, any pixel with a luminosity value between approximately 
64 and 192 will turn black, the others remain unchanged.



The effects in the Color menu

* The more light pixels the image on the screen contains, the more the graph is concentrated on 
the right (this is the case for the image of the tree).

For a luminosity value  given in the abscissa, the graph proportionally represents the quantity of 
pixels of the image having this luminosity value on the ordinates axis.

The blue curve represents the percentage of pixels having at least attained the luminosity value in 
the  abscissa,  the  vertical  red  line  represents  the  pixels  the  luminosity  of  which  is  the  most  
represented on the screen.

The second function of the histogram, as you may have guessed already, is to modify the color 
properties of  the image or video of the current layer (here again,  the animation keys lock the 
parameters for a given position in the timeline).
To do this, we have to use the slider system of the histogram. You may use two, three or four of  
them. The latter enable re-calibration of the histogram by stretching or contracting it.
Let's  again  take  a  look  at  the  pixel  luminosity  component.  Below,  you  see  the  example  of 
luminosity modification using the three sliders:

      
    Before application of the FX stack      Settings                                               After application of the FX stack 

The section of the histogram between the abscissas 25 and 128 will be contracted to fit between 
the abscissas 0 and 51. The section of the histogram between 129 and 255 will be stretched to fit 
between abscissas 52 and 255.
This means that the dark components of the pixels in the image will be reinforced and contracted 
whereas the light components of the pixels in the image will be redistributed, spread and therefore 
reduced.

The first row of tabs contains four tabs: Master, Shadows, MidTones and HighLights.
* Clicking the Shadows tab limits the impact of the slider modifications to the dark colors, gradually.
* Clicking the  MidTones  tab limits the impact of the modifications to the medium tones and will 
reduce them progressively and finally cancel them out for the dark and light colors.
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The tabs Red, Green, Blue and Alpha work according to the same principle 
and  image analysis is reduced to the channels of the corresponding colors.

The tabs Red,  Green,  Blue and Alpha make the other graphs relative to the 
current image appear. Each of them may be modified independently of the 
others.

The principle of contracting and stretching is the same, regardless of how 
many sliders are used. Only the number of contracted or stretched intervals 
changes..



The effects in the Color menu

* Clicking the  HighLights  tab limits the effects of the histogram modifications to light tones, the 
latter waning progressively then canceling out for the medium and dark tones.
* The Master tab affects all color ranges in the same way.

Look at the following graphs for a better understanding:

= + +

Three curves are represented:

* The black curve represents the impact of the modifications in the histogram on the dark tones 
(Shadows tab)
* The gray curve represents the impact of the modifications on the medium tones (MidTones tab)
* The white curve represents the impact of the modifications on the light tones (HighLights tab)

The tones concerned are located on the abscissa.
The impact power is represented on the ordinates axis (the higher the curve for a given range, the 
higher the influence of the histogram modification on this range).

The Color > Sliders effect

In addition to the effects affecting the color on a  « geometric » and « statistic » level, there is a last 
color correction effect which is more complete and is applied using sliders (as the name implies 
…).

* It also has four tabs: Master, Shadows, MidTones and HighLights  which have the same task as 
those in the Histogram tool: used to choose whether you wish to work on lighter or darker color 
ranges.

  

*  The  following  four  tabs:  Gamma,  Contrast,  
Gain, Brightness control how the LUT curves will 
be modified when a slider is moved.

*  The  seven  lines  correspond  to  seven  LUT 
curves  (see  above)  which  may  be  modified: 
Temperature, Magenta, Luminosity, Red, Green,  
Blue and Alpha.

When the  Gamma tab is selected, moving the 
slider  to  the  right  increases  the  height  of  the 
L.U.T curve (and therefore increases the values 
of  Temperature,  Magenta,  Red,  Green,  ...)  for 
the  range  selected  (Shadows,  MidTones, 
HighLights).  The  ends  of  the  curve  are  less 
affected  by  the  slider  modifications  (the 
modifications take place progressively).
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The circled sliders in the graph opposite are used to move, contract 
or stretch the three curves and, consequently, modify the effect of 
the tabs.



The effects in the Color menu

When the Contrast tab is selected, moving the slider to the right increases the height of the L.U.T 
curve in its high sections and decreases the curve in its low sections for the chosen range. This 
means that the strong values of (Temperature, Magenta, Red,…) will be reinforced and the weak 
values reduced for the range of your choice (moving the slider to the left produces the opposite 
effect).

The Gain tab functions in roughly the same way as the Contrast tab, but the ends of the curve are 
gradually less affected by the slider modifications (the modifications of the values of Temperature, 
Magenta, Red,… are the same as with the tab Contrast but work in a more subtle and progressive 
manner).

The effects of  the  Brightness tab  are similar  to the  Gamma tab but  the modifications are not 
applied in a progressive fashion due to the identical attribution from one end of the curve to the 
other.

The Color > Scan Cleaner effect

This effect is used to clean up a scanned image drawn by hand.  Let's take a look at the sketches 
below (the original ones is on the left). 

      >>    (1)

          >>   (2)

This effect will  not only make the light pixels of the image transparent and color the remaining 
pixels black (1) but will also remove unwanted pencil marks (2)
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The effects in the Color menu

The diagram below illustrates the role of the profile curve present in this effect :

The Colors > Line colorize effect 

This  effect  allows  you  to  colorize  the  lines  of  your 
drawings,  following  the  colors  filled  on  the  other 
layers. 

Three parameters can be managed :
•  Radius  (which allow you to choose the spread of 
uour colorize effect, following the  line's thickness).

         
From left to right : Radius to 0, 5, 10 and 15.

• Couleur Source (that will define the color reference to colorize your line). Let's take this image, 
composed of several layers (below and above the layer lines).
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The effects in the Color menu

The Color source mode “Foreground” : as a part of the herb layer 
is above the line layer, the lines of the feet became green.

  

The  Color  Source mode “Background” :  colors  from the layer 
below is used as a reference to colorize the drawing lines.

The  Color  Source mode  “Display”  :  all  colors  visible  have an 
influence on the drawing lines.
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The effects in the Color menu

•  Render mode:  this paramater will  allow you to choose the spread of the effect,  following the 
Manhattan mode (rectangular spread) or Euclidian mode (circular spread).

Original image

Manhattan Mode

Euclidian Mode
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The effects in the Color menu

The Color > Expand mode 

This effect is used to expand a span of colors, but it will respect the notions of color gradient and 
smooth on your image.

The options Radius and Render mode are identical to the options met with the Line colorize effect.

Two squares with a color gradient 
and a smal smooth on the borders

The Expand effect applied with a radius of 10, in Euclidian mode

The Colors > Image Source effect

It is necessary to know a few effects of the Stylize group (like Drop Shadow, Add 
Border or Lumix, ...) in order to master the Image Source effect perfectly. So it will 
be studied at the end of lesson 15.
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The effects of the Keying menu

The effects of the   Keying   menu  

The Keying menu contains all effects which are used to make a color on the screen transparent. 
These effects are sometimes called cut-out and incrustation effects.

The Keying > Luma Keyer effect

The Luma Keyer effect is used to render pixels transparent according to their luminosity.
When you have scanned an image on a white background you obtain a completely opaque layer. 
With  the  Luma Keyer  effect  is  is  therefore  possible  to  make  the  white  pixels  of  this  image 
transparent:

  >        

Let's take a look at the drawing on real paper above. Application of the Luma Keyer effect set with 
correct parameters will render the light pixels transparent (independent of their hue and saturation), 
progressively increase the opacity of the medium tone pixels and leave the dark pixels intact. This 
gives us the image shown to the right.

These are the functions of the Keying > Luma Keyer effect:
* The Display popup menu is used to choose between viewing the source image and viewing the 
result.
* The color box is used to choose the color the luminosity of which you wish to render transparent  
directly on the screen.
* The buttons + and –  are used to adjust the tolerance and softness of pixel cut-out.
* The mini-sliders allow adjustment of the following, depending on the luminosity and with the help 
of the diagram below:

It is recommended to combine the Luma Keyer effect in a multiple FX stack 
with  the  Colors  >  Histogram  or  the  Colors  >  Slider  effects  to  be able  to 
precisely adjust pixel transparency (use the parameters relative to the alpha 

component) and remove the gray aspect (light) of semi-transparent pixels.
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At  this  point,  it  is  possible to re-color the image, if  desired : 
simply place a layer under the image obtained and spread the 
colors of your choice on it (see example opposite).

You may also use the shape floodfill tools studied in lesson 6.

The type of pixels which remain opaque

Those which are progressively made transparent

Those which will be completely transparent
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The effects Keying > Luma Keyer and Colors > Scan Cleaner change the opacity 
of the pixels differently : the  Luma Keyer doesn't remove the unwanted pencil  
marks. The Scan Cleaner change the color of the pixels, and the Luma Keyer 
doesn't.

The Keying > Color Keyer effect

  

The Color Keyer effect uses the same principle as the Luma 
Keyer effect.  It  deletes the selected color on the image or 
video footage of your choice.
It is no longer required to concentrate on pixel luminosity but 
on the entire color.

Two types of parameters may be locked with a key: Tolerance and Smooth.
In the FX stack above we see: the higher the value of the Tolerance parameter, the more colors 
close to « blue » will be deleted.
The higher the value of the Smooth parameter, the less abrupt the transition between opaque and 
transparent pixels will be.

       

Opposite,  most of the bluish colors of the sky 
and cloud become transparent.

The green and dark colors of the tree are further 
away from blue and therefore opaque.

With the Invert parameter, the effect can keep the color chosen in the Color parameter whereas to 
remove it.

    

The  opposite  image  shows  the  result 
when the Invert parameter is checked.

These two keying effects may, of course, by applied to a complete footage, 
which makes work easier when using a scanner with loader or a recorded video 
sequence.

Let's take another concrete situation :
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The character nearby was shot in front of a blue screen. We are going to explain how to remove 
this blue background and to replace it by another background.
It's  a  technique  often  used  for  animation  :  weather  reports  are  shot  with  a  single-colored 
background which is removed and replaced by a weather chart.
Let's go back to our character : the purpose is to make transparent all  the blue pixels and to 
display a new background on another layer. To do so, let's load a landscape background nearby 
and put it as an Animation layer, under the layer containing the character.

       The blue color is called key color (that's why the effect is called keying).

You should have a timeline looking like this :

    

  

The same method is also used to create a weather report (see below)

      

There are other keying effects, more complex, which have to be used in some specific situations.
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Now select the Color Keyer effect in the FX stack.
Choose  a  blue  pixel  from  the  background  and  adjust  the 
tolerance and softness parameters.

Apply the effect  to  the whole  image sequence,  and here it 
goes, the blue background has disappeared and is replaced 
by the landscape.
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The Keying > Chroma Keyer effect      

The Keying > Chroma Keyer effect is used to make pixels transparent depending on their tint and 
saturation.

         

The panel and the buttons of this effect look very similar to the ones of the effect 
Color > Color Eraser. That's why we will not explain each parameters in details...

Let's take for example the video sequence above with orange and red flowers. The background of 
this sequence is a blue-gray shutter (more or less dark blue-gray tints).

If you use the Keying > Color Keyer  effect by selecting one of the dark shutter colors, it will not 
remove all the shutter pixels but it will remove some pixels of the flower's stalk too. (see below (1))

If you use the Keying > Color Keyer effect by selecting one of the light shutter colors, it will remove 
all the pixels of the shutter but it will remove the light pixels of the flower's too. (see below (2))

    (1)        (2)

The results above, obtained after the use of the Keying > Color Keyer effect, are imperfect.

The Keying > Chroma Keyer effect will help us to obtain better results.

   

* The Tint parameter bar will make transparent the blue pixels in a wide range : light blue or dark 
blue will not change the result. The orange-red pixels of the flowers and the green pixels of the 
stalk will stay unchanged.
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* The Saturation parameter bar permits to make green pixels more or less transparent depending 
on their saturation. As a consequence, we will be able to make transparent all the blue-gray pixels.

Here is the result : we finally succeed to keep the pixels of the flowers visible and make the pixels 
of the shutter transparent.

    >>  

To finish our work, we can easily add a landscape on a layer and put it behind the flowers layer. 
(see the timeline below)

      >> 

Let's go back to our blue-screened character :

Although we used the Keying > Color Keyer effect with the our blue-screened character in the last 
chapter, you certainly guess that it is also possible to use the Keying > Chroma Keyer effect.

When characters are shot with blue screen, there are sometimes some undesired light effects, 
especially little blue reflections colorizing some part of the image (see image below on the left).

It is of course possible to remove the blue tint to these pixels by making them grey.  That's the 
function of sliders and buttons from the Spill Removal section of the panel.

    >>   
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The Keying > Alpha Control effect     

Let's take back the example of our flowers. The Keying > Chroma Keyer has been already applied 
and the landscape background is visible behind the flowers. If you look at it in detail, you will see 
that some imperfections remain : a black borderline, more or less visible, is still remaining, small  
lines or points are not fully transparent and stand out from white clouds.
The Alpha Control effect can fix these errors.

     > 

Here is how the effect appears in the FX Stack : 

* You can first notice the presence of a histogram, a 
tool you are now familiar  with.  This  one represents 
the quantity of pixels displayed on screen depending 
on their luma (in percentage).

* In the bottom of the panel, there are some numeric 
fields and mini-sliders at your disposal :

The Shrink parameter can trim the opaque pixels of the image. That is the best to remove the black 
borders around the flowers.

The  Erode  parameter erase progressively the opaque pixels  of  the image by starting from its 
borders. It permits to soften the transition between transparent pixels and opaque ones, and even 
to improve the superimposition effect.

Both  Blur  parameters  can reduce and soften the shapes borders between opaque pixels  and 
transparent ones.

The  Gain parameter permits to turn opaque and to darken pixels which are almost transparent.  
This is very useful to stand out the little imperfections, especially the ones that have not been fully  
removed when using some Keying effects.

On the opposite, the Lift parameter can turn opaque the pixels which are almost transparent.

      
    Use of the Erode parameter               Use of the Shrink parameter           Use of the Gain parameter set to 1000% 
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The Keying > Advanced Keyer effect     

The  Advanced  Keyer  is  the  most  complex  and  the  most  powerful  Keying tool  in  TVPaint 
Animation Professional Edition. Experienced users often use it for very accurate keyings.

We have already seen that each color can be broken up in various ways depending on the color 
system (RGBA, HSLO, YUV) while each system defines color channels. (the YUV system is used 
by the NTSC and PAL video formats)

The Advanced Keyer effect permits to cut-out on each color channel which allows you to do very 
accurate keyings. (see below) 

    

* The Key tab lets you adjust the keyer in the different color systems.

* The Matte tab has the same function as the previously described Keying > Alpha Control effect 
so you can just adjust the cutout process better.

*  Finally,  the  Spill  Removal  tab  is  also  available  and  works  the  same  as  the  Keying  > 
Chroma Keyer one.

        

Working with the Hue and Saturation component of the HSLO system is the same 
than working with the Keying > Chroma Keyer effect.
Working with the Luma component of the HSLO system is the same as working
with the Keying > Luma Keyer effect.
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The Keying > Cross Keyer effect     

          
The Keying > Cross Keyer effect works in a different way than the other keying effects :
It doesn't require to select a range of colors in a color system like RGB, TSL, YUV, etc ...
In this effect, you only need to define a first region whose colors will be kept, and another region 
whose colors will become transparent.

Selecting those two regions can be easily done thanks to the two dedicated Region buttons :
* To select the colors you want to keep after applying the FX, just use the left mouse button on the 
Keep button. After this you will be able to select an area directly on the HUD. (your cursor will be  
changed into a lasso)
* To select the colors which will become transparent, you can use the same method with the Drop 
button.

When selecting a new area on the HUD :
* Use the left mouse button to add it to the previously selected area.
* Use the right mouse button to subtract it from the previously selected area.

To visualize the render of this effect, use the right mouse button on the current activated button 
(Keep or Drop). Of course, the result depends on the two areas you have just selected.

In the example below :
On the left image : there are two areas located on the sky and on the pathway. They indicate the 
colors (red and cyan) that will be kept on the whole picture.
On the right image : there is one area located on the grass and on the trees. It indicates the colors 
(orange and green) that will be dropped.
The picture in the right shows the result after applying the effect :

      >  
    Keep region                                         Drop region                                              Final result

      

* The  swap keep and drop regions button allows to swap the 
Keep and Drop regions.

It is then possible to obtain the opposite result.
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* The Mix parameter allows to extend or restrict the number of colors located in the transparent 
area of the resulting image.

        
     Mix = 0%                                                Mix  = 50%                                            Mix  = 100%

*  The  Edge parameter  allows to adjust  the mixing level  between the transparent  and opaque 
pixels.
The lower the value will be, the less the two regions will differentiate. The higher the value will be, 
the sharper the edges will appear.

        
      Edge = 0%                                            Edge = 50%                                         Edge = 100%

*  The  Spill  Removal parameter  has  the  same  function  as  the  Spill  Removal parameters 
encountered in the effect Keying > Chroma Keyer : it unsaturates the undesired light reflections.
In the example below, we zoomed on the frontier between the grass and the pathway.

        
     Source Image                                       Spill Removal  = 0%                             Spill Removal = 100% 
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Lesson 13

The effects of the Stylize group

In this lesson, you will :

● Discover some effects of the Stylize group dedicated to animation.

● Discover some effects of the Stylize group dedicated to video-editing.



Introduction

Introduction

The effects of the Stylize menu are often used to work on logos, drawings or video footages. We 
will take the images below as reference images for our examples:

        

The Stylize > Glow effect

It is possible to create an aura around a text or any other image containing transparent pixels … 
The Width, Height, Color and Opacity of this aura may change in time thanks to the key system.

      

The Stylize > Grain effect

This effect adds a noise (polychromatic or monochromatic) to the image or video footage of your 
choice. The  Size  parameter is used to set the size of the grains, the  Range  parameter controls 
their distance. 
It is also possible to adjust their color using the parameters  Red Variation, Green Variation and 
Blue Variation as well as modify their transparency.

If a logo is placed in front of a filmed sequence, application of a light noise on the logo helps 
integrate it into the sequence and minimize the « computer » look of the latter. The noise effect 
may also be used to smudge an image or drawing in a different way than a blur effect.

          
 Original image                Monochromatic noise            Polychromatic noise

    
       Original image                                   Blue polychromatic noise                  Noise with larger grain size
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The  running  kid  and  the  TVPaint  logo  are 
located over different background layers.



The Stylize > Bevel effect

The Stylize > Bevel effect

This effect is used to give volume to your logos or drawings.
The Mode popup menu is used to choose between creation of an inner or outer relief. You may 
also use both effects at the same time, which gives a relief effect to the contours of your image.
To give an image relief you must set the Size of the bevel as well as its Lighting using the following 
parameters: Force, Altitude, Direction, Color and Power. 
The Smooth parameter enables attenuation of rough contours by applying a slight blur.

    
Inner bevel                                               Outer bevel                                             Inner and Outer bevel

            
                                 Inner bevel                                  Outer bevel                           Inner and Outer bevel

The Stylize > Drop shadow effect

This effect is useful to add a shadow to a logo or any other image that is not entirely opaque.  
Color, Direction, Distance and Opacity are parameters that may be set using keys at your disposal. 
In this way you can make the shadow of your logo move as if a light source were moving above it.

          
Various shadow distances and directions 

            
Traditional shadow and blurred shadow

(the background and the running kid are located on different layers)

The  Shadow only option  of  the  Toonshading  and  Drop Shadow effects will  be 
studied later in the chapter called « the Color > Image Source effect » 
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The   Stylize > Toon Shading   effect  

This effect differs from the drop shadow as it enables creation of a shadow inside an image. The 
transparent pixels are not affected by the creation of your shadow (see below).

                 
                  Toon Shading                                                      Drop shadow

Let's take the shape filled with white below as an example to study this effect: 

              
     The panel of the toon-shading effect                     Our reference image                     The HUD of the effect

- The Color box is used to choose the color of the shadow you will create.
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- The Intensity option is used to vary the power of the shadow in time:

          

- The Profile option is used to vary the nature of the shadow:

          

                          

- The Size in pixels sets the range of the shadow:

          

-  The  Angle  parameter  is  used  to  choose  the  direction  of  you  lighting/shadow.  When  using 
animation keys, the Rotation parameter reflects the number of complete rotations to be carried out 
before arriving at the chosen angle.

           

- The Spread parameter (in degrees) defines the angle over which the shadow will be spread.
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Using the  HUD is  very practical  to adjust the angle,  size and spread of your 
shadow.

- The Ray Count parameter refines the result when applying the effect. The higher this value, the 
higher the quality of your image, the lower the value, the more noise your shadow will contain.

          

- The  Border box, if checked, is used to create a shadow from the borders of your project (see 
below).

                    
            Original image                            Border option not enabled          Border option enabled

Once you know how to use the Toon-shading effect, it is possible to create all kinds of shadows for 
your characters:

            

The  Shadow only option of  the  Toonshading  and  Drop Shadow effects  will  be 
studied later in the chapter called « the Color > Image Source effect » 
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The Stylize > Erode effect

This effect enables eroding the contours of an image or video footage.
This may create an interesting effect for the appearance or disappearance of images as well as for 
the attenuation of contours (see below…). There are two parameters that may be adjusted using 
keys : Width and Height.

            

The Stylize > Add Border effect

This effect is in a way the opposite of the  Erode effect.  It  enables creation of a border of the 
thickness of your choice around an image. As TVP Animation works with sub-pixel precision, it is 
possible to increment this thickness in steps of 0.5 pixel using the associated mini-slider.
It is also possible to choose the color of the border.

  

Here again, the option Border only will be studied later in the chapter called « the 
Color > Image Source effect » 

The Stylize > Bloom effect

        

This effect produces a light blurred aura on the current image and may give an unreal aspect to an 
animated footage. Contrary to the  Glow effect this bloom is applied to the opaque areas of the 
image.
The parameters Width and Height are the same as those for the Glow effect.

If you wish, you may apply the bloom effect to the channel of your choice (Red, Green or Blue) and 
control Blur, Saturation and Luminosity of this aura.
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The Stylize > Blender effect

        

This effect blends the original image in a certain way and then transforms it into a large puzzle, the 
pieces of which have distorted contours. The adjustable parameter enables random modification of 
the result.

The Stylize > Mosaic effect

              

This effect was already studied in lesson 9. It enlarges the pixels on the screen to the Width and 
Height of your choice.

The Stylize > Posterize effect

        

This effect is used to reduce the number of colors on the screen and simplifies the original image 
or video footage. The Number of colors parameter may be set using the mini-slider and locked with 
a key.

This  Number of  colors  parameter  does not  represent  the  exact  number  of 
colors on the screen but  the number of  colors blended to obtain the effect 
required.
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The Stylize > Noise effect

        

This effect moves the pixels of the original image at a distance corresponding to your parameter 
setting. 
You may also choose the percentage of pixels of the original image to be moved.

Well applied, this effect gives the impression that one sees the image or video footage through 
frosted glass.

The Stylize > Print effect

        

Have you ever looked at a comic or cartoon strip through a magnifying glass? The color areas are 
made up of superposed round points of different sizes and colors.
The Print effect reproduces exactly this aspect.

You may choose to work in Color, in Black & White or work only on the non-opaque areas of the 
image…

        

The Size parameter is used to set the size (and therefore the number) of dots on the screen.
Above you see the Print effect applied with the Color channel and with the Black & White channel.
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The Stylize > Negative effect

        

This effect replaces the color of each pixel with its negative.

The Stylize > Solarize effect

        

This effect reproduces the photographic effect named solarization which consists of mixing the 
colors of an image with the colors of its negative.

The Stylize > Color Range effect

        

This effect substitutes the colors of one of the channels Red, Green, Blue, Alpha or Luminosity with 
those of the gradient of your choice (see lesson 3 for gradients).

In the example above: the gradient blue > orange > yellow was applied on the image's luminosity 
channel: 
the yellow pixels replace the light pixels of the image,
the red pixels replace the mid tone pixels,
the blue pixels replace the dark pixels.
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   These two effects have no parameters.



The Stylize > HalfTone effect

The Stylize > HalfTone effect

        

        

The Halftone effect reproduces the aspect of a « grid » on the current image and gives the current 
image the appearance of an «artist's canvas».

* You may set the parameters for the horizontal and vertical cells (H cells and V cells), Direction,  
Opacity of the grid as well as their type (Line, Dot, Cross, Checks, Blocks, etc.).

* There are also several application modes: Color on black, Color on white, Saturation, etc.

* Finally, you may use the Jitter parameters which will slightly modify the shape of the grid.

The Stylize > Lumix effect

This effect exchanges the luminosity values of the pixels in an image or source video footage with 
those of another image or footage, which gives the impression of seeing an image through the 
contours of another image (see below).

        >>   
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    >>  

The Source Image notion

A source image or footage is used in the Rendering box of the Lumix effect and some other effects 
(in particular the Motion > Keyframer effect which will be studied later). Let's discuss this further:

TVP Animation offers some effects which require the use of an image or footage other than the 
current image. These are referred to as source images or footages.
Several choices are available for the so-called source images or video footage: the project of your 
choice, the layer of your choice, the current brush or animated brush, the spare image, the paper, 
the current display, the FX stack.

                         

* The choice FX stack will use the current image with the effects of the FX stack applied as Source 
Image before applying the parameters set for the Source Image.

* The choice Current layer allows you to apply the effect from the current layer.

* The choice Display allows you to apply on the current layer the effect from the footage viewed 
when playing your project (the effect will be that all layers appear to be merged, while the hidden 
layers are not taken into account).

* You may also choose to use the Spare Image or Paper if they are available.

* When choosing another project, layer or brush, you may adjust the Pre- and Post-Behavior, the 
position and the animation mode: the number « n » of the Position parameter corresponds to the 
image « n » of your project, animation layer or animated brush. 

The Animation mode controls the  « behavior » of your brush, layer or project: random animation, 
ping-pong, animation reduced to the image indicated in the position parameter, etc.

If  the number of source images is lower than the number of images to which your effects are 
applied, you may adjust the Pre- and Post-Behavior for your source (random, pingpong, loop, etc.).

As required, you may choose to flip your source vertically, horizontally or both, before using this  
source.
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The Colors > Image Source effect

The Colors > Image Source effect allows you to display the image or the sequence of your choice 
on the current layer.
* The Source menu use all notions encountered in the last paragraph. As a consequence, you can 
choose to display the current layer, another layer, a paper, the spare image, another project, the 
current custom brush, etc.
* The Blend popup menu is used to choose the mode to be used when drawing the Source Image 
or Sequence on your current Layer (Color, Behind, Erase, ...)
* The Opacity parameter allow you to adjust ... the opacity of the displayed image or sequence.

This effect could seem simple, even obvious, but it has a lot of useful applications :

1  st    example :  

  >>  >> 
   Original image                                  After applying the effect                 After applying all the FX-stack
                                                              Stylize > Glow only                               
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On the unique layer of our timeline, a «TVPaint» 
logo has been drawn. We are going to replace it 
by its own glow.

Let's take a look at the FX-stack opposite :

1)   The  first  effect  that  will  be  applied  is  the 
Stylize > Glow effect.

2)   The  Colors  >  Image  Source effect  is  the 
second  effect  that  will  be  applied.  The  Source 
selected is Current layer and the Blending Mode 
is the Erase Mode.

In this way, the «TVPaint» logo will be removed 
just after the rendering of the glow on the screen.

This process works with other effects 
of the  Stylize group like  Add Border 
or Bevel (with Outer option selected). 

(For  the  Drop  Shadow and  Toonshading 
effects, please study the next example)



The Colors > Image Source effect

2  nd   example :  

In this example, we will create a shadow for the running kid thanks to the  Stylize > Toonshading 
effect. This shadow will be rendered on an empty animation layer.

     

In  the  FX-stack  opposite,  the  Stylize > 
Toonshading effect  will  be  applied  on  the 
animated  layer  called  “Toon  Shading”.  (see 
the timeline below)

The effect Colors > Image Source  allows you 
to specify the reference layer used to render 
the shadow. Here, the Source is the animation 
layer called “color”.

If we use the Erase blending mode as we did 
in  the  first  example,  the  shadow  will 
disappear.  (the  toonshadow  is  inside  the 
running kid)

That's the reason why we will keep the Color 
blending  mode  and  use  the  Shadow  Only 
option of the Stylize > Toonshading effect.
It  allows  us  to  create  the  shadow  of  the 
running kid without re-drawing it.

It is then possible to generate a shadow for 
our running kid on a separate animated layer.
As  a  consequence,  the  character  is  not 
altered by the rendering of the shadow.

In this example, the Colors > Image Source effect allows you to define an image or an animation 
sequence as reference for the “following” toonshading effect in your FX-stack.

   

In this example, it is also possible to replace the effect Stylize > ToonShading by the 
effect Stylize > Drop Shadow. (the Shadow Only option is also present in this effect)
In that case, you will  obtain a classical shadow. Of course, the character layers 

(colors and Running Kid) will stay unchanged.
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The Colors > Image Source effect

Here is the 3D view of the layers you can obtain after using the effects  Colors > Image source, 
Stylize > Drop Shadow and Stylize > Toonshading.

    

Toonshading Layer

Borders Layer

Colors Layer

Drop Shadow Layer

Background Layer

 

                                         

The resulting image

The effects of the Stylize group 13-15



The Stylize > Convolve Effect     

The Stylize > Convolve Effect     

The  effect Stylize >  Convolve  allows  you  to  modify  the  pixels  of  an  image  or  an  animated 
sequence by using a matrix (here below on the right).
For the neophyte, a matrix is an ordered set of numbers listed in a rectangular form. For the 
mathematicians, it is a powerful and convenient calculation tool used in algebra.
To open the matrix relative to this effect, just click on the Edit button of the panel.

   

The matrix of our effect contains 13 rows and 13 columns, and as a consequence 169 numerical 
fields. Each numerical value is usually called coefficient.
The grey boxes are located on the two diagonals of the matrix. It usually gives a better readability  
when you fill in the matrix.

We have already seen that each color can be broken up in various ways depending 
on the color system. For example, the Slider tab of the Color Picker panel gives the 
numerical values of the A color in the R,G,B and T,S,L color systems.

The Stylize > Convolve effect calculates a new value (and so gives a new a color) for each pixel in 
an image or an image sequence by using the values (and so the colors) of its neighboring pixels. 

In the mathematical point of view, each new value in the R,G,B color system will be calculated by 
taking the average of itself and the pixels surrounding it. It is a weighted average using the matrix 
coefficients.
Well, you are an animator, not a mathematician, it  doesn't help you a lot to get an idea of the 
internal working of this effect...

How to obtain convincing results by changing the numerical values of the matrix ?
The examples below should help you in this task.

1  st    example : How to create a Blur  

 
Using  this  3x3 matrix  (3  rows,  3  columns)  will  make each pixel  modify  itself  according to its 
neighboring pixels.

The surrounding pixels will have more weight (or will be more represented) than the central pixel :
this is exactly the common process to render a blur effect.
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Let's take a look at the matrix opposite : each coefficient is equal to 3, 
except  the  central  coefficient  which  is  equal  to  1.  All  the  other 
coefficients are equal to zero (and not visible here)

Here is an example. In the TVPaint logo opposite :

* The white and opaque pixels outside the TVPaint logo are most often 
surrounded by opaque white pixels.
A weighted average of white pixels gives ... a white pixel.



The Stylize > Convolve Effect     

 
 

                              
Below, two zooms on the « T » letter of the TVPaint logo :

    >   
 Before applying the effect        After applying the effect  

    >   
And here is the final result :

   >  
              Before applying the effect                                 After applying the effect  

2  nd     example : What happens with a bigger matrix ?  

 
Using  this  5x5 matrix  (5  rows,  5  columns)  will  make each pixel  modify  itself  according to its 
neighboring pixels. We use here a larger radius than in the 3x3 matrix of the first example.
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From the result above, it is possible to deduce 
the result  of  the  Stylize >  Convolve effect  on 
some pixels 

Here is the result on a wider area of pixels.

The TVPaint logo begin to get blurred ...

* For the pixels located at the frontier between the blue and white areas, the situation is a bit  
more complicated : a weighted average of blue and white pixels gives a more or less light blue, 
as shown below :

* The blue pixels inside the TVPaint logo are most often surrounded by 
blue pixels.
A weighted average of blue pixels gives ... a blue pixel.

Let's  take  a  look  at  the  matrix  opposite  :  each 
coefficient is equal to 3, except the central coefficient 
which is equal to 1. All the other coefficients are equal 
to zero (and not visible here)

In  this  case,  the  principle  is  the  same  as  the  one  enunciated 
above,  but  more pixels  are  taken into account  to calculate  the 
average
It gives a larger blur than the one obtained with the 3x3 matrix. 
(see next page)



The Stylize > Convolve Effect     

Below, two zooms on the « T » letter of the TVPaint logo :

    >                  >     
 Before applying the effect        After applying the effect               Before applying the effect       After applying the effect 

    >    
           Before applying the effect                                      After applying the effect  

It is easy to understand that the bigger your matrix will be (the more coefficients equal to 3 in our 
example), the more pixels will be used to calculate the resulting colors. (the larger will be the blur in 
our example) Here is what you can expect by using bigger matrix, constructed in the same model 
than the one above.

 
 Above the source image. Below the blurs that you can obtain by using a :

                   
        3x3 matrix                                      5x5 matrix                                       7x7 matrix

                   
        9x9 matrix                                     11x11 matrix                                    13x13 matrix

The execution speed of the  Stylize > Convolve effect depends on the number of 
coefficients which are different from zero inside the matrix. In other words, the more 
zero coefficients you will have in the matrix, the faster the effect will be applied.

3  rd   example : How to have a sharper image :  

Obtaining a sharper image is the opposite as obtaining a blurred image.

The surrounding pixels will have less weight than the central pixel : in other words, they will be less 
represented than the central pixel.

Now we can apply this effect to our logo :

     >     
          Before applying the effect                                        After applying the effect  
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Let's take a look at the matrix opposite : each coefficient is equal to -2, 
except  the  central  coefficient  which  is  equal  to  22.  The  central 
coefficient is really higher than the coefficients surrounding it.



The Stylize > Convolve Effect     

As seen above, the weighted average of the blue (or opaque white) pixels gives ... a blue (or white) 
pixel. That's not always the case, as we will see later.

 

It results a sharper image ...

4  th   example : how to draw the edge of a picture :  

In order to obtain the edges of a picture, you need to have a sharper image and you need also to 
make the pixels surrounded by same color pixels become black.

In this case, the pixels surrounded by pixels with the same color will become black. The weighted 
average of the values (or colors) is equal to 0.

The pixels at the frontier between the blue logo and the white background will be strengthened.
Here is the result :

     >     
           Before applying the effect                                       After applying the effect  

5  th   example : How to emboss an image.  

Adding relief to an image can be done by strengthening the pixels colors in a given direction and 
by reducing the impact of the pixels colors in the opposite direction.

     >     
Before applying the effect                 After applying the effect  
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To do so, we will use a matrix which coefficients are close from those we 
used in the last example. Please note that the sum of the surrounding 
coefficients is equal to the opposite of the central coefficient.

The matrix opposite allows to emboss the image as if a light source 
was  added  at  its  right.  (all  the  layers  have  been  merged  before 
applying the effect)

For the pixels located at the frontier between the blue and white areas, the 
situation is a bit more complicated : they will become more visible than the 
blue and white pixels surrounding them.
In other words they will become a little darker.



The Stylize > Convolve Effect     

Now, let's study a few notions :

* We saw that our effect was modifying the color of the pixels on the screen. It is also possible to 
modify the pixels transparency by using the Use alpha button.

In this case, the calculation of the weighted averages is applied to the alpha component of the 
pixels too.

* The  Border popup menu allows to choose how the pixels at the border of the image will  be 
calculated. (The pixels located at the border of your image don't have neighboring pixels ...)
You can choose to use as neighboring pixels :

- Black pixels (none option)
- Pixels resulting from a symmetry of your image (mirror option)
- Pixels resulting from reproduction of the image (tile option)
- Pixels resulting from reproduction of the last (first) line (or column) of pixels (repeat option)

* The multiplying coefficient allows to multiply all the coefficients of the matrix by the same value. 
It does not change anything to your picture if all non-zero coefficients of your matrix are the same. 
Otherwise your convolution effect will be more or less pronounced.

Some preset examples :
Now that you have some basis about the convolution matrix, you can try to modify the numerous 
matrices at your disposal in the bin menu of your effect.

Below, you will find the results obtained with the matrix :

                      
Blurred Image                             Split  Image                         Only the edges

                      
Embossed Image                       Special lightning                        Other Results       
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Lesson 14

The effects of the Distortion group

In this lesson, you will:

● Manage the symmetry effects.

● Manage the Wrapping effects.

● Create a shadow in perspective.     

● Animate with the Wrapping Grid effect.



The Distortion > Flip effect     

The Distortion > Flip effect     

This effect permit to flip horizontally and/or vertically images in the current layer (see the examples 
below). This effect does not use or require animation keys.

      
      Source Image                          Vertical flip                          Horizontal flip                   Horizontal and vertical flip

The Distortion > Mirror effect     

This effect allows you to do a symmetry in relation to an axis in the current layer.
* The Pivot X, Pivot Y and Angle numeric fields allows you to define the axis the symmetry will be 
applied to.
* When using animation keys, the Rotation parameter reflects the number of complete rotations to 
be carried out before arriving at the chosen angle.
* The Opacity parameter allows you to adjust the transparency of the reflected image.

  >>  
 Source Image                                                 Mirror effect,  opacity 50%

If  needed,  you can move the axis through the HUD interactively  in  the current 
project window.
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The Distortion  > Kaleidoscope effect

The Distortion  > Kaleidoscope effect

As  the  name  implies,  the  effect  imitates  the  view  through  a  kaleidoscope.  In  the  following 
paragraphs, the projects will be considered as having the layers merged.

     >>  
              Original image                                      Use of the Kaleidoscope effect

The number of segments is the number of symmetric axes used to obtain the final image (see 
below).

      
Original image                      One horizontal symmetric    Two symmetric axes            Three symmetric axes
                                                axis                                        (horizontal and vertical)
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The Distortion  > Kaleidoscope effect

      
   Four symmetric axes            Five symmetric axes            Six symmetric axes             Eight symmetric axes

                 And so on ...

The value of the first angular parameter varies the axis formed between the symmetric and the 
horizontal axis.

The  grayish  diagrams indicate  the area  in  the  original  image  which  will  be  duplicated  by  the 
symmetry.
In black, the rotation angle applied before symmetry in relation to the red axes.

Here for one symmetric axis :

         

                                

Here for two symmetric axes :
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The Distortion  > Kaleidoscope effect

The Source coordinates define the position on the screen of a point at which the symmetry axes 
cross each other (see the various examples hereafter).

      

                             

      

                           

The value of the second angular parameter is used to vary the global angle of the image obtained:

      

                

The Destination  coordinates define the position on the screen of an image centre obtained after 
application of the effect (see the various examples hereafter).
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The Distortion  > Kaleidoscope effect

      

      

When the  Fill  option is disabled, the kaleidoscope effect is calculated according to the current 
image. When it is enabled, the calculation is also carried out on all reproductions of the current 
image.

Below, the area inside the white rectangle represents the current project window.
All areas inside and outside the white rectangle represent the space used to calculate the effect.

In the 1st case, the option is disabled, the effect is calculated from the current image.
In the 2nd case,  the option is  enabled,  the effect  is  calculated from the current image and its 
reproductions.

        

In both cases the original project is represented with the result after the effect is calculated and the 
other showing the result obtained when the destination parameter is set to another point.
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The Distortion > Perspective : 4 points effect     

The Distortion > Perspective : 4 points effect     

This effect is constructed in the same way as the Perspective tool  from the main panel, except that 
the position of each point can be moved along a stored path. 

   > 
Source Image                                  Current Image                               Result after applying the stack

* The Position tab allows you to manage the coordinates of the four points used for this effect (the 
four corners of the H.U.D)
* The  Render tab permit to select the type of image, called  Source Image, which will be put in 
perspective (current layer, FX-Stack, other project, brush, etc.).

Associated with the Pixel Tracker (this option will be explained in details in the next 
lesson), this effect can wrap a video sequence or a picture onto a moving shape.
This could be the case if the cameraman was moving his recorder while filming  the 
computer screen above.

Here below, a shadow was created for our character. The two effects Color > Source Image and 
Stylize > Drop Shadow were used in order to have the shadow drawn on an empty layer (go back 
to the last chapters of the last lesson for more details).
This shadow was put into perspective thanks to our effect. We succeed to imitate the projection of 
a shadow on the floor.
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The Distortion > Wave effect     

The Distortion > Wave effect     

This effect imitates water waves, as if a rock was thrown into water. (look at the images below). 
* The Center parameter defines the center of the effect, the position where the rock hits the water.
* The Radius parameter defines the maximal distance the waves will go. 
* The Wave parameter defines the number of visible waves.
* The Amplitude parameter defines the maximum height of the waves.
* The Angle and Rotation permit to animate the waves in time.

    

    

Once again, these parameters can be partly adjusted in the project window through 
the H.U.D.

The Distortion > Tornado effect     

We will take advantage of this image which show clouds to study the Distortion > Tornado effect. 
Have you ever noticed how a whirlpool behaves in a washbasin for example ?
The Distortion > Tornado effect produces the same kind of effect, distorting the image or the image 
sequence (look at the images below).

* Like the Wave effect, you will need to define a Center and a Radius (which can be locked with 
animation keys if needed…).
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The Distortion > Tornado effect     

              >>    >>

>>    >>  

* The Angle parameter allows you to define the power of the applied distortion.
* When using animation keys, the Rotation parameter reflects the number of complete rotations to 
be carried out before arriving at the chosen angle.

The Distortion > Bump effect     

   

The  Bump effect allows the creation of a relief, which 
will  be provided by a source image, over the current 
layer.

The  more  luminous  the  source  image  is,  the  more 
important the relief of the pixels in the current image is. 
The  darker  the  source image  is,  the  less  visible  the 
relief is.

On the right below, the source image and the current 
image are the same. It gives a feeling of relief on the 
whole screen.

     
                   Current image                                              Source image = Current image
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The Distortion > Bump effect     

     
                   Source image = TVPaint logo                     Source image = paper

* You can adjust the depth of the relief and soften the borders using the numeric fields Depth and 
Smooth.
* A relief requires a lighting to be visible : thanks to the Apply with menu, you can define a centered 
lighting thanks to the  Center option, or a directional lighting (Direction option) whose angle will 
have to be adjusted.

The Distortion > Displacement Mapping Effect     

   

The Displacement Mapping effect works the same way 
as the Distortion > Bump  effect : the panel and settings 
are the same.

Regarding the Displacement Mapping : the pixels from 
the current image which correspond to the pixels from 
the source  image will  be  replaced  by  different  pixels 
from the current image.

That means : the software makes a translation of the 
current image pixels along a direction or a center, only 
in the opaque areas of the Source image. 

     
     Current image                                                            Source image  = TVPaint logo

The more luminous the Source image is, the more important the displacement of the pixels in the 
current image is. The darker the Source image is, the less visible the Displacement Mapping is.
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The Distortion > Displacement Mapping Effect     

           
                                         Source image = paper

The Distortion > Wrapping Grid effect

      

The wrapping grid is an extremely useful animation tool and is capable of distorting the images in 
time according to the criteria of your choice.

The  Wrapping  grid effect,  when  correctly  used,  can  produce  quite  spectacular  results:  wave 
movement, 3D rotation of faces, movement of hair blowing in the wind, etc... (below, you will find a 
summary overview of the possibilities proposed).

 >>  >>    (project skull.tvp)
1st image                                Movement                              Last image

Once the effect has been placed in the FX stack, a grid is displayed on the current image.

Some hints for beginners:

* The use of two grids will be necessary for your effects to work correctly: these grids are referred 
to as Source and Destination grids.
The Display popup menu is used to select on which of the two grids you intend to work. 

Depending on your choice, the HUD will be modified accordingly: the letter  S appears when the 
source grid is displayed and the letter D appears if the destination grid is displayed.
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The Distortion > Wrapping Grid effect

     
                      Intersections in the Source grid                        Intersections in the Destination grid

In the  HUD, when the source grid is displayed, the destination grid is always visible behind in a 
less bright color. When the destination is displayed, the opposite case applies.

           
Display of Source and Destination grids (the current grid is green, the other is blue)

* Modification of an intersection in the Source  and/or Destination grid distorts the current image 
accordingly.
The image is distorted, stretched or contracted over a narrower or wider area on the screen so that 
the points on the source grid of your initial image are moved to the same location as the points on 
the destination grid.
Below, source and destination points on a grid with the resulting distortion.

      >>  

* The Point menu is used to edit each grid point present on the screen. The latter may be identified 
by their position on the grid (see below).

     

* The first two numeric fields are used to select the number of intersection points on your grids 
(Source  and  Destination  grids  have  the same number  of  intersections).  You  may increase  or 
decrease the height and/or width of these grids. The limit of the grids is 50x50 intersections.
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The Distortion > Wrapping Grid effect

          
4 x 4 grid                                  8 x 4 grid                                   8 x 12 grid

* The five buttons  present in this panel are used respectively to:
- Edit grid points.
- Distort the grid as a whole.
- Copy the source grid to the destination grid.
- Copy the destination grid to the source grid.
- Swap source and destination grids.

 Edit grid points

* When this option is enabled, each intersection point of your grid (source or destination grid) may 
be moved in space along three axes (width, height  and  depth) the effect of which will  result in 
immediate distortion of the current image. 
You may also use the predefined paths to manage intersection movement.

            

Above, from left to right, the initial image, movement of the destination intersection along the X and 
Y axes, movement of the destination intersection along the Z axis.

* It is possible to select several intersection points when the HUD is visible by drawing a rectangle 
inside the HUD. Once this has been done, it is easy to carry out all movements with a single click 
and slide on an intersection.
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The Distortion > Wrapping Grid effect

         

* It is possible to choose an intersection interpolation mode (linear, spline or smooth) in the first 
effect popup menu (see below).

                     
      Spline interpolation                         Smooth interpolation                     Linear interpolation

If the interpolation mode chosen is Spline, use of the [Shift] key when moving the 
handles enables movement of one handle at a time.

 Edit grid bounding box

When the second icon is selected, it is possible to distort the current grid as a whole by rotating it  
or by modifying its dimensions (see below).

      
Original grid                                            Grid with 30° rotation                             Grid with height divided by two

 Swap the source and destination grids

This option is practical when creating a distortion opposite to that of the current distortion.

Below,  the  rear  end  of  the  arrow  represents  the Source  point  of  the  grid  and  the  arrow  tip 
corresponds to the Destination point.
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The Distortion > Wrapping Grid effect

        
Distortion:      Source => destination                                   Distortion:     Destination => Source

The AntiAliasing parameter in the last section allows to smooth the border of the image when this 
one is applied on the project. The options are None, Medium and Best.

Distortion of the current image in time.

We just saw how to distort an image in space using the source and destination grids. To distort the 
current image in time as was done for the «skull.tvp» project, you must:

* Duplicate the latter along the entire layer.

* Unactivate the previsualisation of the effect (use the menu at the bottom left of the FX-Stack)

* Set the display option on Source.

* Pay attention to place intersections of the Source Grid at all strategic points on the image : eyes, 
teeth, etc … and ensure the grid covers the lines of your drawing.

* Copy the Source Grid to the Destination Grid.

* Reactivate the previsualisation of the effect.

* Set the display option on Destination.

* Make the  Destination Grid  slightly different from the  Source Grid  for at least the first and last 
frames of the animation layer and then create the corresponding keys.

The result is a distortion, and consequently, a movement which takes place over a period of time.

 

The method described above is not the only way of using this effect. Many others 
exist. You should try them out and share your impressions in the on-line forum.

The Distortion > Optical Flow effect 

The purpose of this effect is also to distort the current image or animation, but in a different way 
than the Distortion > Wrapping Grid effect. It uses a vector field instead of a grid. This vector field 
defines a flow that will be followed by the pixels of the current image.
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The Distortion > Optical Flow effect 

The parameters of this effect are really close to the  Blur > Motion Blur effect in 
Lesson 10. They have the same functionality as the  Motion Blur effect, the only 
difference between the two effects, is that the rendered image is different. That's 

why the Motion Blur is in the Blur section and the Optical Flow is in the Distortion section.

This effect comprises four tabs :

• The Edit tab

          L'image source

* The first button allows you to set the size of the vector field. More exactly it allows you to set the 
number of vector that you will use on both the horizontal and vertical axis.
Once you have chosen the size, you can edit the current vector field itself.
To do so, display the H.U.D and draw directly on the screen (to be exact : on the H.U.D) with the  
purple circle, as shown below.
If you have a picture behind the vector field, you should see the render of the distortion.

      
  Vector field                                                               Modified image

     

The left mouse button allows you to increase the tension of the 
vectors in a chosen direction.
The right mouse button allows you to decrease the tension of the 
vectors in a chosen direction.

The red points are the source points of your vectors, (they can't 
be moved)
The green points are the destination points your vectors, 
The blue segments are the vectors themselves.

For a given picture in your timeline, modifying the vector field creates an animation 
key.
If more than one animation key is created in the timeline, it means that your vector 

field and thus the distortion will evolve in time.
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The Distortion > Optical Flow effect 

* The Reset Current Key button reset the vector field of the current picture in the timeline. If this 
picture does not have an animation key, a new one will be automatically created.

* The button :  allows you to modify all the vectors of the field in only one operation. This tool is 
perfect if you need to distort, move or pivot an image entirely.

          

The more vectors you will use, the more time you will need to render the effect.

* The button :  allows to change the parameters of your H.U.D brush (i.e : the purple circle)
Like the common tools (airbrush, etc ...) that you use to draw, you can set its profile, size and also  
power.

     

Let's  admit  that  we  will  always choose the direction  opposite 
when editing our vector field (i.e : the red arrow) :

The pictures below shows the impact of the different settings at 
your disposal.
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The Distortion > Optical Flow effect 

The last button that looks like 2 corssing arrows allow you to manage a random distortion of the 
image. This option has the ability to move pixels from your image dimly or strongly. Combined with 
antoher effect, like Stylize > Noise, you will have the opportunity to create a convincing faux-fixe.

• The parameter Seed is a value proposed by default and does not need to be changed.
•  The  parameter  Length defines  the  distance  between  the destination  points  (green)  and the 
source points (red). The bigger this value is, the more the image will be shaked (and conevrsely).
• The parameter Variance allows to increase the strenght of the move, following the Length value. 
The bigger this value, the stronger and the more powerful the tremor will be (and conversely).

• The Selection tab

       

*  In  this tab,  you  can  select  the  vectors  of  the  field  that  you want  to  edit  via  the  previously  
discussed tools.
By default, all the vectors are selected. The two buttons Select All and Clear Selection allow you to 
reset the selections.

As in the main panel, you can use one of the three selections icons :  Square, Freehand 
or Circle selection.
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The Distortion > Optical Flow effect 

   

When doing a selection, if a vector is selected, it appears 
in yellow instead of blue. (if you want to select a vector, 
just select its source)

If a vector source is not selected, its H.U.D color becomes 
lighter.

The tools available in the Edit menu will only apply on the 
selected vectors.

The circle selection use the same parameters as the H.U.D brush (the purple circle) so you can 
select your vectors by “drawing on the H.U.D”
It allows you to have source points only selected in part and thus to have nice effects when editing 
the vectors.

Note that if you reset the size of the vector field, all the settings that you have done 
(vectors, animation keys, selections, ...)  will be lost.

• The Render tab

    

The Render tab allows you to choose :

* The calculation algorithm of the distortions (Blackman 
or by default)

* The distortion mode of the image borders

(The example below illustrates the three modes at your 
disposal.)

                      
                                       Source Image                                               Vector Field

                         
                  None Image Mode                          Mirror Image Mode                        Loop Image Mode
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The Distortion > Optical Flow effect 

• The Display tab

   

The  three  buttons:  Show  Source,  Show Destination 
and Show Vector allow you to select exactly what you 
want  to  see  on  the  H.U.D  :  the  red  source  points 
and/or  the  green  destination  points  and/or  the  blue 
vectors.

The button Show Only Selection allows to see only the 
vectors located inside the current selection.
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Lesson 15

The effects of the Motion and Paint groups, 
management of the paths

In this lesson, you will :

● Study the AutoPaint effect

● Learn how to use paths

● Study the Motion > Keyframer effect

● Study the Motion > Shaker effect

● Study the Stabilization effects    



The Paint > AutoPaint effect

The Paint > AutoPaint effect

Have you ever watched a weather report?

When the program is over, you often see the signature 
of the speaker(s) displayed on the screen.

It  is  possible  to  reproduce  this  effect  in  TVPaint 
Animation, using the Paint > AutoPaint effect.

This is the perfect way to dynamically sign your future 
animated works of art!

* First, you have to record the stroke which corresponds to the signature:
go onto an empty animation layer, click on the Record a stroke button in the AutoPaint effect and 
then draw your signature on the screen.
* When this is done, click on the Stop button or press the [Escape] key.
You have now recorded the signature in the program memory. A long series of keys is visible in the 
timeline (see below).

   

* Delete the current image on the screen (i.e. the signature).
* Select the tool of your choice and adjust its parameters for the future stroke of the signature.
* Stretch your animation layer so that it covers all keys of the timeline.
* Select all its images and then apply the FX stack.
When you play the project you will note that the signature is “drawn” progressively on the screen.

       > > >

To ensure that  your  stroke is  carried  out  on the number  of  images of  your 
choice, two methods are available:

* You may stretch or contract the set of keys right after recording the stroke as 
indicated above.

* You may create an animation layer with the number of images desired and select all 
images before recording the stroke.
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The Paint > AutoPaint effect

Let's now study the AutoPaint effect in detail: 

* Recording the stroke generates a large number of key points on the timeline each of which stores 
the position of your stylus at a given moment. When the stroke is recorded, you may modify the 
position of the stylus on the screen for the key of your choice thanks to the numeric fields X and Y.
* For a given key, the Draw button indicates if the stylus was in contact with the tablet or not. If it is 
not enabled for a given key, there will be no stroke for this key (e.g. this is the case if you lifted the  
stylus during recording).
* Recording a stroke with the  AutoPaint  effect allows for other recordings, too : in particular the 
data relative to  Pressure, Altitude, Azimuth  and  Finger wheel  available on the tablet.  It  is also 
possible  to  choose  whether  this  data  will  be  restored  or  not  when  applying the  FX stack  by 
checking or unchecking the corresponding boxes.
* The section Stroke mode offers several choices : Normal, Size, Full and Last.
These are results obtained using these modes:
- The Normal mode progressively reproduces your stroke on the screen. This is the one we have 
been using since the beginning of this lesson.
- The  Size  modes requires adjustment of the parameter with the same name and will erase the 
stroke progressively in time.

> > > > >

-  The  Last  mode is a kind of  Size  mode parameter set to value « 1 », which only draws one 
« point » of the stroke at a time.
In Complete mode the complete stroke is drawn on the screen, independent of the circumstances.

   

* The last is the Noise parameter: it defines a possible deviation from the 
original path and is used to obtain less regular curves (see opposite, the 
TVPaint logo is slightly distorted, as if written  with a trembling hand).

The AutoPaint effect  is  in  a way similar  to  the  Re-apply option as the result  depends on the 
drawing tool selected just before application of the FX stack.
Here, two interesting examples :

   

Opposite,  after  recording  a  simple  stroke  in  the  shape  of  a  semi-
circular arch, the  AutoPaint effect was applied using the  TextBrush 
tool in Letter mode with the rotation parameter connected to the stylus 
direction.

The text seems to follow the defined path in time, each letter having its own rotation depending on 
its position on the path.
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Management of Paths

Management of Paths

    

In lesson , when studying the Center Blur effect, we already discussed 
the idea that an effect may make use of the Position parameters which 
will then define a path on the screen.

We will now discuss this Path notion in more detail.

    

When an effect authorizes use of a path(s) for one or several of its 
parameters, you have access to the Tools  menu in the panel of the 
corresponding effect as shown opposite.

This is what it contains:
* You may use the Pixel tracker to create a path.
* You may also record a stroke on the screen, to create a path. 
*  The third  option  of  the  Tools  menu allows you  to  re-use  a  path  you  have  already created 
previously in your effects stack and use it with the current parameters.
* As is the case for the palettes, the tool settings, the effects, etc, a path may be renamed, saved, 
etc. The option Path Manager is used for all these tasks.
* The option Add to bin allows you to save the current path under a name of your choice for later 
use (we have already done the same for customized palettes, mixers, tools ..... ).
* The Copy from path bin allows you to re-use a path saved in the Bin for your position parameter.
* The Center option replaces the position values for the current key with those of the center of the 
image.

*  The Constant Speed option allows you to replace all the position values of the keys 

along the path, to have always the same distance between 2 adjoining frames.
* The Reset option deletes all the keys of your effect.

The Path recorder 

Path recording may also be carried out  in  any other effect  to  create a path.  The option Path 
Recorder in the Tools menu relative to the position parameter(s) of your effect will help you to do 
this. The steps described above for the AutoPaint effect are still applicable in this case.

  >    >  

Using the standard Path Recorder allows you to generate a large number of 
keys  containing  position  parameters,  however,  contrary  to  the  AutoPaint 
effect it does not allow to restore pressure, azimuth and altitude.
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The Path manager

The Path manager

The Path Manager mentioned above, has four tabs:

  

 

  

               
    1st path                                                    2nd path                                                   Path average

* The Smooth tab allows you to smooth the values associated with the animation key of the path 
chosen (the higher the numeric value, the more the paths will be smoothed after application).

      >>  
                                                   Basic path                                                   Smoothed path
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* The Manage tab allows you to choose a path amongst those 
already saved in the Bin, and then to rename, copy, delete or 
even invert it, (the path will in this case be taken in the reverse 
direction when used).

* The Average tab has four popup menus for you to choose the 
Bin  paths. It allows you to set the values for each animation 
key of the current path as an average derived from the keys of 
every chosen path.

* When you use an effect of the  Paint or Motion  group, the 
Constant Speed option move the keys of the path to keep the 
same speed along your path for your strokes or animations.

This  is  notably  useful  when  you  work  with  the  Motion  > 
Keyframer or Motion > Multiplane Camera effect.
The speed of the moved images or the speed of the camera 
movement  will  be  directly  linked  to  the  Progress  Profile of 
those effects.
The speed control will then be optimised.



The Path manager

*  The  Size  tab allows you to modify the size of  the complete path on each of the three axes 
(horizontal, vertical or depth).
This may be useful if you wish to transfer a path from one project to another with a different size.

      

                                                    Basic path                                    Path reduced by 50% on the horizontal axis

Using a value of -100% on one of the axes allows you to completely flip your path.

To move the entire path on the screen, you simply select all its keys in the HUD and 
then click-slide using the mouse.

Save paths

We explained above that it is possible to save paths to be used later for an effect of your choice 
(option Add to Bin). However, a path saved in this manner may not be recovered after closing and 
re-opening TVPaint Animation.

Two methods are available to solve this problem:

* The effects of the FX stack and their parameters may be saved in a Bin FX menu (see lesson 9). 
This save mode offers the advantage that it also stores the path(s) associated with your effect so 
that they may be recovered when re-starting TVPaint Animation.

   

* You may also save your paths before closing TVPaint Animation, then reload them after re-start  
thanks to the File menu of the Path Manager. You can also export a path into Lightwave Motion 
format
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The saved path is that of the Manage popup menu, a loaded path will be added 
in the path bin and available in the popup menu of the Manage tab.



The Pixel Tracker

The Pixel Tracker

There is also another way to create paths: follow the movement of the pixels in an animation in 
time. To do this, you use the Pixel tracker panel.

This panel is accessible in the effects requiring use of paths, in the Tools popup menu or directly 
via the Windows main menu (see the corresponding window below).

We will now try to create a path from an eye movement of the Running Kid or the blue-screened 
character. (see below)

When a path is created, we may, for example, re-use it with the AutoPaint effect and the pen tool in 
smooth mode to create a blur on it.

It is also possible to use a lighting effect to create a luminous spot following the movement of 
Running Kid, etc.

               

Pixel Tracker with the Running Kid                         Pixel Tracker with the blue-screened character

  >>  
                      Original animation                                       Path created from pixel tracking at eye level
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Opposite, the path of the eye was 
re-used with Omni lighting.



The Pixel Tracker

This is how to use the Pixel Tracker panel :

* In the first section, you must define the layer on which the character whose movement you wish 
to follow (or any other element) is located. Two time or frame markers determine the section of the 
layer that will be taken into account for pixel tracking (the entire layer, by default).

* In the second section, you must define a focus area within the current image. The Pixel Tracker 
will try to find this in the following images of your video in order to create a path. To « follow » a  
human face, i.e. to create a path from the face, the eye is often used to define the focus area.

The values Ref X and Ref Y are used to choose the center of this focus area and the values Ref W 
and Ref H to set its width and height.
The parameters Track W and Track H will limit search in the focus area to the number of  pixels in 
length and height of your choice, around the focus area of the first image (see diagram below).

If  HUD display is enabled after having clicked on the  Set tracker button, you 
may  modify  these  parameters  directly  with  the  following  combination  : 
[Ctrl+right click+slide the mouse] or [Ctrl+left click+slide the mouse].

If, for example, you select the right eye of the blue-screened character as «focus area», and the 
values for the parameters Track W and Track H are too small, this will make it difficult to find it in 
the following images (as our character is moving).
Inversely, high values for these parameters may define the left eye of the character as « focus 
area » during the process and this will falsify the path obtained.

* The third section contains three popup menus:
The Reference popup menu is used to choose if the reference « focus area » for the process is 
always that of the first image selected or will be updated as tracking progresses.
The  Channel menu will,  depending on your  choice,  restrict  the channels  to which analysis  of 
movement tracking will be applied.
The  Accuracy  popup menu allows you to define the complexity of the concordance test. If  you 
choose 1-1, the test is carried out at pixel level. The tracking is then fairly rough. If you choose
1-64, the pixels determined by the 1-1 test will be moved 64 times by a 64th of a pixel in order to 
fine-tune tracking.

* The fourth section is a zoom on the focus area you have selected.

* The fifth section contains two buttons:
The  Track  button starts the process of creating a path with the chosen parameters whereas the 
Rev. Track button has the same effect but reverses the path.
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When the  pixel tracker tool passes from one image to 
another, it will memorize the focus area of the first image 
and try to find it in the next image in the tracking area. 

This enables creation of the position keys necessary for 
path creation.



The Motion > Keyframer effect

The Motion > Keyframer effect

The Keyframer is doubtlessly one of the most used effects in TVPaint Animation.
It is found in the Effect > Motion main menu.
It is used to move all kinds of drawings on the screen.
To use the Keyframer, you must define the following :
* The object to be moved on the screen: brush, layer, spare image, paper…
* The path taken by the object on the screen using animation keys or pre-defined paths.
* The rotations to be applied to this object using keys.
* The motion blurs and, if required, pre- and post-behavior.

In some of the images hereafter, the background chosen is gray so that 
you can see the white pixels of the HUD.

• 1st example : movement, zoom and motion blur

We will now move the « TVPaint » brush on the screen.
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To start  our study of  the  Keyframer,  we have created a «TVPaint» 
brush (320*100 pixels) as shown opposite. The word TVPaint is written 
in black on a transparent background.

* Go to the Render tab and select the custom brush as source.

* Go back to the Position tab.

* Place the TVPaint brush outside the current project to the left 
using the HUD (see below) and then create an animation key 
for the position variable at the beginning of the layer. 

* Now create an animation key for the  Position  variable at the 
end  of  the  layer  and  place  the  TVPaint  brush  outside  the 
current project as before but this time to the right.

* As needed, you may adjust the position of the movement key 
points using the numeric fields and mini-sliders (use the values 
shown opposite). The X and Y fields represent the position of 
the brush center on the screen.

Playing your project in  Preview mode allows you to check that 
your brush appears on the left of the screen and disappears to 
the right.



The Motion > Keyframer effect

   

To  create  a  path  you  may  position  a  brush 
outside the project area: the brush then appears 
hidden  and  only  its  outline  is  visible  as  HUD 
(see opposite).

Do not immediately apply the FX stack. Did you notice the Z position numeric field? This is used to 
set the depth of the object moved on the screen.
Let's now modify the second key we created: enter the parameters for the following positions : 
X= 540, Y= 240, Z= -800
A fast slide along the timeline allows you to see that our logo moves from left  to right but,  in 
addition to that, zooms towards the viewer ! (see below)

  

A positive value in the Z numeric field would have resulted in the logo 
moving away.

It is possible to generate even more subtle movements as our logo may follow the pre-defined path 
of our choice thanks to the Path Recorder or Pixel Tracker. 
You may also curve the paths thanks to the HUD and the keys of your choice (Linear, Spline or 
Smooth).
For example, in the trajectory below, the logo follows a spline on the screen while zooming lightly 
towards the foreground.

  >>  
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The Motion > Keyframer effect

Now we will make it a bit more complicated... It is possible to leave a trail behind our logo, a trail 
that depends on its speed and trajectory.

The settings of the progress profile (lesson 9) come into their own here: the 
movement is accelerated or slowed at your discretion !

A few words about the AntiAliasing popup. This option can smooth the border of the image when it 
is applied on the project. 

• 2nd example: Pitch, Heading, Bank and Pivot

    

In this second example, we  will pivot 
our  «TVPaint»  logo  using  the  pitch, 
heading and bank parameters.

Reset the values of the Keyframer effect to zero, select the «TVPaint» logo as source again and 
modify the Bank angle using the slider. The logo then turns along the blue axis represented on the 
diagram (see below).

    

Reset the values of the Keyframer  effect to zero and proceed in the same way with the Pitch 
parameter. The logo now turns along the green axis represented in the diagram.
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Go to the Render tab :
the  Blur  step  value defines  the number  of  logos which  will 
make up the « trail ».
The Blur Size is used to set the parameters of the trail length 
(see opposite).

Note  that  a  low  value  generates  a  slight  blur  in  the 
movement  direction  which  is  ideal  for  creating  blurs 
generated by fast object movement.

A zero value will eliminate the trail.



The Motion > Keyframer effect

    

With the Heading parameter, the logo turns along the red axis represented in the diagram.

     

The combination of these three parameters gives a wide variety of results. It is now up to you to  
use these rotations in your animations and videos.
The logo may carry  out  several  rotations around an axis:  you simply modify  the value of  the 
Rotation parameter when creating the animation keys to increase the angle to 360°.
In the examples above, our logo always turns in relation to its center: the axes the logo turns 
around cross each other in its center.
The  Pivot  parameters may be used to modify the position of the rotation axes in relation to the 
brush.
Modifying the pivot X coordinate by increasing it by 100 pixels and decreasing the Y coordinate by 
100 pixels will generate other types of rotation when modifying Pitch, Heading  and Bank, as the 
rotation axes are outside the logo.

Below you will see the effects of the Heading modification for our new pivot.

         

Modifying the Z coordinate of the pivot allows even more complicated 3D movements:

            

Each of the buttons Bank Align., Heading Align., Pitch Align., when enabled, allows modification of 
the brush angle depending on the path it follows. 

Below: the angle of the Heading parameter varies according to the logo trajectory.
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The Motion > Keyframer effect

Some words regarding the Rendering tab:

   

* The Fill option is used to fill the screen with the current source. In this 
case, animating the source will also animate all its copies.

* The  Opacity  parameter is used to adjust logo transparency as time 
progresses.

* The Z camera parameter represents the distance between the « virtual camera » and your image 
in pixels. The smaller this distance, the larger the opening angle of our  « virtual camera ». This 
enables you to use the « wide angle » effect well known in cameras by using the parameters for 
Pitch and/or Bank.

                       >   

Above, the pitch parameter was set to 45° for our merged image of the tree. The image at the top 
was obtained with a Z-Camera equal to 1000, the one below with a value of 210.

                                     > 

• 3rd example
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This third example will allow us to work with different sources 
(Rendering tab) in the Keyframer effect.

Let's  go  back  to  our  « planet »  image  used  in  previous 
lessons.
We'll assume that your cartoon is finished. 
Now you want to scroll the list of participants in the form of 
end credits 



The Motion > Keyframer effect

This is how to scroll the list from bottom to top:
*  In  the  Rendering  tab,  select  the  Projects  list  as  source  and  then  the  name  of  the  project 
containing the list of participants

* Place two keys at the beginning and the end of the animation layer with the position parameters 
close to the illustration below.

  >>    >>  

* Apply the FX stack.

It's done ! … The list moves from the bottom to the top as intended.

Thanks to the  Keyframer anything may be moved on the 
screen: a brush, another project, the layer of your choice, 
the spare image, the current image, etc…
You  simply  choose  what  you  want  in  the  Source  popup 
menu of the Rendering tab.

For  example,  exchange  the  current  brush  with  the 
« butterfly »  animated brush in the Bin tab.
This animated brush may also be moved as you wish and, 
why not, follow one of your pre-recorded paths.
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We'll  assume  that  this  list  is  contained  in  another  project  much 
«higher» than the one of your planet (opposite).

Pay attention that  the text  is  written on a transparent  background, 
then  select  (Background  =  None)  in  the  timeline  of  this  second 
project.



The Motion > Keyframer effect

Below, our butterfly lands on the tree before flying off again and leaving the screen.

           

When using animated brushes or animation layers as source images, additional settings will be 
required. In this case, you have two popup menus at your disposal: Before and After.
They may be used to define how the images of your animated brush or animation layer would be 
applied by the  Keyframer effect if  their number were lower than that of the sequence you are 
working on (application of the brush or animation layer images with  Loop, Pingpong, Random, 
etc.).
For our butterfly we have chosen the Loop mode.

Please note that the H.U.D displays the splines followed by the four corners of the 
source and also the edges of the first and last frames. (see below)

                

• 4th example

This example will  help you understand the  Blend menu in the  Rendering  tab.  Load the video 
footage of  your  choice and then create an animation layer  containing only black and opaque 
frames just in front.
You should then see the following timeline:
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The Motion > Keyframer effect

     

   

It is as if our logo had been applied with the  Eraser color mode. The  Mixer mode refers to that 
encountered when using a spare image.

The Motion > Shaker effect

The Shaker effect allows to generate shaking. The more the X and Y values are high, the more the 
shaking will be violent.

The  Border mode menu indicates if  the image will  be repeated when going out of the drawing 
space (Tile) or if it will be erased (Clear).

  

Clear                                  Tile

The Motion > Stabilization effects     

Imagine that the video sequence you just have loaded is slightly shaking. It's a common situation 
when you're using cameras fixed to a mobile support, for examples hand-held video footages, 
video sequences shot on a boat, etc...
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Create any type of movement for the object of your choice using the 
Keyframer tool. Here, we are taking a red « TVPaint » logo brush. Its 
trajectory is of no importance.

Our red logo will, after application of the FX stack, be placed on each 
black image. So far, nothing new. 

If,  before  applying  the  FX  stack,  you  select  the  Erase mode 
(described in lesson 2) in the Blend popup menu (Rendering tab) you 
obtain the result shown opposite.
Our « black » layer was erased at  the logo passage areas which 
made it possible to see the layer underneath.



The Motion > Stabilization effects     

    >   
Source Image                                                  Slight shakes

It is possible to avoid these undesired shakes by adjusting each images as the sequence goes 
along. If you proceed image after image it can be quickly tiresome.
Fortunately, the Motion > Stabilization 1 point and 2 points effects will take it in charge. 

The Motion > Stabilization 1 point effect     

This effect works as follows : For each image from the sequence, you have to define an  Origin 
point and a  Destination point. The effect will make a panning of the image in order to bring the 
Origin point onto the Destination point, which will stabilize the sequence.
Now let's take an example.

Let's  take  the  background  below  :  the  cameraman has  shaken  a  little  bit  while  shooting  the 
sequence. We can define one of the yellow points below as the Origin point, and estimate that this 
it  should be at the position of the  Destination point  (at the extremity of the yellow arrow) if the 
camera had not shaken.

As soon as these points are defined, the Stabilization effect will do a panning that will bring the 
Origin point onto the Destination point. The footage will not shake anymore.

  

      
Origin point                      Horizontal and Vertical camera  movements           Destination point

You can argue that each positions of the Origin and of the Destination points are different for each 
image, which make the process tiresome. That's why, at this stage, using a path for the  Origin 
and/or  Destination points  can  speed  up  the  process,  especially  paths  created  with  the  Pixel 
Tracker...
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The Motion > Stabilization 1 point effect     

As soon as the effect is applied and that the image is stabilized, you could have 
to crop it to remove the white borders due to possible panning. You can also 
use the fill button to remove the borders by tiling the image.

The Motion > Stabilization 2 points effect     

This effect is similar to the previous one regarding its principle and its working. However it requires 
two Origin points and two Destination points.
The Stabilization 1 point permitted to adjust horizontal and vertical camera shakes.
Using the Stabilization 2 points tends to fix not only the shakes on X and Y axis, but also the slight 
rotation or zoom movements there can be on  Z axis (The effect considers the distance and the 
angle between the Origin points which improve the process and make it more efficient…).

Below, the cameraman has rotated a little bit the camera while shooting the sequence.
If you define two origin and two destination points in the Motion > Stabilization 2 points effect and 
check the Rotation box, the effect will then calculate the x° rotation angle of the image and makes 
the Source and Destination points coincide. (see below at the extremity of the arrows)

        
                2 Origin points                          Rotation moves of the camera                      2 Destination points

If the camera has zoomed a little bit while the sequence was recorded, you will have to use the  
same process and check the Scale button.
As we did for the effect Motion > Stabilization 1 point, you can check the fill button to remove the 
borders by tiling the image.
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Lesson 16

The Rendering > Multiplane Camera Effect

In this lesson, you will :

● Study the concept of a Multiplane Camera.

● Learn  how to  use  the  Multiplane  Camera  effect  (we  will  discuss  various 
examples).



The concept

The concept

With the multi plane camera effect you may control movement of several planes with background 
scenery. Each plane has a specific depth and consequently,  its own speed in the eyes of  the 
observer.

In the image above, the following are placed one over the other in the order of furthest away to 
closest:
the starry sky,  the mountains,  the forest,  the first  row of  trees,  the running kid and finally  the 
second row of trees much closer.

When the animation is complete: 
* The trees in the front will move from right to left very quickly as they are closer to the viewer.
* The mountains at the back will also move from right to left, but much slower.

The blur caused by focusing

This effect can also take into account the fact that the human eye cannot focus on all elements of 
the scenery at the same time.
Just like in traditional photography, if you focus on a object close to you, the objects further away 
will be blurred and vice versa focusing on a distant object will result in blurring of closer objects.

             

In the photos above, the tree is a long way from the rose. In the left photo, the camera has focused 
on the rose and the tree is blurred. In the right photo, the camera has focused on the tree and the 
rose is therefore blurred.
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Editing table and computer multiplane camera

Editing table and computer multiplane camera

Below on the left you will see the schematic diagram of a traditional multiplane camera setup often 
referred to as editing table. Each plane is placed on a sheet of glass and is moved progressively 
while filming.

Our computer multi plane camera effect, seen below right, does not function in the same way: 
In  this  case,  it  is  the  camera  which  moves  progressively  while  filming  and  the  scenery  is 
automatically  duplicated horizontally  (the starry  sky background does not  move and is  always 
placed in front of the virtual camera).

      

The project used in this chapter

The drawing shown on the previous page corresponds to the MPC.tvp project which will be taken 
as a basis to study the multi plane camera effect.
Here, you have the corresponding timeline: 

    

Layer where the effect is applied

Layer «character»

Layer «distant trees» (near)

Layer «distant trees» (far)

Layer «forest»

Layer «mountain»

Layers  «sky»  and  «stars»  which 
do not move

The layers «mountain», «forest», «distant trees 1», «distant trees 2» and «character» will be used 
to reproduce the desired animation.
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3D views

3D views

This effect has an Open stage button which allows you to view the multiplane camera from various 
angles. These 3D views will make adjustment of settings much easier.

The default settings are as follows:
* A perspective view (window bottom left)
* A left side view (window top left)
* A front view (window top right)
* A top view (window bottom right)

The following buttons are available in each panel to simplify viewing:

* The  button allows you to zoom with a click and slide on the left mouse button.
(shortcut : [alt + right click] + move your mouse.)

* The  button is used for panning with a click and slide on the left mouse button.
(shortcut : [alt + left click] + move your mouse.)

* The  button when selected, ensures the zoom and panning options are only applied to the 
current view.

* The  button is used to reset the view to its default values.

* The  button displays the camera and the «viewing angle»

* The   button displays the focusing plane. In other words, the plane on which the image  is 
focused. This plane is seen as a red dotted line in the left and top views.
The focusing plane is also visible in the perspective and front views in the form of a gray rectangle.  
This will be studied in greater detail at the end of this lesson.

* The  button displays all the planes in the perspective view. (see page 10)

The popup menus of each window allow you to customize your viewing options: left, right, top, 
bottom, front, back, camera and perspective.

The front and back views are not in perspective. If you choose to use 
them, remember that you are viewing the various planes «orthogonally 
projected» on the Oxy plane (see next page).
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Positioning in space

Positioning in space

Of course, we will not be working in the same way as with a 3D software, but it is still important to  
know your position in space when working with this effect.

Compliant with the diagram below :

* The crosses visible on the 3D view represent the coordinate point (X=0, Y=0, Z=0) which will be 
used as our reference point when positioning our camera and objects (mountain, forest, etc.).

* The indications X+, Y+ and Z+ indicate the direction of the orientation of the camera in space.

The View tab

 The multiplane camera effect has two tabs:

* The View tab relative to the camera and its setting 
parameters

* The  Planes  tab relative to overlaid planes making 
up the final animation.

The coordinates X, Y and Z of the Camera are in fact the coordinates of the virtual camera filming 
our scene in accordance with the space dimension described in the chapter above.
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The View tab

If, for example, you change the Z coordinate from 1000 to 1500 units using the mini-slider, the 
center  of  the  camera  will  be  moved  further  away  and  the  image  you  see  will  be  changed 
accordingly. 

It is possible to move the camera directly from the window of your choice in the 3D 
viewing mode: simply click and slide with the left mouse button on the gray line or on 
the camera icon.

* The  Angle  and  Rotation  parameters rotate the camera around the  Z axis  (To simplify matters, 
these two parameters are not taken into account in the 3D view).

 >> 

* The Field of view parameter represents the camera viewing angle.
The wider the angle, the greater the number of objects illustrated on the screen.

 >> 
Wide field of view                                                       Narrow field of view

* The Depth of Field effect and Focusing Distance parameters will be discussed at the end of this 
lesson.

* The AntiAliasing popup allows you to smooth, with different precisions, the border of the image 
which is applied on the project.
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The Planes tab

The Planes tab

Now that you have placed your camera in space and chosen a viewing angle, we will now place 
our planes one at a time using the Planes tab.
If you have not used the Wizard, this tab is empty.

       

The Planes popup menu is used to create, rename, duplicate or delete planes. The header of this 
menu contains the name of the plane for which the options are displayed in the panel.

Create an animation with the multiplane camera effect, part 1

* Begin by loading the project «MPC.tvp»
* Go to the «multi plane camera» layer
* Open the FX stack and delete its content
* Select the Multi plane camera effect in the Add FX menu 
In the View tab :
* Set the camera position parameter to (X=0, Y=0, Z=1000) and leave the angle at 0°
* Select a field of view of 30°, a Depth of Field effect of 0 and focusing distance of 1000.
In the Planes tab :
* Create a new plane and name it «character». A panel similar to the one below will appear.

  

At this point, you must:

* Choose a Source image to create the plane. 

As  was the case for  the  Keyframer effect,  the  source 
may  be  of  various  types (project,  layer,  paper,  spare 
image, etc...) and you may set the pre-, post- behavior, 
animation mode settings, etc...

We will select the «running kid» layer for our project.

* Choose a tile mode: Choose « none » in tile mode for 
our running kid.

*  Set  the  Pivot and  Position parameters.  These 
parameters have the same functions as those discussed 
in the Keyframer effect, but don't worry, we will be taking 
another close look at them.
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The Position, Pivot and Size parameters

The Position, Pivot and Size parameters

* When the Pivot parameter is zero, the Position parameter represents the distance between the 
coordinate point (X=0, Y=0 and Z=0) and the center of the source image chosen.

* The  Pivot parameter allows you to use a reference point other than the center of the source 
image to adjust the position and size of your plane. 
This is very useful when you decide to modify the Size of your source image:  Size modifications 
use this pivot point as origin point (below in orange).

                                 
        Increase a plane's size with pivot at bottom                                Increase a plane's size with pivot centered

Once you have understood this concept, positioning planes becomes much easier. All you have to 
do is:
* Position your pivot,
* Place your plane at the bottom of your project,
* Adjust the size of your plane.

Let's  go  back  to  our  «running  kid» plane  and  apply  the aforementioned  procedure  using  the 
following settings:

* Position parameters : X= 0, Y= 246, Z= 0
* Pivot parameters : X= 0 ,Y= 130
* Size parameters: 75% of initial size

 Create an animation with the multi plane camera effect, part 2

* Now that your position, pivot and size parameters are correctly set, you may, if you wish, modify 
the angle and opacity of your plane as well as adjust the blur to be created with the focusing 
parameter (we will discuss this again later).
It is also possible to select a color mode to be used for drawing the plane (color, tint, add, screen, 
etc…).
For our «running kid» plane, we have chosen Angle zero, Size 75%, Opacity 100% and Blur 100%. 
The Blend mode is Color.

* The HUD color box allows you to choose the HUD color for the current plane. This will help avoid 
any confusion when several planes are present on the screen (we have chosen a reddish orange 
color for our «running kid» plane).
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 Create an animation with the multiplane camera effect, part 3

 Create an animation with the multiplane camera effect, part 3

We just created our first plane named «running kid».
We will now create a second plane «deeper» than the first. To do this:
* Create a new plane and name it «forest».
* Choose the «forest» layer of our project as source.
* Our plane shows the forest located behind the running kid. We must therefore give it a position 
value Z<0 (as our «running kid» plane also has the position value Z=0). In this case we choose Z= 
-1500.
The 3D view is adapted immediately: You will notice that the «forest» plane is green (or any other 
color you may have chosen previously) and «character» plane is orange.

* You may now adjust the Pivot parameter (X=0, Y=210) and the remaining position parameters 
(X=0, Y=850). The plane must then be «stuck to the ground»
* All that is left is to choose the Size (300%).
The « forest » layer was created with the  Panning tool in the main panel (refer to lesson 7 for 
further details).  You may therefore duplicate it  horizontally  to avoid having to create too many 
planes. To do this …
* Use the Tile mode popup menu.

      
Without tile mode                                                     With horizontal tile mode 

Now that the second plane has been created, all that remains to be done is create the remaining 
planes in the same way: «close trees», «distant trees», «mountain», with the only difference being 
that the «close trees» plane will have a Z value greater than 0.

If necessary, the FX stack corresponding to the parameters we wish to obtain is 
attached to the MPC.tvp project. You must therefore close it and load it again in 
order to go to the next stage quicker.
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Creating movement: move the camera

Creating movement: move the camera

Do not confuse camera movement and possible changes in the position of your 
planes.
The use of animation keys with plane position parameters is only useful if the latter 

effectively  move  (if  the  camera  is  fixed:  mountain,  forest  and  trees  are  fixed).
In such a case, this method would be justified if we had created an additional plane to 
illustrate movement of the moon in the sky (if the camera is fixed: the moon still makes an 
arc across the starry sky).

Create and manage focusing blurs
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Now everything is ready to move the camera and 
obtain the desired result.
To do this:

* Return to the View tab,
* Go to the first frame of the «multiplane camera» 
layer in the timeline,
*  Create  an animation key for  the  Camera  value 
with X = -700,
* Go to the last frame of the «multi plane camera» 
layer in the timeline,
*  Create  an animation key for  the  Camera  value 
with X = +700,
*  Use  the  Play  button  in  your  project  window to 
view the result.

That's it!



Create and manage focusing blurs

During our animation, all the planes seen in the 3D view on the previous page are in focus.

However, to create a more realistic effect, you may wish to create a camera focusing blur effect 
(refer to page 2 of this lesson, section Focusing blur).

You will therefore have to go back to the View tab and adjust the Focusing distance (i.e. indicate at 
exactly what distance the camera will be focused).
If you have followed all the steps of this lesson, your running kid will be at a distance of 1000 units 
from the camera and your focusing distance is also 1000 units.
The running kid is therefore in focus. In order to blur the other elements (mountain, forest, trees…), 
the Depth of Field parameter will need to be increased (when at 0, no blur is applied).
This is illustrated by the creation of a red cone in the 3D view (see below) and a blur on the screen.

The further the objects are away from the apex of the cone, the more blurred they will be.
Inversely, the closer they are to the apex of the cone, the slighter the blur will be.

If your focusing distance is now 3000, your camera is located at 1000 units from the center point 
and the mountains are 2000 units on the other side of the center point (1000+2000=3000), the 
mountains will be focused and the other planes will be blurred. 

Considering the position of the cone in the 3D diagram, it is also safe to say that the closer the 
camera comes, the more the image will be blurred (see next page).

The focusing plane is also visible in the perspective view and in the front view in the 
form of a gray rectangle. 
In the case of the perspective view, you will  see a gray «viewing angle» at the  
focusing distance.
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Create and manage focusing blurs

In the diagram above, the blur is applied to your plane either inside or outside the 
red cone. The width of the cone only indicates the blur amount.

The Blur parameter present on each plane of the Plane tab is used to adjust the blur 
for each plane individually. It is expressed as a percentage of the blur generated by 
the Depth of field effect parameter.

Make the kid run

Now that the various elements of  our scenery move correctly  and the focusing blur  has been 
adjusted, we may, for example, decide to move our red running kid using another animated source 
at the «running kid» plane level.

* You may choose to use the «Running_Kid_1.tvp» sequence studied in lesson 6 by modifying the 
position parameters of the «running kid» plane using animation keys (in this case he is not running 
on the spot).

* You may also use the «Running_Kid_2.tvp» project studied in the same lesson (*). In this case, 
you will probably not need to modify the position parameters with animation keys as the running kid 
moves from left to right.

(*) This project was created using the Keyframer effect with the «Running_Kid_1.tvp» sequence as 
source.
 
The multiplane camera wizard

You have certainly noticed the   button to the right of the  Open stage  button. This 
button will  help you quickly  place the various planes in order to create a sequence using the 
Multiplane camera effect. Naturally, it was important to first study the global functions offered by 
this effect before introducing you to the latter function. 
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The multiplane camera wizard

So now click on the  Wizard button. The window which then opens asks if  Wizard should create 
planes using external projects or from the layers of  the current project.  These are the 2 most 
common cases. 

Create planes from clips 
The first option uses all the clips available, from the current project and the other opened projects 
too. Once validated, each clips from each projects will become a plane in our Multiplane camera 
effect. The next window to appear invites you to stage these planes. This staging may be adapted 
to meet your specific needs. 
This is how the window looks: 
The animation plane is created as the first plane and the other planes are listed in a column below 
it. Each plane has a check box which allows you to choose whether or not this plane should be 
used in your animation. The planes order is inverted compared to the order in which you opened 
your projects (the last project opened is the first plane, the first project opened will  be the last 
plane). You will have noticed that each plane has a Z axis position value. With the default settings, 
each plane is given a Z value which is a multiple of -100: 0 for the first plane, -100 for the second, 
-200 for the third, etc... Therefore, all you have to do is define the Z values for each plane as you 
require and then validate your choice. All your planes will then be incorporated into the effect with 
the Z values defined above and all that remains is for you to animate them.

Create planes from the layers of your current project
Assuming the project MPC.tvp supplied on the CD is open, check the «layers from current project» 
box and then validate your choice. 
The Wizard will then take each of the layers of the current project and incorporate them in each 
layer as a plane. The planes staging window, corresponding to stage 2, appears and displays each 
layer with the associated Z value: 

In this  window, you have the possibility  to define whether or  not  each plane is  to be enabled 
together with the customized Z axis position value (or not) for each plane.
You may also modify the HUD color.
Now all that remains is to click on OK and the Wizard will automatically create all your planes using 
the layers.
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Other situations

Other situations

We have now learned how to use the multi plane camera effect with a simple example.
Our Multiplane camera effect may also be used in other situations:
Below you will see the transversal movement of the two planets with a fixed sun and Lens Flare 
effect (it will be studied in the next lesson).

 >  > 

The multiplane camera can also be used to zoom between the planes you have created :
* After you have created the planes with the wizard, go in the View tab and on the first frame of the 
«multi plane camera» layer in the timeline.
* Create an animation key for the Camera with a negative value for the Z axis.
* Go to the last frame of the «multi plane camera» layer in the timeline, create another animation 
key for the Camera with a positive value for the Z axis,
* Apply the FX-Stack to the whole layer.
* Use the Play button in your project window to view the result : the first planes should disappear 
smoothly as shown in the example below.

    >>   >>

  >>     

Try it now !
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Lesson 17

The effects of the Rendering group

In this lesson, you will:

● Study  the  rendering  effects  relative  to  the  light  :  Lens-Flare,  Lightning,  
Volumetric Light , Healing Tracker , ...

● Study the rendering effects relative to the text : Time Code Generator, Simple  
text , Multiline text , ...

Note : The Particle Generator effect will be the main subject of the next lesson.

 



The Rendering > Lens Flare effect 

The Rendering > Lens Flare effect 

   

The Lens Flare is an over-illumination effect seen through an optical lens.

Usually encountered in the world of photography, it occurs when the image framed is excessively 
illuminated and when a non adequate lens is used. Several types of lens flare are encountered: 
ring, streaks, circles, … 

They are located along the straight line from the light source to the camera lens used. Sometimes 
the lens-flare effect obtained takes the shape of blades used as the lens diaphragm (see drawing 
below).

  >         
Diagram of a camera with a                Examples of the resulting            Photo with a true Lens Flare effect 

        6-blade diaphragm                          Lens Flare effect (hexagonal effects)

The larger the lens, the more the Lens Flares will be visible and the size is proportional to this lens 
(when  using  the  zoom,  for  example).  We  will  now take  a  closer  look  at  the  various  options 
proposed for this effect in order to allow you to obtain results similar to those illustrated in the 
image above.
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The Rendering > Lens Flare effect 

When you choose the Lens-Flare effect in the Rendering effects  menu, the first parameter to be 
entered is the  Position  of the light source and the lens. The first four numeric fields are used to 
adjust these positions.

The  Lens radius  is  measured in  pixels and is used as a reference for  the size of  future light 
interference effects you wish to create (ring, streaks, circles...). The Luminosity parameter controls 
the luminosity of all light interference visible on the screen.

The position of the light source, lens and lens radius may also be adjusted 
with the HUD 

           

The  Lens  Flare popup  menu creates  various  types  of  lens  flare  effects:  they  may  be  of  the 
Generic, Streaks or Image type. It is also possible to rename, duplicate or delete these effects at 
your convenience.

   

• Lens Flares of the generic type

  
 

- Change the Size of the Lens Flare: this value is a percentage of the lens size (the size that you 
have implicitly chosen when setting the lens radius).

- Change the  Offset of the  Lens Flare  :  in other words, modify the position of the lens flare in 
relation to the center of the lens and light source.

An offset of 0 places your Lens Flare at the same level as the light source.
An offset of 1 places the effect at the same level as the lens center.
An offset of 0.5 places your Lens Flare in the middle of the two aforementioned points.
It is also possible to use a negative offset or an offset greater than 1.
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Once a type of lens flare has been created, its name appears in 
the Lens Flare popup menu.

In the header of this menu you will find the name of the lens flare 
the parameters of which are visible on the screen.

Here  are  the  various  Lens  Flare 
parameters of the generic type.

You may:



The Rendering > Lens Flare effect 

-  Choose single-color or gradient color artifacts (see below).

   

- Modify the profile of your artifact using the profile curve.
This effect is constructed in the same way as we have already seen in lesson 2. Correctly setting 
the profile parameters is essential if exceptional results are to be obtained (see examples below).

      

  

   

The  Blade  mode indicated  above  enables  adjustment  of  all Lens  Flares  of  the generic type 
according to the diaphragm blades of your virtual camera (see diagrams on page 2 of this lesson).
It is very important to set its parameters correctly if realistic results are to be obtained.

You may choose a Blade mode of the Circle type (images above) or a user defined Blade mode 
(see next page).
 - You may choose the Blade count for your virtual camera lens (see examples below, based on the 
various profiles described above).
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The Rendering > Lens Flare effect 

- You may modify the Form factor:
With a factor of 0, the points are linked to form a circle.
With a factor of 1, the points are linked by straight segments.
With a factor of 2, the points are linked by incoming arcs.

- You may modify the Angle of your lens flares:

 When required, each Lens Flare of the generic type may 
be given  its own Blades mode different from the  Global 
blades mode described above. 

The  latter  is  located  at  the  bottom of  the  generic  Lens Flare 
parameters and offers the same options. 
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From left to right: 

The lens diaphragm of  your  camera is  circular, 
with three blades, five blades and seven blades.

From left to right: 

Form factors 2, 1, 0.5 and 0.

From left to right: 

Angles  0°, -15°, -30°, -45°, -60°, 
-75°.



The Rendering > Lens Flare effect 

• Streak type Lens Flares 

Even if the Lens Flares of the Streaks type offer a 
completely different effect than the  Generic lens 
Flares  (see examples below), the parameters are 
nonetheless quite similar. 
You may therefore set the  Size, Offset, Color(s)  
and Profile in the same way as described on the 
previous pages.

There  are,  however,  several  specific  options 
which we will now take a closer look at :

- The Angle and Rotation parameters are used to rotate light interference effects.

   

- The Spokes parameter is used to select the number of spokes in the streaks

 

 

- The Minimum parameter is used to adjust the contrast between the spokes.
If this parameter is set to 0, maximum contrast is obtained.
If this parameter is set to 1, minimum contrast is obtained .

- The Noise parameter is used to adjust the sharpness of the spokes:
If this parameter is set to 0, the spokes are less sharp.
If this parameter is set to 1, the spokes are more sharp.
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(opposite  from  left  to  right   with 
contrast values 1, 0.5 and 0)

(opposite  from  left  to  right  the 
Spoke parameter  with  the values 
200, 50, and 20)

(opposite  from  left  to  right  with 
noise values 1, 0.5 and 0)



The Rendering > Lens Flare effect 

- The Seed parameter is used to randomly vary the streaks layout.

• Lens Flares of the Image type

Lens Flares  of the Image  type allows you, as the name implies, selection of the image of your 
choice to create a lens flare.
* This image, referred to as source image, may be a default image, a project displayed on the 
screen or even a file for which the access path must be given.
* You may set the  Size, Offset  and  Angle  parameters as indicated for the lens flares discussed 
previously.
* Your image will be applied as a lens flare on the current layer. This is possible in the various 
Drawing modes (color, behind, erase, etc.) studied in lesson 2.

• The Render order for lens flares

The Render order popup menu offers the following four options :
* Creation:  your light artifacts are calculated and drawn by the program in the order they were 
created (i.e. as they appear in the lens-flare popup menu, from top to bottom).
* Invert. creation: your light artifacts are calculated and drawn by the program in the inverted order 
of creation (in the lens-flare popup menu, from bottom to top).
* Lens to light: your light artifacts are calculated and drawn by the program according to their offset 
in the direction Lens => Light.
* Light to lens: your light artifacts are calculated and drawn by the program according to their offset 
in the direction Light => Lens.

Take the image type artifacts illustrated below, for example.
Based on their position in the Lens Flare popup menu opposite, they were created in the following 
order: blue, then green, then red. 
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Combined use of several types of lens flares and light 
interference applied to the same point in your project 
may create a very realistic effect.

Opposite  you  will  see  two  generic  lens  flares  and  one 
streaked lens flare to create a sun surrounded by a light halo.



The Rendering > Lens Flare effect 

Here you have the effect obtained (for application in color mode) in the various cases:

       
   Creation                                 Inverted creation                  Light to lens                          Lens to light       

• The Lens Flare Obscuration layer 

Let's assume our drawing is animated as indicated below:
When the planet moves and the sun becomes visible, the Lens Flare effect becomes visible at the 
same time.

 >>  >>  

In general, if an object of any kind passes in front of the 
light source, the lens flare tends to disappear.

The Obscuration layer parameter above allows you to manage this phenomenon.

* To do this, you must first define what is going to block the light source. This may be an image or  
animation in a layer, project, brush, etc... (Pre, Post Behavior, Animation Mode, Position will also 
be defined if necessary).

* The Type of obscuration to take place when the effect is applied must be indicated here:
- The  Alpha  option will  block the lens flare when an opaque object passes in front of the light 
source.
- The Invert alpha option will block the lens flare when a transparent object passes in front of the 
light source.
- The R.G.B option will modify the lens flare color so that it becomes identical to that of the object  
passing in front of the light source.
- The R.G.B + A option functions in the same way as the R.G.B option but also takes into account 
the opacity of the pixels in the same way as the Alpha option. 

* We generally obtain a Lens Flare effect when the lens of your camera is pointed towards a very 
small and very bright light source.
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The Rendering > Lighting effect

The Rendering > Lighting effect

  >    

This effect is used to light up the image or sequence of your choice as if using an exterior light  
source  (light, projector…).

By default, nothing is present in the list. The Lights menu may be used to create one or several 
lighting effects among the following categories: Spot, Omni and Ambient.
As soon as a lighting effect is created, you may duplicate, delete or rename it. 

The Lights menu displays the name of the light whose parameters are shown in the stack. If you 
work with several lights you may go from one to the other by selecting their names in the Lights 
menu.
Here an overview of the different lighting types:

* Omni  lighting lights up a circular area of your choice similar to a projector located on an axis 
perpendicular to the image. The parameters to be set are color, lighting intensity, center and radius 
of the circular area, as well as altitude of the virtual projector.

          

 Omni projector diagram                     Omni HUD                                 Omni  lighting         

* Spot lighting lights  up  the  image similar  to  a  tilted  projector.  Two  position  parameters  are 
available for this mode, which allow you to adjust the position of the light source as well as its 
direction.
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*  Ambient lighting lights up the scene globally in the color 
of your choice. Values under 100% will darken the image, 
values higher than 100% will brighten it. 



The Rendering > Lighting effect

          

Spot projector diagram                     Spot HUD                                 Spot  lighting          

For  many  of  the  parameters  described  above,  the  settings  may  be  made 
directly on the screen (don't forget to display the HUD).

Spot and Omni lighting have a profile editor which works similarly to that of the drawing tools  (see 
lesson 2 for more details).

           
Omni                                          Spot                                           profile
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With the Light popup menu it is possible to 
use  several  light  sources  (regardless  of 
type),  as well  as to  rename, duplicate or 
delete them.

This  is  how  our  cave  may  be  lit  up  in 
various ways !

This  Lighting effect only applies to the opaque pixels of the current layer. To 
obtain the examples above it is therefore necessary to first merge the layers of 
the project.



The Rendering > Volumetric Light effect     

The Rendering > Volumetric Light effect     

   

 

 

 

 

 

 
* You can also define one of the various blend modes for this color through the Blend menu. 

 

* The Channel menu gives several others possibilities :

Invert Alpha : Lighting comes from the image opaque pixels (see below for example).
Alpha : Lighting comes from image transparent pixels : that's what's happening in the example 
above. 
Luminosity : The more luminous a pixel is, the more lightrays it will let go.
Red, Green, Blue : The more red (or green, or blue) component a pixel has, the more lightrays will 
go through it.
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The  Volumetric Light  effect is in the same category as the 
Lighting effect but it works in a different way :

In this effect, the light source is located under the current 
layer and it gives the impression of volume to the light.

The substitute mode is only available in this menu, erasing 
the source image pixels (nearby a white opaque logo on a 
transparent layer with a black background.)

Here is an example : 

Create  a  new project  et  fill  the current  image  with  an 
opaque black color.

Set  the  background  as  Color in  the  Timeline.  The 
background has to be white.

Now put a  TVPaint logo in  Erase mode on this Image 
layer with the TextBrush tool, then change this layer to an 
Anim layer with about  twenty images.

Make the  Center setting move along a path from left to 
right.
You should get an animation similar to the one like the 
image sequence on the left.

*  The  Volumetric  Light effect  requires  to  adjust  the 
position setting of the light source and possibly its Path, 
its Power and its Length.

* You can also define the light color, use a color gradient 
(like in the example on the left) or even have a color that 
depends  on  the source  image.  You  can  select  one  of 
these options in the Color Source menu.



The Rendering > Volumetric Light effect     

In the source image on the left below, only the sky and the green tree will emit lightrays when the 
blue channel option is selected.  (The green tree color is partially composed of blue.)

    
                  Source Image                                                      Luma channel

     
                  Invert Alpha channel                                           Blue channel

                         

* The Shimmer section permits to generate interferences in the Volumetric light :
The Size setting is used to manage the distribution of these interferences. 
The  Angle  and  Rotation make  these  interferences  pivot  and  can  give  the  feeling  that  the 
lightsource is rotating.
The Variation setting accents the contrast between rays.

           
Without Shimmer                                                           With Shimmer       

The Mask section allows you to limit the lighting in a circle whose radius has 
to be defined.
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The Rendering > RotoTracking effect     

The Rendering > RotoTracking effect     

• Presentation and concept

The  RotoTracking effect is first of all  a cut-out effect like the  Chromakey, Colorkey or  Lumakey 
effect. It can also be used to animate drawings in ways comparable to those you can encounter in 
vector based animation softwares.

Here is the principle of this effect : the RotoTracking use one or several closed splines (called B-
splines) and allows you to change their shape in time, thanks to the key system of the FX-stack.
Once the effect is applied, the area inside or outside the spline becomes transparent.

• Two examples

This effect is very useful when the other keying effects are unable to cut-out a picture or a movie 
sequence properly.
On the picture below, we see a red squirrel walking on red and brown leaves. As the leaves colors  
are very close to the squirrel color, the common keying effects will not allow you to cut-out the 
squirrel correctly. In that case, it is advised to use the rototracking effect 

        
  Original picture                                                     

   >   
  RotoTracking spline                                                       Applied result

The RotoTracking also allows you to draw and animate quickly. The control points of the spline can 
evolve softly from a position to another one. As a consequence, the shape of the whole spline will  
evolve in time too.
In the example below, a dolphin has been drawn with the rototracking effect.
The control points are colored in red and the B-spline itself is colored in yellow.
Every key dot can be animated in time. So it is for the whole spline and thus the dolphin.
He can for example move his tail to swim.
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The Rendering > RotoTracking effect     

      
          RotoTracking B-splines created for the first and the last image of the animation layer.

      
       Resulting pictures once the effect is applied.

 Resulting animation once the effect is played.

• The control panel

Let's now study the control panel in detail :
Here is the control panel as it appears when you add the Rototracking  effect in the FX-stack. (see 
below)
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Here is  the  main  difference  between the rototracking and  a  simple  selection 
created with the main panel tools :

Our B-splines can evolve and change their shape in time.



The Rendering > RotoTracking effect     

    

To close the spline that you just began to draw, 
you  only  have  to  click  on  the  first  point 
displayed on the screen.

Do you remind Bézier splines ? We encountered them in lesson 2 when we studied 
the drawing tools. B-splines and Bézier splines are mathematically linked.

Try not to confuse those two kind of splines : Bézier splines go through their control 
points while B-splines don't.

• Managing the opacity

Once the B-spline is closed, the opacity of the pixel area outside the spline becomes transparent 
after applying the effect. The pixel area inside the spline stay the same.

This being the case, the two opacity parameters allows you to modify the opacity of any of those 
two areas.
The numeric field on the top of the control panel allows you to set the opacity of the pixel area 
inside the B-spline. The numeric field on the bottom of the panel allows you to set the opacity of 
the pixel area outside the B-spline.
The invert button allows you to invert the effect : the area of pixels outside the B-spline will remain 
unchanged while the area of pixels inside the B-spline will become transparent.

      
                               Normal                                     With the invert button checked      
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At the top of the panel, the  Spline  popup menu is used to 
create, rename, duplicate or delete B-splines.
Once  a  first  B-spline  is  created,  some  new  buttons  and 
menus appear. (The Point and Blending Mode menus)

The effect can use several B-splines at the same time. 
The header of the menu contains the name of the B-spline 
for which the options are displayed in the panel.

Enable the Head Up Display and check the Preview boxes of 
your FX-stack. Once the first point is drawn on the project 
window, new parameters related to the points drawn in the 
screen appear (position, edge, sharp)



The Rendering > RotoTracking effect     

     
  First opacity parameters set to 50%            Second opacity parameters set to 50%

• Let's now study the icons under the spline popup menu.

From left to right :

   The first icon allows you to place the control points of your B-spline at your convenience.
This icon is selected by default each time you create a new B-spline.
You only have to use the left mouse button on the project window to lay your control points.
Once a control  point is  created,  the  point  menu displays its number and its coordinates.  (see 
below)

If you need to re-open a closed B-spline, you only have to select the « » icon : 
again.

  This second icon allows you to move a control point interactively on the project window. (don't  
forget to display the HUD). To do this, just click and drag the control point.

This may also be done by using the numeric fields and associated mini-sliders shown above.

By clicking on the little padlock buttons, it is possible to « lock » your control points in space 
so that they cannot be moved along the axis (or axes) of your choice. This enables, in 
particular, avoiding untimely movement.

The locked points  may be subject  to  animation keys  and intermediate  points  in  time may be 
created from the locked points.

The animation keys influence the position of the points in time and not in space.
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It is also possible to move several points at the same time :
To do this,  simply use your left  mouse button to draw a 
rectangle  while  pressing the [Ctrl]  key.  You  will  then  be 
able to move at the same time all the points located in the 
rectangular area.



The Rendering > RotoTracking effect     

  The fourth icon allows you to delete the control points of your B-spline. You only need to use 
the left mouse button on the point of your choice to do so.

  The fifth icon allows you to modify the value of the edge of a point.
To do so, you only have to select this icon and drag'n drop a control point of your spline.
You can also use the numerical field of the edge parameter. (see below)

Modifying the edge parameter for a control point allows you to change the frontier that the B-spline 
define.
An opacity gradient will follow the B-spline (see below). This is very convenient to cut a picture 
more softly (as the tail of the squirrel below)
The positive values create an opacity gradient outside the B-spline and the negatives values create 
opacity gradients inside the B-spline.

                
  Edge parameter equal to 0       Edge parameter negative        Edge parameter positive

  

  The sixth icon allows you to adjust the sharpness of each point. (the numeric field and the 
associated mini-slider can replace the interactive HUD)
Modify the sharpness is like changing the distance between the spline and the selected control 
point.
A value of 100 for the sharpness parameter will turn the spline into a pointed one.
The B-spline will follow the angle given by the vertex. (see below)
This allows you to adjust the curvature of the B-spline
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  The third icon allows you to add new control points on the B-spline. 
Once activated, you will note that if you drag your mouse near the B-spline, a 
small cross appears. (see below) It means that you can create a new control 
point.

Once  the  edge  parameter  is  changed,  the  HUD 
shows a blue spline. The opacity gradient is located 
between the yellow and the blue spline and follow the 
shape of those two splines.

On the opposite screenshot, the edge parameters was used to 
cut out the tail of the squirrel.



The Rendering > RotoTracking effect     

         

On  the  left  picture,  the  sharpness 
parameter of the right-top point of the 
spline is set to 0.

On  the  right  picture,  the  sharpness 
parameter of the right-top point of the 
spline is set to 100.

 The seventh and last icon turn on the display of a control box which allows you to do a lot of  
modifications directly on the project window (see below)
You may contract, stretch, rotate or translate the current B-spline as a whole by using the handles 
of the box. (don't forget to activate the HUD) 

      

• The master controllers

    

You  could  find  annoying  to  create  animation  keys  for 
every spline and every point of a spline. (for example, a 
five points spline need almost  30 animation keys to be 
created if you want to move it from a place to another 
one.)
That's the reason why the animation key controllers have 
been added in the panel. They are black encircled in the 
picture opposite.

 

The animation key controller near the spline popup menu allows you to create an animation key for 
each parameter of the spline : points, opacity, ... by using only one mouse click.

The animation key controller near the points popup menu allows you to create an animation key for 
each parameter of the point : position, sharpness, edge, ... by using only one mouse click.

• Working with several B-splines

It is possible to use several B-splines.
To create a new B-spline, proceed in this way :

– Select New B-spline in the popup menu
– Display the HUD and check the preview box
– Add control points on the screen and close the B-spline.
– Set the position, edge and sharpness parameters for each points.
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Use the [Shift] key with a drag action to translate the whole B-Spline



The Rendering > RotoTracking effect     

• The blending modes

The last popup menu of the RotoTracking effect panel is called blending mode. It is useful when 
you manage more than one B-spline
If you use two splines (this is also true for more than two splines) :
– The add mode will add the opacity of the two area of pixels.
– The sub mode will subtract the opacity of the current shape from the second one.

         

         

In those two last examples, the edge and sharpness parameters are 
taken into account.

• Some ideas to make your B-spline move on the screen

Let's take a common B-spline.
The coordinates x and y of a control point define its position on the screen.
Three options are available in the interpolation menu : spline, linear or polynomial. This affects the 
path of the control point in time.
If you use the tool menu, its coordinates may follow the path of your choice. You should of course 
use the  pixel  recorder, pixel  tracker,  etc  ...  which  constitute  an excellent  way to manage the 
movement of control points in time.

Once the effect is applied, its shape and parameters will go from one location to another one.
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The Rendering  > Healing Tracker effect 

The Rendering  > Healing Tracker effect 

Maybe you recorded a video sequence which contains some faults : it could be a micro boom, a 
floor lamp or the vapor trail of a plane.
Any modifications to the  video-sequence require a lot of work : each frame has to be corrected 
separately. Most often, you need to remove the unwanted areas of the sequence and finally you 
have to replace them one by one.

The Rendering > Healing Tracker effect allows you to apply this kind of correction really quickly :
It combines the use of the Healing mode (studied in lesson 7) and the B-spline notion encountered 
in the Rendering > Rototracking Effect chapter.

    

The  Healing  Tracker panel  appears  as  illustrated 
opposite :
In the first section, several choices are available for the 
source image or footage needed for the healing mode. 
(FX-stack,  current  layer,  display,  paper,  current  brush, 
other project, ...)
When  choosing  another animated  source,  you  may 
adjust the Pre- and Post-Behavior, the position and the 
animation  mode  (random  animation,  ping-pong, 
animation reduced to the image indicated in the position 
parameter, etc.)
As  required,  you  may  choose  to  flip  your  source 
vertically, horizontally or both, before using this source. 
(see lesson 13 for more details)

In the second section, you can manage your B-splines. This has been explained in detail in the 
Rendering > Rototracking Effect chapter.

Here is how it works :
on the image below, an unwanted floor lamp is visible. This effect will  apply the healing mode 
inside the B-spline surrounding the floor lamp. So the floor lamp will disappear.
The healing source area can be recognized by its unique centered handle (the HUD should be 
enabled)

  >     

Note that the distance (offset) between the healing source area and the destination area of the 
effect (inside of the B-spline) can be modified in time by using the animation keys.
Those two areas have always the same shape for a given image of the footage.
Take a look now at the video footage below : a plane is flying slowly in the sky, over the sea.
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The Rendering  > Healing Tracker effect 

   >> 
  First image of the footage                                                Last image of the footage

      
       Attached timeline

We will now examine in more detail how to suppress the vapor trail of the plane.
* First, begin by selecting FX-stack as source sequence of the Healing Tracker effect.
* On the first frame of the footage, create a B-spline surrounding the vapor trail.
* Use the animation key controllers on the right of the spline menu to create a set of keys for each 
point of your B-spline.
* On the last image of the footage, change the shape of your B-spline in order to make it surround 
the extended vapor trail.
* Use again the animation key controllers on your modified B-spline.
* Move carefully the healing source area by using the HUD : the vapor trail should not be visible  
anymore.
* If you slide along the timeline with the preview mode enabled in your FX-stack, the shape of your 
B-spline should progressively change.
* Then, you only have to select all the images of your layer and to apply the effect.

   >>  
    First image of the footage               (FX-stack preview enabled )               Last image of the footage
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The Rendering  > Healing Tracker effect 

It is also possible to suppress the clouds at the bottom of the footage :
In order to have a good result, the healing source area needs to be an even section of the screen, 
without clouds.

   >
  
Some other spectacular renderings can be obtained if you use another project as source in the 
healing tracker effect. With some training, you should be able to obtain those results :

         
        The healing source project                                   The picture on which the effect will be applied

         
          Above, one of the two B-splines we used.             Here is the final result :
                                                                                             The sea has been replaced by the clouds

The use of the edge parameter for the points of your B-spline is sometimes useful 
to have better results.
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The Rendering > Background Generator effect

The Rendering > Background Generator effect

The  Background  generator  effect is  used  to  create  horizontal,  vertical  or  four  corner  color 
gradients. These gradients are applied to the current image as described in lesson 2.
You may choose any color you like as well as the opacity and then have them change with time by 
creating animation keys.
Below, you will find four examples of gradients used in Color, Add, Tint or Subtract  mode.
It is also possible to change the colors of clouds, planet, or even place the planet within a bluish 
atmosphere…

                
     Source image                                        Gradient  in Color  mode                      Gradient applied in Colorize  mode

                
     Source image                                        Gradient  in Color  mode                      Gradient applied in Add  mode

          
    Source image                                         Gradient  in Color  mode                     Gradient applied in Tint  mode

          
    Source image                                         Gradient  in Color  mode                    Gradient applied in Subtract  mode
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The Rendering > Plasma effect 

The Rendering > Plasma effect 

The Rendering  > Plasma effect is similar to the  Wave effect because they produce both circles. 
However, this effect produces multicolored waves and can be adjusted with several parameters :

* The Linear 1, Linear 2 or the Smooth option in the Generator menu in the settings panel modifies 
the profile of the generated wave's shape (look at the examples below).

     

* It is possible to work with one, two, three or four circles (see below).

     

* You can choose the way these waves will mix together. Below you can find the modes :

          
    Add                                Sub                                 Multiply                           Divide

          
     Maximum                         Minimum                         Average                          Différence

 
     Distance
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The Rendering > Plasma effect 

* Finally, some settings related to color channels are also available : Global phase,  Red phase, 
Green phase, Blue phase and Alpha phase.

      

The Rendering > Perlin Noise effect     

This effect generates shapes thanks to mathematical functions and is sometimes used to imitates 
water waves and other water effects.

            

You can : 
* adjust Width and Height of the generated shapes,
* mix these shapes to the current image thanks to the Colorize, Tint, Multiply, ... modes,
* use a picked color, a gradient or the color from the current image,
* change the complexity of the shapes thanks to the Octave setting,
* Invert the effect colors or change its Opacity.

          
 Octave = 1                                           Octave = 2                                           Octave = 5
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The Rendering > Text effect     

The Rendering > Text effect     

We saw in lesson 5 how to create a  Text Brush  using 
the Text tool from the tool panel.
The  Rendering  >  Text effect  should  not  disorientate 
you. 
* The Text field is where you have to type the text, 
* The Font menu allows you to change the font,
* You already know the various settings like Size, Size 
X, Spacing, Italic, Tracking and Angle. However, these 
values can be keyframed now (which cannot be done 
with the simple Text Brush tool).
So you can make a text going bigger and bigger, make 
it switch to italic, or make the spacing change, etc... or 
all at the same time !

Let's take a look to the new settings : 

*  You can make the text  follow a  path  thanks to  the  Position settings (with  a  stored path  or 
graphically through the HUD).
* The Angle setting permits to adjust the angle made by the text (in relation to the horizontal line), 
* The Rotation setting can increase the Angle value with a multiple of 360,
* The Align menu allows you to change the position of the HUD text handle : right, left, centered.

There are still 3 tabs left : 

* The Font tab manage the pixels of the text itself

     

* The borders tab manage the pixels of the borders of the text : you can adjust de thickness of the 
border.

      

* The  Shadow tab can create a shadow for the text : the  Angle and  Distance  settings give the 
position of the shadow. 
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The Rendering > Text effect     

In each tab, blur settings can be adjusted and there are three filling types available : 

* fill with a picked color (you will be able to change its opacity). See the first example of this page

* fill with a color gradient (you will be able to adjust its angle).

      

* fill with a texture you will have to define (current image, spare image, brush, paper, etc...).

      

TVPaint  Animation Professional Edition  can  use  non-occidental  fonts  like 
chinese, japanese, arabic fonts, ...

The Rendering > Multiline Text effect     

   

The effect Rendering > Multiline-Text is the most important 
titling tool of TVPaint Animation Professional Edition.

The first thing to do when using this effect is import text 
lines. To do this you may :
* use text lines stored in an ascii .txt files
* use text lines stored in your clipboard.
(for  example,  if  you have cut  or copied some text from 
another software)

After this choice, your text is displayed on the screen. Two kind of H.U.D are available for this 
effect. The parameters directly adjustable on the screen depends on the H.U.D selected :
* angle, size and position on the screen for the position H.U.D
* the text itself for the text H.U.D

      
  The position HUD                                    The text HUD
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The Rendering > Multiline Text effect     

Several kinds of HUD handle alignments are available by using the nine buttons below :

Your text lines may be horizontally centered, left justified or right justified.

       

Your text lines may be vertically centered, top or bottom justified. (here below the text was first 
rotated at 90°)

         

The three last buttons allow you to set the horizontal and/or vertical offset between the text lines.
Note that the unit is the pixel. (It is also possible to use negative numbers of pixels.)

      

It  is  possible  to  set  or  animate  each  line  of  the  whole  text  by  using  the  same method  than 
encountered in the Rendering > Simple Text effect. The framed area of the FX-stack below shows 
the font, position, border, shadow ... parameters discussed in the previous chapter.

At the top of the panel, the line popup menu is used to create, rename, duplicate or delete lines.
The header of the menu contains the name of the line for which the options are displayed in the 
panel.
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The Rendering > Multiline Text effect     

It is possible to create animation keys for all parameters of every line by using the 
control key located next to the line popup menu.

Let's now study the animation popup menu :
*  The  roll  option allows you to move your text lines from the bottom to the top of  the project 
window.
* The crawl option allows you to move your text lines from the left to the right of the project window.
The progress of those options can be set by using the position parameter.
The extreme values : 0% and 100% makes the text lines disappear from the screen.
A value of 50% corresponds to the initial position of the text lines on the the project window.

The Rendering > Time Code Generator effect

           
This effect displays the time code of the current image in the current layer at the position of your 
choice.  Three modes are available:
* Current project mode duplicates the timeline data in number of frames or time code depending on 
the selections made (Frame or Time Code refer to lesson 4).
* Free run mode is used to define the parameters to be taken into account for the entire current 
layer independent of the timeline: You must therefore specify the position of the first frame, the 
number of frames per second and the display (frame or time code in hours, minutes, seconds and 
frame number). The Invert option is used to create a count-down effect.
* User defined mode works in the same way as Free run mode with the simple difference that all 
frames of the layer have independently set parameters thanks to the use of the animation key 
system.

Regardless of the mode chosen, the second section of the panel enables:
* selection of the Font of your choice,
* Size variation,
* setting of Position parameters for the current project,
* modification of font and background Color and Alpha.

    

Opposite,  an  example  of  an  application 
with the current frame number in black with 
a gray background.
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The Rendering > Pattern Generator effect     

The Rendering > Pattern Generator effect     

   

The  Rendering > Pattern Generator effect allows 
you  to  display  the  classical  video  patterns  on 
screen :

              
                Bar 100                              Bar 75    

                    
Bar + pluge                        Bar + red                               Bar SMTPE

                    
Grey step 10                     Grey step 5                           Grey ramp
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Lesson 18

The Rendering > Particles Generator effect

In this lesson, you will learn:

● To create a particles system.

● To modify a particles system.

● To use a particles system in order to add special effects to your videos or put 
the finishing touches to your animations.



Presentation and concept

Presentation and concept

Let's  take  the  following  elements  into  consideration:  fog,  smoke,  fireworks,  snow,  fountains, 
sunshine, a tennis ball bouncing off the ground.
These natural phenomena and other objects taken from daily life don't seem to have anything in 
common except maybe that a lot of time is required to make a successful and correct animation of 
them.

      

Let's study them more closely:
- Fog and fountain are made of fine water droplets: they are suspended in the air and more or less 
opaque in the case of the fog; they are projected into the air by a source and fall back with the  
force of gravity in the case of the fountain.
-  Sun  and  fireworks  are  respectively  composed  of  helium,  hydrogen  and  various  chemical 
products. The latter are concentrated in a ball for the sun or expelled into the atmosphere in the 
case of fireworks.
- Smoke is also composed of various chemical products, generating different types of smoke. As it  
is  very light it  is  not subject to  the force of gravity and moves with the wind. The tennis ball,  
however, bounces several times before coming to a standstill and the wind has little influence on it.

In each case, we deal with « particles » in the broader sense of the word: water droplets, chemical 
products, tennis ball, etc. These particles move and are affected by the force of gravity, the power 
of wind or air resistance, etc. They may bounce or come from several places at once. 
The place or places where the particles come from are referred to as «emitters ».

TVP Animation does not only make it possible to draw such particles but also to manage their 
movement using the parameters described previously. This offers considerable time saving when 
creating animations and other special effects (drawing and animating the particles one after the 
other would require months of work…).

You have understood already that it is the effect referred to as  Rendering > Particles Generator 
which will help us succeed in this matter.

Learn by example

You will very quickly notice that the particles generator is an effect which offers a wide range of 
options.

Generally, you need to learn how to set :
*  the  parameters  of  the  world  (or  universe)  in  which  the  particles  will  move:  wind,  gravity, 
collision…
* The parameters of the particle emitter(s): movement, angle, rotation… 
* The particle parameters: life span, velocity, number, opacity… 

The multitude of parameters is so vast that it may discourage the beginner. For this reason and for 
didactic purposes, numerous pre-defined examples have been included in this program to help you 
master this powerful drawing tool.

Many users use them as a model to introduce the particles into their own creations. These pre-
defined examples, sometimes referred to as presets, are accessible via the Bin FX menu.
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Presentation and concept

Choosing Browse opens a window that is specific to the particles generator (see below). 

 

Two boxes may be checked in order to improve the quality of the particle animation depending on 
the power of your computer: Full Quality and AAliasing.

If a pre-defined example is close to the result you wish to obtain for your project, you may choose 
to set the parameters of the particles generator according to this example. To do this, just click on 
the  Copy to FX button then close the window above. Now you study the example in detail and 
modify it to your needs.
We will come back to this process to illustrate some situations.

The tabs of the   Particles Generator   effect  

The Particles Generator works with various tabs and sub-tabs which are not necessarily all visible 
at first use. 
Below you will find a summary before starting a detailed description:

    

The names in the lower levels are sub-tabs.

For example, the particles tab has two sub tabs : 
Current and Shape.
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In the popup menu you may choose a pre-defined example 
from the following categories: cartoon, misc, nature, objects,  
party, pyrotechnic, sci-fi, text, water. 
(Using  the  ▼  and  ▲  buttons  you  may  scroll  from  one 
example to another.)

When you have chosen an example, its name will appear in 
the header  of  the popup menu and you may observe the 
changes made to the particle system directly in the window.

The Bin FX menu appears as illustrated opposite:
You are already familiar with the functions Add, Load and Save: they are present 
for each effect available in TVP Animation. However, the functions  Browse and 
Presets are new.



The tabs of the Particles Generator effect

The World tab

The World tab is used to manage the parameters of the « world » in which our particles will move 
(see below).

Two preview options are offered in the World tab: the  Bounding box  check box and the Quick 
preview button.

- The  Bounding box check box is used to 
display  a  colored  rectangle  around  the 
particles  present  in  the  current  project 
window when the preview button of the FX 
stack is enabled.

The particles going out of the project which 
are   susceptible  to  come back under  the 
influence  of  certain  factors  (wind,  gravity, 
etc.) are also framed.

     
Although this option may render the preview a bit complicated when many 
particles are on the screen, it  is very useful to distinguish the position of 
low-opacity particles.

This is very useful to interactively view and modify a particle animation before applying the effect to 
all frames of a layer. 
This button is present in all other tabs and sub-tabs of the particles generator effect.
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- The  Quick Preview  button displays a window very similar to the 
one which allows you to choose a predefined set of particles.

Here, you cannot select a predefined example and any parameter 
modification  within  your  effect  will  have  a  direct  impact  on  the 
animation shown to you.



The tabs of the Particles Generator effect

The Seed parameter is used to generate a random particle emission using calculation algorithms. 
This  parameter  enables  changing  the rendering  so  that  two  effects  which  would  be  identical 
elsewhere are different.

The  Gravity  parameter  is  used  to  take  the  earth's  gravity  into  consideration  during  particle 
movement.

                             

- When the gravity is increased to, e.g. a value of 10 , the water 
droplets   will  fall  to  the  ground  faster,  because  the  distance 
between  the  emitter  (water  jet  origin)  and  the  drop  point  is 
shorter.

                

- Decreasing the value to 0.5 will increase the distance traveled 
by the droplets.
The distance between the point where the droplets are emitted 
and the drop point is longer.

      

- When the gravity is set to zero, there is no gravity and the water 
droplets will follow a straight trajectory. 

      

-  TVP Animation  offers  the  possibility  to  work  with  negative 
gravity values, which has the effect that the force of gravity may 
be inverted (the water droplets will then go up).

This is useful in certain cases, for example, to represent metal 
particles drawn by a magnet.

In  order  for  the force of  gravity  to  have an impact  on our  particles,  it  is 
necessary to attribute a Weight to them. We will come back to this when we 
talk about the specific particle parameters.
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Select the pre-defined example (water >water jet) and copy 
it to the particles generator (see left).

In this example, our particles are water droplets projected 
from right to left.

Open the quick preview window. We will  be able to study 
the  influence  of  the  various  parameters  available  in  the 
World tab on the movement of the latter.



The tabs of the Particles Generator effect

Let's take a look at the pre-defined example  (objects > popcorn):  the popcorn kernels are our 
particles and they move vertically to the top before falling back under their own weight.

The parameters Angle, Rotation and Wind strength allow you to simulate the impact the wind has 
on the particles (see examples below), and to make them more or less move in a direction of your 
choice (wind with a negative value affects the particles in a direction opposite to the one you have 
chosen).

                
Wind = 0                            Wind = 100                                       Wind = - 200                   

Note that using animation keys will allow you, if necessary, to change the direction of the wind in 
time as well as its strength (to avoid creating a wind that is too uniform).

The  Alpha  Collision  menu  is  similar to  the  Source  tab studied  in  lesson 15  when  using  the 
Keyframer. We will not go back to the concepts Source, Pre-Behavior, Animation, Post-Behavior  
and Offset.

There is, however, a functional difference: when the Alpha Collision box is checked, the particles 
will take into consideration the shape of the image(s) selected by you as source and, in case of a 
collision with one of them, bounce off them.

Draw a slope with an angle of approximately 30° with the horizontal line on all images of a layer 
with 120 images. In the particles generator, choose the pre-defined example: (objects > apples),  
check the Alpha Collision box and then select FX stack as source. To finish, apply your effect.

 >  >  > 

You will note that the apples bounce off the surface that you have just drawn!

This may be taken even further as the surface on which the particles bounce may evolve in time 
(for this, you have to choose an animated source).
It is even possible to modify the height of the particle bounce, as we shall see later.

18-6 The Rendering > Particles Generator effect



The tabs of the Particles Generator effect

Below, you find two summary illustrations for the trajectory of any object.

    

    

The Emitters tab

The Emitters  tab (see below), as its name implies, is used to set the parameters of the sources 
emitting the particles.
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The tabs of the Particles Generator effect

The following emitters may be chosen :
A point (see pre-defined example sci-fi > galaxywarp), a line (see pre-defined example objects > 
tetris), a rectangle (see pre-defined example nature > lava or cartoon > eyes), an ellipse...

These are the various HUD displayed according to the chosen emitter:

         Point                            Line                                   Rectangle                                              Ellipse

The center of the emitters is shown in green, its shape is marked by red dots.
The purple handles describing the shape of circular arcs indicate the angle at which the particles 
are projected. We will study them in detail when discussing the Emitter > Current tab.
Below, the smoke coming from the steam engine was created using a Point type emitter.

    
                                                                    Above, a zoom on the HUD.

These particle emitters are, of course, virtual. If you use the particles generator effect for animating 
water coming out of a fountain or tap, or smoke coming from a steam engine, you just have to draw 
the fountain, tap, steam engine…
It is possible to work with several emitters, placed where you want. The Emitter popup menu will 
facilitate your task as it offers you the possibility to Create, Rename, Delete and Duplicate  emitters 
(note that the name of the emitter you are working on is displayed in the header of the popup 
menu).

Using several emitters may be useful when, for example, you wish to animate a building starting to 
burn: with several emitters,  fire and smoke may come from several windows or chimneys with 
varying intensity (see below).
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The tabs of the Particles Generator effect

All these types of emitters have a center that you may place wherever you wish using the  X, Y and 
Z coordinates (the « Z » coordinate is used to set the depth parameter as you have already seen 
when studying the Keyframer).
The Tools  and Interpolation  (Linear, Spline  or  Polynomial) popup menus are used to define the 
path to be followed by your emitter source in time.
By clicking on the little padlock buttons, it is possible to « lock » your emitters in space so that they 
cannot be moved along the axis (or axes) of your choice. This enables, in particular,  avoiding 
untimely movement.
The locked points may be subject to animation keys and « intermediate » points in time may be 
created from the locked points.

The animation keys influence the position of the points in time and not in space.

The Angle option is used to point the emitter in the direction of your choice. It is also possible to 
turn your emitter  using the animation key system. The  Rotation  parameter is used to manage 
rotations of more than 360°.

Some settings, not shown above, are specific to the emitter you choose to work with. Depending 
on the emitter chosen these are: length of the line, length and width of the rectangle, size of the 
two ellipse axes.

You will note that, once the emitter is created, two tabs appear: the Current tab and the Particles 
tab.

The Emitters > Particles tab

The Emitters > Particles tab is used to manage the particles projected by the emitter.

The  Particles popup menu enables creation of one or several sets of particles. Several types of 
particles  may  be  emitted:  see  the  pre-defined  examples  (sci- fi > galaxywarp),  (party > magic 
candle) or (pyrotechnic > explosion-b) to convince yourself. 
You may also duplicate, rename or delete a set of particles via this same menu. The name of the 
set of particles you are working with appears in the header of the popup menu.
As soon as a set of particles is created, new parameters for setting the particles appear (see next  
page).

The Rendering > Particles Generator effect 18-9



The tabs of the Particles Generator effect

All particles appear, move along the screen and then disappear again. The time the particles move 
is referred to as the Life span of the particles.
The Life parameter is used to adjust the particle life span in seconds:
-  it is short for fireworks : party > magic candle
-  it may also be long: nature > fog.

The Number parameter contains the number of particles emitted per second: 
- if required, this parameter may be very high: pre-defined example  (sci-fi > galaxywarp) 
- or reduced : pre-defined example (object > dice)
A decimal number enables emission of a very small number of particles. For example, a setting of 
0.3 generates a particle every 3 seconds, a setting of 0.01 generates a particle every 100 seconds.

When the  Single  box is  checked and one particle  has been emitted,  no other particle  will  be 
emitted before the last particle has reached the end of its life, whether it is still on the screen or not.
The pre-defined example (object > golf shot) is ideal for testing this option.

Let's assume that the Life span of our golf ball particle corresponds to the time it spends in the air 
(once the ball has landed, it is no longer possible to see it in the sky and it is too far away from the  
field of view to see it on the grass from afar).
If  you check the  Single  box,  a new golf  ball  will  be shot  only  when the first  ball  has landed, 
independent of the fact whether the latter has left the screen on its trajectory or not (and even re-
entered it on the same trajectory … see below).

The Number of Points is only valid with the emitters line, rectangle and ellipse.
It is used to distribute the areas from which the particles are emitted along the contours of the 
emitter you are using.
Below, the particles of the pre-defined example  (party > stage lights)  are used with a Line  type 
emitter then with an Ellipse type emitter.
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Shooting the second ball when the first has landed (i.e. 
at the end of its life …).
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A parameter referred to as  Link to emitter  is present in this tab: it is used to define whether the 
particles will follow an emitter or not when it moves along the path chosen by you.

1st example: a steam engine was drawn on the screen. The Keyframer effect was used to simulate 
steam engine movement from left to right.
A Pixel tracker was used to create a path which follows the engine's chimney. Therefore, when the 
train moves, an emitter following this path will always be at chimney level.
In the images below, the smoke particles are linked with the emitter which is the engine's chimney 
set at 100%. The movement of the smoke is not natural.

  >>  

In this drawing, the parameter Link to emitter is 25%. This time, the smoke movement is correct.

  >>  

2nd example: the beacons below, as they are particles, are necessarily linked to their emitter: the 
roof of the police car. They move at the same time as the car when it is driving. The Link to emitter 
is therefore 100 %.
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Line type emitter

From top to bottom :
Point parameter = 0 or 1
Point parameter = 3
Point parameter = 5

Ellipse type emitter

Point parameter = 9
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The Emitters > Particles > Current tab

This tab is used to manage the properties of the particles themselves.

     

The most simple are Velocity and Size: any pre-defined example may be used to study these two 
notions.

The parameters Weight and Bounce are more subtle :

- The Weight of a particle has an influence on its movement if the Gravity parameter in the World 
tab is  not  set  to zero:  the heavier  a particle,  the more the force of  gravity  will  accentuate  its 
movement. The lighter it is, the less effect the force of gravity will have. 
A Weight of zero has the result that the particle is not subjected to the force of gravity.
If  you place the pre-defined example  (nature  > sun) in  the stack and then modify  the gravity 
parameter, you will note that this has no influence on particle movement.

- The Bounce parameter is used to set the particle bounce strength (the Alpha Collision box of the 
World tab must be checked and a collision source chosen…).
Below: the Bounce of a tennis ball thrown left to right for different parameter values: 85, 100 and 
115 (note that values over 100 cause unnatural bounces relative to the laws of physics…)

    

- The  Friction  parameter is set to slow the particles down. If the particles move through the air 
(which is most often the case), we are dealing with air resistance. The latter is low and a parameter 
set at a value close to zero will be sufficient. 
There are, however, other situations : let's assume that the balls are thrown at floor level. These 
balls will slow down and stop due to the friction of the floor. If the same balls are thrown on a lawn,  
they will be stopped even faster.
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The pre-defined example  (objects > dice) also provides an interesting case: by increasing the 
Friction parameter to 180, and due to the fact that the particles grow smaller in size during their life 
span, one gets the impression that the dice roll on a surface and, after a certain limit, fall into a 
void. 

- The Opacity parameter is used to set particle transparency. 
This is very useful, for example, when you are animating soap bubbles: these wouldn't be perfectly 
opaque…

-  The  Motion  Randomness  parameter  controls  the  movement  of  imperfect  particles  and 
accentuates the realistic aspect of the particle jet. It is used, for example, to create an uneven fog, 
movement of bubbles in the air, smoke, etc. 
This parameter is used to avoid having to create too many animation keys which would be required 
to render a trajectory uneven. This parameter comes into its own with the  Variation parameter 
described hereafter. The pre-defined example (party > popcorn) uses this method.

- The Spin parameter controls particle movement around its local axis (the latter is defined in the 
Handle popup menu of the Shape tab which will be discussed below…)
Its use may provide various results. As required, study the pre-defined examples (objects > dice) 
and (objects > tetris).

- The  Align parameter, if enabled, acts on the rotation parameter and directly turns the particles 
according to their trajectory.
See below : two particle jets with and without alignment.

  With alignment     Without alignment

All parameters studied have the parameters Variation and Profile to their left.
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The profile preset is used to vary a parameter (Size, Velocity, 
Opacity, Bounce, etc. ) during the life span of a particle.

Click  on  one  of  the  profile  icons  (circled  in  black  in  the 
example opposite) to open a traditional profile window.
We have already seen these when studying the drawing tools.
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The Variation represented  by  the  V button  is  used  to  render  the  parameter  with  which  it  is 
associated more or less random. RMB click on the V icon to enter a numeric value in this field.

For example, if the particles Size parameter is set at 50, a Variation with a value of 25 means that 
each particle emitted will have a random size ranging from 25 to 75.

In the example given above (misc > plumefury), the variation function was used to attribute the 
particle Size, Spin and Life random values.

Combined  with  the  Motion  randomness parameter  and  correctly  used,  the 
Variation function provides excellent results. It is almost impossible to tell that a 
computer was used to create this effect!  

The tab Emitters > Particles > Shape

This tab is used to define the type of particles to be used.
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Let's  take  the  pre-defined  example  (pyrotechnic  >  smoketrail) shown 
opposite.
The three circled profiles below are those used in this example.
You will note that the particle behavior and profile size and opacity are well 
balanced:

* The smoke particles are small  close to the emitter source 
and become bigger as the smoke dissipates in the air. 

* The smoke particles are opaque at the beginning (yellowish-
orange areas) and become transparent at the end (red-black 
areas).

* A parameter with the profile indicated opposite does not vary 
during the period the particles are displayed and remains at 
the value you have chosen.
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The Source  popup menu is used to select either a default particle (circular with an opacity level 
decreasing towards the edges) or an image of your choice. When required, the image may be a 
brush, animated brush or current project. 
In the case of brushes, you may select it using the file requester. 

 

 

The Anti-aliasing option allows you to finalize the general aspect of the particles. We have already 
discussed this when studying the drawing tools (lesson 2 and lesson 7).

The  Handle  menu works in  the same way as that  encountered when studying the brush and 
animated  brush  tools.  It  defines  the particle  axis  which  is  the  reference  axis  when  a  spin  is 
imposed on the particle.
You may choose a handle located in the center of the particle (more precisely, in the center of the 
HUD rectangle surrounding it) or in one of the four corners of the latter.
As a last resort, you may even place the handle manually.
The Handle is also used as a reference point when calculating collisions. Furthermore, if you need 
to calculate a collision, it  may be wise to place the handle elsewhere than in the center of the 
particles in order to obtain better results (see diagrams below).

         

When the Source chosen is an animated brush, the Animation popup menu is used to set the order 
in which the source images appear on the screen:
- The None option authorizes display of the AnimBrush's first frame only.
- The Once option is applied to each frame of the animated brush one after the other and stops at 
the last.
- The  Loop option is also applied to each frame of the animated source one after the other, but 
starts  a new cycle  each time it  reaches the last  frame and so on until  the  particle  dies (see 
predefined example: objects > coinfountain).
- The Random and Loop option randomly selects a start frame amongst the frames making up the 
animated source,  then repeats these source frames in order starting from the selected frame. 
When the source footage has come to an end, it starts again (see predefined example: cartoon > 
eyes).
- The Ping pong option is used to first repeat the animated source frames in a rising order. Once 
the last frame is attained, it repeats the frames in a descending order and so on until the end of the  
particle lifespan.
- The Random option is used to display the animated source frames randomly.
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Opposite, use of the 
default particle.
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- The  Random at start  option is used to display the animated source frames randomly for each 
particle, and then to keep it until the end of the particle life span (see predefined example: objects 
> tetris).
- The Particle age option varies the source frame displayed according to the age of its particle. All 
animated source frames are displayed once during the particle lifespan.
- With the Particle direction option the animated source frame chosen depends on the direction of 
the source in space. A coin thrown into the air, for example, will show one side on the way up and  
another on the way back down to the ground.
- With the Generator's direction option the animated source frame chosen depends on the angle 
formed  between  the  particles  generator  and  the  horizontal  plane  (see  above  in  the  chapter 
Emitters tab page 7 with examples line, point, rectangle or ellipse).
- With the Emitter direction option the animated source frame chosen depends on the angle formed 
between the particles emitter and the horizontal plane (see below in the chapter Emitters/Current 
tab, page 18).

The Blend popup menu is used to choose the mode to be used when drawing the particles on the 
screen  (color,  behind,  erase,  etc…).  Refer  to  the  predefined  example  (nature  >  sun)   for  an 
example of how to use the Add mode. 
In lesson 2 you were given a detailed description of the drawing modes available in TVP Animation 
(the Substitute and Mix modes refer to the modes encountered when using a spare image).

The Color source popup menu is used to modify the particles' color:

- The Color option is used to give a tint of your choice to the particles (use the Color box and Alpha 
parameter).
An Alpha value of 100% will totally change the natural color of the particles.

- The  Gradient  option is used to modify the color of particles emitted based on a color gradient 
(refer to the predefined examples: party > fireworks or misc > worma).

-  The  Mode  menu contains  some of  the  options  already  seen in  the  Animation  menu above. 
However, these options do not apply to all consecutive elements of an animated brush, but to the 
colors of your particles in accordance with the color gradient chosen. 
The color gradients chosen to be applied to your particles will depend on the choices you make in 
this menu.

In the example (party > fireworkscold) the particles' color covers the entire color spectrum of your 
particles for as long as they live.
In the example (party > stage lights) the particles' color is chosen randomly and kept as long as the 
particles live.
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The Emitters > Current tab

Let's take a closer look at the Current tab:

            

The  Active  button either  displays or  hides the emitter  named in  the Emitters popup menu (of 
course, your particle settings are retained). This function will render your task easier when working 
with several emitters at the same time and a large number of particles are displayed on the screen.
In order to understand the way the parameters described below work, we recommend you make 
full use of the Quick preview window.

The  Pre-Render  parameter  displays  the particles  on the screen after  the number  of  seconds 
entered here have timed out. 
Let's go inside the framework of a typical set of particles (pyrotechnic > smoketrailc).
Setting the pre-render value to 10 seconds will ensure you do not see the outset of the flames as 
they will already be well developed right from the beginning of the animation.

Some examples:
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The Range parameter is used to define the emitter 
opening  angle.  The  particles  bundle  will  then  be 
emitted within the arc defined. 

The Angle and Spin parameters are used to define 
the Direction in which the particles are ejected (see 
opposite).
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Do not confuse Direction of emitter  and Direction of 
the bundle of particles from the emitter.

In the example opposite: the emitter is a straight line 
at  an  angle  of  45°  (oblique)  and  the  direction  of  particles 
emitted is -90° (to bottom right) with an opening angle of 1°.

The New first check box, when checked, ensures that newly emitted particles are displayed in front 
of the older particles.
The result obtained with the predefined example (text > titre1) is similar to this option:
                

                  

New first box not checked                                          New first box checked

All  other  parameters:  Number,  Life,  Size,  Velocity,  Weight,  Bounce,  Friction,  Opacity,  Motion  
randomness and  Spin are the same as those encountered in the  Emitters > Particles > Current 
tab.
However, in this case we are dealing with «master» controllers: they are set as a percentage and 
have a direct influence on all particles of the emitter at the same time.

This is extremely practical when you wish to increase or decrease the size of all particles at the 
same time without modifying the size value for each type of particle emitted. This also eliminates 
the need for numerous calculations for each operation.
The use of animation keys with the master controllers often allows you to save a great deal of time.

To finish off, you may have noticed the animation key controllers next to the Emitters and Particles 
popup menus.

These are used to create animation keys for all parameters of the emitter or particle named in the 
popup menu header at the same time.
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Lesson 19

The advanced functions of TVPaint Animation

In this lesson, you will learn to :

● Go further about customized panels.

● Use the plug-ins at your disposal.

● Use the « George » scripting language.

● Use the “recorder”.



Customized panels

Customized panels

Adding an action

In the lesson 7, we have seen how to create a custom panel and how to save bryshes and colors 
inside. However, custom panels may also contain actions such as functions, scripts, etc... Their 
icons and information may be changed also.

Adding an action is done using the panel at the bottom left of this page :
* Using the first two text fields you may define a name and in-line help comment for your future 
customized function . 
* The buttons and menus List, Tool and A color allow you to choose the icon corresponding to the 
action you will create.

      

Opposite  you  find  the  list  of  icons  supplied  with 
TVPaint Animation.

To create a new icon, you simply have to create a 
brush with its image and select the Tool button.

* The numbered lines are the actions to be carried out one after the other when you click on the 
icon corresponding to your function.

Above you find the example of 
an  action  which  selects  all 
images of the current layer, flips 
them and  copies  them all  to  a 
new layer.
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The actions at your disposal.

Several possibilities are available if you decide to create an action. You can :

* Select a shortcut in the numerous program functions. (see previous page)

* Select an FX-Bin file stored in the FX-stack to re-use it.

* Open Plug-in  allows you to place a button to fast-start  plugins.  (they will  be introduced and 
explained in the next section of this lesson) 

* Open  panel  allows  you  to  create  dependencies  between  your  panels,  i.e.  you  may  display 
secondary panels from the main panel, for example. This may be useful for organizing your custom 
brushes or the contents of your various Bins. 

         

* Remove the current command.

* Insert a new command.

* Select a script command (for example : TV_Circle, etc ...)

* Grab the A color, B color or the current tool.

* It is possible to Grab the Light Table.

* You may call up a George automation script.

* Grab the tool only or with the A color or with the B color or with 
those two colors.

* Select a KeyStroke, call a plug-in and open a Tool Bar.

George Scripts and commands will be discussed further in this lesson.

How to manage the created actions.

Once your buttons are created in the custom panel, other options become available:

* With a simple selection in your custom panel you may cut or copy the icons/actions that you have 
just created. You simply use the menu described above to « paste » your icons/actions later.

* With a right click on an icon/action in the custom panel, you may edit, duplicate or delete it.

 >  >  > 
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How to use the plug-ins 

To use the plug-ins at your disposal, you have to :
* Open a custom panel
* Create a new button in this panel
* Select the plug-in you need as action to do for this button
The panel relative to the plug-in will then be visible once you click on the corresponding button.

The  Canon Plug-in is  available  only  if  you have selected it  during  the installation 
process of the software. It is available only on PC computers at this time.

The Color Factory plug-in

The Color Factory plug-in allows you to modify the values of the R,G,B and Alpha channels of the 
selected images, thanks to mathematical formulas. (ie : R,G,B and Alpha values of the pixels of 
your images) 

Based on the additive color principle, all colors are mixture of red, green and blue 
(more or less dark) in exact proportions.

Each color can be broken up in various ways depending on the color system. For  
example, the Slider tab of the Color Picker panel gives the numerical values of the A 
color in the R,G,B and H,S,L color systems.

Each text field of the  Color Factory panel describes one component (R,G,B or Alpha) and can 
contain a mathematical formula. The new values of those components will be computed using the 
formulas you have entered (the Alpha component indicates the opacity of the pixels).

The variables that you can use in your formulas are listed in the table below (all in lower case) :

 The variables :
r Value of the Red component of the pixel 
g Value of the Green component of the pixel 
b Value of the Blue component of the pixel 
a Value of the Alpha component of the pixel 
x x coordinate of the pixel
y y coordinate of the pixel
w Width of the current project
h Height of the current project

And here are listed the arithmetic operators :

 Arithmetic Operators Examples :
+ add 18 + 3 = 21 
– subtract 18 – 6 = 12
* multiply 18 * 3 = 54
/ divide 18 / 3 = 6

It is possible to use parentheses  (  )  in order to set priorities in your computations. If you don't use 
them, the Color Factory plug-in will evaluate the operations from the left to the right.
For instance :      1+2*3 = 9        1+(2*3) = 7
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Here are a few examples using the Color Factory plug-in.
* Let's begin with a classic image without any modification :

       

* Here is a negative of the previous landscape :

       

* Below, the red and blue components of the landscape have been inverted : the sky turned into 
orange and the road turned from red to blue. The green component stay unchanged.

       

*  The  Color  Factory plug-in  can  also  be  used  to  create  nice  color  gradients.  Therefore,  the 
formulas on the right panel below are more complicated.

       

* Below, simple additions have been done with the red and green color channels inverted.
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* Here is the last example : an opacity gradient from the top right to the bottom left of the image.

       

The Canon plug-in (PC only)

The Canon plug-in allows the user to retrieve photos from a Canon digital camera and to put them 
directly into a TVPaint Animation layer.
This plug-in is very convenient for the animator who want to work in stop-motion directly with the 
software.
Here are the steps to use the Canon Plug-in with TVPaint Animation :

* What is required :
- The Canon driver of your camera must be correctly installed in your system. (Microsoft Windows 
only at this time)
- You should have a compatible Canon camera (see the list in Appendix) powered and plugged into 
an USB port of your computer.
- You have to set your camera in playback mode. Don't use the shooting mode as it does not allow 
you to manage your camera via the computer.

  Go lesson 5 to know more about the Video input panel !

It  is  advised always to close your Video Grabber and Video Canon panels before 
quitting the software. 

The Direct Show plug-in (PC Only)

DirectShow  is  an  application  programming  interface  from  Microsoft  which  contains  a  set  of 
software libraries. It is a component of DirectX and allows to manage multimedia files. 

The DirectShow Plug-in provides support for USB, SCSI, FireWire, ... compatible hardwares.
(in theory all Windows Driver Mode (WDM) compatible hardwares)

The WaveForm plug-in

Generally speaking, an oscilloscope is an electrical equipment which allows you to monitor and 
measure periodic signal voltages. If it is calibrated in order to receive video signals, it is also called 
WaveForm monitor. In the audiovisual environment, they are often used to check if the transmitted 
video signal has its characteristics in conformity with the applicable broadcasting rules.
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Our WaveForm Plug-in allows the audiovisual professionals to use their classical tools.
Thanks to this Plug-in, it is now easy to check the integrity of a signal, manage calibration and 
colorimetric adjustments, control the validity of numerical signals, ...
The popup menu allows you either to select :
* A Composite WaveForm monitor
* A VectorScope
* A Component WaveForm monitor

The monitors at you disposal  in  this WaveForm Plug-in act  as if  all  layers of  the 
current picture where merged.

Here are some options relative to the different displays at your disposal :
* The Composite WaveForm monitor can use luminance and/or chrominance signal(s).
* The VectorScope can use two calibration sets : 75 % and 100 %
* The Component WaveForm monitor can use the R,G,B or Y,U,V systems.

Let's now explain the other options :
* It is possible to set the luminosity of the display thanks to a mini-slider.
* The reticule button allows to show or hide the different axis and channels.
* If the transparency button is checked, the black background will not appear when using the apply 
button.
* The apply button allows you to copy on the current image the results obtained in the WaveForm 
Plug-in panel.

How to use the « George » scripting language

Introduction: what is George ?

George  is  a  programming  language  which  allows  you  to  use  the  numerous  tools  of  TVPaint 
Animation. Every program written in this language is called “George Script”. Other softwares use 
sometimes the word “Macro” instead of “Script”.

A George Script allows you to execute specific TVPaint Animation command such as :
Create a new layer, draw a circle on this area, save the current project, add a bookmark, etc…

Those Scripts are usually created to save some time when executing a repetitive task is needed. 
Experienced programmers use TVPaint Animation commands in order to create “.dll ” plug-ins
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Some George Scripts are available as example with the software, but you can also create your 
own scripts and/or exchange them with members of the TVPaint Community. (You can access the 
TVPaint forum here: http://www.tvpaint.com/forum/)

Finding, Editing and Using George Scripts

After installing TVPaint Animation on your computer, George Scripts are located in the directory:

C:/program files/TVPaint Animation/George       Windows.
Applications/TVPaint Animation/Contents/Ressource/George/ Apple OS-X.

Those George Scripts are in fact usual ASCII text files and have a “.grg” extension.
It is possible to edit or create them with any text editor like  Notepad from Microsoft Windows or 
Text Edit from Mac OS-X.

The scripts are in theory working on the both standards PC and Macintosh, whatever the computer 
used to create them.

 

 

Once  a  George  Script has  finished  its  programmed  tasks,  the  Undo  option  of  the  TVPaint 
Animation main panel allows you to cancel all the changes it has generated.

A few examples of George Scripts

Often, George Scripts need an action from the user in order to be launched. For instance : 
The George Script named “long.grg” waits for a segment to be drawn on screen and finally returns 
its length.
The George Script called “clock.grg” waits for a circle to be drawn on screen and finally draws a 
clock inside this one.
The George Script called “button Z.grg” waits for a rectangle to be drawn on screen and returns a 
bevelled button inside it
A few  George Scripts don’t need any action from the user to be started: it’s the case with the 
George Script called ”Zsurface.grg”.
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To use one of the George Scripts at your disposal, just follow the 
steps below:
_ open a custom panel
_ create a new button on this panel
_ select the action:  -Set script-  for this button
_ select a file with a “.grg” extension in the file requester

Once finished, if you click on the just created button, the George 
Script will then be launched.

At every moment, you can stop the execution of a George Script by using the 
[Esc] key.

A window, indicating on which line the execution of  the script  was stopped, 
should popup.

http://www.tvpaint.com/forum/index.php


How to use the « George » scripting language

      
Above: the results of the scripts: button Z, Long, Clock, Zsurface and Polystar

A few George Script are more complicated and some requesters may appear.
It is the case with the George Script called Polystar.grg : during its execution, a first requester asks 
you to specify how many vertices should be drawn. If you apply your script on an animated layer 
(after selecting all its frames), a second and third requesters will ask you more informations (see 
below)

             

Programming in George language

George is a scripting language which can do the basics:
- Loops (do the same thing n times),
- Conditional testing (if this is true then do that),
- Computations (a+b, sin(a),...).

The George language is not particularly fast,  but it  is flexible and very easy to use.  On many 
points, George is comparable to the Pascal language or other well known programming language.
However it’s  not aimed at developing heavyweight applications as are for example the C or C++ 
languages. George is first and foremost a scripting language.

Instructions and Commands

George needs classical instruction to structure the scripts: tests, loops, computation, conditional 
events, etc… For a better readability, all the instructions will be written in green in this manual.
For example : 
If, Else, End, For, Do, Until, While, …      for conditionals tests
Cos, Sin, Tan, Rnd, …                             for computations

You can also call  in your scripts TVPaint Animation commands, which call specific tools of the 
software.

They can be differentiated from the classical George instruction because they all begin with the 
« tv_ » prefix. (They will be written in blue color)
For instance :
* The command tv_LayerCreate allows you to create a new layer.
* The command tv_SaveBrushAnim saves the current brush on the hard drive.
* It is possible to change the colors of the bin tab thanks to the tv_SetPalette command
* Etc… (You will find in appendix the complete instruction and command listings of the George 
Language.)

All TVPaint Animation commands need their own arguments and return some values as answer.
For example, the tv_LayerCreate command needs a name for the layer that you want to create.
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This command returns some information regarding your layer: opacity, number of pictures, place of 
the timeline,… So you can reuse or modify them.

It  would be too long to enumerate here the arguments and the return values of each George 
command.  All  those  parameters  are  fully  explained  in  the  developper  kit  (SDK)  of  TVPaint 
Animation. The SDK is available on demand at the email address: tvpaint@tvpaint.fr

Make sure to differentiate George instructions (which often start with a
sharp : #) and George commands for TVP Animation (which always start with the 
« tv _ » prefix).

The commands act on the software itself and on your current display whereas George 
instructions are used to write the structure of the program (conditionals, computations,
loops, ...)

Since approximatively 10 years, all the softwares using the TVPaint technology offers 
a scripting language.
Here  are  some  informations  regarding  the  compatibility  between  those  scripting 
language :  If you upgraded to TVP Animation, your old scripts should still work.
However,  some  recent  commands  (for  instance:  TV_AddBookmarks)  are  not  
available in older products using the TVPaint Technology. (Aura, Mirage,…)

An example of program written in George.

The  program on  the  next  page  comes  from the  file  clock.grg.  It  allows  you  to  draw a  clock 
displaying the current time on the project window.

We suggest you create a button assigned to this script in a custom panel, as explained previously.
After this operation, it should be easy for you to test this George Script in the project window.

Once this stage is passed, you can try to edit the George Script, to modify it and to test it again in 
TVPaint Animation. This should help you learn the basics of the George Language.

The best way to get used to George scripts is probably to try the example programs 
that come with TVPaint Animation. 

Study them and make small alterations to them, then run them and see the effects of your 
changes. 
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The  clock.grg  script :

    

Param Circle
// TVPaint should wait for the coordinates of a circle before running the
// program. The user must therefore draw a circle to start the program.

Parse result command x y r button
// Fetches the coordinates of the user’s circle.

if cmp(command,"Circle")==0
tv_Warn "This program needs the coordinates of a circle !"
exit

// If there are no coordinates for a circle, warn the user and end the program.
End

t=time
parse t h m s

// Fetches the hours (h), minutes (m) and seconds (s) of the current time.
m=m+s/60

// The seconds can slightly alter the minutes arm of the clock.
tv_Pen r/30 // Selects a pen proportional to the clock size.
tv_Circle x y r // Draws the outline of the clock.
ang=360/12
d=r-(r/10)
#for i=0 to 360-ang step ang

// Loop to draw the 12 hour markers on the clock
#a=cos(i)*d
#b=sin(i)*d
tv_Dot x+a y-b 0

#end

i=h*360/12 // Draw in the hours
d=r/2
a=sin (i)*d
b=cos (i)*d
tv_Line x y x+a y-b

i=m*360/60 // Draw in the minutes
d=r-(r/8)
a=sin(i)*d
b=cos(i)*d
tv_Line x y x+a y-b

// End of the example

Commands Description

Here are some information regarding the commands that you can find on the previous page :

Below, each command will be followed by the syntax of the variables it requires. 
For example, to draw a straight line from one point to another, you must give the coordinates of the 
start point then the end point.
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The syntax to draw such a line would be:

tv_Line   x1 y1 x2 y2 [0/1]

The [0/1] parameter indicates that you can use either the left [0] or the right [1] mouse button. This 
is optional; by default, it’s always the left button that will be used.

To summarize :

[ ] Variables inside square brackets are optional.
/ The “/” symbol separates several options of which only one is used.
For instance, 0/1 means either 0 or 1.

tv_Circle x y r [0/1]
This command allows you to draw a circle with a radius r and a center located on the pixel with 
(x,y) coordinates. The [0/1] parameter indicates that you can use either the left [0] or the right [1] 
mouse button.
Of course, the circle will be drawn on the current image on the current layer.

tv_Dot x y [0/1]
this command allows you to use the current tool (airbrush, pen, custombrush,…) on the pixel with 
(x,y) coordinates, in the current image on the current layer.
The [0/1] parameter indicates that you can use either the left [0] or the right [1] mouse button.

tv_Warn text
This command displays a popup dialog box containing the character string text and an “ok” button.
The character string must be surrounded by quotation marks.

tv_Pen size
This  command allows  you  to  select  the  pen  tool  with  its  current  parameters  (drawing  mode, 
opacity, power, ...) and change its size.

You should always remember that a George Script will use TVP Animation as it finds 
it, i.e. with the functions and options that are currently set. 

For instance, if you want to draw a red line with a George Script, the script needs to 
be told more than just the line coordinates. Unless you explicitly tell it to use a red 
color,  your script  will  go ahead and use the current color when the script is run,  
whatever it may be.

Similarly, if when you run the script it is in the Behind or Colorize drawing mode, you 
won’t exactly be getting the clean line you were hoping for.

A few useful options

It is now time to explain some programming conventions:

1°) A sharp character #  at the beginning of a line will not affect the execution of the script.
For instance, the line :

Pause 20

will pause the execution of your script during 20 seconds.
And the following script line will have the same result :

#Pause 20 
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2°) You can use only one instruction or command on the same line. For instance, if you use the 
following line in a script :

Print "wait a little" Pause 20

An error message will be returned.
The two lines below will not return any error messages :

Print "wait a little"
Pause 20

3°) Everything on a line that is after a double slash // is ignored. They are only
comments that have been put into the script to make it more understandable and  readable by 
humans. For instance, the line :

Pause 20 // wait 20 seconds

makes TVPaint Animation wait during 20 seconds.
However, the line :

// Pause 20

will not pause the execution of your script.

TVP Animation sees no difference between uppercase and lowercase letters. For 
instance,  TV_layercreate,  tV_LaYeRcReAtE,  tv_LAYERCREATE are  all  exactly 
the same command.

How to use the variables

It is not necessary to declare the types of your variables in a George Script.
For  instance,  you can write  the two lines below in a script  without  declaring  that  the variable 
MyNumber is numeric or the variable Answer  boolean.

MyNumber=10
Answer=false

As  for  commands  and  instructions,  the  George  language sees  no  difference 
between uppercase and lowercase letters.  For  instance,  MyNumber, mynumber, 
MYNUMBER, MyNuMbEr  are all exactly the same variable.

The George language use a few reserved variables in order to work correctly. You 
can use them as you wish, but it is not advised to modify them.

That is the case with the two variables « Time » and « Result » (encountered in the 
clock.grg  script  above)  which  contains  respectively the  current  time  and  the  
results of the last used TVP Animation command.
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The operators at your disposal

Arithmetic Operators Examples :

- negative 18  ->   -18
** exponent 18**3=18*18*18=5832
* multiplication 18*3=54
/ division 18/3=6
+ addition 18+3=21 
- subtraction 18–6=12

Logic Operators Examples :
&& and a&&b
II or aIIb

Related Operators Examples :

== equal x==6 x==x+2 
!= not equal to x!=5 x!=y-3
> greater than x>4 x>y-z

>= greater or equal than x>=3 x>=z/y
< less than x<8 x<-y

<= less or equal than x<=7 x<=x+5

The « = » operator is an assignment operator and allows to assign a given value to the variable of 
your choice. For example :

MyNumberOfLayers=5

The  «  ==  »  operator  is  an  comparison  operator  between  two  variables,  usually  used  during 
conditional tests. For example :

if a==5

The comparison operator is not appropriate if  want to know if two non numerical variables are 
equal. For this, you need to use the instruction cmp, as shown in the clock.grg  script above :

 if cmp(command,"Circle")==0

The Param and Parse instructions, the launching modes.

The instruction Parse allows you to split up a character string into smaller character strings

Rainbow="red orange yellow green blue indigo violet"
Parse  Rainbow color1 color2 color3
tv_warn  color1          //  displays « red »
tv_warn  color2          //  displays « orange »
tv_warn  color3          //  displays « yellow green blue indigo violet »
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Usually,  each  George Script begins with the  Param instruction.  It  allows you to choose which 
action will have to be done by the user in order to start the script execution : drawing a circle, a 
segment, a rectangle ...

* The script line :

          
     Param None 

allows the George Script to be executed without waiting for an user action.

* The two script lines :

          

     Param Single
     Parse result command x y button

allows you to execute a George Script after a simple mouse click on the project window. 

      

- The character string  «  single» will be assigned to the variable called 
command if a point is drawn on the screen.
- The point coordinates will be assigned to the variables x and y.
- The button selected by the user to draw the point will be assigned to 
the variable called button. (1 for RMB, 0 for LMB).

* With the following script lines :

          

     Param Line
     Parse result command x1 y1 x2 y2 button

The George Script will be launched only if a segment is drawn on the project window.

      

- The character string  « Line » will  be assigned to the variable called 
command if a line is drawn on the screen.
-  The  coordinates  of  the  points  at  the  ends  of  the  segment  will  be 
assigned to the variables  x1 y1 and x2 y2  ( see opposite )
- The button selected by the user to draw the line will be assigned to the 
variable called button. (1 for RMB, 0 for LMB).

* With the two script lines below :

          

      Param Circle
      Parse result command x y r button

The George Script will be launched only if a circle is drawn on the project window.

      

- The character string  « Circle » will be assigned to the variable called 
command if a circle is drawn on the screen.
- The coordinates of the circle center will be assigned to the variables x 
and y.
- The radius of the circle will be assigned to the variable r.
- The button selected by the user to draw the circle will be assigned to 
the variable called button. (1 for RMB, 0 for LMB).

* With the following script lines :

          

      Param Rectangle
      Parse result command x1 y1 x2 y2 button
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The George Script will be launched only if a rectangle is drawn on the project window.

      

-  The character  string  « Rectangle » will  be assigned to the variable 
called command if a rectangle is drawn on the screen.
-  The  coordinates  of  the  points  at  the  ends  of  the  rectangle  will  be 
assigned to the variables  x1 y1 and x2 y2  ( see opposite )
- The button selected by the user to draw the rectangle will be assigned 
to the variable called button. (1 for RMB, 0 for LMB).

* With the two script lines below :

          

      Param Freehand
      Parse result command x y button

The George Script will be launched only if a freehand curve is drawn on the project window.

      

-  The  character  string  « Freehand » will  be  assigned to the variable 
called command if a curve is drawn on the screen.
- The button selected by the user to draw the curve will be assigned to 
the variable called button. (1 for RMB, 0 for LMB).

The character strings

It  is  important  to  know how to use the character  strings because they usually  plays a part  in 
numerous situations.
For example, in the following script lines, a loop allows to load the projects :
D:/cartoon3.tvp, D:/cartoon4.tvp, ... ... ... D:/cartoon15.tvp, D:/cartoon16.tvp.

For number=3 to 16

  NameOfTheFile="D:/cartoon"number'.tvp'

tv_loadproject NameOfTheFile

End

As shown above, you will have to use simple quotation marks ('...') or double quotation marks (''...'') 
in order to differentiate variables from character strings.

In the example above :

number  and  NameOfTheFile    are variables
D:/cartoon  and  .tvp  are character strings

The variable NameOfTheFile receive the concatenation of D:/cartoon,  number  and  .tvp
In other words, the character strings d:/cartoon and .tvp, the variable number have been joined 
end to end in order to create the variable NameOfTheFile.

It  is  possible  to  use the  Concat instruction to  join  end to end character  strings 
and/or variables. The following lines have the same effect :

NameOfTheFile=number'.jpg'
 NameOfTheFile=Concat(number,.jpg)

If you need to use simple quotation marks ('...') or double quotation marks (''...'') in your character 
strings, you must surround them with the other quotation marks at your disposal, as shown in the 
example below :
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Print  ' My prefered animation program is " TVP Animation " '

// will surround the name of the software with double quotation marks.

Print  " My prefered animation program is ' TVP Animation ' "

// will surround the name of the software with single quotation marks.

The arrays

As in other programming languages, George can create and use arrays with one, two or more 
dimensions.

To create an array, you only need to add parentheses or square brackets after the name of a 
variable. You can use either parentheses or square brackets.

For instance,
MyArray(i) or MyArray[i] represent the same array with one dimension.
MyArray(i,j) or MyArray[i,j] represent the same array with two dimensions.
MyArray(i,j,k) or MyArray[i,j,k] represent the same array with three dimensions.
And so on ...

With the George language, it is not necessary to indicate or declare the dimension 
or the number of elements before using an array.

In the exemple below, an array called color with one dimension was created.
It contains four elements : "Magenta", "Cyan", "Yellow" and "Black"
We used a loop to display its content.

color[1]="Magenta"
color[2]="Cyan"
color[3]="Yellow"
color[4]="Black"

For i=1 To  4

        tv_warn color[i]            //  displays each color : "Magenta", "Cyan", "Yellow"
          // and  "Black", in a dialog box.

End

Functions and procedures

Let's assume that you are writing a script which needs some instructions, conditional tests, etc ... 
to be executed several times. (For instance, a script which tests the pixel's colors several time and 
acts differently depending on the obtained results. )

Copying the same lines several time in a George Script can quickly become fastidious. It doesn't 
make the things easier when you need to check or modify your script.
That's the reason why writing procedures and functions is very convenient :

* A function is a set of instructions and commands which allows you to execute a precise task 
inside a George Script. The functions are independent from the remainder of the George Script 
and are located at the end of the script.
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The part of a George Script which distinguish itself from the function(s) will be called “main part of 
the  script”. All the functions are available at any moment in order to be used by the Main part of  
the script. A function can receive parameters and always returns a result.

* A procedure is a function which does not return results.

Here is an example of a script using a function :
(Of course, using functions is really useful when you have to create bigger and more sophisticated 
scripts )

Param Single
Parse result command abscissa ordinate button
tv_warn TestBlackColor(abscissa,ordinate)

//  Main part of the script ▲
// - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -  
//  Function ▼

Function TestBlackColor(x,y)
Local r g b alpha sum
tv_getpixel x y
Parse result r g b alpha
If alpha<>0

sum=r+g+b
If  sum==0

Return " the pixel's color is black "
Else

Return " the pixel's color is NOT black "
End

Else
Return " the pixel is transparent "

End
End

The line :

tv_warn TestBlackColor(abscissa,ordinate)

Can be replaced by the two following lines :

 Answer=TestBlackColor(abscissa,ordinate)
 tv_warn Answer

Here is the syntax of the instructions relative to the procedures and functions :

Function NameOfTheFunction (Variable1, Variable2, Variable3, etc ... )
This instruction declares the existence of a function or a procedure in a George Script. (there is no 
instruction called « procedure »)
This  instruction  is  followed by the procedure or  function name,  and then by the name of  the 
variables (from the main part) that are needed.

Functions and procedures must always be located after the main part of your script. 
Calling a function or a procedure in the main part  of  your script  can be done by 
writing its name and the needed variables between parenthesis, separated by comas.
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Local LocalVariable1, LocalVariable2, LocalVariable3, etc ... 
This instruction allows you to specify the variables which will be used solely inside your function or 
procedure.

Return Result
This instruction allows you to specify the result of your function and to make it available in the main 
part of the script. It could be a character string, a numerical value, a boolean value, etc  ...
In the main part of your script, it is possible to save it into a variable, and after to re-use it.
This instruction is optional. If you don't use it, you have created a procedure instead of a function.

End
This instruction is needed to finish your function or procedure.

The functions and procedures written in George language can be recursive. In other 
words, a function can call itself. It allows you to create more sophisticated scripts.

For instance, drawing a fractal curve can be done thanks to a recursive script
(see below)

  >    >  

How to create libraries of functions and procedures.

We have just seen in the last chapter that it was possible to create your own George functions and 
procedures.
This may be taken even further as you can store your functions and procedures in «.grg» files and 
you can re-use them in other scripts written in George.
In other words, you can create your own libraries.

To insert one of your libraries in a George Script, you only have to write the following line in your 
script :

     #Include "MyLibrary.grg"

The instruction  #Include will  search the file called  MyLibrary.grg  in the directory containing the 
current George Script or in the root directory of  TVPaint Animation.

The following line allows you to specify a more precise access path, from the base directory :

     #Include "MyFolderOfLibraries/MyLibrary.grg"

Please read the Initialization File section in the appendix of this user-manual if you 
want to change the root directory of TVP Animation.

Two examples of libraries are available in the directory :
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C:/program files/TVPaint Animation/George/Include       Windows
Applications/TVPaint Animation/Contents/Ressource/George/         Apple OS-X

They are called Basic.grg and Advanced.grg and are related to character strings management.

     # Include "include/basic.grg"

     # Include "include/advanced.grg"
     

To  make  them available  in  the  George Scripts 
given with the software, you only need to add the 
opposite lines at the end of those scripts :

The Startup.grg file

At startup, the first thing that TVPaint Animation does (after displaying the main toolbox, but
before giving control to the user) is to run the  Startup.grg script (which should be in  the same 
directory as the other scripts). 
When there is no  Startup.grg file, nothing will  happen. Otherwise, you have at your disposal a 
startup file that gets run every time you load TVPaint Animation.
If, for example, you rename the Logo.grg file to Startup.grg, it will load the TVPaint Développement 
logo to screen every time you run TVPaint Animation.
You  could  also,  thanks  to  a  simple  George  script,  define  all  your  preferred  parameters.  For 
instance : load a project from your harddrive, change the current colors,  add some layers to your 
project, etc…

The TVPaint Animation Plug-in developpement

As  explained  before, George  is  not  the  only  program  that  can  send  commands  to  TVPaint 
Animation.
Any other program could theoretically do so. Examples using an Excel script, a C program or other 
languages are certainly conceivable.

Besides, it is possible for experienced users or third-party companies to create Plug-ins that can be 
used with TVPaint Animation.
Those  Plug-ins allows you to add customized tools to the software like  effects on pictures, new 
drawing modes, new tools or new functions.
The Plug-in may be in the « .dll » (Dynamic Link Library) file format, which can be obtained thanks 
to a compiler. « .dll » files are not readable in a text editor, unlike the classical George Scripts.

For more details about this subject, please visit the TVPaint Developpement forum. You can also 
ask us the development kit (also called SDK) at the email address : tvpaint@tvpaint.fr
This kit contains source codes for interface functions, documentation and some detailed plug-in 
examples.

Adding arguments 

You can add arguments to the execution of TVPaint Animation. These arguments are :
- images (just write the path and file name),
- scripts (syntax: script=PathAndFileName.grg),
- george commands (syntax: cmd=GeorgeCommand).

For example :
TVPaint Animation.exe "MyImage" "script=MyScriptPathAndName.grg" 
"cmd=MyGeorgeCommand"
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The Drawing Recorder

The Drawing Recorder

The aim of the Drawing Recorder panel (Windows > Utilities) is to store all the strokes of the user 
when he is drawing. With this feature, it is possible to create an animation from a static drawing. So 
the result of the Drawing Recorder is an animation which shows each step of the drawing and how 
it has been constructed. Note that it is possible to change the current tool during the drawing and 
the timing of the drawing is preserved when the animation is created.

Each time the content  of  the  image changes,  a new image is  added in  the animation of  the 
Drawing Recorder.

          

The original image which was drawn, while the Drawing Recorder was 
running, 3 letters with 3 different tools.

The animation, based on the original image, created thanks to the drawing recorder.

The Drawing Recorder panel is very simple, three buttons and a preview.

*  The  menu  above  allows  you  to  choose  to  preserve  the  alpha 
channel (Current layer) or not (Display).
* The preview area and the slider below it allow to see and navigate 
between each frame of the record.

* The Record/Pause button  starts or pauses the recording.
*  When the user thinks he has finished his work,  the new Project 

button   allows  you  to  create  a  new  project  and  store  all  the 
strokes/frames of the recording.

* And with the Skull button  , it is possible to delete the current 
recording to be able to start a new one.

The Tutorial recorder

This custom panel allows you to record easily your TVPaint Animation interface.  This is really 
useful, especially to create tuorials. This panel can be found in the menu Custom panelsî.

The first button is used to start the record, whereas the second allows to stop and generate an 
images sequence into the TVPaint Animation's timeline.
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The video cards compatible with TVPaint Animation (Pro)

The video cards compatible with TVPaint Animation (Pro)

For both video input and/or output, some video cards are compatible with TVPaint Animation (Pro):
Here is the complete list, with all the features detailed (only for PC at this time) :

Hardware
Model

Native file 
format

Video Output Video Input

Possibility to 
view your 
work on 
TVPaint 

Animation 
Pro and the 

video 
hardware

Needs a 
rendered 
preview 

before being 
available on 

the video 
hardware

The current 
project 

window (with 
opacity 

values) can 
be keyed over 

a live video

Image 
grabber
option

Possibility 
to display 
the current 
video in the 

project 
window

Leitch 
VelocityQ .dps

Leitch 
Velocity HD Should be added in the next updates of  TVPaint Animation Pro

DPS 
PAR - PVR
Hollywood

Matrox 
DigiSuite

DigiSuite LE
DigiSuite DTV

.avi

Newtek
VTNT

VT[2] – VT[3]
.rtv

DV
compatible

with OHCI 1394
.rtv

WDM
Web Cam

Digital Camera

Bluefish 444 quicktime
 avi

cineon

Bluefish 444 HD
Should be added in the next updates of  TVPaint Animation Pro

       = Available            = Not available
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The hardware native file formats, if they are available, are used by TVPaint  
Animation Pro and your  video card during the video import  and/or  export 
process.
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The digital camera working with the Canon Plug-in (PC only)

The digital camera working with the Canon Plug-in (PC only)

Please find below the list of theorically supported models regarding the canon SDK we used for 
this plugin (PC only at this time)

PowerShot A10, PowerShot A20, PowerShot A30, PowerShot A40, PowerShot A60, PowerShot A70, 
PowerShot A75, PowerShot A80, PowerShot A85, PowerShot A95 
PowerShot A100, PowerShot A200, PowerShot A300, PowerShot A310, PowerShot A400, PowerShot A510, 
PowerShot A520 
PowerShot S10, PowerShot S20, PowerShot S30, PowerShot S40, PowerShot S45, PowerShot S50, 
PowerShot S60, PowerShot S70 
PowerShot S100, IXY DIGITAL, DIGITAL IXUS 
PowerShot S110, IXY DIGITAL 200, DIGITAL IXUS v 
PowerShot S200, IXY DIGITAL 200a, DIGITAL IXUS v2 
PowerShot S230, IXY DIGITAL 320, DIGITAL IXUS v3 
PowerShot S300, IXY DIGITAL 300, DIGITAL IXUS 300 
PowerShot S330, IXY DIGITAL 300a, DIGITAL IXUS 330 
PowerShot SD100, IXY DIGITAL 30, DIGITAL IXUS II 
PowerShot S400, IXY DIGITAL 400, DIGITAL IXUS 400 
PowerShot SD10, IXY DIGITAL L, DIGITAL IXUS i 
PowerShot SD110, IXY DIGITAL 30a, DIGITAL IXUS IIs
PowerShot S410, IXY DIGITAL 450, DIGITAL IXUS 430 
PowerShot S500, IXY DIGITAL 500, DIGITAL IXUS 500 
PowerShot SD20, IXY DIGITAL L2 , DIGITAL IXUS i5 
PowerShot SD200, IXY DIGITAL 40, DIGITAL IXUS 30 
PowerShot SD300, IXY DIGITAL 50, DIGITAL IXUS 40 
PowerShot SD400, IXY DIGITAL 55, DIGITAL IXUS 50 
PowerShot SD500, IXY DIGITAL 600, DIGITAL IXUS 700 
PowerShot G1, PowerShot G2, PowerShot G3, PowerShot G5, PowerShot G6 
PowerShot Pro90 IS 
PowerShot S1 IS, PowerShot S2 IS 
PowerShot Pro1 

The EOS class of digital cameras are not supported at this time.

T  he   George instructions  

Here is the complete list of George instructions :

abs
acos
asin
atan
break
char
cos
cmp
cut

date
do...until
exit
len
for
if...else...end
max
min
param

parse
pause
print
rnd
sin
sqr
tan
time
trunc

version
while
concat 
for...to...end 
function 
local 
return 
while...end 
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The George language commands

Here is a non exhaustive list of George commands :

tv_airbrush
tv_alphaloadmode
tv_alphasavemode
tv_areadraw
tv_areainit
tv_areamove
tv_tvpaint2back
tv_tvpaint2front
tv_background
tv_blend
tv_bookmarksenum
tv_bookmarkset
tv_bookmarkclear
tv_bookmarktoggle
tv_bookmarknext
tv_bookmarkprev
tv_brushcut
tv_brushfromclipboard
tv_brushinfo
tv_brushpoly
tv_brushrestore
tv_brushtoclipboard
tv_bump
tv_circle
tv_circlefill
tv_clear
tv_colorfactory 
tv_crazyblur
tv_densitylinex
tv_densityliney
tv_densityx
tv_densityy
tv_display
tv_dot
tv_ellipse
tv_ellipsefill
tv_fastline
tv_fieldcopy
tv_fielddouble
tv_fileinfo
tv_fill
tv_filter
tv_firstimage
tv_flipimagex
tv_flipimagey
tv_fixmotion
tv_framerate
tv_gauge
tv_gblur
tv_getactivetool
tv_getactiveshape
tv_getapen
tv_getbpen
tv_getfield
tv_getheight
tv_getmouse
tv_getpalette
tv_getpath

tv_getpixel
tv_getpixeldisplay
tv_getpixellayer
tv_getprojectname
tv_getuser
tv_getwidth
tv_ghostline
tv_grab
tv_imagefromclipboard
tv_imagetoclipboard
tv_lastimage
tv_layeranim
tv_layercopy
tv_layercreate
tv_layercurrentid
tv_layercut
tv_layerdensity
tv_layerdisplay
tv_layerduplicate
tv_layerfetch
tv_layergetid
tv_layergetimage
tv_layergetpos
tv_layerhold
tv_layerimage
tv_layerinfo
tv_layerinsertimage
tv_layerinvert
tv_layerkill
tv_layermerge
tv_layermergeall
tv_layermove
tv_layerpaste
tv_layerrename
tv_layerselect
tv_layerselectinfo
tv_layerset
tv_layershift
tv_layerstencil
tv_layerstretch
tv_line
tv_listrequest
tv_loadbrush
tv_loadbrushanim
tv_loadimage
tv_loadpalette
tv_loadproject
tv_loadsequence
tv_loadspare
tv_lockcacheflush
tv_lockdisplay
tv_lockmouse
tv_magicnumber
tv_menuhide
tv_menushow
tv_mosaic
tv_noise
tv_nop

tv_panning
tv_penbrush
tv_pencil
tv_perswrap
tv_piccolor
tv_preserve
tv_propelling
tv_projectclose
tv_projectcurrentid
tv_projectduplicate
tv_projectenumid
tv_projectinfo
tv_projectnew
tv_projectselect
tv_readprojectstring
tv_oilbrush
tv_quit
tv_rangeclear
tv_rangegrab
tv_rangenoise
tv_rangeset
tv_ratio
tv_readuserstring
tv_readtextfile 
tv_recorder
tv_rect
tv_rectfill
tv_redo
tv_reqangle
tv_reqfile
tv_reqfloat
tv_reqnum
tv_reqstring
tv_request
tv_resetdisplay
tv_resizepage
tv_savebrush
tv_savebrushanim
tv_savedisplay
tv_saveimage
tv_savemode
tv_savepalette
tv_saveproject
tv_savesequence
tv_selectshapetool
tv_serialnumber
tv_setapen
tv_setbpen
tv_setcolor
tv_setpalette
tv_shadow
tv_smooth
tv_smoothdensity
tv_smoothedge
tv_spareadddensity
tv_sparecopy
tv_sparekill
tv_sparesubdensity

tv_spareswap
tv_sparetoback
tv_sparetofront
tv_specialbrush
tv_speed
tv_stacksavebin
tv_stacksave
tv_stackloadbin
tv_stackload
tv_stackexecutebin
tv_stackexecute 
tv_stackopen
tv_stackclose
tv_stackapply
tv_stackclear
tv_startframe
tv_strokepoint
tv_strokesize
tv_tcmode
tv_textbrush
tv_texttool
tv_tornado
tv_undo
tv_updateundo
tv_unlockcacheflush
tv_unlockdisplay
tv_unlockmouse
tv_version
tv_vfgetfont
tv_vfstringsize
tv_waitbutton
tv_warn
tv_warpbrush
tv_wave
tv_wetbrush
tv_writepixel
tv_writeuserstring
tv_writeprojectstring
tv_zdot
tv_zline
tv_zspline

More information : http://wiki.tvpaint.com/
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The main characteristics of the export formats :

The main characteristics of the export formats :

You can export projects from TVPaint Animation using several different file formats. 
DIP, AVI, GIF, QUICKTIME, DPX, FLI, PNG, PCX, SUNRASTER, PSD, TGA, JPG, ILBM, TIFF, 
BMP.
And you have these further formats for TVPaint Animation Pro: FLYER CLIP, D1 RTV, CINEON, 
SGI, SOFTIMAGE, VPB.

* The FLYER CLIP file format lets you export an animation that you can use with the VideoToaster 
Flyer from Newtek. The animation is saved as a single file and has usually a resolution of 752x480.

* You can use the D1 RTV file format in order to export an animation usable with the VideoToaster 
from Newtek . The animation is saved as a single file and has a resolution of 752x486 for NTSC 
ans 720x576 for PAL

* The CINEON export format was created by the Eastman Kodak Company in order to be used 
with their scanners and recorders. It uses logarithmic data (10 bits).

* The VPB format is native to the Quantel Video Paintbox. It uses 24 bits per pixels (more than 16  
millions of colors). Although the VPB format use stencils and layers, TVPaint Animation Pro does 
not translate its layers into VPB layers at this time.

The other export formats are classified in the table below.

   

= Available / possible for this 
file format

               

= Not available or not 
recommanded for this file format

Export Colors Other options

File format :
Animation 
as single 

file

Image or 
Image 

sequence

8 bits :

256 colors

24 bits

16.777.216 
colors

Save 
Opacity

Save 
Layers

Compression

TVP 

(AUR MIR)
-

DIP -

AVI -

GIF
One 

transparent 
color

QUICKTIME -

 DPX -

FLI
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The main characteristics of the export formats :

Export Colors Other options

PNG

PCX

SUNRASTER -

PSD -

TGA

JPG -

BMP
in TVP

ILBM

TIFF -

SGI
-

SOFTIMAGE 
-
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The available keyboard shortcuts and commands

The available keyboard shortcuts and commands

[All Commands]

Tools: Right Mouse Button 
Undo: Multi Redo 
Undo: Last Action 
Undo: Project: Redo 
Undo: Project: Undo 
Undo: FX Stack: Redo 
Undo: FX Stack: Undo 
Color: Pick 
Color: Pick B Color 
TVP Animation: Magic Number 
TVP Animation: Help 
Image Buffer: Hold 
Image Buffer: Fetch 
Spare: Copy To 
Spare: Exchange 
Clipboard: Save Image 
Clipboard: Load Image 
Clipboard: Save Brush 
Clipboard: Load Brush 
File Project: New 
File Project: Open 
File Project: Save 
File Project: Save As 
File Project: Save all 
File Project: Close 
Project: Clip: Save Current Clip 
TVP Animation: Quit 
TVP Animation: Iconify 
Printer: Config 
Printer: Print 
Twain: Acquire 
File Import: Project 
File Import: Sequence 
File Import: Brush 
File Export: Sequence 
File Export: Brush 
Interface: Open Main Panel 
Interface: Close Main Panel 
Interface: Toggle Main Panel 
Interface: Open Menu Panel 
Interface: Close Menu Panel 
Interface: Toggle Menu Panel 
Interface: Toggle Tools Panel 
Interface: Open Tools Panel 
Interface: Close Tools Panel 
Interface: Toggle FX Panel 
Interface: Open FX Panel 
Interface: Close FX Panel 
Interface: Open Time Line Panel 
Interface: Open XSheet Panel 
Layer: Set Frame Repeat 
Interface: Open Project Panel 
Interface: Toggle LightTable Panel 
Interface: Open LightTable Panel 
Interface: Close LightTable Panel 
Layer: Light Table: Out Of Pegs Reset Keys 
Layer: Light Table: Out Of Pegs Edit Next Key 
Layer: Light Table: Out Of Pegs Edit Prev Key 
Interface: Toggle Palette Panel 
Interface: Open Palette Panel 
Interface: Close Palette Panel 
Interface: Toggle Layer Panel 
Interface: Open Layer Panel 
Interface: Close Layer Panel 
Interface: Toggle Navigator Panel 
Interface: Open Navigator Panel 
Interface: Close Navigator Panel 

Interface: Toggle Remote Panel 
Interface: Open Remote Panel 
Interface: Close Remote Panel 
Interface: Toggle Gradient Panel 
Interface: Open Gradient Panel 
Interface: Close Gradient Panel 
Interface: Toggle Coordinates Panel 
Interface: Open Coordinates Panel 
Interface: Close Coordinates Panel 
Interface: Toggle Paper Panel 
Interface: Open Paper Panel 
Interface: Close Paper Panel 
Interface: Toggle Guides Panel 
Interface: Open Guides Panel 
Interface: Close Guides Panel 
Interface: Toggle Grid Panel 
Interface: Open Grid Panel 
Interface: Close Grid Panel 
Interface: Open Video In Panel 
Interface: Close Video In Panel 
Interface: Toggle Video In Panel 
Interface: Open Video Out Panel 
Interface: Close Video Out Panel 
Interface: Toggle Video Out Panel 
Interface: Open Preview Settings Panel 
Interface: Close Preview Settings Panel 
Interface: Toggle Preview Settings Panel 
Interface: Open Preferences Panel 
Interface: Open Display Panel 
Interface: Close Display Panel 
Interface: Toggle Display Panel 
Interface: Open Shape Settings Panel 
Interface: Close Shape Settings Panel 
Interface: Toggle Shape Settings Panel 
Interface: Open Path Manager Panel 
Interface: Close Path Manager Panel 
Interface: Toggle Path Manager Panel 
Interface: Open Pixel Tracker Panel 
Interface: Open Path Recorder Panel 
Interface: Open Connection Panel 
Interface: Open Drawing Recorder Panel 
Interface: Close Drawing Recorder Panel 
Interface: Toggle Drawing Recorder Panel 
Interface: Open Custom Panel 
Interface: Close Custom Panel 
Interface: Toggle Custom Panel 
Interface: Open Peg-Holes Registration Panel 
Interface: Close Peg-Holes Registration Panel 
Interface: Toggle Peg-Holes Registration Panel 
Interface: Open Image Mark Panel 
Interface: Close Image Mark Panel 
Interface: Toggle Image Mark Panel 
Interface: Open Stopwatch Panel 
Interface: Close Stopwatch Panel 
Interface: Toggle Stopwatch Panel 
Interface: Open History Panel 
Interface: Close History Panel 
Interface: Toggle History Panel 
File Project: Resize 
Interface: Configure Keyboard 
TVP Animation: About 
Interface: Close Window 
Interface: Next Cursor 
Layer: Pick Layer 
Layer: Merge Display 
Layer: Merge visible 
Layer: Merge Selected 
Layer: Make Anim 
Layer: Recompute Exposures 
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Layer: Rename 
Layer: Select All 
Layer: Select Image From Keys 
Layer: Delete 
Layer: Duplicate 
Layer: New 
Layer: New Layer From Selected Images 
Layer: New Layers From Selected Images 
Layer: Insert Single Image Before Current Image 
Layer: Insert Single Image After Current Image 
Layer: Duplicate Single Image 
Layer: Insert Instances Before Current Image 
Layer: Insert Instances After Current Image 
Layer: Duplicate Image 
Project: Clip: Insert Images 
Project: Clip: Append Images 
Project: Clip: Duplicate Image 
Project: Clip: Insert Single Image 
Project: Clip: Append Single Image 
Project: Clip: Duplicate Single Image 
TVP Animation: Room 1 
TVP Animation: Room 2 
TVP Animation: Room 3 
TVP Animation: Room 4 
Layer: Insert Tween Image 
Layer: Insert Tween Images 
Layer: Retime 
Layer: Resize 
Project: Duplicate 
Layer: Select All Images 
Layer: Delete Image 
Project: Clip: Delete Image 
Project: Previous 
Project: Next 
Layer: First Layer 
Layer: Last Layer 
Layer: Previous Layer 
Layer: Next Layer 
Layer: First Layer with Selection 
Layer: Last Layer with Selection 
Layer: Previous Layer with Selection 
Layer: Next Layer with Selection 
Layer: Move Layer Up 
Layer: Move Layer Down 
Layer: Position Lock 
Layer: Position Unlock 
Layer: Position Lock Toggle 
Layer: First Image 
Layer: Last Image 
Layer: Next Image 
Layer: Prev Image 
Layer: Go Right 
Layer: Go Left 
Layer: Go Up 
Layer: Go Down 
Layer: Go Left with Selection 
Layer: Go Right with Selection 
Layer: Go Up with Selection 
Layer: Go Down with Selection 
Layer: First Image with Selection 
Layer: Last Image with Selection 
Layer: Next Image with Selection 
Layer: Prev Image with Selection 
Layer: Next Key 
Layer: Prev Key 
Layer: Next Key with Selection 
Layer: Prev Key with Selection 
Layer: Create Key 
Layer: Delete Instance Head 
Layer: Toggle Auto Key 
Layer: Select All Keys 
Layer: Toggle Display All 

Layer: Toggle Stencil 
Layer: Invert Stencil 
Layer: Show All 
Layer: Hide All 
Layer: Clear All Stencil 
Layer: Invert All Stencil 
Layer: Previous Blending Mode 
Layer: Next Blending Mode 
Image: Basic Scan Cleaner 
Image: Flip Horizontally 
Image: Flip Vertically 
Image: Flip Both Axis 
Timeline: Zoom In 
Timeline: Zoom Out 
Layer: Light Table Mode 
Timeline: Toggle Frames/Time Code 
Layer: Toggle Background Mode 
Layer: Background Mode None 
Layer: Background Mode Color 
Layer: Background Mode Check 
Preview: Play 
Preview: Play From Current Image 
Preview: Flip Book 
Preview: Flip Light Table 
Preview: Flip Previous Frame 
Layer: Exposure: Add single 
Layer: Exposure: Add multiple... 
Layer: Exposure: Remove single 
Layer: Exposure: Remove multiple... 
Layer: Exposure: Remove All 
Layer: Exposure: Go to Next Instance 
Layer: Exposure: Go to Previous Instance 
Layer: Exposure: Next Loop 
Layer: Exposure: Prev Loop 
Layer: Exposure: Go to Instance Head 
Layer: Exposure: Go to Instance Tail 
Layer: Exposure: Break 
Layer: Exposure: Delete Instance Head 
Layer: Exposure: Select 
Project: Clip: Add Exposures 
Project: Clip: Add Single Exposure 
Layer: Exposure: Toggle Auto Create Instance 
Layer: Exposure: Activate Auto Create Instance 
Layer: Exposure: Inactivate Auto Create Instance 
Layer: Exposure: Toggle Auto Break Instance 
Layer: Exposure: Activate Auto Break Instance 
Layer: Exposure: Inactivate Auto Break Instance 
Layer: Exposure: Faux-Fixe 
Layer: Exposure: Faux-Fixe Mode Repeat 
Layer: Exposure: Faux-Fixe Mode Ping Pong 
Layer: Exposure: Faux-Fixe Mode Random 
Layer Sound: Load 
Timeline: Fit To Clip 
Timeline: Fit To Selection 
Timeline: Fit To Layer 
Timeline: Fit To Keys 
Timeline: Fit To Sound 
Timeline: Fit To Frame 
Timeline: Fit To Exposure Handle 
Layer: Reverse Selection 
Layer: Split 
Layer: Join Selected Layers 
Layer: Link 
Layer: Align Left 
Layer: Align Right 
Layer: Slide 
Layer: Slide To 
Layer: Go to Image 
Timeline: Expand / Collapse Current Layer 
Layer: Select Current Image 
Layer: Select Current Layer 
Layer Blending Mode: Color 
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Layer Blending Mode: Behind 
Layer Blending Mode: Erase 
Layer Blending Mode: Shade 
Layer Blending Mode: Light 
Layer Blending Mode: Colorize 
Layer Blending Mode: Tint 
Layer Blending Mode: Saturate2 
Layer Blending Mode: Value 
Layer Blending Mode: Add 
Layer Blending Mode: Sub 
Layer Blending Mode: Multiply 
Layer Blending Mode: Screen 
Layer Blending Mode: Replace 
Layer Blending Mode: Substitute 
Layer Blending Mode: Difference 
Layer Blending Mode: Divide 
Layer Blending Mode: Overlay 
Layer Blending Mode: Dodge (Light2) 
Layer Blending Mode: Burn (Shade2) 
Layer Blending Mode: Hard Light 
Layer Blending Mode: Soft Light 
Layer Blending Mode: Grain Extract 
Layer Blending Mode: Grain Merge 
Layer Blending Mode: Subtract 
Layer Blending Mode: Darken Only 
Layer Blending Mode: Lighten Only 
FX Stack: Apply 
FX Stack: Reset All 
FX Stack: Delete All 
Zoom: New Zoom window 
Zoom: Toggle Aspect 
Zoom: Toggle Video 
Zoom: Center 
Zoom: In 
Zoom: Out 
Zoom: Fit 
Zoom: Fit Project Panel 
Zoom: 100% 
Zoom: Rotation Reset 
Zoom: Rotate +15 (counter clockwise) 
Zoom: Rotate -15 (clockwise) 
Zoom: Flip horizontally 
Zoom: Flip vertically 
Zoom: Shake 
Zoom: Black Preview 
Zoom: Show full page 
Interface: Full Screen 
Zoom: Scroll Up 
Zoom: Scroll Up Left 
Zoom: Scroll Left 
Zoom: Scroll Down Left 
Zoom: Scroll Down 
Zoom: Scroll Down Right 
Zoom: Scroll Right 
Zoom: Scroll Up Right 
Interface: Toggle windows display 
Zoom: Next Zoom window 
Zoom: Prev Zoom window 
Tools: Draw Dot 
Tools: Custom Brush Stamp in Place 
Tools: Toggle Stencil 
Tools: Toggle Paper 
Tools: Toggle Transparency 
Tools Brush: Move Left 
Tools Brush: Move Right 
Tools Brush: Move Up 
Tools Brush: Move Down 
Tools Brush: Increase Size 
Tools Brush: Increase Size 2 
Tools Brush: Decrease Size 
Tools Brush: Decrease Size 2 
Tools Brush: Change size 

Tools Brush: reset 
Layer: Clear 
Tools Mode: Next 
Tools Mode: Prev 
Tools Mode: Default 
Drawing Mode: 01 (Color) 
Drawing Mode: 02 (Behind) 
Drawing Mode: 03 (Erase) 
Drawing Mode: 04 (Panto) 
Drawing Mode: 05 (Merge) 
Drawing Mode: 06 (Shade) 
Drawing Mode: 07 (Light) 
Drawing Mode: 08 (Colorize) 
Drawing Mode: 09 (Tint) 
Drawing Mode: 10 (Grain) 
Drawing Mode: 11 (Smooth) 
Drawing Mode: 12 (Noise) 
Drawing Mode: 13 (Negative) 
Drawing Mode: 14 (Sharp) 
Drawing Mode: 15 (Emboss) 
Drawing Mode: 16 (Solarize) 
Drawing Mode: 17 (Saturate) 
Drawing Mode: 18 (UnSaturate) 
Drawing Mode: 19 (Add) 
Drawing Mode: 20 (Sub) 
Drawing Mode: 21 (Multiply) 
Drawing Mode: 22 (Screen) 
Drawing Mode: 23 (Alpha Diff) 
Drawing Mode: 24 (Healing) 
Drawing Mode: 25 (Overlay) 
Drawing Mode: 26 (Burn) 
Drawing Mode: 27 (Dodge) 
Drawing Mode: 28 (Darken) 
Drawing Mode: 29 (Lighten) 
Tools Brush: Air 
Tools Brush: Pen 
Tools Brush: Oil Paint 
Tools Brush: Water Color 
Tools Brush: Mechanical 
Tools Brush: Pencil 
Tools Brush: Warp 
Tools Brush: Special 
Tools Brush: Text 
Tools Brush: CustomBrush 
Tools Brush: Previous 
Tools Brush: Next 
Tools Brush: Toggle Display 
Brush: Toggle CutBrush 
Brush: Cut Rectangle 
Brush: Cut Magic Wand 
Brush: Cut Poly 
Brush: Cut Freehand 
Brush: Double Size 
Brush: Halve Size 
Brush: Toggle Handle Corner 
Brush: Move Handle Corner 
Brush: Outline 
Brush: Double Width 
Brush: Double Height 
Brush: Halve Height 
Brush: Halve Width 
Brush: Flip Horizontally 
Brush: Flip Vertically 
Brush: Rotate 90° 
Brush: Rotate -90° 
Brush: Rotate 
Brush: Resize 
Brush: Free Resize 
Brush: Optimize 
Brush: Optimize Source 
Brush: Toggle Transparency 
Brush: Next Animbrush 
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Brush: Previous Animbrush 
Brush: Toggle Stamp/Brush 
Shape: Apply 
Shape: Cancel 
Shape: Erase Last Point 
Shape: Freehand Dot 
Shape: Single Dot 
Shape: Freehand 
Shape: Freehand Fill 
Shape: Circle 
Shape: Circle Fill 
Shape: Circle 2Pts 
Shape: Circle 2Pts Fill 
Shape: Circle 3Pts 
Shape: Circle 3Pts Fill 
Shape: Line 
Shape: Poly Fill 
Shape: Flood Fill 
Shape: Spline 3Pts 
Shape: Spline 
Shape: Spline Fill 
Shape: Spline B-Spline 
Shape: Spline B-Spline Fill 
Shape: Rectangle 
Shape: Rectangle Fill 
Shape Select: FreeHand 
Shape Select: Rectangle 
Shape Select: Ellipse 
Shape Select: MagicWand 
Shape Select: Spline 
Shape Select: Clear 
Shape Select: Invert 
Shape Select: Copy To CustomBrush 
Shape Select: Cut To CustomBrush 
Shape Select: Copy To New Layer 
Shape Select: Cut To New Layer 
Shape Transform: Pan 
Shape Transform: Position 
Shape Transform: Warp 
Shape Transform: Camera 
Tools Pantograph: Set 
Tools Healing: Set 
Timeline: Notes: Toggle Display 
Timeline: Notes: Show 
Timeline: Notes: Hide 
Timeline: Notes: Toggle 
Timeline: Notes: Open 
Timeline: Notes: Close 
Timeline: Audio: Toggle 
Timeline: Audio: Open 
Timeline: Audio: Close 
Audio: Scrub: Never 
Audio: Scrub: Scrub 
Audio: Scrub: Always 
Audio: Scrub: Toggle 
Audio: Mute: On 
Audio: Mute: Off 
Audio: Mute: Toggle 
Tools: Crop 
Tools: Zoom In 
Tools: Zoom Out 
TVP Animation: Copy Selection 
TVP Animation: Paste 
TVP Animation: Cut Selection 
TVP Animation: Select All 
TVP Animation: Delete Selection 
Color: Up 
Color: Down 
Color: Right 
Color: Left 
Color: Invert A/B 
Color: Hue << 

Color: Hue >> 
Color: Saturation - 
Color: Saturation + 
Color: Luminosity - 
Color: Luminosity + 
Color: Red - 
Color: Red + 
Color: Green - 
Color: Green + 
Color: Blue - 
Color: Blue + 
Gradient: Next 
Gradient: Previous 
Gradient: Load 
Gradient: Save 
Gradient: Default 
Gradient: Invert 
Grid: Toggle 
Grid: Snap 
Grid: Display 
Guides: Toggle 
Guides: Snap 
Guides: Display 
Guides: Add 
Guides: Remove 
Display: Show SafeArea 
Display: Show FieldChart 
Display: Show Stencil 
Display: Show Selection 
Display: Show Paper 
Display: Show Camera 
Grab: Video Input 
Grab: Switch Modes 
Grab: Grab Length 
Grab: Increase Grab Length 
Grab: Decrease Grab Length 
Bookmarks: Set 
Bookmarks: Clear 
Bookmarks: Clear All 
Bookmarks: Toggle 
Bookmarks: Next 
Bookmarks: Previous 
Mark In/Out: Set Mark In 
Mark In/Out: Toggle Mark In 
Mark In/Out: Go to Mark In 
Mark In/Out: Set Mark Out 
Mark In/Out: Toggle Mark Out 
Mark In/Out: Go to Mark Out 
ImageMarks: Set 
ImageMarks: Clear 
ImageMarks: Toggle 
ImageMarks: Clear All 
ImageMarks: Next 
ImageMarks: Previous 
Project: Publish 
Project: Publish in HTML 
Project: Publish in PDF 
Project: Publish in EDL 
Project: ReExport in EDL (Current clip, Original param.) 
Project: ReExport in EDL (Current clip, Custom param.) 
Project: Clip: Duplicate 
Project: Clip: Split 
Project: Clip: Add 
Project: Clip: Insert 
Project: Clip: Remove 
Project: Scene: Duplicate 
Project: Scene: Add 
Project: Scene: Insert 
Project: Scene: Remove 
Project: Scene: Split 
Project: Scene: Join 
Project: Clip: Goto Next 
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Project: Clip: Goto Next with selection 
Project: Clip: Goto Previous 
Project: Clip: Goto Previous with selection 
Project: Clip: Goto First 
Project: Clip: Goto First with selection 
Project: Clip: Goto Last 
Project: Clip: Goto Last with selection 
Project: Scene: Goto Next 
Project: Scene: Goto Next with selection 
Project: Scene: Goto Previous 
Project: Scene: Goto Previous with selection 
Project: Scene: Goto Head 
Project: Scene: Goto Head with selection 
Project: Scene: Goto Tail 
Project: Scene: Goto Tail with selection 
Project: New Project From Selected Clips 
Project: Clip: Copy Current
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[Shortcuts]

"A" = Zoom: Shake 
"B" = Brush: Toggle CutBrush 
"C" = Brush: Rotate 
"D" = Shape: Freehand 
"E" = Tools Brush: Next 
"F" = Shape: Flood Fill 
"G" = Grid: Toggle 
"H" = Brush: Halve Size 
"I" = Project: Clip: Append Images 
"J" = Spare: Exchange 
"K" = none 
"L" = Shape: Line 
"M" = Zoom: New Zoom window 
"N" = Color: Invert A/B 
"O" = Brush: Outline 
"P" = Interface: Toggle Palette Panel 
"Q" = Shape: Spline 
"R" = Shape: Rectangle 
"S" = Shape: Freehand Dot 
"T" = Tools Brush: Text 
"U" = Undo: Last Action 
"V" = Interface: Full Screen 
"W" = Preview: Flip Book 
"X" = Brush: Flip Horizontally 
"Y" = Brush: Flip Vertically 
"Z" = Tools Brush: Change size 
"Shift A" = Interface: Toggle Tools Panel 
"Shift B" = Layer: Toggle Background Mode 
"Shift C" = Tools Healing: Set 
"Shift D" = Interface: Open Preferences Panel 
"Shift E" = File Export: Brush 
"Shift F" = Layer: Go to Image 
"Shift G" = Interface: Open Grid Panel 
"Shift H" = Brush: Double Size 
"Shift I" = Project: Clip: Insert Images 
"Shift J" = Spare: Copy To 
"Shift K" = Layer: Clear 
"Shift L" = File Project: Open 
"Shift M" = none 
"Shift N" = File Project: New 
"Shift O" = Brush: Toggle Handle Corner 
"Shift P" = Tools Pantograph: Set 
"Shift Q" = TVP Animation: Quit 
"Shift R" = Shape: Rectangle Fill 
"Shift S" = File Project: Save 
"Shift T" = none 
"Shift U" = Undo: Multi Redo 
"Shift V" = Zoom: Show full page 
"Shift W" = File Project: Close 
"Shift X" = Brush: Double Width 
"Shift Y" = Undo: Multi Redo 
"Shift Z" = Brush: Rotate 90° 
"Ctrl A" = TVP Animation: Select All 
"Ctrl B" = none 
"Ctrl C" = TVP Animation: Copy Selection 
"Ctrl D" = Shape Select: Clear 
"Ctrl E" = Tools Brush: Previous 
"Ctrl F" = Layer: Slide To 
"Ctrl G" = none 
"Ctrl J" = none 
"Ctrl K" = Interface: Configure Keyboard 
"Ctrl L" = Layer: Light Table Mode 
"Ctrl N" = Layer: New + Layer: Make Anim 
"Ctrl O" = File Project: Open 
"Ctrl P" = Printer: Print 
"Ctrl Q" = none 
"Ctrl R" = 
"Ctrl S" = File Project: Save 
"Ctrl T" = Shape Transform: Position 
"Ctrl U" = none 

"Ctrl V" = TVP Animation: Paste 
"Ctrl W" = none 
"Ctrl X" = TVP Animation: Cut Selection 
"Ctrl Y" = Brush: Flip Vertically 
"Ctrl Z" = Undo: Last Action 
"Ctrl Shift A" = none 
"Ctrl Shift B" = none 
"Ctrl Shift C" = none 
"Ctrl Shift D" = none 
"Ctrl Shift E" = File Export: Sequence 
"Ctrl Shift F" = none 
"Ctrl Shift G" = none 
"Ctrl Shift J" = none 
"Ctrl Shift K" = none 
"Ctrl Shift L" = none 
"Ctrl Shift N" = none 
"Ctrl Shift O" = none 
"Ctrl Shift P" = none 
"Ctrl Shift Q" = none 
"Ctrl Shift R" = none 
"Ctrl Shift S" = File Project: Save all 
"Ctrl Shift T" = none 
"Ctrl Shift U" = none 
"Ctrl Shift V" = none 
"Ctrl Shift W" = none 
"Ctrl Shift X" = none 
"Ctrl Shift Y" = none 
"Ctrl Shift Z" = none 
"Cmd A" = TVP Animation: Select All 
"Cmd B" = none 
"Cmd C" = TVP Animation: Copy Selection 
"Cmd D" = none 
"Cmd E" = none 
"Cmd F" = none 
"Cmd G" = none 
"Cmd H" = none 
"Cmd I" = none 
"Cmd J" = none 
"Cmd K" = none 
"Cmd L" = none 
"Cmd M" = none 
"Cmd N" = Layer: New 
"Cmd O" = File Project: Open 
"Cmd P" = none 
"Cmd Q" = TVP Animation: Quit 
"Cmd R" = none 
"Cmd S" = File Project: Save 
"Cmd T" = none 
"Cmd U" = none 
"Cmd V" = TVP Animation: Paste 
"Cmd W" = Interface: Close Window 
"Cmd X" = TVP Animation: Cut Selection 
"Cmd Y" = Undo: Multi Redo 
"Cmd Z" = Undo: Last Action 
"Cmd Shift A" = none 
"Cmd Shift B" = none 
"Cmd Shift C" = none 
"Cmd Shift D" = none 
"Cmd Shift E" = File Export: Sequence 
"Cmd Shift F" = none 
"Cmd Shift G" = none 
"Cmd Shift H" = none 
"Cmd Shift I" = none 
"Cmd Shift J" = none 
"Cmd Shift K" = none 
"Cmd Shift L" = none 
"Cmd Shift M" = none 
"Cmd Shift N" = none 
"Cmd Shift O" = none 
"Cmd Shift P" = none 
"Cmd Shift Q" = none 
"Cmd Shift R" = none 
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"Cmd Shift S" = File Project: Save 
"Cmd Shift T" = none 
"Cmd Shift U" = none 
"Cmd Shift V" = none 
"Cmd Shift W" = none 
"Cmd Shift X" = none 
"Cmd Shift Y" = none 
"Cmd Shift Z" = none 
"0" = Interface: Toggle Layer Panel 
"1" = Zoom: Scroll Down Left 
"2" = Zoom: Scroll Down 
"3" = Zoom: Scroll Down Right 
"4" = Zoom: Scroll Left 
"5" = Zoom: Center 
"6" = Zoom: Scroll Right 
"7" = Zoom: Scroll Up Left 
"8" = Zoom: Scroll Up 
"9" = Zoom: Scroll Up Right 
"Ctrl Pad 0" = Zoom: 100% 
"Ctrl Pad 1" = TVP Animation: Room 1 
"Ctrl Pad 2" = Tools Brush: Move Down 
"Ctrl Pad 3" = TVP Animation: Room 2 
"Ctrl Pad 4" = Tools Brush: Move Left 
"Ctrl Pad 5" = none 
"Ctrl Pad 6" = Tools Brush: Move Right 
"Ctrl Pad 7" = TVP Animation: Room 3 
"Ctrl Pad 8" = Tools Brush: Move Up 
"Ctrl Pad 9" = TVP Animation: Room 4 
"Cmd 0" = none 
"Cmd 1" = none 
"Cmd 2" = none 
"Cmd 3" = none 
"Cmd 4" = none 
"Cmd 5" = none 
"Cmd 6" = none 
"Cmd 7" = none 
"Cmd 8" = none 
"Cmd 9" = none 
"/" = Tools Brush: Decrease Size 2 
"*" = Tools Brush: Increase Size 2 
"-" = Tools Brush: Decrease Size 
"+" = Tools Brush: Increase Size 
"," = Layer: Pick Layer 
";" = Color: Pick 
":" = Tools Brush: reset 
"!" = Timeline: Notes: Toggle 
"<" = Zoom: Out 
">" = Zoom: In 
"&" = none 
"~" = none 
""" = none 
"#" = none 
"'" = none 
"|" = Interface: Toggle Coordinates Panel 
"`" = none 
"_" = none 
"\" = none 
"@" = none 
"(" = none 
")" = none 
"[" = Zoom: Flip horizontally 
"]" = Zoom: Flip horizontally 
"{" = none 
"}" = none 
"$" = none 
"?" = none 
"%" = none 
"." = none 
"=" = Layer: Toggle Display All 
"^" = none 
"F1" = TVP Animation: Help 
"F2" = Drawing Mode: 01 (Color) 

"F3" = Drawing Mode: 02 (Behind) 
"F4" = Drawing Mode: 03 (Erase) 
"F5" = Drawing Mode: 04 (Panto) 
"F6" = Drawing Mode: 05 (Merge) 
"F7" = Drawing Mode: 06 (Shade) 
"F8" = Drawing Mode: 07 (Light) 
"F9" = Drawing Mode: 08 (Colorize) 
"F10" = Drawing Mode: 09 (Tint) 
"F11" = Zoom: Show full page 
"F12" = Interface: Toggle windows display 
"Ctrl F1" = none 
"Ctrl F2" = none 
"Ctrl F3" = none 
"Ctrl F4" = Interface: Close Window 
"Ctrl F5" = none 
"Ctrl F6" = none 
"Ctrl F7" = none 
"Ctrl F8" = none 
"Ctrl F9" = TVP Animation: Iconify 
"Ctrl F10" = none 
"Ctrl F11" = none 
"Ctrl F12" = none 
"Shift F1" = none 
"Shift F2" = none 
"Shift F3" = none 
"Shift F4" = none 
"Shift F5" = none 
"Shift F6" = none 
"Shift F7" = none 
"Shift F8" = none 
"Shift F9" = none 
"Shift F10" = none 
"Shift F11" = none 
"Shift F12" = none 
"Ctrl Shift F1" = none 
"Ctrl Shift F2" = none 
"Ctrl Shift F3" = none 
"Ctrl Shift F4" = none 
"Ctrl Shift F5" = none 
"Ctrl Shift F6" = none 
"Ctrl Shift F7" = none 
"Ctrl Shift F8" = none 
"Ctrl Shift F9" = none 
"Ctrl Shift F10" = none 
"Ctrl Shift F11" = none 
"Ctrl Shift F12" = none 
"Space" = Tools: Right Mouse Button 
"Shift Space" = none 
"Ctrl Space" = none 
"Tab" = Project: Clip: Goto Next 
"Shift Tab" = Project: Clip: Goto Previous 
"Ctrl Tab" = Zoom: Next Zoom window 
"Ctrl Shift Tab" = Zoom: Prev Zoom window 
"Enter" = Shape: Apply 
"Shift Enter" = none 
"Escape" = Shape: Cancel 
"Shift Escape" = none 
"Home" = Layer: First Image 
"Shift Home" = Zoom: Rotation Reset 
"Ctrl Home" = Layer: First Layer 
"Ctrl Shift Home" = none 
"End" = Layer: Last Image 
"Ctrl End" = Layer: Last Layer 
"Shift End" = none 
"Ctrl Shift End" = TVP Animation: Magic Number 
"Del" = TVP Animation: Delete Selection 
"Shift Del" = Shape: Erase Last Point 
"Ctrl Del" = none 
"Ctrl Shift Del" = none 
"Backspace" = Layer: Clear 
"Shift Backspace" = none 
"Ctrl Backspace" = none 
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"Ctrl Shift Backspace" = none 
"Wheel Up" = Tools Brush: Increase Size 
"Shift Wheel Up" = Tools Brush: Increase Size 2 
"Ctrl Wheel Up" = none 
"Ctrl Shift Wheel Up" = none 
"Wheel Down" = Tools Brush: Decrease Size 
"Shift Wheel Down" = Tools Brush: Decrease Size 2 
"Ctrl Wheel Down" = none 
"Ctrl Shift Wheel Down" = none 
"Up" = Layer: Go Up 
"Shift Up" = Layer: Go Up with Selection 
"Ctrl Up" = Layer: Move Layer Up 
"Ctrl Shift Up" = Bookmarks: Toggle 
"Down" = Layer: Go Down 
"Shift Down" = Layer: Go Down with Selection 
"Ctrl Down" = Layer: Move Layer Down 
"Ctrl Shift Down" = Color: Down 
"Left" = Layer: Go Left 
"Shift Left" = Layer: Go Left with Selection 

"Ctrl Left" = Layer: Exposure: Go to Previous Instance 
"Ctrl Shift Left" = Bookmarks: Previous 
"Right" = Layer: Go Right 
"Shift Right" = Layer: Go Right with Selection 
"Ctrl Right" = Layer: Exposure: Go to Next Instance 
"Ctrl Shift Right" = Bookmarks: Next 
"Page Up" = Layer: Prev Key 
"Shift Page Up" = Zoom: Rotate +15 (counter clockwise) 
"Ctrl Page Up" = none 
"Ctrl Shift Page Up" = none 
"Page Down" = Layer: Next Key 
"Shift Page Down" = Zoom: Rotate -15 (clockwise) 
"Ctrl Page Down" = none 
"Ctrl Shift Page Down" = none 
"MMB" = none 
"Shift MMB" = none 
"Ctrl MMB" = none 
"Ctrl Shift MMB" = none
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The technical support and internet resources

We did our best to provide you a detailed user-manual, with a lot of illustrated examples.
However, you may still have questions regarding the software.
You can find additional and helpful informations about the TVPaint technology on our website :
www.tvpaint.com

You will find :

* Latest news, about the TVPaint Technology
* Tutorials, palettes, custom brushes, papers, scripts and plug-in.
* Some user-stories,
* Latest demos and updates For your current Software.
* Discussion forums with a technical support in french, english and spanish language.
* A gallery where hundreds of pictures and animations will show you the possibilities given by the 
TVPaint solutions from its creation.

It's  the  share  place  !  The  TVPaint  forums  gather  the  discussion  of  our  users, 
samples of their works as well as brushes, scripts and tips for the benefit of all. Feel 
free to post your own productions and to share your techniques !

Join the TVPaint users Community !

When  contacting  us  via  email,  forum,  phone,  ...  please  don't  forget  to  give  us  the  following 
informations :
* Your computer (PC, Macintosh, Linux...), its CPU (AMD, Intel, ...), it's amount of RAM
* Your operating system (apple OS-X, Microsoft windows, ...)
* The version of TVPaint Animation (Pro) that you are running : you can find it in the about section 
of the software (see below)
* Your video hardware, if you have one.
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The technical support and internet resources

Here are our full coordinates :

TVPAINT DEVELOPPEMENT
Route de Marange 
57280 Maizieres les Metz 
FRANCE

Phone : +33 (0)387 173 598
Fax : +33 (0)387 173 599
Email : tvpaint@tvpaint.fr

                

              

TVPaint  Developpement  is  located  at 
Maizieres Les Metz, 10 km aways from Metz. 
Transportation means for meeting us are :
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Planes : 
Metz / Nancy Lorraine Airport - 40 Km
http://www.metz-nancy-lorraine.aeroport.fr/ 
Luxembourg Findel Aiport - 55 Km
http://www.luxair.lu/fr/airport/ 

Trains : 
Metz Railway Station
Booking / Information SNCF :
Phone : +33 (0)8 92.35.35.35
http://www.sncf.com 

Metz Taxi :
Phone : +33 (0)3 87.56.91.92

Car : 
Autoroute A31, Exit n35
For a custom itinerary :
http://www.viamichelin.com 

http://www.viamichelin.com/
http://www.sncf.com/
http://www.luxair.lu/fr/airport/
http://www.metz-nancy-lorraine.aeroport.fr/
mailto:tvpaint@tvpaint.fr
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